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Welcome

Welcome to Seagate Crystal Reports, the most powerful Windows 
reporting tool available today. 

●   If you are new to the product, you will soon understand 
why more than a million users worldwide turn to Seagate 
Crystal Reports for all their reporting needs. 

●   If you are upgrading, thanks for your vote of confidence. 
Every effort has been made to make this release the best 
ever, offering major improvements over earlier versions.

This manual has been totally redesigned to fit the way users tell 
Seagate Software that they work. The emphasis is on getting the 
job done in the easiest way possible. To eliminate confusion, a 
show-as-you-go style that uses pictures liberally to demonstrate 
procedures has been adopted.

This manual contains instructions for most of the typical reporting 
tasks and for some very sophisticated tasks as well. It also 
contains a great deal of conceptual information to help you better 
understand databases, reporting, and the program itself.

There are many topics in this manual that deal with general areas 
of interest such as placing fields, formatting your report, and 
sorting records, as well as topics that deal with more specific areas 
of interest such as advanced formula creation and accessing 
different types of data. 

In most chapters, the Hands-On topics flow from general to more 
specific areas of interest. Consult What you will find in this chapter... 
(first page of each chapter) to target the information you need in a 
hurry.

Two kinds of Hands-On tutorials

Hands-On sections in this manual contain two types of tutorials:

1. Overview tutorials

2. Procedural tutorials
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Overview
tutorials

Overview tutorials present an overall view of a process. They are 
designed to provide an understanding of the concepts involved 
and are cross referenced to procedural tutorials for step-by-step 
instructions on completing core procedures contained within 
them. For example, a typical overview tutorial might discuss how 
to place three unrelated reports in a single report. One of the 
process steps is, “Create the first subreport.” No details on how to 
do this are provided in the overview tutorial; a cross reference is 
included to the procedural tutorial that will explain in a detailed 
fashion how to create a subreport.

Procedural
tutorials

Procedural tutorials demonstrate core procedures that are used 
again and again. For example, even though you may use 
subreports in many different situations, the two detailed 
procedures you need to understand are:

1. how to insert a subreport, and

2. how to link a subreport to the data in the primary report.

Each of these is explained in a step-by-step fashion using detailed 
process tutorials.

Command, button, key, and control conventions

This manual uses the following conventions:

Commands
and buttons

For easy recognition, command names and button names from the 
standard and supplementary toolbars and format bar are 
displayed in small caps. For example: NEW command, PRINT 
button, etc.

Dialog box
controls

Buttons, lists, check boxes, and other dialog box elements are 
displayed in italics. For example, Suppress check box, OK button, 
etc.

Key
combinations

Keyboard shortcuts appear in the following forms:

●   Delete means the Del key (either the Delete key, or the Del 
key on your numeric keypad).

●   Enter means the Enter, Return, CR, or ↵ key, depending on 
which of these keys appears on your keyboard.
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●   Ctrl-Key, Shift-Key, and Alt-Key are examples of the 
notation for two key combinations. Press the first key in the 
combination (Control, Shift, or Alt), and, at the same time, 
press the second key in the combination (designated above 
as Key). For example: Ctrl-C means to hold the Control key 
down and then press the letter C on your keyboard (Ctrl-C 
is the Windows Copy command).

Other
conventions

●   Text enclosed in double brackets (for example, 
«information») is intended to expand or explain the 
information that it follows.

●   Computer type indicates data that you are to enter using 
the computer keyboard. It is also used to show example 
formulas.

●   Field names appear in the following format:

{file.FIELD}

   file represents the alias of the table the field comes 
from.

   FIELD represents the name of the field in that table.

●   Text that you should pay special attention to within normal 
body text is underlined.

●   NOTES are used to provide extra or special information 
regarding the preceding topic.

●   \WINDOWS\SYSTEM refers to the System subdirectory of 
the Windows directory on your computer or network 
server. By default, this directory is 
C:\WINDOWS\SYSTEM in Windows 3.1 and Windows 95 
and C:\WINNT35\SYSTEM32 in Windows NT 3.51 or 
later. This directory may be different on your system. If you 
are unsure, contact your network administrator, or refer to 
your Windows documentation.

●   Related Topics lists point to other topics in this manual and 
online Help systems that deal with related procedures, 
additional uses for the same command or dialog box, or 
alternative methods for accomplishing the same task.
4 Seagate Crystal Reports User�s Guide



●   Not all of the pictures used in the Hands-On sections reflect 
exactly what you will see on screen.

   Some of the example reports have been designed to 
illustrate concepts only, not the actual look of your 
finished report.

   Some menus have been shortened by removing some of 
the commands that are unrelated to the current 
discussion.

   The data in some lists has been abbreviated to focus 
attention on the specific items of interest.

   In some cases, an individual screenshot illustrates both a 
before and after state of a dialog box when such an 
illustration can be done without confusion.

●   In the Hands-On tutorial sections, be sure to pay attention 
to the callout text accompanying all screenshots and 
graphics. Often the callouts are steps necessary to complete 
the tutorial and to pass by one inadvertently may cause 
undesirable or incorrect results.

Using Seagate Crystal Reports documentation

In addition to this User’s Guide, the product includes a 
comprehensive set of online and printed learning tools to help 
you when you are getting started with the program and when you 
need answers fast in your day-to-day reporting.

Whether you are a beginner or an expert, Seagate Crystal Reports 
documentation provides a clear and easy path to productivity. For 
a complete description of learning tools and suggested learning 
paths, see Learning Seagate Crystal Reports, Page 35.

PROFESSIONAL EDITION FEATURES

This User’s Guide is distributed with both the Standard and 
Professional Editions of Seagate Crystal Reports. The following 
list identifies those features and capabilities that are discussed in 
the User’s Guide but that are available only in the Professional 
Edition:
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●   Crystal Web Report Server

●   Crystal Report Engine Automation Server

●   Crystal Report Engine Object Library

●   Active Data Driver

●   Crystal Data Object (CDO)

●   Crystal Dictionary Designer 

●   Crystal Query Designer

●   Reading SQL databases

●   Reading Microsoft Exchange data files

●   Exporting to ODBC data sources

Seagate Crystal Reports online Help features

The online Help systems included with the program are full of 
useful information.

●   Seagate Crystal Reports online Help (CRW.HLP)
This help file includes all the information included in the 
Seagate Crystal Reports User’s Guide with special emphasis 
on helping the user understand the interface with hundreds 
of “How to” tutorials.

●   Developer’s online Help (DEVELOPR.HLP)
Description of all functions and structures, conceptual 
information, and sample code for the following:

   ActiveX

   Crystal Report Engine Automation Server

   Active Data Driver

   NewEra

   PEPlus

   Report Engine API

   Visual Basic API

   VBX

   VCL
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●   Dictionary online Help (DICTNRY.HLP)
Dictionary online Help includes all the information you 
need to create, modify, and work with dictionaries.

●   Query Designer online Help (QUERY.HLP)
Query Designer online Help includes all the information 
you need to create and edit queries for use in creating 
reports

●   Readme online Help (README.HLP)
ReadMe Help including topics such as the following:

   Obsolete API calls

   Installation Topics

   Configuration and SetUp Topics

   Quick Start

   International Partners Directory

   BackOffice Reports

   Using DBGrid with the Query Module

●   Runtime File Requirements online Help 
(RUNTIME.HLP)
Runtime Help including all the DLLs and UFLs distributed 
with Seagate Crystal Reports including:

   the exact name,

   location, and

   description.

●   Pro Sample Reports online Help (SAMPLE.HLP)
Sample Reports Help for Professional edition of Seagate 
Crystal Reports including:

   the reports listed by type,

   name of the sample report,

   description of each,

   list of financial functions used in each report with a link 
to a complete description of the function, 

   Back Office sample reports.
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●   Standard Sample Reports online Help (SAMPLE.HLP)
Sample Reports Help for the Standard edition of Seagate 
Crystal Reports including:

   the reports listed by type,

   name of the sample report, and

   description of each.

●   Reports at a Glance online Help (RPTGLANC.HLP)
Reports at a Glance online Help is a complete online help 
system for the Reports at a Glance application.

Here is just a sampling of things you will find in these help files:

●   Explanations of error messages and formula compiler 
errors. Search for Error Messages and Formula Compiler 
Warnings in Seagate Crystal Reports online Help.

●   Runtime information so you know which files to include 
when you include the Crystal Report Engine with your 
application. See Runtime File Requirements online Help.

●   Tips and Tricks: dozens of helpful hints for working with 
Seagate Crystal Reports. Search for Tips and Tricks in 
Seagate Crystal Reports online Help.

●   Formulas for study: a series of complex formulas that 
showcase the use of Seagate Crystal Reports functions, 
operators, and formatting language in solving a number of 
real-world reporting problems. Search for Formulas in 
Action Index in Seagate Crystal Reports online Help.

●   Specialized formulas: a collection of formulas that address 
specific reporting needs. Search for Specialized Formulas in 
Seagate Crystal Reports online Help.

●   Sample formulas: a number of topics contain sample 
formulas that can be cut and pasted directly into the 
Formula Editor to save you time. Search for Copying 
formulas from online Help in Seagate Crystal Reports online 
Help.

●   Formula functions and operators: a complete and detailed 
list of all functions and operators you can use when creating 
formulas including specialized financial functions used to 
design our sample reports. Search for Functions or Operators 
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or for the individual function or operator by name in 
Seagate Crystal Reports online Help.

●   Full documentation of the Report Engine API. Search for 
Report Engine Functions in Developer’s online Help.

●   Sample code for making calls to the Report Engine from 
your C, Visual Basic, or Delphi application. Using the Copy 
(Ctrl-C) and Paste (Ctrl-V) commands built into Windows 
Help, you can copy this code and paste it as ASCII text into 
any editor that supports Windows Copy and Paste 
procedures. Search for Copying code from online Help in 
Developer’s online Help.

●   Full documentation of the Report Engine Class Library, a 
C++ class library addition to the Microsoft Foundation 
Class Library. Use the class definition in the Report Engine 
Class Library to access the Crystal Report Engine from your 
C++ application. Search for Class Library Index in 
Developer’s online Help.

●   Full documentation for the Crystal Custom Control, the 
Crystal ActiveX control, and the Crystal VCL you can use 
when working with development environments that 
support them. Search for The Crystal Custom Control, The 
Crystal ActiveX Control, or The Crystal VCL in Developer’s 
online Help.

●   Breakdown of sample applications included with the 
program. Search for Sample Applications in Developer’s 
online Help.

Online Help is a warehouse of information that can make your 
reporting more productive and enjoyable. A comprehensive 
indexing system and hundreds of search terms provide you a 
variety of avenues for finding the help you need, right from your 
computer. Once you see what's in the help system, you will most 
definitely return to it often.
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If you need more help...

WEB SITE

http://www.img.seagatesoftware.com/

INTERNET

●   Report Creation and Design
tsrcad@img.seagatesoftware.com 

●   Delphi/VCL
tsvcl@img.seagatesoftware.com

●   dBase and Paradox
tsxbse@img.seagatesoftware.com

●   Report Engine API
tscrpe@img.seagatesoftware.com 

●   Crystal Info Product Support
tscinfo@img.seagatesoftware.com

●   Report Engine NewEra Class Library Issues
tsnewera@img.seagatesoftware.com

●   Report Engine C++ Class Library Issues
tsmfc@img.seagatesoftware.com

●   Miscellaneous Issues
tsmisc@img.seagatesoftware.com

●   Operating System Specific Issues
tsosplat@img.seagatesoftware.com

●   Visual Basic, VBX, OCX Support
tsvbocx@img.seagatesoftware.com

●   PC database connectivity Support
tspcdata@img.seagatesoftware.com

●   SQL/ODBC connectivity Support
tssql@img.seagatesoftware.com 

●   OLE Automation Tools
tsole@img.seagatesoftware.com
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●   Web Developer Tools
Web Viewers
ActiveX Viewers
tsweb@img.seagatesoftware.com

●   Holos, Essbase, and other OLAP Products
tsolap@img.seagatesoftware.com

COMPUSERVE

GO REPORTS

FAX SUPPORT

Fax Support (604) 681-7163

TELEPHONE SUPPORT

Telephone Number (604) 669-8379

For more information on these services, please see Product 
Support, Page 635.
Welcome to Seagate Crystal Reports 11



12 Seagate Crystal Reports User�s Guide



1 Installation and Quick Start

What you will find in this chapter...
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Quick Start, Page 18
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Installation Requirements

16-bit version The 16-bit version of Seagate Crystal Reports has the following 
installation requirements:

●   Microsoft Windows 3.1 or higher

●   Minimum RAM: 8 MB (16 MB for Windows NT 3.51 or 
higher)

●   Recommended RAM: 16 MB (32 MB for Windows NT 3.51 
or higher)

●   Minimum hard drive space required: 18 MB

●   Maximum hard drive space required:

   75 MB for the Standard Edition

   108 MB for the Professional Edition

32-bit version The 32-bit version of Seagate Crystal Reports has the following 
installation requirements:

●   Microsoft Windows 95 or Microsoft Windows NT 3.51 or 
higher

●   Minimum RAM: 8 MB (16 MB for Windows NT)

●   Recommended RAM: 20 MB (32 MB for Windows NT)

●   Minimum hard drive space required: 21 MB

●   Maximum hard drive space required:

   90 MB for the Standard Edition

   148 MB for the Professional Edition

If your system does not meet these requirements, the program 
may not run correctly.
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Installing Seagate Crystal Reports

Insert the CD or diskette in the appropriate disk drive.

Windows

3.1 or NT 3.51

1 Choose the RUN command from the File menu.

2 When the Run dialog box appears, type:

x:\setup

«x represents the appropriate drive letter.»

For example, if your CD is in drive d:, type:

d:\setup

3 Click OK or press Enter to activate the installation program. 
The Installation dialog box appears.

4 Follow the directions on the screen to set up the program.

During the installation procedure, you can choose an Automatic 
or Custom installation. 

●   If you select Automatic, all of the program files are installed 
to your hard drive. 

●   If you select Custom, you will be given the opportunity to 
select which program files are installed to your hard drive.

Windows 95

or NT 4.0

1 Choose RUN from the Start menu. 

2 When the Run dialog box appears, type:

x:\setup

«x represents the appropriate drive letter.»

For example, if your CD is in drive d:, type:

d:\setup

3 Click OK or press Enter to activate the installation program. 
The Installation dialog box appears.

4 Follow the directions on the screen to set up the program.
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During the installation procedure, you can choose an Automatic 
or Custom installation. 

●   If you select Automatic, all of the program files are installed 
to your hard drive. 

●   If you select Custom, you will be given the opportunity to 
select which program files are installed to your hard drive.

Installing on a network workstation

If you are operating a network workstation that runs Windows 
locally and Seagate Crystal Reports is already installed on your 
network server, you do not need to install the program on your 
workstation. Instead, you can run the workstation setup 
application that was installed with Seagate Crystal Reports.

During installation, you can choose a Full Network Install or a 
Partial Network Install.

●   A Full Network Install installs all application modules on 
the network server and allows users to run the program 
from the shared drive. This method is recommended for 
diskless workstations.

●   A Partial Network Install installs only the main application 
modules on the network server. This type of installation 
requires each user to run a workstation setup to install 
several modules on the client machine. With this 
installation method, the program will run faster and will 
take up less local disk space than a Local Install.

Workstation setup (SETUP.EXE) is installed in the 
\CRW\WKCSETUP (16-bit) or \CRW\WKCSTP32 (32-bit) 
directory on the network drive on which Seagate Crystal Reports 
was installed.

Windows

3.1 or NT

1 From the Program Manager, choose RUN from the File menu. 
The Run dialog box appears.

2 In the Run dialog box, highlight the network drive and 
directory in which Workstation Setup resides and run the 
SETUP.EXE application.
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3 Follow the directions on the screen to set up your 
workstation.

Windows 95

or NT 4.0

1 Choose RUN from the Start menu. The Run dialog box 
appears.

2 In the Run dialog box, highlight the network drive and 
directory in which Workstation Setup resides and run the 
SETUP.EXE application.

3 Follow the directions on the screen to set up your 
workstation.

Upgrading from a previous version

If you are upgrading from a previous version (4.5, 5.0, Crystal 
Reports for Visual Basic, etc.), the installation routine ensures that 
there will be no conflict between different versions of the program 
running on the same machine. When it finds a previous version of 
Seagate Crystal Reports on your system, the setup application:

●   installs the program to the directory you specify,

●   installs the new CRPE.DLL into the \WINDOWS\SYSTEM 
directory,

●   renames DLLs in the WINDOWS\CRYSTAL directory, 
installed by your previous version of Seagate Crystal 
Reports, with *.OLD extensions. If, for some reason, you 
need to use the older versions of the files later on, you only 
need to rename them back to a *.DLL extension,

●   installs the PD*.DLLs and UX*.DLLs (16-bit) or the 
P2*.DLLs and U2*.DLLs (32-bit), and several other DLL files 
required by the program into the WINDOWS\CRYSTAL 
and WINDOWS\SYSTEM directory and changes their 
extensions from *.DLL to *.OLD, and 

●   installs any common third party DLLs such as 
CTL3DV2.DLL or WBTRCALL.DLL to the 
WINDOWS\SYSTEM directory.

This upgrade procedure makes it unnecessary to change your 
AUTOEXEC.BAT file.
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Quick Start

If you are an experienced Windows user who wants to get right 
into the program, follow these steps to set up a report for the first 
time.

NOTE: If you are not an experienced user, please refer to Learning 
Seagate Crystal Reports, Page 35.

1 In Windows 3.1 and NT 3.51, start the program by double-
clicking the Seagate Crystal Reports icon in the Program 
Manager. In Windows 95 and NT 4.x, click Start and then 
select the program from the Seagate Crystal Reports program 
folder.

2 Click the NEW button on the standard toolbar. The Report 
Gallery appears.

3 Select one of the eight Experts to build a report with the help 
of an Expert, click the Another Report button to use a template 
for building your report, or click the Custom button to build a 
custom report. If you click Custom, the Report Gallery 
expands, and you can then select a Report Type and Data Type 
for your custom report.

4 If you choose Custom and select:

●   Data File, the Choose Database File dialog box appears. 
Select the first database you want to activate for your 
report.

●   SQL/ODBC, the Log On Server dialog box appears. 
Highlight the data source you want and then highlight the 
first table you want to use from the Choose SQL Table 
dialog box when it appears.

●   Dictionary, the File Open dialog box appears. Highlight the 
dictionary you want to use for your report.

The Design Tab appears with Report Header, Page Header, 
Details, Page Footer, and Report Footer areas. You create your 
report by inserting and formatting items in each of these areas.
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NOTE: If you want to use additional database tables for your

report and match them up on a record-by-record basis, click the

LINK EXPERT button on the supplementary toolbar and then select

the table(s) and set up the links in the Visual Linking Expert when

it appears. Search for Visual Linking Expert in Seagate Crystal

Reports online Help.

5 Each of the default report areas contains a single section. If 
you want to add additional sections, click the SECTION EXPERT 
button on the standard toolbar and add the sections you want 
using the Section Expert.

Once you have added sections to an area, you can move, 
merge, and delete them in the Section Expert. See How to add, 
delete, move, and merge sections, Page 89.

6 If you want to toggle the grid on and off, choose the OPTIONS 
command on the File menu and make your changes in the File 
Options dialog box when it appears. See How to turn the grid 
on/off, Page 86.

7 If you are working with the grid off and you want to use 
snap-to guidelines for positioning objects, click the top or left 
ruler wherever you want guidelines to appear.

●   Move a field to a guideline until it snaps to the guideline.

●   Move the guideline arrow to move the guideline (and any 
objects that are snapped to it).

●   Drag the guideline arrow away from the ruler to remove the 
guideline. See How to add, delete, and move guidelines, Page 82, 
and How to move and position objects using guidelines, Page 83.

8 If the Insert Fields dialog box is not visible, click the INSERT 
FIELDS button on the standard toolbar. The Insert Fields dialog 
box appears with the Database Tab active. This dialog box 
displays a list of all of the fields in the active database table(s). 
To speed the entry of multiple fields, the box remains on 
screen until you click the Close button. You can move the 
dialog box to a new location or resize it if you wish. See How 
to insert database fields, Page 118.

9 Select the field(s) you want to appear on the report. You can 
select and place them one at a time, or you can use the Shift-
click combination to select a number of contiguous fields or 
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the Ctrl-click combination to select fields from the list at 
random. Drag and drop is also active. Place the fields in the 
Details section where you want them to appear.

10 If you place multiple fields, they will appear next to each 
other in the order they appear in the Insert Fields dialog box. 
The program marks the position of each field with a 
rectangular frame. The characters in the frame indicate 
whether the field is text (xxx...), number (555...), currency 
($555...), date (12/31/99), time (00:00:00), dateTime (12/31/99 
00:00:00), or Boolean (T/F).

NOTE: You can see the actual field names and field types by

toggling the Show Field Names check box on in the File Options

dialog box (Layout Tab). Search for Configuring Seagate Crystal 
Reports in Seagate Crystal Reports online Help.

NOTE: The program automatically places field titles in the Page

Header section unless you have toggled the Insert Detail Field 
Titles check box off in the File Options dialog box (Layout Tab).

Search for Configuring Seagate Crystal Reports in Seagate Crystal

Reports online Help.

NOTE: If you add additional Details sections to your report,

please note that field titles will only be placed in the Page Header

section for fields in the Details A (the original) section of your

report.

11 Once you have objects in place, you may want to adjust the 
report sections somewhat. You do this using the shortcut 
menu that appears when you right-click the shaded area to 
the left of the section ruler.

●   If you want to expand the section to accommodate an 
additional line, choose the INSERT LINE command.

●   If you want the program to automatically align the objects 
in the section horizontally, choose the ARRANGE LINES 
command.

●   If you want to reduce the size of the section to eliminate 
unnecessary white space above and below objects, choose 
the FIT SECTION command. See How to add/delete white space 
between rows, Page 241.
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12 To create a report title, you must first enter the title in the 
Document Properties dialog box. Choose the SUMMARY INFO 
command from the File menu. Enter a title in the Title text box 
of the Document Properties dialog box. Click OK. Choose the 
REPORT TITLE command from the Insert|Special Fields menu. 
A rectangular placement frame appears when you move the 
cursor over your report. Click once in the Report Header (RH) 
section to place the report title. The report title field will 
contain the text that you typed in the Title text box of the 
Document Properties dialog box. See How to add a title page to 
your report, Page 131.

13 To see how your results will print, click the PRINT PREVIEW 
button on the standard toolbar. 

If you want to speed processing time while building your 
report, you can preview your report using only a small subset 
of the available data. To do this, choose the PREVIEW SAMPLE 
command from the File|Print menu. See Preview Tab, Page 72.

In either case, the program takes you to the Preview Tab. You 
can fine tune your report in the Preview Tab if you wish while 
seeing the results as actual report data. You can also close the 
Preview Tab and continue working on your report in the 
Design Tab.

14 If you want to:

●   change the placement or width of a field,

●   format a field, or

●   insert a subtotal or grand total,

click the field to select it. Handles appear on the top, bottom, 
and both sides of each selected field.

●   To change the placement of the field(s), drag the field 
placement frame to its new position using the mouse.

●   To change the width of the field, drag the right or left 
handle using your mouse.

●   To format font, alignment within field, number, currency, 
date display, border, color, indentation, or to summarize the 
field, right-click the field. A shortcut menu appears listing 
various commands for formatting and summarizing the field.
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NOTE: If you want the formatting to apply only under certain

conditions, click the Conditional Formula button next to the

formatting property in the Format Editor, and create a formula

that defines those conditions. See Conditional formatting, Page 235.

NOTE: Many of the font and formatting options are available on

the format bar. See Format bar, Page 59, for more information on

the options available.

15 If you want to create a formula to make data calculations or 
comparisons, click the INSERT FIELDS button on the standard 
toolbar. When the Insert Fields dialog box appears, click the 
Formula Tab to activate it. 

●   Click the New button. The Formula Name dialog box 
appears. Enter a name for your formula and click OK. The 
Formula Editor appears. 

●   Enter the formula in the Formula Editor. Enter fields, 
operators, and functions by selecting them from their 
respective scroll lists or type them in. You can check your 
formula syntax via the Check button. When finished editing, 
click the Accept button to return to the Insert Fields dialog 
box. Click the Insert button to place the formula just like you 
would a database field. See Formulas 101, Page 321, and 
Advanced Formulas, Page 345, or search for Functions and 
Operators and Variables in Seagate Crystal Reports online 
Help.

16 To insert a subreport (a report within a report), click the 
INSERT SUBREPORT button on the supplementary toolbar and 
choose an existing report to import as a subreport or use the 
Create Report Expert to create a new subreport. See How to 
insert a subreport, Page 434.

●   If you want the records in your subreport to match up with 
the records in your primary report, click the Link Tab of the 
Insert Subreport dialog box and specify the link in the 
Subreport Links dialog box when it appears. See How to link 
a subreport to the data in the primary report, Page 436.

17 To insert a cross-tab object in your report, click the INSERT 
CROSS-TAB button on the supplementary toolbar and set up 
the cross-tab in the Cross-Tab dialog box when it appears. See 
Cross-Tab Objects, Page 445.
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18 To create a parameter field (a field that prompts you for a 
value whenever you retrieve data for your report), click the 
INSERT FIELDS button on the standard toolbar, then click the 
Parameter Tab in the Insert Fields dialog box when it appears. 
Click the New button to set up a parameter field. Once created, 
you can insert the parameter field in your report like a 
database field or select it from the Fields list in the Formula 
Editor. 

●   You can use parameter fields in your report (as title or label 
prompts), in selection formulas (as selection criteria 
prompts), and in formulas (for a variety of purposes 
including specifying sort fields). See Parameter Fields, Page 
391.

19 To add a graph or chart, click the INSERT CHART button on the 
standard toolbar. See Graphing, Page 405.

20 To insert a spreadsheet, picture, or other OLE object that you 
can edit from within Seagate Crystal Reports using the tools 
from the object’s native application, choose the OBJECT 
command from the Insert menu. See OLE, Page 415, and How 
to insert a graphic/picture as an OLE object, Page 426.

21 To change the record sort order, click the SORT ORDER button 
on the standard toolbar. The Record Sort Order dialog box 
appears. Select the field(s) you want to use for sorting the 
report data and the sort direction. See How to do a single field 
sort, Page 281.

22 If you want to limit your report to specific records (for 
example, the records of California customers that have year-
to-date sales greater than $10,000), click the first field on 
which you want your selection to be based and click the 
SELECT RECORDS button on the standard toolbar. When the 
Select Expert appears, set up your record selection criteria. See 
Record and Group Selection, Page 249.

23 To print your report, click the PRINT button on the standard 
toolbar.

That’s it! It is that easy to build a report. To practice concepts 
introduced in this Quick Start, proceed to Tutorial - Customer List, 
Page 165. 
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2 What�s New

What you will find in this chapter...

Sensational new interface gives you power and control, Page 26

Multiple section reports offer new reporting alternatives, Page 27

Subreports expand report usefulness, Page 27

Query Designer adds ad-hoc querying capabilities, Page 28

Conditional formatting adds new intelligence to reporting, Page 28

Parameter fields mean multi-purpose reports, Page 29

Text objects give you text with intelligence, Page 29

Preprinted-form reports easier than ever, Page 30

Enhanced cross-tab capabilities help identify trends, Page 30

More powerful formulas extend your capabilities, Page 31

In-place editing makes it easy to edit OLE objects, Page 31

Dragging objects between reports cuts creation time, Page 32

Web solution serves up variety of online reports, Page 32

HTML exporting simplifies Web activities, Page 33

New database support improves data access, Page 33

Running totals made easy, Page 34

Arbor Essbase support extends reporting capabilities to OLAP data 
sources, Page 34

Smart Navigation, Page 34
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Sensational new interface gives you power and control

The report design environment offers greater flexibility than ever 
before.

●   The Design and Preview Tabs are broken into areas and 
each area can contain multiple sections, each with different 
data and/or properties. See Identifying and working with 
areas and sections, Page 71.

●   The Preview Tab now provides Smart Navigation 
technology in the new Group Tree view. Using the Group 
Tree, you can quickly drill down on group data to review 
the details of each group. See Preview Tab, Page 72.

●   The Preview Tab now lets you expand and collapse report 
sections so you can review data with different levels of 
detail. See How to drill down on summarized data, Page 88.

●   The new Section Expert enables you to insert, delete, move, 
merge, and format sections from one place. See Getting to 
Know Seagate Crystal Reports, Page 51.

●   Vertical and horizontal guidelines make it easy to place and 
align objects with precision. See How to add, delete, and move 
guidelines, Page 82, and How to move and position objects using 
guidelines, Page 83.

●   Multiple levels of undo and redo make it easy and safe to 
experiment, and they provide a fail-safe mechanism against 
inadvertent errors. See How to undo/redo activities, Page 87.

●   The standard and supplementary toolbars and format bar 
can be moved, resized, and enlarged, enabling you to 
customize your environment for maximum efficiency. See 
How to move and resize toolbars and the format bar, Page 80.

These are just a few of the new features in the design environment.
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Multiple section reports offer new reporting alternatives

Now you can include multiple sections in any area of your report 
and you can format each section independently of the others. 
Using this capability you can:

●   create custom form letters that deliver different messages to 
different readers (See How to create a form letter using a text 
object, Page 218.),

●   format numbers and dates differently depending on the 
audience (See How to format objects conditionally, Page 224.),

●   create unusual printing effects (See How to alternate 
background colors for rows, Page 226.),

●   force objects to print in the order you specify, and more. 

See Multiple Section Reports, Page 213.

Subreports expand report usefulness

Seagate Crystal Reports enables you to create subreports and 
place them in your report. You can create freestanding reports 
based on tables that are not related to those in the primary report, 
or you can bind the subreports to primary report data.

With subreports, you can create one report that provides all the 
information you need instead of having to create multiple reports. 
You will find it easier to create reports and analyze report data 
with the new subreport feature.

Subreports can be inserted into most sections of the main report 
and the main report can contain numerous subreports. 

Existing report files (.RPT) can be used as subreports. Subreports 
can have any report format; they can be cross-tabs or contain 
graphs. Thus, you can present columnar data from one report 
right next to a graph from another report.

Subreports let you present different types and views of data all on 
one report for convenient viewing of information and efficient 
analysis. See Subreports, Page 429.
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Query Designer adds ad-hoc querying capabilities

Seagate Crystal Reports now includes a powerful Query Designer 
that allows processing of all aggregate functions on the database 
server. A complete SQL Editor is included to fine tune your 
queries. And, as you would expect, you can create reports from 
query result sets. Ad-hoc queries, reports, or both? Seagate 
Crystal Reports has it all. See Queries, Page 467.

Conditional formatting adds new intelligence to reporting

Seagate Crystal Reports has always been known for its flexibility 
in formatting report data. This version takes a giant step beyond 
earlier versions by allowing you to format data conditionally 
based on whatever criteria you want to use.

●   Do you want sales figures to print in red if more than 10% 
under quota, in green if more than 10% over quota, and in 
black in all other cases?

●   When your data contains domestic and international data, 
do you want to print dates and currency values in the 
expected format for every country?

●   Do you want a section to print only if it contains a record 
from a Canadian company?

●   Do you need to customize your report colors to meet 
corporate standards or design requirements?

You can do these and countless other things using conditional 
formatting.

Virtually all field, object, and section formatting (color, font, 
border, alignment, visibility, and more) can be controlled by 
creating simple, straightforward formulas. See Conditional 
formatting, Page 235, Formulas 101, Page 321, and Advanced 
Formulas, Page 345.
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Parameter fields mean multi-purpose reports

Now you can create parameter fields. Parameter fields prompt 
you for a value when the report is run for the first time or the data 
is refreshed. With parameter fields, you can:

●   change report titles or labels, 

●   modify record selection criteria, 

●   specify sort fields, and

●   set threshold levels for flagging purposes, 

all by responding to simple prompts when you run the report. 
Using parameter fields you can create a single report that satisfies 
a number of needs. It makes your work easier and more efficient. 
See Parameter Fields, Page 391.

Text objects give you text with intelligence

Text objects give you flexibility and control when you insert text 
in your report.

●   Text objects replace text fields. A text object can contain a 
character, word, paragraph, or even an entire document, 
making them perfect for creating customized form letters.

●   Each text object contains its own mini word processor, 
making it easy to insert and edit text.

●   Text objects and elements within text objects can be 
independently formatted with fonts, colors, line breaks, 
tabs, and more.

●   Database fields can be inserted into a text object in-line with 
automatic trimming to fit properly within text. Text objects 
can also contain formula fields.

●   Text objects can be inserted and edited in-place on the 
report, making report design easier. Now you can readily 
see how a text object looks on the page in relation to other 
objects.
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●   Presentation quality is improved with total control and 
flexibility over text object formatting. See How to insert text 
objects, Page 120.

Preprinted-form reports easier than ever

The ability to design reports that print on forms is greatly 
enhanced now that you can place objects anywhere in the new 
freeform, drawing program-type environment. New rulers and 
guidelines facilitate the precise placement of objects on the form, 
and the built-in tab and ruler capabilities in text objects gives you 
more flexibility and control. There’s even a new Forms Expert that 
speeds the design process. For fast, efficient reporting on 
preprinted forms, you can not beat Seagate Crystal Reports. See 
How to make an object underlay a following section(s), Page 124.

Enhanced cross-tab capabilities help identify trends

Cross-tabs are now objects that you can insert into your report. 

●   You can insert as many cross-tabs as you need, and you can 
even insert cross-tabs in subreports. See How to create a 
cross-tab object, Page 452.

●   You can use formulas that are defined elsewhere on the 
report in cross-tabs. 

●   You can include multiple summary fields or calculations in 
your cross-tabs. For example, for a single item you can 
summarize both quantity and price information. See How to 
create a cross-tab with multiple summary fields, Page 459.

●   You can independently format rows and columns with 
background colors, borders, and fonts for better looking 
and easier-to-understand cross-tabs. See How to format a 
cross-tab, Page 463.

●   You can print cross-tabs that extend beyond the width of a 
page. You can also create cross-tabs that are longer than a 
single page and the program will automatically repeat the 
column headings at the top of each page. See How to print 
cross-tabs that span multiple pages, Page 466.
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●   You can design and edit cross-tabs easily with the ability to 
call up the Cross-Tab Expert from both the Design and 
Preview Tabs. See Cross-Tab Objects, Page 445.

Using these capabilities, you can create sophisticated cross-tabs 
like this with ease:

More powerful formulas extend your capabilities

Seagate Crystal Reports includes new functionality that lets you 
create even more powerful formulas than ever before. With Date, 
Time, and DateTime data types, you can now create date 
formulas, time formulas, and date/time formulas. With the ability 
to place arrays in variables, all new running total functions, as 
well as specialized financial functions, your complex reporting 
needs are easier than ever before. See Advanced Formulas, Page 345.

In-place editing makes it easy to edit OLE objects

Seagate Crystal Reports draws upon OLE technology to add solid 
new functionality to your reporting environment.

●   All pictures are converted to static OLE objects. Double-
click an object and the program displays the tools to edit 
that object, all while staying in Seagate Crystal Reports.
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●   While working in the Design Tab, you can convert OLE 
objects to a format that is supported by your editing tools. 
For example, if you have a .TIF picture and no .TIF editor, 
you can convert the picture to a Paintbrush format that can 
be edited in the paint program that ships with Windows. 
See OLE, Page 415.

Dragging objects between reports cuts creation time

Now you can open multiple reports and drag many kinds of 
objects between them. Now there is no need to “reinvent the 
wheel”. If you have an object in one report and you need to use it 
in a different report, just drag it where it is needed. 

You can also drag objects into Seagate Crystal Reports, from any 
application that is an OLE server application. Microsoft Word and 
Excel are examples of this kind of application. Just highlight the 
object (such as text or worksheet cells) and drag it into the report. 
The object becomes part of your report. Double-click it and you 
can edit it in place using the application you created it with. See 
OLE, Page 415.

Web solution serves up variety of online reports

The Web Server’s Java and ActiveX viewers enable you to publish 
Active Server reports that can be viewed with a browser. These 
reports can be created on-the-fly using either archived or newly-
refreshed data. Web reports created with Seagate Crystal Reports 
aren’t static “snapshots.” Users can point and click (drill down) to 
see the details behind summarized data, change selection 
formulas, parameter fields and even SQL stored procedures. 
Reporting was never easier across the internet or within an 
enterprise via an intranet. See the Technical Reference for further 
information.
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HTML exporting simplifies Web activities

With Seagate Crystal Reports, you can now export your reports 
directly to HTML format. With this capability, you can publish 
your reports on the World Wide Web and on organizational 
intranets. Combining this capability with other Seagate Crystal 
Reports features, you can add dynamic reporting to your web 
applications. Some benefits of exporting to HTML include:

●   HTML report can be viewed by any web browser.

●   Specific Microsoft, Netscape, and Oracle web extensions are 
available when exporting to HTML.

●   Reports are automatically converted to HTML, saving you 
time and tedious effort when preparing database 
information for the web.

As the Internet and intranets become more and more important to 
many businesses, Seagate Crystal Reports is providing the tools 
you need to take advantage of the new opportunities. See How to 
export reports, Page 148, and search for HTML in Seagate Crystal 
Reports online Help.

New database support improves data access

Seagate Crystal Reports now supports more databases than ever, 
and it provides new ways to access previously supported data for 
enhanced performance. The program now ships with drivers for 
INFORMIX, Microsoft Exchange, ASCII, DB2/2, Access, Excel, 
SQL Server, Oracle, Sybase, Lotus Notes 3.0 (16-bit, Pro only), 
scalable SQL (16-bit), and more 32-bit drivers, including FoxPro 
and Btrieve, than ever before. It has native drivers for 
INFORMIX< ACT! 3.0, Arbor Essbase, IBM DB2 (DB2, DB2/2, 
DB2/400, DB2/6000), Centura (16-bit), Microsoft Exchange, IIS, 
SMS, SQL Server, NT Event Logs, Pervasive Scalable SQL (16-bit), 
Sybase X 2 (16-bit), Paradox, Web Activity Logs, Oracle X 2 (16-
bit), Access via Jet, and more. Connecting to your data has never 
been easier. See Working With Databases, Page 513, and Data 
Sources, Page 583.
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Running totals made easy

Seagate Crystal Reports has always been the industry leader when 
it comes to sorting, grouping, and totalling data. With the 
inclusion of specialized running total functions, it extends its lead 
even further. Now you can create running totals in a list, running 
totals group-by-group, and other advanced totalling activities 
using fewer and less-complex formulas than ever before. See 
Advanced Totalling, Page 377.

Arbor Essbase support extends reporting capabilities to

OLAP data sources

Seagate Crystal Reports has always been known for its ability to 
report on a wide range of PC and SQL data sources. It now reports 
on Arbor Essbase OLAP data as well. Whether your databases are 
relational or multi-dimensional, you can use Seagate Crystal 
Reports to produce professional reports quickly and easily. See 
Reporting on OLAP data, Page 191.

Smart Navigation

Seagate Crystal Reports enables you to use Smart Navigation to 
jump immediately to the report information you want to see. The 
program displays a high level outline of the report, showing the 
hierarchy of groups and subgroups in a familiar tree format. 
When you click on the tree node for the group that interests you, 
the program jumps immediately to the part of the report that 
contains the information for that group. You don't have to page 
through long reports trying to find specific pieces of information; 
with Smart Navigation, one mouse click and you're there. 
34 Seagate Crystal Reports User�s Guide



3 Learning Seagate Crystal
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What you will find in this chapter...

Learning Seagate Crystal Reports, Page 36

User’s Guide, Page 36

Online Help, Page 43

Books Online, Page 43

Sample Reports, Page 44

Glossary, Page 44

Sample Data - CRAZE.MDB, Page 45

Suggested learning paths, Page 47
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Learning Seagate Crystal Reports

Seagate Crystal Reports comes with a wide variety of tools and a 
comprehensive sample database to help you learn the program 
and use it efficiently. 

The purpose of this chapter is to:

●   explore the various learning sections in this manual,

●   introduce the other tools that come with the program, and

●   suggest learning paths based on your background. 

User�s Guide

The following is a short description of each chapter in this manual 
for easy reference. It is recommended that you read through these 
brief descriptions in order to familiarize yourself with the content 
and design of the manual to make locating information later more 
efficient.

WELCOME TO SEAGATE CRYSTAL REPORTS

Welcome to Seagate Crystal Reports, Page 1, is an introduction to 
Seagate Crystal Reports documentation. This chapter provides an 
overview of all documentation included with Seagate Crystal 
Reports, special conventions used, as well as a handy directory of 
important phone, fax, and e-mail addresses for contacting Seagate 
Software, Information Management Group.

CHAPTER I, INSTALLATION AND QUICK START

Installation and Quick Start, Page 13, includes everything you need 
to getting up and running with Seagate Crystal Reports. Intended 
for experienced users and new users who like to “learn by doing,” 
the Quick Start covers all of the key elements of working with the 
program in a few short pages.
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CHAPTER 2, WHAT�S NEW

Seagate Crystal Reports has been enhanced for this release. What’s 
New, Page 25, identifies and describes the main new features, and 
points you to sections of the manual where they are discussed in 
depth. Users who are familiar with earlier versions of Seagate 
Crystal Reports will benefit the most from this chapter.

CHAPTER 3, LEARNING SEAGATE CRYSTAL REPORTS

Learning Seagate Crystal Reports, Page 35, introduces you to the 
various tools available for learning Seagate Crystal Reports. It also 
suggests learning paths that you might follow based on your 
background.

CHAPTER 4, GETTING TO KNOW SEAGATE CRYSTAL

REPORTS

Getting to Know Seagate Crystal Reports, Page 51, introduces you to 
Seagate Crystal Reports. In this chapter you will learn about the 
tools, the pointers, and the tabs you will use to design, preview, 
and analyze your reports. This chapter explains what to do and 
then shows you how to do it. All levels of users will benefit from 
reading this chapter.

CHAPTER 5, REPORTING 101

Reporting 101, Page 95, concentrates on the basic concepts of report 
design, and then explains, in easy terms, the things you should 
understand and consider in order to:

●   select database tables, 

●   select fields, 

●   place objects on your report, 

●   sort, group, and total data, and

●   select records to be included in the report.

This chapter is written for people new to reporting, but contains a 
lot of background information that users at all skill levels may 
find useful. Armed with that kind of information, you will be 
well-prepared to create powerful reports that run efficiently and 
that provide exactly the information you need.
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CHAPTER 6, PRINTING, VIEWING, AND EXPORTING

Printing, Viewing, and Exporting, Page 135, details the ways you can 
print, view, and export your finished reports. It introduces you to 
a number of printing considerations, shows you how to use the 
report viewers (including the Active X and Java viewers that work 
in web browsers), and it explains how you can export your reports 
in various formats to a variety of destinations such as e-mail, 
Lotus Notes, and Microsoft Exchange.

CHAPTER 7, TUTORIAL - CUSTOMER LIST

Tutorial - Customer List, Page 165, is the primary tutorial for Seagate 
Crystal Reports. It is a product introduction that leads you step-
by-step through the creation of a report, introducing you to may 
of the key features of the program in the process. This tutorial has 
been written for the new user. No prior knowledge of reporting is 
expected. By the time you finish the tutorial, you should have 
enough understanding of the program to feel comfortable getting 
started on your own report.

CHAPTER 8, REPORTING ON OLAP DATA

Reporting on OLAP data, Page 191, shows you how to create reports 
with OLAP data from Arbor Essbase. While the procedures are 
similar to working with PC and SQL data, there are several 
additional tools in Seagate Crystal Reports for working with 
multi-dimensional data sources.

CHAPTER 9, MULTIPLE SECTION REPORTS

Multiple Section Reports, Page 213, introduces the various kinds of 
sophisticated reporting available when using the multi-section 
reporting capabilities in Seagate Crystal Reports. These 
capabilities enable you to create reports that treat individual 
values differently based on sets of criteria you establish. With 
multiple-section reporting, you can format objects and sections 
differently based on field values, put conditional messages in 
form letters, add blank lines automatically when certain 
conditions are met, and perform many other reporting tasks. 
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CHAPTER 10, FORMATTING

Formatting, Page 231, leads you through the steps that are 
necessary to format your report. Formatting refers to those things 
that you can do to change the layout and design of your report, as 
well as the appearance of text, objects, or entire report sections. 
Using the formatting tools in Seagate Crystal Reports, you can call 
attention to certain data, change the presentation of dates, 
numbers, and other values, hide unwanted sections, and do a 
variety of other things to give your report a professional 
appearance.

CHAPTER 11, RECORD AND GROUP SELECTION

Record and Group Selection, Page 249, shows you how to filter which 
records and groups of records you want to be included in your 
report. Using the record and group selection tools included in 
Seagate Crystal Reports, you can do such things as including 
records only for a specific group of customers, a specific range of 
account numbers, or that fall within a particular date range.

CHAPTER 12, SORTING, GROUPING, AND TOTALLING

No other program has the sorting, grouping, and totalling 
capabilities of Seagate Crystal Reports. Sorting, Grouping, and 
Totalling, Page 271, provides a tour of the kinds of sorting, 
grouping, and totalling you can do within a report, and then it 
shows you how. This chapter is an excellent overview for both 
beginners who may not understand sorting, grouping, and 
totalling, as well as advanced users, who want to know more 
about the program’s sorting, grouping, and totalling capabilities.

CHAPTER 13, FORMULAS 101

Seagate Crystal Reports is equipped with a powerful formula 
language. Once you become comfortable working with formulas, 
your reporting capabilities are virtually endless. Formulas 101, 
Page 321, gets you started creating simple formulas. It familiarizes 
you with the tools of the Formula Editor and leads you step-by-
step through the formula creation process. This chapter has been 
written for people new to formulas and shows you exactly how to 
perform each step. It is a chapter intended to get you beyond the 
mystery of formulas and into using them for your everyday 
reporting needs.
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CHAPTER 14, ADVANCED FORMULAS

Advanced Formulas, Page 345, gets into the realm of “what is 
possible” with Seagate Crystal Reports. It shows you how to 
create and use variables, how to “tweak” formula evaluation 
times so the formula is evaluated against the “right” data, and 
how to perform complex conversions. Written for the advanced 
user, this chapter shows you how to use Seagate Crystal Reports 
to create customized formulas for all your reporting needs.

CHAPTER 15, ADVANCED TOTALLING

Advanced Totalling, Page 377, introduces you to a number of 
advanced totalling techniques. Seagate Crystal Reports, always a 
leader in sorting, grouping, and totalling, includes special 
functions that enable you to perform sophisticated running total 
activities with ease. The tutorials included in this chapter 
demonstrate techniques using these functions to produce running 
totals in a list, running totals within record groups, as well as 
other advanced totals.

CHAPTER 16, PARAMETER FIELDS

Parameter Fields, Page 391, shows you how to use parameter fields 
effectively for formulas, record selection formulas, and other 
reporting needs. Parameter fields are fields that prompt you to 
specify a value each time you refresh the data in your report. 
When you supply a value, the program runs the report using that 
value. By using parameter fields in formulas, selection formulas, 
and in the report itself, you can create one report that you can 
modify quickly as your needs change.

CHAPTER 17, GRAPHING

Seagate Crystal Reports enables you to present summarized data 
in colorful, easy-to-read charts and graphs. Graphing, Page 405, 
shows you how to create graphs and how to use them in your 
reports to make report data more meaningful and easier to digest 
quickly. Users can even drill down to see the details behind the 
graphical summaries.
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CHAPTER 18, OLE

Often when you insert a graphic, spreadsheet, or some other 
object into a report, you may later find it necessary to change that 
object. Normally to make the changes, you have to go through a 
number of steps including saving files, opening additional 
applications, etc. All of these steps can be avoided using Object 
Linking and Embedding (OLE). OLE allows you to insert objects 
(OLE objects) into a report from other applications (OLE server 
applications) and then use those applications from within Seagate 
Crystal Reports to edit the objects if necessary. OLE, Page 415, 
shows you what is possible in Seagate Crystal Reports with OLE 
and how to implement it.

CHAPTER 19, SUBREPORTS

A subreport is a report within a report. Using subreports you can 
combine unrelated reports into a single report, coordinate data 
that can’t be otherwise linked, and present different views of the 
same data in a single report. Subreports, Page 429, shows you what 
you can do in Seagate Crystal Reports using subreports and how 
to create them.

CHAPTER 20, CROSS-TAB OBJECTS

A cross-tab is an object that summarizes data and then presents 
the summaries in a compact row and column format that makes it 
easy to make comparisons and identify trends. For reports that 
use the word “by” in the report description (sales by state, orders 
by customers, etc.), cross-tabs generally present more data in a 
more compact easier-to-understand form than other reporting 
methods. Cross-Tab Objects, Page 445, introduces you to the cross-
tab reporting tools, and it shows you how to create cross-tab 
reports quickly and easily.

CHAPTER 21, QUERIES

Queries, Page 467, shows you how to create queries that you can 
use for ad-hoc analysis or result sets for creating reports. Using 
the Crystal Query Designer you can create, modify, and optimize 
complex SQL queries with ease.
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CHAPTER 22, DICTIONARIES

Dictionaries are structured and simplified views of data that you 
can create for some or all of the individuals in your organization. 
Using dictionaries, users see only the information they need and 
that you want them to see. They reduce support costs and time, 
increase user productivity, and reduce data misuse, loss, and 
damage. Dictionaries, Page 491, shows you how to set up and use 
dictionaries to improve organizational efficiency and security.

CHAPTER 23, WORKING WITH DATABASES

Understanding database concepts, relational database design, and 
performance considerations can help you get the most out of 
Seagate Crystal Reports. Working With Databases, Page 513, leads 
you through the basics and provides a detailed explanation of the 
way the program accesses linked data. The information in this 
chapter will help you optimize your reporting for maximum 
efficiency. This chapter contains information both for the beginner 
and the advanced user.

CHAPTER 24, DATA SOURCES

Seagate Crystal Reports works with all kinds of data, from simple 
text files to advanced client-server SQL databases. Data Sources, 
Page 583, shows you how the program connects to various data 
sources and what files have to be in place to make the connection. 
This is an in-depth chapter for advanced users who need to know 
how Seagate Crystal Reports works beneath the surface. 

APPENDIX A, REPORT PROCESSING MODEL

Seagate Crystal Reports uses a sophisticated multi-pass reporting 
model for processing reports. Understanding when different 
parts of the reporting process take place can help you design more 
efficient reports and solve reporting problems. Report Processing 
Model, Page 629, is written for the advanced user.

APPENDIX B, PRODUCT SUPPORT

Product Support, Page 635, introduces you to the various ways you 
can obtain product support.
42 Seagate Crystal Reports User�s Guide



Online Help

Online Help includes all of the information from the manual as 
well as a description of each command, dialog box, formula 
function and operator, included with the program. Sample 
formulas, sample records, group selection formulas, and 
hundreds and hundreds of topics on virtually anything related to 
reporting - online Help has it all.

In learning to use menu commands for example, online Help 
gives you an explanation of what the command does, then a 
thorough explanation of any dialog boxes the menu command 
activates, and finally, tutorials for performing tasks using the 
menu command. By working through the topics for any menu 
command, you can find out why you would use it and become an 
expert in its use.

You can navigate through online Help using the Contents Tab, you 
can use the Search facility to look up topics by key words, or you 
can use the full-text Find facility to pinpoint topics that contain the 
word of interest. It is suggested that you take advantage of the 
online Help often while learning Seagate Crystal Reports.

For more information on the help systems, see Using Seagate 
Crystal Reports documentation, Page 5.

Books Online

Books Online contains the full text of this manual, as well as a 
complete Technical Reference in electronic format. Both online 
books are included with the CD version; only the Technical 
Reference is included with the diskette version of Seagate Crystal 
Reports. These manuals have been created with Adobe Acrobat; 
Acrobat Reader has been included on the CD and setup disks to 
allow you to view or print these documents.

Books Online are hypertext documents with hundreds of jumps to 
take you to topics of interest, related topics, and technical 
information. Additionally, Acrobat Reader has a full text search 
capability so you can find any topic of interest if you can think of 
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just one unique word it might contain. With electronic search and 
jump capabilities, Books Online gives you the tools to find the 
information you need in a hurry.

You can set up Books Online in a variety of ways to suit your 
needs. Consult the Acrobat Reader Help System for a complete 
explanation of the options.

Sample Reports

Seagate Crystal Reports comes with many professionally 
designed sample reports in two categories:

1. General departmental reports cover a wide range of reporting 
needs for many of the departments in an organization.

2. Financial reports address the specific needs of financial 
institutions and corporate finance departments. (Financial 
reports are available with the Professional edition only.)

The sample reports are valuable learning tools. 

●   By studying the content of the reports, you can see the kind 
of information that is needed and how it is presented.

●   By studying the layout and design of the reports, you can 
see how the information is arranged for clarity.

●   By studying the formatting of the reports, you can see how 
key information is emphasized and what was done to make 
the reports visually pleasing. See Sample Reports online 
Help, SAMPLE.HLP.

Glossary

Seagate Crystal Reports comes with a comprehensive glossary 
explaining basic database and reporting concepts as well as issues 
specific to the program. Unlike some glossaries which offer little 
substance, this glossary gives in-depth explanations of terms from 
Seagate Crystal Reports. 

Reading the glossary is an excellent warm-up before you start 
working with the other training aids.
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Sample Data - CRAZE.MDB

Seagate Crystal Reports comes with CRAZE.MDB, a sample 
database you can use when learning the program. CRAZE.MDB is 
a Microsoft Access 2.0 database and all of the necessary drivers are 
included with the program. You should be able to open the 
database directly and begin designing reports. Virtually all of the 
examples in this manual are based on CRAZE.MDB data.

CRAZE.MDB is a database that contains data for Craze Mountain 
Bikes, a fictitious manufacturer of mountain bikes and 
accessories.

The database includes the following tables:

●   Craze Info
Company data for the Craze Mountain Bike company 
including the company logo in both color and black and 
white.

●   Credit
Information from customer credit memos such as credit 
authorization IDs and amounts.

●   Customer
Data for the customers served by the company.

●   Employee
Company-oriented data for the employees of Craze 
Mountain Bikes.

●   Employee Addresses
Personal data for Craze Mountain Bikes employees.

●   Orders
Identifying and tracking data for orders.

●   Orders Detail
Line item data for orders.

●   Product
Descriptive data for Craze Mountain Bike products.

●   Product Type
Category data for Craze Mountain Bike products, including 
product pictures.
Learning Seagate Crystal Reports 45



●   Supplier
Data for the suppliers who serve Craze Mountain Bikes.

The links (relationships) between the tables are as follows: 

CRAZE.MDB also includes:

●   a query (Top Customers), and

●   a parameter query (Credit_Limits) that you can use to learn 
how to report on those kinds of data sets, as well as,

●   the Craze Info table which is not linked to any other table. 
This table contains company information for Craze 
Mountain Bikes. 

NOTE: The sample data has been designed to illustrate various
reporting concepts in a training environment, not to teach
database design. While there are alternative ways of designing a
database, this design was selected to keep the tutorials and
examples focused on reporting, not on data manipulation.
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Suggested learning paths

There is no correct learning path for everyone; you have your own 
needs, and will learn in your own way and at your own speed. 
What follows are simply suggested learning paths for several 
kinds of users.

The order of the elements in each path is a suggested order, yet 
one that has been carefully structured to speed the learning 
process. Locate the category that best describes your reporting 
experience and follow the path from start to finish to get the best 
results.

New user

(business)

The following learning path is suggested for new users who 
expect to use Seagate Crystal Reports on a casual basis.

●   Give the Glossary, Page 643, a quick read.

●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Read Reporting 101, Page 95.

●   Read Printing, Viewing, and Exporting, Page 135.

●   Work through Tutorial - Customer List, Page 165.

●   Read Record and Group Selection, Page 249.

●   Scan Sorting, Grouping, and Totalling, Page 271.

●   Read Formulas 101, Page 321.

●   Review Sample Reports, Page 44.

●   Refer to online Help and the Hands-On skills tutorials as 
needed.

Business user

upgrading

from an earlier

version

The following learning path is suggested for users who are 
upgrading from an earlier version of Seagate Crystal Reports.

●   Scan the Glossary, Page 643, for new terms.

●   Read Installation and Quick Start, Page 13.

●   Read What’s New, Page 25.
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●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Scan Reporting 101, Page 95.

●   Scan Printing, Viewing, and Exporting, Page 135.

●   Scan Multiple Section Reports, Page 213.

●   Scan Record and Group Selection, Page 249.

●   If you have limited formula experience, read Formulas 101, 
Page 321.

●   If you have a working knowledge of formulas, read 
Advanced Formulas, Page 345.

●   Scan Subreports, Page 429.

●   Review Sample Reports, Page 44.

●   Refer to Hands-On skills tutorials as needed.

New power

user

The following learning path is suggested for new users who 
expect to use many of the sophisticated features of Seagate Crystal 
Reports.

●   Read Quick Start, Page 18.

●   Read What’s New, Page 25.

●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Scan Reporting 101, Page 95.

●   Scan Printing, Viewing, and Exporting, Page 135.

●   Read Multiple Section Reports, Page 213.

●   Scan Record and Group Selection, Page 249.

●   Scan Sorting, Grouping, and Totalling, Page 271.

●   Scan Formulas 101, Page 321.

●   Read Advanced Formulas, Page 345.

●   Read Advanced Totalling, Page 377.

●   Read Parameter Fields, Page 391.

●   Read Subreports, Page 429.

●   Read Performance considerations for all reports, Page 528.
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●   Read Report Processing Model, Page 629.

●   Review Specialized Formulas in online Help.

●   Refer to the Glossary, Page 643, and Hands-On skills 
tutorials as needed.

Power user

upgrading

from an earlier

version

The following learning path is suggested for power users who are 
upgrading from an earlier version of Seagate Crystal Reports.

●   Read What’s New, Page 25.

●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Read Advanced Formulas, Page 345.

●   Read Performance considerations for all reports, Page 528.

●   Read Report Processing Model, Page 629.

●   Review Power Formulas in online Help.

●   Refer to the Glossary, Page 643, and Hands-On skills 
tutorials as needed.

New MIS user The following learning path is suggested for MIS (Management 
Information Systems) professionals who are using Seagate Crystal 
Reports for the first time.

●   Read Quick Start, Page 18.

●   Read What’s New, Page 25.

●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Read Multiple Section Reports, Page 213.

●   Read Advanced Formulas, Page 345.

●   Read Advanced Totalling, Page 377.

●   Read Parameter Fields, Page 391.

●   Scan Subreports, Page 429.

●   Read Performance considerations for all reports, Page 528.

●   Read Report Processing Model, Page 629.

●   Review Power Formulas in online Help.

●   Refer to the Glossary, Page 643, and Hands-On skills 
Learning Seagate Crystal Reports 49



tutorials as needed.

MIS user

upgrading

from an earlier

version

The following learning path is suggested for MIS users who are 
upgrading from an earlier version of Seagate Crystal Reports.

●   Read What’s New, Page 25.

●   Read Getting to Know Seagate Crystal Reports, Page 51.

●   Read Multiple Section Reports, Page 213.

●   Scan Sorting, Grouping, and Totalling, Page 271.

●   Read Advanced Formulas, Page 345.

●   Read Advanced Totalling, Page 377.

●   Read Parameter Fields, Page 391.

●   Read Subreports, Page 429.

●   Read Dictionaries, Page 491.

●   Read Performance considerations for all reports, Page 528.

●   Read Data Sources, Page 583.

●   Read Report Processing Model, Page 629.
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4 Getting to Know Seagate
Crystal Reports

What you will find in this chapter...

The application window, Page 52

Menu bar, Page 52

Standard toolbar, Page 55

Supplementary toolbar, Page 57

Format bar, Page 59

Status bar, Page 60

Shortcut menus, Page 62

Cursors, Page 64

Design Tab, Page 66

Preview Tab, Page 72

Other fundamentals, Page 76

HANDS-ON (Report Design Environment), Page 80

HANDS-ON (Sections and Areas), Page 89
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The application window

The application window is clear and easy to understand. 

●   The title bar identifies the current report and it contains the 
standard Windows buttons.

●   The menu bar appears just below the title bar.

●   The standard toolbar appears just below the menu bar.

●   The format bar appears just below the standard toolbar.

●   The supplementary toolbar appears just above the status 
bar.

●   The status bar appears at the bottom of the window.

Menu bar

The menu bar is the command center of Seagate Crystal Reports. 
Each option on the menu bar activates a drop-down menu of 
commands that you can use to create, modify, print, and save 
your reports.
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The menu bar contains the following menus:

●   File menu

●   Edit menu

●   View menu

●   Insert menu

●   Format menu

●   Database menu

●   Report menu

●   Window menu

●   Help menu

File menu The File menu includes commands you can use to open, close, and 
save files, to save files under a different file name, and create new 
reports, mailing labels, and cross-tabs, as well as several other 
kinds of reports. It also includes a command you can use to exit 
the program. Additionally it contains commands that enable you 
to preview your report before printing, to export your report to a 
disk file in a variety of formats, to send your report to a printer, to 
change page margins, and to select a printer if you want the report 
to print on something other than the default printer. You can also 
add summary information to help you identify your report as well 
as change the default settings so the program works the way that 
is the most efficient for you. Search for File menu Commands in 
online Help.

Edit menu The Edit menu includes commands you can use to modify aspects 
of your report. It includes commands to undo and redo actions, to 
edit fields, formulas, summaries, subreport links, OLAP 
members, OLE objects, and OLE links, to view a sample of the 
data in a selected field, and to cut, copy, and paste report and OLE 
objects.You can also use Edit menu commands to show, hide, 
move, merge, or delete report sections, delete groups, and to 
convert static OLE objects to editable bitmaps. Search for Edit 
menu commands in online Help.
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View menu The View menu includes commands you can use to modify the 
user interface of the program. View menu commands enable you 
to show or hide the standard and supplementary toolbars, format 
bar, and status bar, to zoom in and out on your report to view it at 
different magnifications, and to turn guidelines, the grid, and the 
rulers on and off. You can also toggle the Group Tree view on and 
off from the View menu. Search for View menu commands in online 
Help.

Insert menu The Insert menu includes commands you can use to insert 
database fields, text objects, formula fields, parameter fields, 
cross-tab objects, subtotals, grand totals, summaries (counts, 
averages, etc.), groups, sections, and several special fields such as 
print date and page number. The Insert menu also includes 
commands that enable you to insert group name fields, 
subreports, graphics, lines, boxes, graphs, and OLE objects into 
your report. Search for Insert menu commands in online Help.

Format menu The Format menu includes commands you can use to change the 
look of the elements in your report. It includes commands for 
changing fonts and for adding field borders, background color, 
and drop shadows. The Format menu has commands for 
formatting fields that are embedded in text objects, for formatting 
individual paragraphs in those text objects, and for entire sections 
of the report as well. There are also commands for formatting 
graphs as well as formatting and pivoting cross-tabs. Finally, using 
Format menu commands, you can have the program automatically 
arrange report objects, apply professionally designed styles to the 
entire report, and move objects in a stack of objects forward and 
backward. Search for Format menu commands in online Help.

Database menu The Database menu includes commands you can use to add and 
delete tables for use with your reports, to change the alias used to 
identify a table, and to link and unlink tables. It has commands for 
logging on and off SQL and ODBC servers, for showing Essbase 
report scripts, showing and editing SQL queries, and modifying 
parameters for stored procedures. The Database menu also has 
commands that direct the program to look for tables in new 
locations, change database drivers used in your report, to remove 
tables from a report and to adapt your reports appropriately if 
there are minor changes in table structure. Search for Database 
menu commands in online Help.
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Report menu The Report menu includes commands you can use to select the 
records or groups to be included in your report, select the order in 
which report data is to be sorted (by record or by group), specify 
subreport links, and specify a print date for your report. It has 
commands for updating the data used in a report and for 
gathering all the files you need for distributing your reports. You 
can also use one of the Report menu commands to create an 
executable version of your report that you can share with others 
that do not have Seagate Crystal Reports. Search for Report menu 
commands in online Help.

Window menu The Window menu includes commands you can use to rearrange 
icons and windows. It also lists the report windows that are open 
and includes a command that lets you close all report windows at 
once, if desired. Search for Window menu commands in online Help.

Help menu The Help menu includes commands you can use to access Seagate 
Crystal Reports online Help index and search facility that 
provides context sensitive Help. It has commands for registering 
the program, accessing technical information about your 
computer system, and creating a technical support request. You 
can toggle the Welcome dialog box on and off, and if connected to 
the internet, you can access several key pages of the Seagate web 
site using commands on the Help menu. One final command, 
gives you information about the version of the program you are 
using. Search for Help menu commands in online Help.

Standard toolbar

Seagate Crystal Reports groups several commonly used 
commands on the standard toolbar that remains on screen at all 
times (unless you decide to toggle it off in the Toolbars dialog 
box).

The standard toolbar eliminates some of the steps needed to 
activate the commands and can thus greatly speed your work in 
creating reports. Each command available via the standard 
toolbar is discussed in online Help. (Search for each command by 
name.)
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NOTE: In the 32-bit version of Seagate Crystal Reports, you can

move the standard toolbar to another fixed location in the

window or set it up as a floating palette. See How to move and 
resize toolbars and the format bar, Page 80.

If you are not sure what a button on the standard toolbar does, 
place the pointer over the button and hold it there. A Tool Tip will 
appear, giving you a quick description of the button.

The buttons on the standard toolbar perform the following 
functions: 

Create a new report.

Open an existing report.

Save your report.

Send your report to a printer.

Preview your report in the Preview Tab.

Export your report to a file or e-mail.

Refresh report data.

Cut selected object/data to the Clipboard.

Copy the selected object/data to the Clipboard.

Paste object/data from Clipboard to the report.

Undo an action.
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Supplementary toolbar

The supplementary toolbar gives you quick access to many 
advanced report-enhancing experts and features. Activate the 
supplementary toolbar by clicking the SUPPLEMENTARY TOOLBAR 
button found on the far-right of the format bar. 

Redo an action.

Insert database, formula, parameter, and group name 
fields.

Insert a text object.

Insert a summary.

Activate the Report Expert.

Format any section of your report.

Set record/group selection criteria.

Set record sort order.

Insert a graph/chart.

Search for a specific record.

Sets the magnification factor for viewing your report.

Context-sensitive Help.
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Insert a line.

Insert a box.

Insert a picture.

Arrange report elements automatically to best fit 
page.

Activate Style Expert to apply a professionally-
designed style to your report.

Insert a group.

Insert a subreport.

Insert a cross-tab object.

Find Top/Bottom N records or sort on summary 
information.

Activate the Format Editor to modify object 
properties.

Compile your report.

Activate the Report Distribution Expert.

Define links between tables.
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Format bar

The format bar enables you to access many popular formatting 
options with the click of a button or a selection from a drop-down 
box. You simply select the data you want to format, then click the 
appropriate button or list option to format the data.

Two drop-down boxes appear at the left side of the format bar.
 

Use these drop-down boxes for selecting new fonts and font sizes 
if you want to use something other than the default. 

The buttons on the format bar perform the following functions: 

Increase the font size of the selected data one point 
each time you click the button.

Decrease the font size of the selected data one point 
each time you click the button.

Change the selected data to boldface.

Change the selected data to italic face.

Change the selected data to be underlined.

Align the selected data flush left.

Center the selected data.

Align the selected data flush right.

When a number field is selected, places a currency 
symbol with the number.1
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Status bar

The status bar at the bottom of the application window displays 
valuable information to help users work with the program more 
efficiently.

TOOLBARS/FORMAT BAR FUNCTIONS

When the cursor is over a toolbar or format bar button, the status 
bar displays a short description of the button’s function.

MENU COMMAND DESCRIPTIONS

When you highlight a menu command, the status bar displays a 
short description of the command. 

CURRENT SELECTIONS

When you highlight or place an object, the status bar displays the 
name of the object (or its object type) plus its location and sizing 
information. 

When a number field is selected, places a thousands 
separator in the number.1

When a number field is selected, places a percentage 
sign with the number.1

When a number field is selected, adds one decimal 
place to the number.1

When a number field is selected, subtracts one 
decimal place from the number.1

Toggles the Group Tree’s Smart Navigation on/off in 
the Preview Tab. See Group Tree view, Page 74.

Toggles the supplementary toolbar on/off. See 
Supplementary toolbar, Page 57.

1The program refers to your setting in the International section 
of the Control Panel (Windows 3.x, and Windows NT 3.51) or 
the Regional Settings section of the Control Panel (Windows 
95 and Win NT 4.0).
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To identify objects, the status bar displays:

●   the words OLE Object for a picture or other OLE object,

●   the alias and field name for a field,

●   the words Line for a line, Box for a box, and Text for a text 
object,

●   the field type for special fields (Print Date, Record Number, 
and so forth), 

●   the summary name for a summary or subtotal,

●   the formula name for a formula, and

●   the parameter field name for a parameter field.

The status bar also displays:

●   how far the object is from the left and top boundaries of a 
section, and

●   how big the object is.

Using this information, you can easily move and resize objects 
with precision.

DATA RETRIEVAL INFORMATION

When you preview your report for the first time or refresh the 
data in the Preview Tab, the status bar displays four figures that 
describe the data retrieval processing.

1. The first number defines the number of records selected out of 
the number of records read.

2. The second number defines the number of records read.

●   If your report has a selection formula, the records selected 
figure will typically be smaller than the records read figure. 
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●   If your report does not have a selection formula, records 
selected will always be equal to records read.

3. The third number displays the total number of records that 
will be processed.

●   If your report is based on a single table, the figure that is 
displayed should remain constant.

●   If your report is based on linked tables, and if any one-to-
many situations exist, the figure will typically increase as 
the program identifies all of the linked records.

4. The final number is the percentage of the total records that 
have been processed.

Once the report has finished processing, the program displays 
only the number of records selected and the percentage 
processed.

Shortcut menus

When you are working in either the Design or Preview Tab, you 
can speed up your work considerably using shortcut menus. 
When you right-click a report element (a picture, section, field, 
etc.), the program displays a shortcut menu next to the element. 
Unlike the program’s standard menus that group commands by 
function (editing, inserting, etc.), shortcut menus are element-
specific; they contain only those commands that are available for 
use with the selected element.

The shortcut menus are valuable because they:

●   display the name and source (alias) of the element at the top 
of the menu so you can identify the elements on your report 
with a single click.
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●   make it easier to learn the program because they eliminate 
the need to remember where to find a command.

●   make working with the program more efficient because you 
are dealing with only a compact list of commands which 
make it easier to pick the right one.

●   spotlight the things you can do with an element making the 
program more intuitive to use. 

Right-click the gray area of

the Details section and you

get a menu like this...

Right-click a field and you

get a menu like this...

Right-click the Design

Tab itself an get a menu

like this...
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Cursors

Seagate Crystal Reports uses a number of different cursors at 
different points in its operation: 

The Arrow cursor is the primary cursor. It is used for 
making menu choices, selecting options from dialog 
boxes, working with scroll bars, clicking buttons and 
objects, and so on. 

The Hourglass or Background Processing cursor is 
the cursor that appears whenever the program is 
processing a command. Whenever the hourglass is 
visible, you can not choose any commands or proceed 
further with your report.
The Double-Arrow resizing cursor. It changes to one 
of a number of different double-arrow cursors 
whenever it is over a resizing handle on a bit-mapped 
graphic, a graphic box, a graphic line, or a field. 

The Move cursor is available whenever you are 
moving a single object to another location in your 
report.

The single-unit Drag and Drop cursor is available 
whenever you are dragging a single item over an area 
where it can be dropped.

The multi-unit Drag and Drop cursor is available 
whenever you are dragging multiple items over an 
area where they can be dropped. It is also used to 
copy multiple items at one time.
The Stop cursor. It appears whenever the item you are 
dragging is over an area in which it can not be 
dropped. For example, the cursor appears when you 
drag a cross-tab object into a section where it can not 
be placed.

The Copy cursor is available whenever you are 
copying a single item.
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The Section Sizing cursor. The Arrow cursor changes 
to the section sizing cursor whenever it is positioned 
over the boundary of any of the report sections. Using 
this cursor you can drag a section boundary line to 
expand or reduce the size of a section. 

The Section Splitting cursor. It appears when you 
position the pointer over the left boundary of a report 
section. When you click, a horizontal line appears that 
you position where you want to split the section. 
The Link cursor. It appears when you are manually 
creating links in the Visual Linking Expert. Search for 
Visual Linking Topics Index in Seagate Crystal Reports 
online Help

The Drill Down cursor appears when the pointer is 
positioned over a summary value or a graph in the 
Preview Tab. When you double-click a summary 
value or graph element with the Drill Down cursor, 
the program displays the details behind the 
summary.
The Pencil cursor is a drawing cursor. It appears 
whenever you insert boxes and lines. The point of the 
pencil marks the spot where the drawing begins and 
is used to define the size and shape of the object 
drawn.

The Help cursor is available by clicking the Help 
button on the Standard Toolbar. Use the Help cursor 
to access the online Help system. Simply click the 
report element, dialog box, etc., with the cursor to 
bring up context sensitive Help for that item.
The Tiny Hand cursor is available in the online Help 
system. The Arrow cursor changes to the Tiny Hand 
cursor whenever it is positioned over text or a graphic 
that jumps to another topic in online Help.

The 2-Dimensional panning cursor. It appears as an 
Intellimouse feature for scrolling through your report 
in any direction in the Preview Tab.
The Scroll cursor. It appears as an Intellimouse 
feature for scrolling up/down in your report in the 
Preview Tab.
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Design Tab

When you are working with Seagate Crystal Reports, you will 
probably find yourself using the Design Tab more than any other 
part of the program. 

The Pan cursor. It appears as an Intellimouse feature 
for panning right/left in your report in the Preview 
Tab.

The North panning cursor. It appears as an 
Intellimouse feature for panning North (up) in your 
document.
The South panning cursor. It appears as an 
Intellimouse feature for panning South (down) in 
your document.

The East panning cursor. It appears as an 
Intellimouse feature for panning East (to the right) in 
your document.
The West panning cursor. It appears as an 
Intellimouse feature for panning West (to the left) in 
your document.

The Northeast panning cursor. It appears as an 
Intellimouse feature for panning Northeast (up and to 
the right) in your document.
The Northwest panning cursor. It appears as an 
Intellimouse feature for panning Northwest (up and 
to the left) in your document.

The Southeast panning cursor. It appears as an 
Intellimouse feature for panning Southeast (down 
and to the right) in your document.
The Southwest panning cursor. It appears as an 
Intellimouse feature for panning Southwest (down 
and to the left) in your document.
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The Design Tab is the place you do most of your initial work when 
creating a report. It designates and labels the various sections of 
your report. You can place objects in these sections where you 
want them to appear, specify your sorting, grouping, and totalling 
needs, do your initial formatting, and so forth. See Area printing 
characteristics, Page 69.

The Design Tab provides the most efficient environment for 
designing your report because you work in the tab with data 
representations, not data itself. When you place a field on the 
report, the program uses a frame to identify the field on the tab; it 
does not retrieve the data. Thus, you can add and delete fields and 
other objects, move them around, set up complex formulas, and 
more, without tying up the computer or network resources it 
takes to gather the data.

The report you create in the Design Tab is a kind of virtual report; it 
has the structure and the instructions for creating the final report, 
but it is not the report itself. To turn the Design Tab report into a final 
report or into a report that you can fine tune, you “just add data.” 
You do this whenever you preview the report, print it, or output it 
in any other way. The actual data will now appear in the report.

Design Tab

Areas

When you first begin creating a report, Seagate Crystal Reports 
automatically creates five areas in the Design Tab. 

●   Report Header
This section is generally used for the report title and other 
information you want to appear at the beginning of your 
report. It can also be used for graphs and cross-tabs that 
include data for the entire report.
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●   Page Header
This section is generally used for information that you want 
to appear at the top of each page. This can include such 
things as chapter names, the name of the document, and 
other similar information. You can also use this section to 
display field titles above the fields on your report.

●   Details
This section is used for the body of the report. The bulk of 
your report data will generally appear in this section. This 
section will be printed once per record.

●   Report Footer
This section is used for information you want to appear 
only once at the end of the report, such as grand totals, and 
for graphs and cross-tabs that include data for the entire 
report.

●   Page Footer
This section usually contains the page number and any 
other information you want to appear on the bottom of each 
page.

If you add a group, a summary, or a subtotal to your report, the 
program creates two additional sections:

●   Group Header
This section typically holds the group name field, and it can 
be used to display graphs or cross-tabs that include data 
specific to the group. It is printed once at the beginning of a 
group.

●   Group Footer
This section generally holds the summary value, if any, and 
can be used to display graphs or cross-tabs. It is printed 
once at the end of a group.

When you add a group, a summary, or a subtotal, the Group 
Header area appears directly above the Details area and the 
Group Footer area appears directly below the Details area.
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If you set up additional groups, the program creates new group 
areas between the Details area and the existing Group Header and 
Group Footer area(s). 

Like the original areas, each of these newly added areas can 
contain one or more sections. By default they each contain a single 
section.

Area printing
characteristics

Each report area has its own printing characteristics. It is 
important to understand these characteristics because they affect 
when and how often different report objects get printed.

WHEN AREAS PRINT

Areas print in the order they appear on the Design Tab (top to 
bottom). If there is more than one section in an area, the sections 
print in the order they appear within the area. Thus, if you have 
three Report Header sections, all three of those sections will print, 
in order, before the section(s) in the Page Header area begin to 
print.
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HOW OFTEN OBJECTS PRINT

Your decision on where to place objects on the Design Tab is made 
easier if you understand how often each of the areas prints. Once 
you understand this, most of your reporting decisions are 
straightforward. This information becomes most useful, however, 
when you are trying to decide where to place graphs, cross-tabs, 
and formulas to get specific results.

Objects print in the following ways:

●   Objects placed in the Report Header area print once, at the 
beginning of the report. 

   Graphs and cross-tabs placed in this area contain data 
for the entire report. 

   Formulas placed in this area are evaluated once, at the 
beginning of the report.

●   Objects placed in the Page Header area print at the 
beginning of each new page. 

   You can not place graphs or cross-tabs in this section.

   Formulas placed in this area are evaluated once per 
page, at the beginning of each new page.

●   Objects placed in the Group Header area print at the 
beginning of each new group. 

   Graphs and cross-tabs placed in this area contain data 
just for the group.

   Formulas placed in this area are evaluated once for each 
group, at the beginning of the group.

●   Objects placed in the Details area print with each new 
record. 

   You can not place graphs or cross-tabs in this area. 

   Formulas placed in this area are evaluated once for each 
record.

●   Objects placed in the Group Footer area print at the end of 
each group. 

   Graphs and cross-tabs placed in this area contain data 
just for the group.
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   Formulas placed in this area are evaluated once for each 
group, at the end of the group.

●   Objects placed in the Report Footer area print once at the 
end of the report.

   Graphs and cross-tabs placed in this area contain data 
for the entire report.

   Formulas placed in this area are evaluated once, at the 
end of the report.

●   Objects placed in the Page Footer area print at the bottom of 
each page. 

   You can not place graphs or cross-tabs in this area.

   Formulas placed in this area are evaluated once per 
page, at the beginning of each new page.

Identifying and
working with

areas and

sections

By default, each area contains only a single section. The name for 
that section appears directly to the left of the section. If you have 
multiple sections in an area, the sections are designated as a, b, c, 
and so forth.

NOTE: Initials, such as RH, PH, D, PF, RF, and so on, are used to

identify each section if you have toggled the Show Short Section 
Names in Design check box on in the File Options dialog box.

Search for File Options dialog box in Seagate Crystal Reports online

Help.

NOTE: If you right-click the shaded area containing a section

name, a shortcut menu appears with section-specific options. If

you right-click the shaded area to the left of the section names, a

shortcut menu appears with area-specific options.

The program displays a section ruler immediately to the left of 
each section. The section ruler is used to add, remove, and move 
guidelines and to provide a visual reference when you are placing 
objects. See How to add, delete, and move guidelines, Page 82.
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Whenever you add a new section, the program creates a ruler for 
that section. See How to add, delete, move, and merge sections, Page 89.

Other Design

Tab capabilities

There are several other capabilities built into the Design Tab.

●   You can resize a section by dragging its boundary. See How 
to split and resize sections, Page 92.

●   You can split a section (create two sections from one) by 
clicking its left boundary. See How to split and resize sections, 
Page 92.

●   You can add horizontal and vertical guidelines by clicking 
the rulers. See How to add, delete, and move guidelines, Page 82.

●   You can zoom in and out on your report at any 
magnification from 25% to 400% of the original size. See 
How to zoom your report in and out, Page 86.

Preview Tab

When you want to preview your report before printing, click the 
PRINT PREVIEW button on the standard toolbar.

The program gathers the data, makes the necessary calculations, 
and displays the report in the Preview Tab on electronic “paper.” 
With the data in place, you can review the spacing and formatting 
of your report and see the actual results of all your summaries, 
formula calculations, and record and group selections.

In true WYSIWYG (What You See Is What You Get) fashion, you 
can work directly on this live data, fine tuning it until the report 
has the exact look you want.

The program works with data in the following manner:

Section ruler.
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●   The first time the Preview Tab is used, it retrieves data from 
your underlying data source(s) and saves it with the report 
(unless you have set up the program not to save data).

●   From that point on, the program uses the saved data 
whenever you preview the report unless you specifically 
refresh it or add a field that requires the program to retrieve 
new data.

Seagate Crystal Reports provides two views for previewing your 
report:

1. Standard view, and

2. Group Tree view.

Standard view  

In standard view, the report is displayed a page at a time. Using 
the navigation buttons in the Preview Tab, you can move to the 
beginning or end of the report, or you can move backwards and 
forward through the report a page at a time. For shorter reports or 
reports in which you're primarily interested in seeing the “bottom 
line” totals, standard view provides all of the functionality that 
you need.

THE DATA AGE INDICATOR

The Data Age indicator indicates the date the data was last 
refreshed or initially retrieved, whichever is the most recent. If the 
data was initially retrieved or refreshed today, it indicates the 
time it happened. Search for Save Data with Report command in 
Seagate Crystal Reports online Help.
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Group Tree

view

You can toggle the Group Tree view on/off using the TOGGLE 
GROUP TREE button on the format bar.

The Group Tree view presents a split screen. 

●   The right pane of the screen displays the report. 

●   The left pane displays a high level outline of the report, 
showing the hierarchy of groups and subgroups in a 
familiar tree format. 

When you click the tree node for the group that interests you, the 
program jumps immediately to the part of the report that contains 
the information for that group. For longer reports or reports in 
which you wish to jump back and forth between different groups, 
the Smart Navigation features of the Group Tree view make your 
work extremely efficient.

Similarities/

differences

from Design

Tab

You have the same formatting capabilities in the Preview Tab as 
you do in the Design Tab. Menus (both menu bar and shortcut 
menus), the standard and supplementary toolbars, rulers, and the 
format bar remain active, giving you essentially the same 
functionality you have when working with a report in the Design 
Tab. However, when you are making many changes, it is quicker 
to make the changes in the Design Tab.

●   The Design Tab and Preview Tab are tied together 
internally. Any changes you make in one are reflected in the 
other.
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●   The Preview Tab has a single vertical ruler at the left of the 
tab instead of the individual section rulers like the Design 
Tab. The functionality of the ruler is the same.

●   The Preview Tab identifies report sections in the shaded 
area to the left of the data. With a quick look you can tell 
which report section the data is printing from. While section 
names appeared only once in the Design Tab, they print 
each time a section prints in the Preview Tab.

●   The Record counter (see DATA RETRIEVAL 
INFORMATION, Page 61), the Data Age indicator (see THE 
DATA AGE INDICATOR, Page 73), and the Page Forward/
Page Back controls (see Preview Tab, Page 72), are all active 
in the Preview Tab.

●   The Preview Tab highlights every value when you select a 
field whereas only the field frame is highlighted in the 
Design Tab.

A DIFFERENT FEEL

Working in the Preview Tab has a different feel than working in 
the Design Tab.

Each field in a database contains dozens, hundreds, or even 
thousands of values, depending on the number of records in the 
database. When you place a field in the Design Tab, a single field 
frame represents all those values. When you highlight the field, 
sizing handles appear on the frame and the frame changes color.

In the Preview Tab, however, you are working with the actual 
data. Instead of a field frame representing many field values, the 
values themselves appear. 

●   When you highlight a field or formula field value, you are 
actually selecting every value in the field. 

   The program places a sizing frame around the specific 
value you select.

   It highlights every other value from the field.

●   Likewise, when you select a summary value, you are 
actually selecting all of the related summary values. 
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   The program places a sizing frame around the specific 
value you select.

   It highlights all the related summary values.

Aside from the obvious appearance differences, the process of 
building and modifying a report is the same in both the Design 
Tab and the Preview Tab. You should find it easy to work with 
your reports in both places.

Other fundamentals

The Seagate Crystal Reports reporting environment is extremely 
flexible. 

●   You can turn on grid snap, set the grid to a maximum of up 
to 1", and make the grid visible or invisible in the Design 
Tab, the Preview Tab, or both (see How to turn the grid on/off, 
Page 86).

●   You can also work without a grid, placing your objects 
wherever you want them in your report (see Free form, Page 
77 and Free form with guidelines, Page 77).

●   Finally, you can use guidelines if you wish to align and 
resize objects with precision (see How to move and position 
objects using guidelines, Page 83).

Set up your environment so it works the way you work best.

Grid The grid is a series of row and column coordinates. When the grid 
is active, the program enables you to place objects only at these 
coordinates, not between them. In this way it makes it very easy 
for you to place and space data on your report and to align objects 
as needed. If you attempt to place an object between grid 
coordinates, the program “snaps” the object to the grid, that is, it 
moves the object automatically to the nearest set of row/column 
coordinates.

You activate the grid and specify its size and visibility properties 
on the Layout Tab in the File Options dialog box. By default, the 
grid is not active. See How to turn the grid on/off, Page 86.
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Free form Unlike earlier versions of Seagate Crystal Reports, in this version 
you can work without a grid, in a free form environment similar 
to that of a drawing program. Free form means simply that you 
can place objects anywhere you want them to appear on your 
report. Your only restriction is that the program will not allow you 
to place graph and cross-tab objects in the Page Header, Page 
Footer, or Details sections. See Area printing characteristics, Page 69.

To work in a free form environment, toggle the Snap To Grid check 
box off using the Layout Tab of the File Options dialog box. Search 
for File Options dialog box in Seagate Crystal Reports online Help.

Free form with

guidelines

You may want to work in a free form environment yet still have 
the ability to align objects, or to move or resize them as a group. 
You can do this using guidelines.

Guidelines are lines that extend vertically or horizontally from the 
Design and Preview Tab rulers. Guidelines have a snap property; 
when you move an object within a guideline’s magnetic range, the 
object snaps to or attaches itself to the guideline.

●   Once an object is snapped to a guideline, when you move 
the guideline, the object moves too.

●   If you have several objects snapped to a guideline, they all 
move when you move the guideline.

●   If you have several objects snapped to a guideline on two 
sides (right and left, or top and bottom) and you move one 
of the guidelines, you resize all of the objects similarly.

Using guidelines in a free form environment gives you flexibility 
with control. See How to add, delete, and move guidelines, Page 82, 
and How to move and position objects using guidelines, Page 83.

Sections and

objects

Seagate Crystal Reports enables you to insert a variety of objects 
in your report:

●   Field objects
Fields from database tables and from the result sets 
returned by formulas, parameter, group name, queries, and 
stored procedures. See How to insert database fields, Page 118.

●   Text objects 
Characters, words, even entire documents. See How to insert 
text objects, Page 120.
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●   Picture objects
Bitmaps - *.bmp, *.pcx, *.tif, *.tga, *jpeg. See How to insert a 
picture, Page 121.

●   Graph/chart objects 
Graphs that display summarized data. See Graphing, Page 
405.

●   Subreport objects 
Reports within reports, freestanding or bound to the data in 
the primary report. See How to insert a subreport, Page 434.

●   Cross-tab objects 
Spreadsheet-like reports that help identify trends. See 
Cross-Tab Objects, Page 445.

●   OLE objects
Pictures, spreadsheets, text, and other objects created in 
OLE server applications. See OLE Objects Overview, Page 
416.

Objects are containers. They can hold data, and in some cases, 
other objects (for example, a text object can contain field objects as 
well as text, and labels in a cross-tab object are actually text 
objects). Each object has properties that define the way the object 
acts in your report.

You can set attribute properties for objects, conditional properties, 
or a combination of the two. 

●   You set fixed properties using dialog box options. 

●   You set conditional properties using special formulas. 

See Conditional formatting, Page 235, and Absolute formatting, Page 
233.

You can insert most objects in most report sections. But the 
program restricts you from placing some objects in some sections 
because it does not make sense to place them there. For example, 
since a Details section prints with each record, a cross-tab object 
placed in a Details section would produce a cross-tab report for 
each record, not something that would be very useful. The 
program thus excludes cross-tab objects from the Details section. 
See Area printing characteristics, Page 69, for a summary of section/
object restrictions.
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NOTE: See How to make an object underlay a following section(s), 
Page 124, for information on printing objects in sections where

they can not be physically placed.

You never have to worry about putting an object where it doesn’t 
belong; the program takes care of that for you. For those objects 
that the program allows in a section, just because you can put it in 
that section it does not necessarily mean that it makes sense to put 
it there. That is a different situation that requires some judgement 
on your part. For example, if you put a picture object:

●   in a Report Header section, it prints once at the beginning of 
the report.

●   in a Group Header section, it prints once with every group. 

●   in a Details section, it prints once with every record.

Based on what you are trying to accomplish in the report, it clearly 
makes sense to put the object in one of the sections and not in the 
others. It is up to you to decide what is best for your report.

You can also set fixed and conditional properties for sections just 
as you can for objects. See Conditional formatting, Page 235.

Underlaying

objects

By default, when you place an object into a section: 

●   the section expands to accommodate the object, if necessary, 
and 

●   the object prints in the section where it is placed, whenever 
that section prints. 

However, when you place an object in a section that you have set 
to underlay the following sections:

●   the object still prints when the section it is placed in prints, 
but, 

●   it underlays the following section(s) as well.

NOTE: Objects placed in a section can underlay all sections up to

(but not including) its �sister� section. For example, the Page

Header section can underlay all sections up to (but not including)

the Page Footer section.

This enables you to produce a number of interesting report effects. 
For example you can:
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●   print an object so it appears one time in the Details section 
beside a number of details (for example, a graph that 
compares sales figures by region along side the details for 
the regions),

●   print a company watermark that is centered on the page, 
flowing through multiple sections, and

●   use a scanned bitmap of a form as a guide in setting up a 
report to print on preprinted forms.

Using the Underlay facility, you can produce stunning visual 
effects. See How to make an object underlay a following section(s), Page 
124.

HANDS-ON (Report Design Environment)

How to move and resize toolbars and the format bar

The 32-bit version of Seagate Crystal Reports includes movable, 
resizeable standard and supplementary toolbars and format bar. 

You can move these bars into fixed positions or you can turn them 
into floating pallets if you wish. You move and resize these bars in 
the following ways:

Moving To move the bars, click on the bar where there is no button and 
drag the bar to a new position.

Resizing To resize the bars, position the pointer over an edge or corner of 
the bar. When the resizing pointer appears, drag it inward or 
outward to resize the bar. 

Drag the bar to the desired position.
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You can toggle the standard toolbar, supplementary toolbar, and 
format bar on and off using the Toolbars dialog box. 

A check mark indicates that the bar is visible.

Related Topics

Standard toolbar, Page 55

Format bar, Page 59

Dragthecursor

to create the

desired size.

To go from 
this...

to this... 

The bar will be

resized as specified.
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How to add, delete, and move guidelines

Seagate Crystal Reports provides guidelines to help you 
accurately place objects on your report. Guidelines are non-
printing lines that you can place anywhere in the Design and 
Preview Tabs to aid in alignment. You can toggle the visibility of 
the guidelines on and off in two ways:

1. Using the two commands on the View menu, GUIDELINES IN 
DESIGN and GUIDELINES IN PREVIEW. Search for Guidelines in 
Design command and Guidelines in Preview command in Seagate 
Crystal Reports online Help.

2. Using the two options, Show Guidelines in Design and Show 
Guidelines in Preview on the Layout Tab of the File Options 
dialog box. Search for File Options dialog box in Seagate Crystal 
Reports online Help.

Seagate Crystal Reports inserts guidelines automatically in some 
situations:

●   Whenever you insert a field or formula field in your report, 
the program automatically creates a guideline at the left 
edge of the field frame and snaps the field and field title to 
it.

●   If you summarize a field, the program snaps the summary 
to the same guideline to assure proper alignment.

●   When you right-click the shaded areas to the left of a section 
and choose the ARRANGE LINES command, the program 
automatically creates one or more horizontal guidelines in 
the section and snaps the fields to them.

Adding
guidelines

There may be times that you want to insert guidelines manually.

Click this ruler to activate

a horizontal guideline.

Click this ruler to activate

a vertical guideline.
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Moving
guidelines

Each guideline is attached to an arrowhead on its originating 
ruler.

Deleting
guidelines

Each guideline is attached to an arrowhead on its originating 
ruler.

NOTE: With the Snap to Grid option toggled on you will only be

able to insert or move guidelines in grid increments. To get the

full power of movement with guidelines, toggle the Snap to Grid 
option off using the Layout Tab in the File Options dialog box.

Search for File Options dialog box in Seagate Crystal Reports online

Help.

How to move and position objects using guidelines

Positioning
objects with
guidelines

Guidelines have a snap property that automatically snaps objects 
to them. That is, objects will connect to the guidelines as 
positioning devices.

An object can snap to a horizontal guideline on its top, bottom, or 
horizontal midline (the line that bisects the object horizontally).

Drag the guideline arrowhead

to the desired position.

Drag the guideline arrowhead

away from the ruler.
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An object can snap to a vertical guideline on its right or left side or 
vertical midline (the invisible line that bisects the object 
vertically).

When a guideline has its snap property toggled on and you move 
the guideline, you move all objects that are snapped to the 
guideline.

NOTE: When you move a guideline, you move any object that is
snapped to it. But if you move an object that is snapped to a
guideline, the program does not to move the guideline.

Snap to the top.

Snap to the midline.

Snap to the bottom.

Snap to

the left.

Snap to

the right.

Snap to the midline.

Drag the guideline to

the desired position.

The object will move

with the guideline.
84 Seagate Crystal Reports User�s Guide



Resizing
objects using
guidelines

When you snap one or more objects to guidelines on two sides 
(top and bottom, or right and left), you can resize the object(s) by 
dragging either or both of the guidelines. This can be especially 
helpful if you need to resize a number of objects similarly at the 
same time.

This is a two step process. 

1. First you have to snap the object(s) to two guidelines.

2. Then you have to drag a guideline to resize the object(s).

Snapping
objects with
two guidelines

You may have two or more objects that you want to resize and they 
are either the same size (height or width) or different sizes. The 
process for resizing with two guidelines is the same for either case.

1 Begin by creating a guideline and snapping one side of the 
object to that guideline.

3 Now click the object to activate the sizing handles.

5 Repeat Steps 2 through 4 for every additional object you want 
to snap to both guidelines.

6 If the objects are not yet the size you want them, drag either or 
both of the guidelines until the objects are the correct size.

2 Create a second guideline to

the right of the object. It should

not be touching the object.

4 Drag the resizing handle

over to the second guideline.

The object will snap to

the second guideline.
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How to turn the grid on/off

The Design and Preview Tabs have an underlying grid structure 
that you can activate and resize in the File Options dialog box. 

1 Choose the OPTIONS command from the File menu. The File 
Options dialog box appears with the Layout Tab active.

NOTE: By default, all of the grid options are toggled off.

How to zoom your report in and out

You can easily zoom in on your report. You can choose any 
magnification from 25% to 400%. This feature is active in both the 
Design and Preview Tabs. 

To zoom your report in or out, set the zoom level you want using 
the MAGNIFICATION FACTOR drop-down box found on the 
standard toolbar. 

2 Set the Grid Size, Snap to, and Show

options in this dialog box.
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It is helpful to view reports at low magnifications in order to get 
an overall picture of the layout of your report. Views at higher 
magnifications work well for attention to the details of the report. 

How to undo/redo activities

Seagate Crystal Reports includes multiple levels of undo. With 
multiple levels of undo, you can undo several changes, a step at a 
time, until you have your report in the condition you want it. 

The program also has a redo feature that reverses an undo. If you 
move an object, for example, and do not like its new position, you 
can click UNDO to move it back to its original position. If you then 
change your mind, you can click REDO to restore it to the place 
where you moved it.

●   To undo an action, click the UNDO button on the standard 
toolbar. The first time you click the button, it reverses the 
most recent change you made to your report. Each 
additional time you click the button it reverses the next 
most recent change.

Set the desiredmagnification factor

and click OK when finished.

25%

50%

100%
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●   To redo a change after you have undone it, click the REDO 
button on the standard toolbar.

The program disables the UNDO button and the UNDO/REDO 
commands whenever there is nothing to undo/redo or you have 
made a change that can’t be reversed. 

NOTE: If you undo an action (Action A) and then perform some
new action, you will no longer be able to redo action A.

How to drill down on summarized data

You can drill down on your data using the drill down cursor (to 
show the data behind individual groups). See Sorting, Grouping, 
and Totalling, Page 271.

Drill down

cursor

Seagate Crystal Reports allows you to drill down on group or 
summary information in the Preview Tab in both the Standard 
and the Group Tree view (see Standard view, Page 73 and Group 
Tree view, Page 74). When you position the cursor over any 
summary value that you can drill down on, the program displays 
a drill down cursor. 

If you double-click, the program reveals the details behind that 
specific summary value. For example, if the drill down cursor 
becomes active over the city summary, you can double-click to see 
the details behind that summary. See Cursors, Page 64.

●   If you have only a single summary, you can look at the 
summary or at the data from the individual records that are 
summarized.

●   If you have multiple summaries, you can look at the 
summaries behind summaries (the city summaries that 
make up the region summaries, for example), or at the data 
from the individual records that are summarized.
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HANDS-ON (Sections and Areas)

How to add, delete, move, and merge sections

The Design Tab opens originally with a standard set of report 
sections, each in a standard size (see Design Tab Areas, Page 67). 
You can not delete any of these original sections but you can add 
to them. Once you have added sections, you can delete them, 
move them in relation to other similar sections, or merge related 
sections together.

While there are different ways to do this, an easy way is using the 
SECTION EXPERT button.

1 Click the SECTION EXPERT button on the standard toolbar. The 
Section Expert appears with a list of all the sections in the 
report. When there are more than one of any kind of section, 
the sections are lettered A, B, C, and so on.

2 Highlight the section you want

to work with from this list.

Click Insert to insert

a new section.

ClickDelete to delete

an existing section.

Click Merge to merge two

sections.

Click the arrow buttons to

move a section up or down

in an area.
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Inserting a
section

Click the Insert button. The program adds a new section 
immediately below the highlighted section.

NOTE: You can also insert a section by right-clicking the shaded

area to the left of any section in the Design or Preview Tabs and

choosing the INSERT SECTION BELOW command from the shortcut

menu that appears.

Deleting a
section

Click the Delete button. The program removes the highlighted 
section from your report.

Moving a
section

1 Highlight the section you want to move.

2 Click the Up or Down arrow to move the section.

The data originally in Section

(C) is moved to Section (A).

The data in the other sections

is moved down.

3With Section (C) highlighted,

click the up arrow twice.
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NOTE: You can only move a section up or down within an area.

NOTE: The letters that identify the sections describe their relative

(as opposed to original) position. Thus, if you move a �C� section

up, it becomes a �B� section. It loses its original �C� designation.

Merging two
related sections

There may be times when you have placed objects in two sections 
(where they print sequentially) and you want to put them all in a 
single section (where they print simultaneously). You can merge 
the two sections and then rearrange the objects as needed in the 
new section.

1 Move the sections so the two sections you want to merge 
follow each other in the list.

2 Highlight the top section.

3 Click the Merge button. The program combines both sections 
into a single section.

4 Rearrange the objects as needed.

5 With Section (B) highlighted,

click the Merge button and

Section (C) will bemerged with

Section (B) to form one section.
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How to split and resize sections

You can split a section into two or more sections or resize sections 
easily in the Design Tab.

Splitting a
section

1 Move the pointer over the left boundary of the section you 
want to split. 

2 When the pointer becomes the section splitting cursor, click 
the boundary. See Cursors, Page 64.

3 When a horizontal line appears, drag it up or down to split 
the section the way you want it.

Resizing a
section

Move the pointer over the bottom boundary of the section you 
want to resize and, when the pointer becomes a resizing cursor, 
drag the boundary to make the section bigger or smaller as you 
wish.

If you have one or more objects in a section and you want to resize 
the section to remove unnecessary white space, right-click in the 
shaded area to the left of the section in the Design and Preview 
Tabs and choose the FIT SECTION command from the shortcut 
menu that appears. The program automatically resizes the 
section, moving the bottom boundary of the section to the baseline 
of the bottom object in the section.

4When the section splitting cursor

appears, drag the horizontal line to

the desired position.

The section will split at the line.
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A section will automatically expand vertically in two instances:

●   when you place an object and the object is bigger (vertically) 
than the section you put it in, and 

●   when you expand an object (vertically) so it becomes bigger 
than the section it resides in.

NOTE: You can not resize a section smaller than an object in the
section.

Drag the resizing
cursor up to make
the section above

smaller.

Drag the resizing
cursor down to

make the section
above bigger.
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5 Reporting 101

What you will find in this chapter...

Basic report design, Page 96

How to design a prototype, Page 104

Concepts in reporting, Page 105

Beyond basic reports, Page 113

HANDS-ON (Report Creation and Design), Page 113

HANDS-ON (Finishing Your Report), Page 130
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Basic report design

The purpose of this topic is to suggest a structured approach to 
preparing reports with Seagate Crystal Reports. The approach 
includes the following elements: 

●   deciding on the content of your report, 

●   developing a prototype on paper, 

●   setting up the prototype using Seagate Crystal Reports, 

●   specifying the records/groups to be included in the report,

●   manipulating the data with formulas and functions, 

●   grouping, summarizing, and sorting your data, 

●   editing and formatting the data, 

●   adding graphic enhancements and OLE objects, and 

●   printing the finished report.

This section has been designed to provide you with a conceptual 
understanding of the reporting process.

Deciding on

the content of

your report

Before you do anything else, you should outline the information 
you want your report to provide. Use the following list of 
questions as a guide in making that outline:

●   What is the overall purpose of the report? 

●   Who is going to read the report? 

●   What is the report title going to be? 

●   What information do you need besides the title to identify 
the report? 

   Where is that information to come from? 

   If the information exists in a database table, what types 
of fields is the data stored in: number, text, etc.?

●   What identifying information do you want to appear at the 
bottom of each page? At the top of each page?

   Where will that information come from?
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   If the information exists in a database table, what types 
of fields is the data stored in: number, text, etc.?

●   What specific data do you want to appear in the body of the 
report? 

   Where will that data come from? 

   Does that data exist in data fields or does it need to be 
calculated from data field values? 

   What types of fields is the data stored in: number, text, 
etc.? 

   Do you want your data sorted? 

   How?

   Do you want the data broken into groups?

   What kind of groups?

   Do you want your data summarized?

   Subtotaled? Averaged? Counted? or some other kind 
of summary value? 

   What do you want to total?

   Do you want to show summaries for all the groups 
or just the top or bottom groups?

   Do you want the group summaries sorted in any 
special order?

   Do you want to add text labels to the summaries?

●   What information, if any, do you want flagged on the 
report? 

   How do you want it flagged?

   By color?

   By a text flag? 

●   What other information do you want highlighted in some 
way so that it really stands out? 

   How do you want it highlighted?

   Colored text?
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   Special font or font size?

   Borders or background color?

   Do you want to label the highlighted information as 
well?

●   Do you want the report to be based on all records in the 
database or only on specific records? 

   Which records?

Purpose What is the overall purpose of the report?

Reports are management tools. Their purpose is to help 
individuals quickly grasp the essential elements and relationships 
found in raw data so they can make effective decisions. For a 
report to be effective, it has to present the right data in a logical 
way. If it presents the wrong data or if it presents the right data in 
a haphazard manner, the report may slow the decision making 
process or even encourage incorrect decisions.

A good starting place in the development of a report is to write out 
the purpose of the report in a sentence or two. The purpose 
statement helps you focus on your primary needs, and it gives 
your report both a starting point and a goal. Here are some 
examples of purpose statements: 

●   The purpose of this report is to show monthly and year-to-
date sales by sales representative, compare this year's 
numbers to last year, and flag representatives whose sales 
figures do not meet company standards. 

●   The purpose of this report is to show sales activity for each 
item in inventory, and to suggest reorder quantities based 
on that activity. 

●   The purpose of this report is to calculate bowling averages 
and handicaps for each member of the bowling league. 

Clarifying the purpose of the report before you start is a critical 
step in the overall process. A report without a clear purpose is like 
a meeting without a clear agenda; it rambles and accomplishes 
little. 
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Readers Who is going to read the report?

A single report is often used by many individuals. A detailed, 
company-wide sales report, for example, may be used by sales 
representatives, the regional sales manager, the national sales 
manager, and the Chief Operating Officer (COO). 

Each of these individuals will be interested in different aspects of 
the report. 

●   A sales representative will use the report to evaluate his/
her individual sales performance and to compare that 
performance to that of other representatives in the region. 

●   The regional sales manager will use the report to evaluate 
the representatives in his/her region and to compare the 
region's performance to that of other regions. 

●   The national sales manager will use the report to evaluate 
the performance of his/her regional managers and to 
compare overall sales to the current sales forecasts. 

●   The COO will use the report to evaluate the performance of 
the Vice President of Marketing and the sales department as 
a whole, and to project such things as manufacturing needs, 
warehouse locations, etc. 

Since each of the users of the report has different interests, it is 
important to plan the report so it includes the information each of 
the users is looking for. 

Title What is the report title going to be? 

Write out a working title for your report. You may decide to 
change it later, but at least you will have a title to use when 
creating your prototype report.

Do you know
the data you
want to use in
your report?

Do you know the type of database you are reporting from? 
Whether you will be reporting off a data file, SQL/ODBC, or a 
dictionary?

If you do not know, ask an internal source for the database type 
and location of your data and to set you up with access to that 
database if necessary. See Data Sources, Page 583.
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Are you familiar enough with your data to find the information 
you want? When you are looking for the Customer Contact name, 
can you find the field in a database table?

Your MIS professional, database administrator, or co-workers will 
have to help you become familiar with your data.

Header
information

What information do you need besides the title to identify the 
report?

You may wish to include the current date, information on who 
prepared the report, a block of text to describe the purpose of the 
report, the range of data covered, or something similar. If you are 
going to include such information, write it down so you can use it 
in preparing your prototype. 

Header
information
sources

Where will that information come from? 

The information can come from a variety of sources, depending 
on the kind of information you plan to use. 

●   The current date can be inserted using the PRINT DATE FIELD 
command on the Insert|Special Field menu. 

●   Information on who prepared the report might be drawn 
from individual data fields in the database table(s) used. (If 
it is to be drawn from a database table, what table? Or, what 
combination of tables?) 

●   A block of text can be created as a text object and placed 
anywhere on the report. 

As you begin to think of where the information is to come from, 
you begin formally structuring the report. 

Data types in
the header

If the information exists in a database, what types of fields contain 
the data: number, text, etc.? 

Seagate Crystal Reports uses different rules for working with 
different types of data. You will find it helpful later if you note the 
data type of each piece of data you plan to draw from a database.

Footer
information

What identifying information do you want to appear at the 
bottom of each page (page number, page n of N, report name, 
author's name, the word “Confidential”)? See How to insert a page 
n of N field, Page 119.
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Footer data
sources

Where will the information come from? 

As with Report Header data, the information for your Report 
Footer can come from a variety of sources, depending on the kind 
of information you plan to use.

Data types in
the footer

If the information exists in a database table, what types of fields is 
the data stored in: number, text, etc.? 

Report body
data

What specific data do you want to appear in the body of the 
report? 

When you think of a report, it is probably the body of the report 
that you think of. The body should contain all the data that you 
need to fulfill the statement of purpose you wrote for the report. 
It should also contain all of the data needed by the various users 
that you have identified.

Body data
sources

Where will that data come from? 

This step requires you to look at the available database table(s). 
Seagate Crystal Reports allows you to combine data from 
different databases to create your reports, so you have a great deal 
of flexibility in your work. 

●   Much of the data in a typical report will be taken directly 
from data fields. Which data fields will you be using and 
where are they located? 

●   Other data will be calculated based on data fields. Which 
data fields will be used in the calculations? 

●   Still other data will be placed directly into the report using 
text objects (headings, notes, labels, etc.). 

Existing or
calculated?

Does the data exist in data fields or does it need to be calculated 
from data field values? 

Some report information can be drawn directly from data fields 
(sales information, for example); other information will have to be 
calculated based on data field values (sales commission, for 
example, based on the relationship of sales to quota). In your 
planning, it can be helpful to segregate or flag data that needs to 
be calculated from that which can be used directly. See Formulas 
101, Page 321.
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Data types in
the body

What types of fields contain the data: number, text, etc.? 

While it is important to understand data types for all data you will 
be using, it is of critical importance that you know the data type 
for data fields that will be used in calculations. Functions and 
operators work with specific kinds of data, so it's important to 
know the data type to know which functions and operators you 
can use in your calculations. Search for Functions Index and 
Operators Index or the function or operator by name in Seagate 
Crystal Reports online Help.

Record or
group
selection

Do you want the report to be based on all records or groups in the 
database or only on specified records or groups? 

Seagate Crystal Reports gives you the opportunity to base a report 
on all records in a given database, or on a limited set of records 
from the database. Using Seagate Crystal Reports you can select 
records based on simple date ranges or comparisons, or you can 
create complex formulas to identify the records to be included. 
Take a few minutes to determine the records needed for your 
report and list the criteria to be used for selecting those records. 
See Record and Group Selection, Page 249.

Groups Do you want your data organized into groups? How? By 
customer? By date? Or by other criteria? Seagate Crystal Reports 
provides several options for grouping data in your report. See 
How to group data, Page 285.

Group values Do you want to show a subtotal at the end of each group? A 
count? An average? Seagate Crystal Reports allows you to specify 
several kinds of group values. See How to summarize grouped data, 
Page 289, and How to subtotal grouped data, Page 291.

Group value
positions

Where do you want the group values to appear? With the group 
data? With the group data but on a page separate from other 
groups? Only at the bottom of the page? 

Seagate Crystal Reports gives you all of these options. 

Grand totals,
subtotals,
averages, etc.

Do you want to total, average, count, or determine the maximum 
or minimum value included in all the values in any column on 
your report? 
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Seagate Crystal Reports allows you to do this and place the grand 
total (or the grand total average, grand total count, etc.) at the 
bottom of the selected column. 

Flags What information, if any, do you want flagged on the report? 

You may want to call attention to some data by flagging it on your 
report. For example, non-moving inventory items are often 
flagged on inventory reports so they can be given special 
attention. You might want to flag each item that has shown no 
activity during the last month, during the last three months, or 
during some defined period. So, if you want any information 
flagged, identify the information and the conditions that will 
trigger the flagging. See How to flag values that meet certain 
conditions, Page 246.

Flag options How do you want it flagged? 

You may want to flag items with an asterisk or some other 
symbol, or you may want a word to appear as a flag. In any case, 
you should write out flagging instructions so they are handy. 

Highlights What information do you want highlighted in some way so that it 
really stands out? 

Seagate Crystal Reports gives you the opportunity to underline 
report elements, or to change the font type, size, or color used for 
specific report items. It allows you to put borders around items 
and to draw lines and boxes to break your report into sections, set 
off headings, etc. All of these formatting tools can be used to 
highlight key data on a report. If you have data that you want 
highlighted, you should write down highlighting instructions so 
they are handy too. See Formatting, Page 231.

Sorting Do you want your data sorted based on record or group values? 

Seagate Crystal Reports gives you both alternatives. See Sorting, 
Grouping, and Totalling, Page 271.

Developing a
prototype on
paper

Graphic designers generally begin their work on a magazine 
cover, brochure, or display advertisement with a rough pencil 
sketch. They often use boxes, circles, or other symbols to represent 
the graphic elements they intend to include in the final product, 
and they often use lines or scribbles to represent text. Doing the 
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rough design on paper helps them create a look for each page. It 
helps them find a balanced way of positioning the various 
elements before they begin working with sophisticated graphics 
tools. You will find a similar exercise helpful in designing your 
reports. See How to design a prototype, Page 104.

While a paper prototype is useful regardless of your expertise 
with Seagate Crystal Reports, it is particularly valuable when you 
are first learning the program. With the paper prototype in hand, 
you can put your full effort into learning and using the commands 
instead of trying to design and learn at the same time. 

How to design a prototype

●   Get paper of the size you will be using for your finished 
report. 

●   Position your title and other descriptive header 
information, using boxes or lines to represent report 
elements. 

●   Position your footer information. 

●   Review the page for balance. 

●   Look at the information you intend to include in the body of 
your report. 

   Count the number of fields you will be using and 
estimate the appropriate spacing between fields. 

   Use rectangles to pencil in the fields using your 
estimated spacing.

   Change the spacing if you need to. 

   Decide on a logical sequence for presenting the data in 
the body of the report. 

   Label the fields to indicate that sequence. 

●   Use small boxes to indicate group values and totals. 

●   Place some random flags in the column where you want the 
flags to appear. 
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●   Darken any elements you want highlighted so they stand 
out from the rest of your prototype. 

●   Review your finished product for look and balance, and 
make changes as needed. 

Concepts in reporting

The purpose of this section is to give you a conceptual 
understanding of the tasks necessary to create a fairly standard 
report such as the one created in Tutorial - Customer List, Page 165. 
Each topic is discussed in relation to the Tutorial; please refer to 
Tutorial - Customer List, Page 165, throughout for an illustration of 
these concepts.

The concepts are presented in the order you may use to create 
such a report and sources of additional information will be 
provided.

Report Expert,
Another
Report, or
Custom
Report?

Each time you create a new report, you have three options:

1. using a Report Expert, 

2. using Another Report as a template, or 

3. creating a Custom Report from scratch.

You will probably use all options at some point in time.

REPORT EXPERT

The Report Experts help you create reports as quickly as possible 
and many new users and developers alike prefer to create the 
majority of their reports using them. All you have to do is choose 
the Expert that most closely matches your report type. The Expert 
walks you through the process of creating your reports step-by-
step. 

You can quickly create the report and see how it looks against 
your actual data. And best of all, if you then decide you want to 
make changes you can get back to the Report Expert to further 
modify your report. Search for Experts Index in Seagate Crystal 
Reports online Help.
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ANOTHER REPORT

If you want to build a new report based upon one that already 
exists, you can use another report as a template to base your 
report on. The program will make a duplicate of the original 
report, which you can modify however you please to create your 
new report. Use this option whenever you think templates can 
save you time. Templates are useful:

●   when you need to create a new report with a different 
grouping or different record selection than that of an 
existing report, 

●   when you need to create a series of reports, each a little 
different than the last, 

●   when you need to reconstruct a report based on an earlier 
time period using the same report structure used today, or

●   when you need to create an entirely new report based on a 
set of databases that are linked in another report. You can 
create a report and delete the fields without disturbing the 
underlying links. Then, without relinking, you can build all 
your new reports based on this report.

CUSTOM REPORT

The Custom option is used when you want to create your report 
from scratch. This is used often when you want the full flexibility 
and control of building your reports from the ground up or if your 
report type is different than the many report types available in the 
Experts.

The Custom option was chosen for the Tutorial - Customer List, Page 
165, because creating a report from scratch most fully illustrates 
the basics of reporting.

Selecting your
data

The next step when creating your reports, is to select the data you 
want to use in your report. This is a two step process. The first step 
is to determine what type of data you want to work with and the 
second step is to actually select the data. See How to select data and 
begin creating a report, Page 113.
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Seagate Crystal Reports provides four different data types:

●   data file,

●   SQL/ODBC, 

●   dictionaries, and

●   queries.

DATA FILE

Choose the Data File option if you want to use any of the standard 
(not client-server) PC databases to report on. These are typically 
databases whose data and all software used to access that data are 
on a single machine. Seagate Crystal Reports can access many of 
the most common PC database formats directly; the program has 
built-in capabilities to directly open database files and tables 
designed in dBASE, FoxPro, Clipper, Btrieve, Paradox, and 
Microsoft Access, among others. Once the program is installed on 
your system, you can immediately begin creating reports based 
on these databases simply by selecting the appropriate file. See 
Data Sources, Page 583.

The Data File option was chosen for the Tutorial - Customer List, 
Page 165, because the sample data, CRAZE.MDB, is a Microsoft 
Access database. 

SQL/ODBC

Choose the SQL/ODBC option if you want to use SQL or ODBC 
data sources.

●   SQL (Structured Query Language) databases are perhaps 
the most popular and most powerful database formats. 
They usually work over a client/server network 
architecture and they use:

   an SQL server to create, store, and manipulate database 
files, tables, fields, and records, and 

   an SQL client interface allowing workstation users to 
retrieve data.

See Using SQL and SQL databases, Page 545.
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●   ODBC (Open Database Connectivity) is a standard 
developed by Microsoft through which many different 
types of data can be accessed by a single application. An 
application need only communicate with one set of files, 
ODBC, to instantly be able to work with any source of data 
that can be accessed by ODBC.

See ODBC data sources, Page 606.

Seagate Crystal Reports provides direct drivers for many of the 
most popular SQL systems, and ODBC capabilities as well.

DICTIONARIES

In many large organizations, data is stored in a variety of places. 
It may be in different databases, on different servers, and so forth. 
IS departments often use naming schemes for tables and fields 
that are logical and predictable, but the names assigned may seem 
cryptic to non-technical staff. Enabling staff to create reports 
themselves in such an environment can create extensive training 
and support problems and possibly compromise data integrity. 
Dictionaries provide a solution to these problems. They allow you 
to provide your staff with ready access to the data in a form that 
they can understand, but they also allow you to maintain 
complete control and security over your data resources.

A dictionary is a structured, simplified, and secure view of 
organizational data that you can create for some or all of the users 
in your organization.

A dictionary is an optional metalayer that you can place between 
the user and the data. Using the capabilities of the metalayer you 
can:

●   design a single, dynamic view of all the data that is 
necessary to create organizational reports and queries,

●   include multiple data sources, tables, and links,

●   organize the data and rename tables and fields to make it 
easier for users to understand the content and purpose of 
the data,

●   limit access to specific columns of data (for example, letting 
only executives see the salary column of the employee data 
files),
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●   place restriction formulas on specific rows of data (for 
example, allowing managers to view employee information 
only for those employees with a salary under $40,000),

●   create complex data manipulation formulas that users can 
access without the need to understand formula concepts.

Dictionaries reduce support cost and time, increase user 
productivity, and enable you to add an additional layer of security 
between the user and the data.

NOTE: When you create a report using a dictionary, the only data
you can use in the report is the data you access through the
dictionary; you can not use a dictionary and some other data
source in the same report. Because the dictionary is often used to
impose data security, it would breach that security to allow
unrestricted data access in a dictionary report.

NOTE: You can include a subreport based on a different data
source in a primary report based on a dictionary.

NOTE: Dictionaries are an optional metalayer. You can use
Seagate Crystal Reports without ever using dictionaries.

See Dictionaries, Page 491.

QUERIES

A query is simply a request for specific information from a 
database. If you are requesting that information from an SQL 
database (or from a database that you access via ODBC), your query 
must be written using the Structured Query Language (SQL). The 
SQL language is not difficult to learn, but mastering the fine points 
of creating and retrieving data using SQL can take quite a while. 
Since the Query Designer eliminates the need to understand SQL, it 
can get you building effective queries right away.

The Query Designer has been designed to meet the needs of 
individuals with little or no query background as well as the 
needs of experienced SQL professionals.

●   If you are new to querying, you will enjoy the way the 
Query Designer helps you create queries, even if you have 
no knowledge of SQL whatsoever. By answering a few 
questions on a set of sequential tabs, you give the program 
all the information to generate a query that fits your needs. 
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●   If you are an SQL professional, you will appreciate the 
facility that enables you to fine tune the queries that the 
Query Designer generates. If you are more comfortable 
writing your own SQL queries, you will find it easy to enter 
your queries directly or even paste them in from another 
source.

The Query Designer can be a powerful tool for many of your 
information gathering needs.

NOTE: The Query Designer can only access data stored in an

ODBC data source.

Linking If your report contains data from two or more database tables you 
will need to link at this point when creating your reports. You link 
database tables so records from one database will match related 
records from another. For example, if you activate a Suppliers 
table and a Product table, you link the databases so that each 
product (from the Product table) can be matched up with the 
supplier that made the product (from the Supplier table).

The majority of your reports will probably require data from two 
or more tables so linking will be necessary. The process of linking 
is made easy with the Visual Linking Expert. See How to add and 
link multiple tables, Page 116, and search for Visual Linking Topics 
Index in Seagate Crystal Reports online Help.

NOTE: You will never find it necessary to link tables in reports

from a query because any links required by the data have already

been processed.

Placing data on

your report

Placing data on your report is a very important task. You have to 
know what type of data you want to place on your report and also 
where on your report you want to place them.

DATABASE FIELDS

Much of the data you place on your report will be database fields, 
displaying data as it is stored in the database. For example, in 
Tutorial - Customer List, Page 165, the Customer Name, City and 
Country fields are placed on the report. Normally, you will place 
database fields into the Detail section, but in certain circumstances 
you will place them in other sections of your report. See How to 
insert database fields, Page 118.
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TEXT OBJECTS

Text objects will be used in your reports for a multitude of 
purposes. They are a powerful way of inserting titles; labelling 
summaries and other data on your report; and for easily 
combining database fields. For example, in the Tutorial - Customer 
List, Page 165, text objects are used to easily display the two 
contact name database fields as one object, to insert a column 
heading for the concatenated contact name, and to insert a title in 
your report. See How to insert text objects, Page 120.

SPECIAL FIELDS

To display information such as Page Numbers, Print Date, and 
Report Comments use the commands on the Insert|Special Field 
menu. See How to insert special fields, Page 118, and search for 
Special Field commands in Seagate Crystal Reports online Help.

FORMULA FIELDS

If you want to display data that is a calculated value, you will 
need to create a formula field and place that formula field on your 
report. For example, if your database only stores the order and 
ship dates for orders but you need to display the number of days 
it takes to ship the order, you will need to create a formula field 
that will calculate the number of days between ordering and 
shipping. This is just one simple example of the use of formula 
fields. See Formulas 101, Page 321, for an introduction to formulas.

Formatting data At this point in creating a report, you may want to do some basic 
formatting. Perhaps you would like to change the font size and 
style of a text object used as a title. Or, if you have a number field, 
such as a sales figure, you might want to place a dollar sign before 
the number or change the number of decimal places displayed.

For example, in the Tutorial - Customer List, Page 165, you format 
the title, add a text object to identify the Contact Name 
information, and insert the company logo. See Formatting, Page 
231.

Record
selection

Record selection, the task of paring down the data in your reports 
to include only the data required for your report, is a crucial step 
in report creation. You will rarely want a listing of all the 
information in a database. Most often you will be interested in 
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only the sales in a given time period or for a certain product, etc. 
For example, a sales report may be designed to only include sales 
from one product line for the last calendar month.

The sample data used for the Tutorial - Customer List, Page 165, has 
information from both United States and International customers. 
Record selection is used to create a report that lists only those 
customers in the United States. See Record and Group Selection, Page 
249.

Grouping,
sorting, and

summarizing

your data

Once you have created a basic report you will want to organize 
the data by grouping related information, sorting individual 
records, and summarizing, subtotaling, and grand totalling.

GROUPING RECORDS

To organize your data, you may want to group related data 
together. For example, in the Tutorial - Customer List, Page 165, 
after grouping the Customer List by region, you divide the list 
into region groups. That way, a sales manager for the California 
region could quickly locate the California group and see the 
customers within their region only. See How to group data, Page 
285.

SORTING RECORDS

Seagate Crystal Reports allows you to specify the order in which 
you want the records on your report displayed. For example, after 
grouping in the Tutorial - Customer List, Page 165, you sort the 
records within each region in alphabetic order by Customer 
Name. Many of your reports will use some type of sorting. 
Depending on the report, you will sort the records in a list or sort 
in conjunction with grouping. See How to do a single field sort, Page 
281, and How to sort records within groups, Page 287.

SUMMARIES, SUBTOTALS, AND GRAND TOTALS

Many of your reports will use some sort of totalling. For example, 
in a North American sales report grouped by state, you might 
want to calculate the total dollar amount sold in each state. You do 
this by creating a subtotal on the sales field. Summaries are also 
used at the group level, allowing you to calculate averages, 
counts, and other group (aggregate) values. For example, in a 
sales report you may want to calculate an average of sales per 
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state (average summary on the sales field) and calculate the 
number of products sold in the state (distinct count of the product 
name field).

See How to summarize grouped data, Page 289, and How to subtotal 
grouped data, Page 291.

Beyond basic reports

Once you are comfortable with the basics of reporting, you will be 
ready to investigate powerful reporting features including:

●   graphs (see Graphing, Page 405), 

●   OLE objects (see OLE, Page 415), 

●   form letters (see How to create a form letter using a text object, 
Page 218), 

●   subreports (see Subreports, Page 429), 

●   cross-tabs (see Cross-Tab Objects, Page 445), 

●   multi-section reports (see Multiple Section Reports, Page 213),

●   and much, much more.

HANDS-ON (Report Creation and Design)

How to select data and begin creating a report

You can use Experts to help you create reports as quickly as 
possible. When you click the NEW REPORT button on the standard 
toolbar, the Report Gallery appears. In the Report Gallery you will 
find a series of buttons representing the different types of Experts 
that are at your disposal.
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●   Click the icon for the type of report you want to create and 
follow the steps outlined on the tabs in the Expert that 
appears. 

●   If you want to build a new report based upon one that 
already exists, click the Another Report button. You can 
select a report file to serve as a template for your new 
report. The program will make a duplicate of that original 
report, which you can modify however you please.

●   If you want to build a report from scratch, click the Custom 
button. Several Report Type and Data Type icons will 
appear at the bottom of the Report Gallery. Click the 
buttons appropriate to your needs.

 

The program will open a dialog box that enables you to select the 
data you need. Since building reports from scratch is the easiest 
way to learn about all the powerful features of the program, this 
is the method discussed throughout the documentation. For 
information on creating reports from another report, see 
ANOTHER REPORT, Page 106, and search for Report Templates in 
Seagate Crystal Reports online Help and Sample Reports in Sample 
Reports online Help. 
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1 Using the File Name and Directories

list boxes, select the desired file.

2 Click OK to

add the file to

your report.

If you choose Data File 
as your data source...

1 First, choose the

Server Type.

2 Then, using the SQL Tables and

SQL Databases list boxes, select

the desired table and click OK.

If you choose SQL/ODBC 
as your data source...

3 Click done once you have added

all you want.
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Related Topics

Data Sources, Page 583

How to select a dictionary for a report, Page 510

How to add and link multiple tables

After you have selected a database table to begin working on your 
report, you may need to select a second table and then link the 
tables so the records in each table match up. For example, if you 
are using a Customers table and an Orders table for your report, 
you will need to link the tables so the records in the Orders table 
are matched up with the records of the customers who placed the 
orders.

1 Choose the ADD DATABASE TO REPORT command from the 
Database menu. The Choose Database File dialog box 
appears. 

2 Using the Directories, Drives, and File Name boxes, select the 
new database that you want to use in the report and click OK 
when finished. The Visual Linking Expert appears and 
displays the databases currently available for linking. Search 
for Visual Linking Expert in Seagate Crystal Reports online 
Help.

NOTE: If the Auto-Smart Linking option is toggled on in the

Database Tab of the File Options dialog box, you will not have to

1 Using the File Name and Directories

list boxes, select the desired file.

2 Click OK to

open the file and

add it to your

report.

If you choose 
Dictionary as your 
data source...
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manually create links between the tables. See Linking tables, Page 
520, and search for File Options dialog box in Seagate Crystal

Reports online Help.

NOTE: If your primary database is either Access or Btreive, all

tables contained in those databases will appear in the Visual

Linking Expert. You do not have to manually add each table to

your report.

 

NOTE: When manually creating links, the field you are linking

�to� field must be an indexed field. For more information on

indexed fields and tables, see Indexed tables, Page 518.

The Visual Linking Expert closes, and you are returned to your 
report. The linked databases are now available to use. If you are 
not satisfied with the link, you can modify it using the Visual 
Linking Expert. Search for Visual Linking Topics Index in Seagate 
Crystal Reports online Help.

Related Topics

Working With Databases, Page 513

SQL join types (ODBC data sources), Page 537

To link databases automatically,

click the Smart Linking button.

To create links manually, drag a field from one table to a field in another

table. If successful, a link line is created. If unsuccessful, a message is issued.

ClickOK when

finished.

To specify the tables,

click the Tables button.
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How to insert database fields

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box appears with the Database Field Tab 
active listing all of the fields in the chosen database(s).

How to insert special fields

Seagate Crystal Reports allows you to insert Page Number, 
Record Number, Group Number, Print Date, and Total Page 
Count fields, among others, into your report easily. 

To insert special fields, choose the SPECIAL FIELD command from 
the Insert menu. A submenu appears with the special fields 
available for use in your report. Search for Special Field commands 
in Seagate Crystal Reports online Help.

2 Click the field you want

to appear in your report.

3 Click the Insert button

to place it in your report.

To speed the report building process,

this dialog box remains on screen until

you click the Close button. You can

move the dialog box wherever you wish.

4 Click the Browse button

to review the values in the

selected field.
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Each special field is inserted into your report as an object. An 
object frame appears that you can place into the desired position 
on your report.

NOTE: If you want to change the formatting of any of the inserted
objects, right-click the object and click the OBJECT PROPERTIES

button on the supplementary toolbar. The Format Editor appears
where you can make the desired changes. See Formatting, Page 
231.

How to insert a page n of N field

You can use special fields and text objects to create a Page n of N 
field where n is the current page number and N is the total number 
of pages in the report. 

1 Insert a text object where you want the field to appear in the 
Page Header or Page Footer section of your report. See How to 
insert text objects, Page 120.

2 Type in the word “Page” followed by a space. 

NOTE: The text object must be in edit mode for you to be able to
enter text. See How to work with text objects, Page 216, for more
information on the text object edit mode.

3 Insert a Page Number field in the text object using the PAGE 
NUMBER command on the Insert|Special Field menu. (Search 
for Page Number command in Seagate Crystal Reports online 
Help.)

4 Type in a space, the word “of” and another space.

Choose a command

to insert the desired

special field.
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5 Insert a Total Page Count field using the TOTAL PAGE COUNT 
command on the Insert|Special Field menu. (Search for Total 
Page Count command in Seagate Crystal Reports online Help.)

Now, when you print the report the program will print “Page n of 
N” for each page of your report.

How to insert text objects

Click the INSERT TEXT OBJECT button on the standard toolbar. 

An empty object frame appears. 

●   Click once on the border of the text object to select it for 
resizing and moving. 

●   Double-click inside the text object to select it for editing. The 
Design Tab ruler changes to a text object ruler sized to the 
dimension of the selected object. To the left, a tab indicator 
appears.

The ruler allows you to add indents and align text within the text 
object. By clicking the tab indicator, you can cycle through the 
four tab options available.

Position the text object where you

want it to appear in the report.

Left-aligned tab.

Right-aligned tab.

Center-aligned tab.

Decimal-aligned tab.

Once you have chosen the desired tab, click

the position on the ruler where you want to

insert it.

Drag to set the

left margin.

Drag to set the

right margin.
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How to use a database field in a text object

The primary function of a text object is to hold text. However, text 
objects can hold database fields as well, making them ideal for 
creating custom form letters.

1 Insert a text object in your report.

3 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box appears with the Database Tab active.

4 Highlight the database field you want to insert and drag it 
into the text object. As you move the drag and drop cursor 
over the text object, the program displays a movable insertion 
point. See Cursors, Page 64.

How to insert a picture

Often when you are developing reports you would like to include 
a picture. For example, you may wish to put a company logo into 
the header of a report. 

1 Click the INSERT PICTURE button on the supplementary 
toolbar. The Open dialog box appears.

2 Type in the text and

spaces that you want to

appear before the first

database field (if any).

5 Drag the object so the

insertion point is located

where you want the

database field to appear

and drop the field.
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2 Select the desired picture file from the file list and click Open 
to return to your report. An object frame appears with your 
picture inside it ready to be positioned.

How to select, move, and resize objects

Selecting

objects

Select an object by clicking it once. An object must be selected to 
be able to change the font, move the object, etc. When you select 
an object, sizing handles appear around it.

Moving and

resizing objects

Once an object is selected, you then tell the program what you 
want to do with it. For example, you can move or resize an object 
as follows:

3 Position the picture object where

you want it to appear in the report

and click once.

This frame indicates the

object is selected.
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Selecting
multiple
objects

Seagate Crystal Reports allows you to select multiple objects 
using the marquee selection technique.

Once the objects are selected, you can move them as a group. 

NOTE: You can move objects over (across) other objects without

affecting the placement of the objects beneath.

You can move fields between sections with the following 
exceptions:

●   grand totals can only be moved within the Report Footer 
section or to the Report Header section, and

Press and hold the mouse

button to activate themove

cursor and drag the objects

to the desired position.

Drag the handles of the

frame to change the size of

the objects.

To move an 
object...

To resize 
an object...

2 Drag the selection

rectangle to the

bottom right of the

objects, surrounding

them completely.3 When you release

the mouse button, the

rectangle disappears

and object frames

appear around the

selected objects.

1 Position the mouse

pointer above and to

the left of the objects

you want to select.
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●   a subtotal or summary can be moved only within its 
originating section or to the header of its originating 
section.

Related Topics

Formatting concepts, Page 232

How to make an object underlay a following section(s)

In this example you will make the CRAZE logo (CRAZEC.BMP) 
underlay multiple sections. This is a procedure similar to what 
you will follow when you want to insert a company watermark to 
serve as a background for your reports.

To make an object underlay a following section, you place it in the 
section above the section you want it to underlay. Then you toggle 
the Underlay Following Sections option on in the Section Expert for 
the section that you placed it in.

CREATING A SIMPLE REPORT

1 To get started, you need to create a simple report using the 
Customer table in CRAZE.MDB (located in the \CRW 
directory or the directory in which the program resides).

2 Place {customer.CUSTOMER NAME} and {customer.LAST 
YEAR’S SALES} side-by-side in the Details section of your 
report. To eliminate unnecessary objects in this example, 
delete the field titles that the program places in the Page 
Header section for each of these fields.

3 Break your data into region groups. To do this, choose the 
GROUP command from the Insert menu and choose 
{customer.REGION} as the sort and group by field.
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INSERTING A PICTURE

1 Click the PICTURE button on the supplementary toolbar.

2 Choose the picture file CRAZEC.BMP (located in the \CRW 
directory or the directory in which the program resides) and 
place it in the Page Header section, to the right of the body of 
your report.

NOTE: In this example, the picture is placed to the right of the
fields because it is not meant to underlay the text. When you are
working with a watermark, a subdued picture designed to be
nearly invisible, place it directly above the text.

3 Click the PRINT PREVIEW button on the standard toolbar. Note 
that the picture prints first (entirely in the PH section) and 
then the body of the report follows. Return to the Design Tab 
when finished previewing.
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UNDERLAYING THE FOLLOWING SECTION(S)

1 Click the SECTION EXPERT button on the standard toolbar. The 
Section Expert appears.

2 Highlight the Page Header section and toggle the Underlay 
Following Sections option on. See Types of formatting properties, 
Page 233.

3 Preview your work again. Note that now the picture prints in 
the Group Header and Details sections, next to (instead of 
above) the text in the body of the report. 

NOTE: Placing the picture to the right of the body of the report,
as you did here is the same technique you would follow if you
wanted a graph or an employee picture to print beside the details
that pertain to the graph or to the employee.

4 Return to the Design Tab and resize the object vertically so it 
is two or three times bigger and preview the report again. The 
bitmap now underlays more sections. 
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The area the picture underlays is determined by:

●   its size,

●   the section you place it in originally, and

●   the position in the section in which you place it.

By modifying size and placement, you can create many stunning 
effects using the underlay capabilities.

Pre-printed

forms

If you print to pre-printed forms, you may be able to:

1 Scan a form. 

2 Place it in your report as a bitmap.

3 Line up the bitmap and the report using the underlay 
capability and the ability to move objects anywhere you want 
them.

4 Print your report and the form as a single unit, thus 
eliminating the need to print the forms separately.

How to hide parts of the report

There are a number of properties you can set to keep particular 
parts of your report from printing.

Hiding sections Seagate Crystal Reports has three properties you can set in the 
Section Expert to hide report sections. 
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1. Hide (Drill Down OK)
The Hide property hides the section whenever you run the 
report. You can use the Hide property, for example, in a 
summary report where you want to display only the 
summaries but not the details behind the summaries. When 
you apply the Hide property to a section, the section can 
become visible if you drill down to see the section contents. 
You can only apply this property absolutely; you can not 
apply it conditionally with a formula.

2. Suppress (No Drill Down)
The Suppress property also hides a section when you run the 
report. Unlike the Hide property, however, you can not apply 
the Suppress property and then drill down to reveal the 
section contents. You can apply this property absolutely, and 
you can apply it conditionally, as well, using a formula. A 
Form Letter is a great example of the Suppress option. You 
create two details sections - one to suppress if sales are over 
$X and one to suppress if sales are less than $X.

3. Suppress Blank Section
The Suppress Blank Section property hides a section whenever 
there is nothing in it. If something is in the section, it remains 
visible.

Hiding objects Seagate Crystal Reports has three formatting options in the 
Format Editor that you can use to hide individual objects.

1. Suppress If Duplicated (Common Tab)
prevents a field value from printing if it is identical to (a 
duplicate of) the value that comes immediately before it. The 
value does not print but the space in which it would have 
printed remains.

Duplicated

values are

suppressed

and do not

print.
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2. Suppress If Zero (Number Tab) 
prevents a value from printing if it is a zero value. The value 
does not print but the space in which it would have printed 
remains. To remove the blank space, toggle the Suppress Blank 
Section option on in the Section Expert.

NOTE: This will only work if there are no other objects in the

section.

NOTE: To eliminate the blank lines in this situation, use the

Section Expert and toggle the Suppress Blank Section option off for

the section the field is in. This will eliminate the lines as long as

there are no other objects in the section.

3. Suppress (Common Tab) 
hides an object when you run the report. It is common, for 
example, to apply this property to formulas that are needed to 
do some report calculations but that you do not want to print 
when you run the report. When this property is toggled on, 
the object will not print.

The zero

values are

suppressed

and do not

print.

The object is invisible

and won�t print.
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NOTE: You can click the Conditional Formula button for any of

these properties and create a formula that will make the setting

conditional on some event. See Conditional formatting, Page 235.

To set these properties, highlight the object, click the OBJECT 
PROPERTIES button on the supplementary toolbar and set the 
property in the Format Editor when it appears.

HANDS-ON (Finishing Your Report)

How to insert page headers and footers

You can insert page headers and footers by placing the 
information in the Page Header or Page Footer sections of the 
Design Tab. 

●   Information to appear only on the first page of the report 
goes in the Report Header (RH).

●   Information to appear only on the last page of the report 
goes in the Report Footer (RF).

●   Information to appear at the top of every page goes in the 
Page Header (PH).

●   Information to appear at the bottom of every page goes in 
the Page Footer (PF).

You can use text, fields, or formulas in these sections just as you 
can in the Details section.
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Related Topics

How to create a footer that appears on all pages but the first, Page 244

How to add a title page to your report

Seagate Crystal Reports provides a quick, easy way to add a title 
page to your report using the REPORT TITLE command on the 
Insert|Special Fields menu. In order to use this command you 
must have a title entered in the Summary Tab of the Document 
Properties dialog box. See How to add summary information to your 
report, Page 132.

1 Choose the REPORT TITLE command from the Insert|Special 
Field menu. A placement frame appears when you move the 
cursor over your report. 

3 With the report title highlighted, click the SECTION EXPERT 
button on the standard toolbar. The Section Expert appears. 

2 Move the placement frame to

the Report Header section and

click one to place the frame.
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Now, the title will appear on the first page and your report will 
begin on the second page.

How to add summary information to your report

There may be times when you want to include non-printing 
comments with your report (a personal note to the report 
recipient, a note to explain more thoroughly the data on which the 
report is based, a report title, a comment about some particular 
data on the report, etc.).

The SUMMARY INFO command on the File menu provides a facility 
for including anything from a short note to hundreds of lines of 
text with your report. The comments do not print with the report; 
they remain in the Summary Tab of the Document Properties 
dialog box where they can be reviewed on demand. Search for 
Document Properties dialog box in Seagate Crystal Reports online 
Help.

When you choose the SUMMARY INFO command, the Document 
Properties dialog box appears with the Summary Tab active.

With the Report Header

section highlighted...

... toggle the New

Page After option on.
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Related Topics

How to add a title page to your report, Page 131

Search for Report Title command in Seagate Crystal Reports online 
Help.

Search for Report Comments command in Seagate Crystal Reports 
online Help.

Search for Special field commands in Seagate Crystal Reports online 
Help.

Enter the desired

information and click

OK when finished to

return to your report.
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6 Printing, Viewing, and
Exporting

What you will find in this chapter...

Printing considerations, Page 136

Design solutions for printing/distributing, Page 137

Report creation checklist for distributed reports, Page 146

Updating printer drivers, Page 147

Report distribution, Page 147

HANDS-ON (Distributing Your Report), Page 148

HANDS-ON (Viewing Reports With a Web Browser), Page 155
Printing, Viewing, and Exporting 135



Printing considerations

When printing, inconsistencies may occur if different printer 
drivers are used to create and print your reports. These 
inconsistencies are a result of the varied methods that individual 
printer drivers measure text metrics, such as font size. When 
printed, text-based objects may be misaligned, cut-off, or 
overprint each other. Examples of text-based objects include 
string or character fields, text objects, memo fields, numeric fields, 
and formula fields.

Problems such as these may arise when you have:

1. Two identical printers, but each one is using a different 
printer driver.

2. Two different printers using the same printer driver.

3. Two different printers using different printer drivers.

4. One printer driver that uses the TrueType font and a second 
printer driver that maps a TrueType font to a PostScript font.

5. Two identical printers using the same printer driver, but 
each one is printing from a different version of Microsoft 
Windows.

6. Two identical printers using the same printer driver, but the 
printer drivers are different versions.

7. Two identical printers, two identical printer drivers, and 
two identical operating systems, but the resolution of the 
video driver is different.

Thus, while a document using one printer driver may require six 
full lines to display a block of text:

●   using second printer driver that measures fonts narrower 
could result in the same block of text requiring less than six 
full lines, or

●   using a third printer driver that measures fonts wider could 
require more than six full lines.

For the most part, this situation can’t be avoided. Therefore, the 
goal of the report distributor is to design reports that 
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accommodate printer driver dependency and still print 
consistently using different printer drivers. To do this, Seagate 
Crystal Reports provides several design solutions. If taken into 
account when creating your report, these solutions can ensure 
proper printing and distribution for your report in almost any 
environment.

Design solutions for printing/distributing

NOTE: Before reformatting your report using the techniques

outlined in this section, please see Updating printer drivers, Page 
147.

There are several things to keep in mind when designing reports 
that will be distributed in different environments. For the best 
results, consider the following:

●   Spacing within text-based objects, Page 137,

●   Placing text-based objects, Page 139,

●   Placing multi-lined text-based objects, Page 141,

●   Section characteristics, Page 142,

●   TrueType fonts, Page 142,

●   Video resolution, Page 143,

●   Specific margins, Page 143,

●   Default printer, Page 143, and

●   Free form placement, Page 144.

Spacing within
text-based
objects

While it is recommended to have the Free Form Placement option 
toggled on (see Free form placement, Page 144), spacing text-based 
objects evenly in the free form environment can be somewhat 
tricky.

To align text objects, there are two features to assist you:

1. the grid

2. guidelines
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USING THE GRID

Each section of a report contains a design grid. It can be toggled 
on/off and set to different sizes as needed (see How to turn the grid 
on/off, Page 86). Once set, the grid remains the same size for all 
sections. It is measured from the upper left hand corner of each 
section and continues down and to the right until the end of the 
section. A new grid of the same size then begins from the upper 
left hand corner of the next section, and so on, through the end of 
the report.

Seagate Crystal Reports gives you the option of snapping objects 
to the grid. When you toggle the Snap to Grid option on using the 
Layout Tab of the File Options dialog box:

●   The upper left corner of all newly placed text-based and 
OLE objects will snap to a grid point.

●   Objects placed before enabling Snap to Grid will not move to 
snap to the nearest grid point. They will remain where they 
are. 

●   If you resize an object, the side (or sides) that you are 
resizing snap to the closest grid point.

USING GUIDELINES

Guidelines are used to line up objects. They too have a snap 
property that automatically snaps objects to them (see Positioning 
objects with guidelines, Page 83). However, the snap property of 
guidelines works differently for text-based objects than other 
objects (i.e., OLE objects). When a text-based object snaps to a 
guideline, it is the baseline of the text and not the object frame that 
snaps to the guideline. You can find the baseline of a text-based 
object by locating the special indicators positioned on either side 
of the object directly at the baseline. 

Thus, if you need to place several text objects of different font sizes 
on one line and have their baselines line up, you will want to snap 
them to a guideline at the baseline indicator.

Baseline indicator.
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Becoming familiar with the properties and functionality of the 
grid and guidelines will require some experimentation. 

NOTE: If you have Free Form Placement toggled off and you enable

Snap To Grid:

●  all objects will snap to the guidelines for vertical placement,

and

●  the left boundary will snap to both vertical guidelines and

grid points.

Placing text-
based objects

When a text-based object is placed on the report, the object is 
represented by an object frame. The height of the object frame is 
based on the height of the font. The width however, is determined 
differently depending on the text-based object you are working 
with.

●   For database fields that are not memo fields, the width is 
initially determined by the width of the field as defined in 
the database, and the average character width as provided 
by the font and font size selected.

For example, you have a database field called 
{customer.LAST NAME} and your database defines this 
field as a text field with a length of 35 characters. When you 
place this field on your report, the width of the boundary 
will be 35 times the average character width of the font and 
font size that the text-based database field is formatted to. 
Remember that this is the initial default boundary width. 
The width can always be resized to increase or decrease the 
width as you see fit.

●   For text objects, the default width is approximately 17 
average character widths wide. Text objects are different in 
that their width will automatically expand as you enter in 
text and/or database fields. Again, as with all other text-
based objects, the width can be resized by the user.
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●   For different number fields, such as double, single, integer, 
long integer, and byte, the default widths are all different. 
Once again, as with all other text-based objects, the width 
can be resized by the user.

Whether the default widths are accepted or the text-based objects 
are resized, a problem could arise if the text inside the object prints 
right to the edge of the object frame. While the report may look 
fine on the machine it was designed on, when the report is printed 
using another printer driver that measures the font wider, the 
length of the text grows but the object frame remain fixed. This 
results in the text being truncated or cut off.

There are several ways to prevent text from being truncated:

1. Select the object and click the OBJECT PROPERTIES button on the 
supplementary toolbar. Using the Common Tab of the Format 
Editor, toggle the Can Grow option on. The object is formatted 
to print on multiple lines, so if the text prints wider than the 
object, the text will wrap onto additional lines.

NOTE: This is not an effective solution for strings of text that do

not have spaces in them such as single words because though the

line will wrap, the text string will break at the edge of the object

frame and then wrap.

2. Expand the object frame so that it is a little wider than the 
widest block of text that the object will contain. There are 
many times where the actual text in a database field is far less 
than the field is formatted to be.

For example, a {table.LAST NAME} field is designed with a 
field size of 80 and the longest name in the database is 28 
characters. In this case, when you first place the field in your 
report, the field will be 80 times the average character width. 
Reduce the width of the field, but not so much that it is just 
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long enough to accommodate the longest string of text. 
Instead, make it a little wider in order to allow for growth.

While each of these options offer an effective solution when 
dealing with a single text-based object in a section, there are still 
design considerations when placing more than one text-based 
objects in a section. When sizing one object, you must consider its 
placement with regard to other objects in the section.

The best rule of thumb is:

●   Avoid designing reports where the space between each 
object is very tight. Leave room for growth by expanding 
the width of the object by approximately 5%. 

●   Alternatively, you may consider reducing the size of the font.

Placing multi-
lined text-based
objects

While text-based objects that are formatted to print on multiple 
lines follow the same design rules as other objects, they have an 
additional characteristic that must be considered. If the printer 
driver expands or contracts the spacing of the text, word 
wrapping may differ causing the number of lines necessary to 
print the object to change to accommodate growth or shrinkage.

When placing multi-lined text-based objects, you could encounter 
problems if you have other objects in the same section placed 
directly below them.

Unlike single-lined text-based objects, expanding the object frame 
of a multi-lined text-based object to accommodate possible 
growth is not a viable option. When you do this, the line width 
simply increases to according to the expanded boundaries. 

So, where possible, place multi-lined text-based objects at the 
bottom of a section. If they require more lines to print, the section 
will expand downward to accommodate the growth and they will 
not endanger other objects.
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Section
characteristics

A report consists of several sections including the Report Header, 
Page Header, Group Header, Details, Group Footer, Page Footer, 
and Report Footer (see Design Tab Areas, Page 67).

Each report section is made up of a series of lines. When a text-
based object is placed in a section, it is placed on a line so that the 
text is aligned to the baseline. The line’s height is then adjusted by 
the printer driver so that it is high enough to accommodate the 
object.

●   If another text-based object is placed on the same line and 
its font size is larger than the first object, the line’s height is 
extended to accommodate the second object.

●   If another text-based object is placed on the same line and 
its font size is even larger, the line’s height is extended 
again to accommodate the third object.

Thus, a line’s height is determined by the text-based object with 
largest font on the line.

As text-based objects are added to a report, either in the same 
section or other sections, line height is adjusted to accommodate 
the various fonts. Because this vertical (inter-line) spacing is 
determined by the printer driver, it makes it difficult to create 
reports designed for pre-printed forms when they may be printed 
in various environments.

It is recommended that you follow these guidelines when 
designing reports:

●   Always print a test page.

●   Keep all font sizes the same.

●   Be sure to print pre-printed forms on the same machine.

TrueType fonts Designing your report using printer-specific fonts may lead to 
problems when printing using different printers. The fonts may 
not be supported by other printers or, while they are supported, 
they may not be installed on the printers.

When printing, if the printer-specific fonts are encountered that 
the printer driver does not recognize, Seagate Crystal Reports 
substitutes the fonts, creating inconsistent results. In order to 
avoid this situation, it is recommended that only common 
TrueType fonts be used when designing reports.
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Video
resolution

If you have two identical printers, two identical printer drivers 
and two identical operating systems, but the resolution of the 
video driver varies between machines, the pagination of 
documents will be different. 

Unfortunately, there is no way to create Windows documents that 
are immune to changing video driver resolutions. However, it is 
best to set your video resolution to 640 x 480 pixels when 
designing reports. A report designed using a coarse resolution 
(640 x 480 pixels) and printed on a finer resolution will not 
encounter as many formatting changes as a report designed using 
a finer resolution (800 x 600 pixels) that is printed on a coarser 
resolution (640 x 480 pixels).

Developing reports with your video resolution set at the most 
common and coarsest resolution will ensure that your reports will 
be the least sensitive to video driver settings.

Specific
margins

Seagate Crystal Reports has the option of setting specific margins 
or using the printer’s default margins (see How to change margins, 
Page 240). 

Problems may arise if you choose to design your reporting using 
the default margins. 

●   When the report is printed in another environment where 
the printer’s default margins are greater (thus less printable 
area), the report objects on the right side of the report will 
print off the page.

●   When the report is printed in another environment where 
the printer’s default margins are smaller (thus more 
printable area), the entire report will be moved to the left of 
the page.

It is recommended that you always set your own margins. Even if 
the margins you want to use are the same as your default margins, 
be sure that the Use Default Margins option in the Page Setup 
dialog box is toggled off, and you set your margins manually 
using the PRINTER SETUP COMMAND.

Default printer In general, it is a good idea not to choose a specific printer. Even 
though the printer may be identical, how the printer is recognized 
can still vary according to operating systems. Consider the 
following example:
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An HP Laser III printer is being installed on 3 different 
operating systems.

●   With Windows 95, the printer name can be changed so that 
HP Laser III is Front Reception Printer but the printer driver 
will be listed as HPPCL5MS.DRV.

●   With Windows NT, the printer name is also referenced and 
can be changed by the user but the printer driver is always 
WINSPOOL.

●   With Windows 3.x, the printer is recognized by the name of 
the printer, in this case HP Laser III and the printer driver is 
HPPCL5MS.DRV.

If you specify the specific printer, Seagate Crystal Reports will be 
looking for that printer by name. If the specific printer you specify 
can’t be found, the default printer will be chosen resulting in the 
possibility of printing inconsistencies.

If you need to specify a specific printer such as a label printer or a 
printer dedicated to printing invoices, the printer name must be 
the same as the name of the printer the report was designed on. Be 
aware that anyone printing the report must use that same printer 
or they could encounter problems.

NOTE: If your report is part of an application that you are

distributing, you can provide a Select Printer dialog box. Using

this dialog box, users of your report can choose the correct printer

or rename the printer accordingly.

Free form
placement

FREE FORM PLACEMENT ON

In order to create dynamic reports and reduce printer driver 
dependency as much as possible, it is recommended that all 
sections of the reports be formatted with the Free Form Placement 
option toggled on. This is especially true if your report includes 
OLE objects such as graphs, boxes, lines, and bitmapped images 
such as company logos.

When a section is formatted with Free Form Placement, all objects 
can be placed anywhere in that section. Seagate Crystal Reports 
places objects within a section based on their absolute coordinates. 
These absolute coordinates determine the vertical placement of 
objects in your report. This means that you control the vertical 
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placement of single-lined objects rather than the printer driver. In 
so doing, you can better protect your reports from printing 
inconsistencies using various printer drivers. 

However, while the printer driver no longer controls the vertical 
spacing of text-based objects within the sections, it still determines 
horizontal spacing of text within the text-based objects as well as 
the inter-line spacing of multi-lined text objects. So, while Free 
Form Placement allows you better control, you must still take into 
account these considerations when designing your reports (see 
Placing multi-lined text-based objects, Page 141.

FREE FORM PLACEMENT OFF

If a section has the Free Form Placement option toggled off, the 
program no longer references the object’s absolute coordinates to 
determine where it prints.

●   The absolute x coordinate is only referenced to determine 
where each object begins printing horizontally (left/right 
placement). 

●   The y coordinate is still referenced for vertical placement of 
the object but the coordinates may be adjusted by Seagate 
Crystal Reports when the printer driver changes.

So, if the report is printed using a printer driver that measures 
inter-line spacing greater than the original printer driver, the y 
coordinate will be increased and the text-based object will be 
printed farther down the page. With Free Form Placement toggled 
off, the user no longer controls the vertical placement of text-
based objects; it is the printer driver that determines it instead.

However, the placement of OLE objects such as graphics, boxes, and 
lines is not controlled by the printer driver. So, Seagate Crystal 
Reports always references these object’s absolute coordinates when 
placing and printing. With these varied methods of placing text-
based and OLE objects, problems can arise when combining the two.

Consider the following example:

A box (OLE object) is placed around a database string field 
(text-based object). Everything looks great and everything is 
aligned as it should be. If the report is printed using another 
printer driver that measures inter-line spacing greater than the 
original printer driver:
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●   the placement of the box will not change relative to the 
section it is in (the x and y coordinates will not change), but

●   the vertical placement of the text-based object will change 
because the y coordinate will be adjusted upward based on 
the printer driver being used. 

NOTE: The value is a measurement from the section�s upper left

corner; so, the greater the value, the farther down the page the

object will print.

If you are distributing reports with sections formatted with Free 
Form Placement toggled off, and you want the objects to be 
surrounded by a border or formatted with lines, it is better to 
modify the objects’ border properties rather than inserting lines 
and boxes. This way, the borders will always stay with the objects. 
Simply right-click the object and then select the CHANGE BORDER 
command from the shortcut menu that appears (see How to add 
color, shading, and borders, Page 238).

Remember, every section can be formatted with Free Form 
Placement toggled on or off. While it is better to toggle the option 
on in some cases and not in others, it is highly recommended that 
every section in your report be formatted the same.

Report creation checklist for distributed reports

1. To accommodate possible growth caused by a varying font 
measurements of different printer drivers:

●   do not place objects extremely close to each other, and

●   either increase the width of text-based objects by 
approximately 5% or reduce the size of the fonts.

2. Consider where and how you place multi-lined text-based 
objects. The number of lines necessary to print a text-based 
object may vary when printed using different printer drivers.

3. Use Windows TrueType fonts where possible because being 
the most common fonts they are readily available on all 
versions of Microsoft Windows and can realized on all 
printers.
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4. Use the most common and coarsest video driver settings. It is 
recommended that you set your video driver resolution to 640 
x 480 pixels.

5. Set specific page margins.

6. Do not choose a specific printer. Choose the default printer 
unless your application or compiled report requires a specific 
printer.

7. After the report is completed and you are happy with the 
results, format every section to have Free Form Placement 
toggled on.

8. Remove all guidelines from the reports.

By adhering to this checklist your report will be the least sensitive 
to changing printer drivers and ready for distribution.

Updating printer drivers

In order to maintain performance, Seagate Crystal Reports queries 
the printer driver for each of the font elements (font metrics), such 
as average character height, character width, height of the 
ascenders and descenders, internal leading, etc. Sometimes a 
problem arises when using an older printer driver that does not 
return the font metrics accurately. If you are experiencing 
problems when printing (missing fields, incorrect formatting, 
etc.), it is recommended that you obtain and install the latest 
updated drivers for your printer. In many cases, these newer 
printer drivers will provide the accurate font metrics and printing 
issues will be remedied.

Report distribution

There are many ways to distribute reports. 

●   You can print the report and send it out by hand. 

●   You can choose to export your reports in Seagate Crystal 
Reports format (.RPT). 
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●   If you want to e-mail your report to someone who does not 
have Seagate Crystal Reports, you can export the report in 
MS Word or Excel format directly to an Exchange folder 
(search for Exchange Data Access in Seagate Crystal Reports 
online Help online Help), as well as many other e-mail 
systems. 

●   You can even publish the report on the Internet by 
exporting your report to HTML. See How to export reports, 
Page 148.

HANDS-ON (Distributing Your Report)

How to export reports

You can export your finished reports to a number of popular 
spreadsheet and word processor formats, into HTML format, 
ODBC format, and into a number of common data interchange 
formats as well. This makes the distribution of information easier. 
For example, you may want to use report data to project trends in 
a spreadsheet package or enhance the presentation of data in a 
desktop publishing package.

NOTE: When you export a report to a different file format other
than Seagate Crystal Reports format (.RPT), you may lose some or
all of the formatting that appears in your report. The program
attempts to preserve as much formatting as the export format
allows.

1 With the report you want to export active, click the EXPORT 
button on the standard toolbar. The Export dialog box 
appears. 
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The dialog box is broken into two sections, a Format section 
and a Destination section.

2 Using the Format drop-down box, select the format in which 
you want to export the report. For example, if you want to 
convert the report to Microsoft Excel 4.0 format, choose Excel 
4.0 (.XLS) from the list.

3 In the Destination drop-down box select a destination for your 
file.

●   If you want to save the report to a disk file, select Disk file.

●   If you want to attach the report to an e-mail document, 
select the appropriate Mail application. Seagate Crystal 
Reports supports Microsoft Mail (MAPI), Microsoft 
Exchange Mail (MAPI), and Lotus cc:Mail (VIM).

●   If you want to store the report in a Microsoft Exchange 
folder, select Exchange Folder.

●   If you want to send the report to a Lotus Notes database, 
select Lotus Notes Database.

4 Click OK, and the export process begins.

When you export a report to a disk file, the Choose Export File 
dialog box appears. Use the controls in this dialog box to select a 
path and file name for your file.

NOTE: While the program assigns the native extension to all files
you export in a specific word processor, database, or spreadsheet
format, it automatically assigns the extension *.TXT for all files
you export in one of the common data interchange formats. The
program you want to use the data in, however, may look for
specific extensions other than *.TXT. Consult the manual for that
program to determine the correct file extension, and change the
extension accordingly in the File Name edit box.

5 Click OK. The program exports the report to a disk file in the 
format you specify.

Exporting

to e-mail

Since each e-mail system supported by the Export facility operates 
a little differently, the following instructions are generic in nature.

1 When you export to e-mail, the program asks you to log on to 
your system. Log on in the normal way.
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2 Select the individual(s) to whom you are going to send the 
report.

3 When the message screen appears, the system displays an 
icon indicating that a report is attached. The icon will vary, 
depending on the format used to export the report. 

4 Type in any message that you want to include with the report.

5 Send the message. A dialog box appears allowing you to 
monitor the progress of your export.

6 When the export is finished, the message will appear in the 
addressee's mailbox. The recipient opens the message in the 
normal way and double-clicks the icon to call up the report.

NOTE: Both Microsoft Mail and Microsoft Exchange Mail use

MAPI. If you intend to attach a report to an Exchange e-mail

message, do not select Exchange Folder as the export destination,
select MAPI instead.

NOTE: If you have questions regarding the operation of your e-

mail system, please refer to the documentation that came with the

system.

Exporting to

Lotus Notes

Lotus Notes is a powerful groupware application that promotes 
communication and information sharing between different 
departments in an organization.

NOTE: You must have version 3.0 or later of the Lotus Notes

Windows client. Seagate Crystal Reports will not export to a Lotus

Notes OS/2 client.

1 With the report you want to export active, click the EXPORT 
button on the standard toolbar. The Export dialog box 
appears. 

2 Select an export file format, select Lotus Notes Database as the 
export destination, and click OK. The Select Database dialog 
box appears.

3 In the Select Database dialog box, highlight your Lotus Notes 
server from the Servers list box, and select the database to 
which the report will be exported.

4 Verify that the file name in the File name text box is correct, 
and click OK. The Comments dialog box appears.
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5 Type in any comments that you want to appear when another 
user selects your report from the Lotus Notes Desktop.

6 Click OK, and the report is exported.

The next time a user logs on to Lotus Notes with access to the 
Lotus Notes database that you selected, that user will see your 
report listed in the Lotus Notes Desktop. The user can double-
click the report file name to display the comments you wrote and 
double-click the report icon that appears to view the report.

Exporting to

an Exchange

Folder

An Exchange folder can contain standard notes (mail), files, and 
instances of Exchange forms. Seagate Crystal Reports lets you 
export a report file to an Exchange folder. You select the folder, 
and the report is stored there in the format that you specify. For 
more information, search for Exchange Data Access in Seagate 
Crystal Reports online Help.

1 With the report you want to export active, click the EXPORT 
button on the standard toolbar. The Export dialog box 
appears. 

2 Select the desired export file format from the Format drop-
down box.

3 Select Exchange Folder as the export destination, from the 
Destination drop-down box and click OK. The Choose Profile 
dialog box appears.

4 Select the desired profile from the Profile Name drop-down 
box. If the profile is not listed, click the New button to create it. 

5 Click OK when finished.

6 When the Select a Folder dialog box appears, highlight the 
folder in your profile where you want the report to appear, 
and click OK.

7 The report is exported to the Exchange folder you selected. 
The exported report can be accessed through the Microsoft 
Exchange client.

Exporting to

HTML

Providing support for the Internet and corporate intranets 
becomes more important with every passing day. Seagate Crystal 
Reports recognizes this importance and provides World Wide 
Web support. Although incorporated as an export format, HTML 
represents a whole new export destination for your reports as well.
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By exporting your reports in HTML format, Seagate Crystal 
Reports provides you with a new option for rapid, convenient 
distribution of important company data. Once exported, your 
reports are accessible with many of the most popular web 
browsers including Netscape and Microsoft Internet Explorer.

1 With the report you want to export active, click the EXPORT 
button on the standard toolbar. The Export dialog box 
appears. 

2 From the Format drop-down box, select one of the HTML 
formats listed.

●   If Netscape is your browser, select HTML 3.0 (Netscape 2.0) 
format.

●   If you are using Microsoft Internet Explorer as your 
browser, select HTML 3.0 (Explorer 2.0) format.

●   The third HTML option, HTML 3.0 (Draft Standard), is a new 
form of HTML that has not been officially released yet, but 
has been released for comments. If you are working with 
this new form of HTML, select this HTML format.

3 Select a destination from the Destination drop-down box such 
as a disk file, an e-mail address, Microsoft Exchange, or Lotus 
Notes. The rest of this section assumes you select Disk file to 
store the HTML document in a directory on a web server.

4 Click OK. The Export To Directory dialog box appears. When 
exported to HTML format, a report may make more than one 
HTML file. For this reason, the program asks you for the 
name of a directory to export the report to, and uses default 
names for the HTML files. The initial HTML page will be 
saved as DEFAULT.HTM. This is the file you open if you 
want to view your report through your web browser.

5 Select an existing directory, or create a new directory for the 
report.

6 Click OK. The program exports the report to HTML format.

Exporting to an

ODBC data

source

Seagate Crystal Reports allows you to export reports to any ODBC 
data source. If you have an ODBC data source set up for a 
database or data format, you can export your report to that data 
format through ODBC.
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For instance, you may have an ODBC data source set up through 
ODBC Administrator that you normally use to access database 
tables designed in Microsoft SQL Server. Using the Export dialog 
box, however, you can select your SQL Server data source and 
export your report as a new SQL Server database table.

NOTE: You must have an ODBC data source set up through

ODBC Administrator for the program to export to a particular

ODBC database format. See Exporting to an ODBC data source, 
Page 152, and How to set up an ODBC data source, Page 562.

Exporting to an ODBC data source lets you:

●   change data from a centralized database into a format 
compatible with a local DBMS application,

●   change data from a local database format into a format 
compatible with a centralized database,

●   create a new database table that can be used as a separate 
data set in future reporting,

●   create a mini data-warehouse, and

●   manipulate database data by filtering records, adding 
formulas, and removing fields to create a new database 
table that provides the data you need most for your work.

1 With the report you want to export active, click the EXPORT 
button on the standard toolbar. The Export dialog box 
appears. 

2 From the Format drop-down box, select the ODBC data source 
for the format you want to export your report. For example, 
ODBC - CRSS allows you to export your report to a Microsoft 
SQL Server database.

3 Destination is ignored when you are exporting a report to an 
ODBC data source. You do not need to make any changes to 
the Destination drop-down box. Simply click OK in the Export 
dialog box.

4 If your ODBC data source specifies a particular database, the 
report will be exported to that database. Otherwise, the Select 
Database dialog box appears. Select the database that this 
report will be added to as a new table, and click OK.
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5 If the ODBC data source you selected requires a log on ID and 
password, the Login or SQL Server Login dialog box appears. 
Enter your ID and Password, then click OK. The Enter ODBC 
Table Name dialog box appears. 

6 Enter the name you want to give the new table in the 
database, and click OK. The program exports the report as a 
new table in the database you specified.

NOTE: If your report contains a binary field, you will be unable to

export it to an ODBC data source successfully.

Search for Export format and destination files in Runtime File 
Requirements online Help (RUNTIME.HLP).

How to fax a report

Many fax applications, such as Microsoft Fax and Delrina WinFax, 
allow you to set up a printer driver that will fax documents over 
a modem. When using one of these applications, you can fax a 
report from Seagate Crystal Reports.

1 Choose the PRINTER SETUP command from the File menu. The 
Print Setup dialog box appears.

2 Select your fax driver from the Name drop-down box. 

3 Click OK when finished.

4 Choose the PRINTER command from the File|Print menu. The 
Print dialog box appears.

5 Click OK to fax the report. Your fax application will appear, 
allowing you to select a cover page and fill in the appropriate 
fax information. 
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HANDS-ON (Viewing Reports With a Web

Browser)

How to request reports from a web browser

The easiest way to request a report from the Crystal Web Report 
Server is to simply request the report file in the form of a URL 
address.

1 Open your web browser and make sure you have access to 
your web server.

2 Open a report from your browser by requesting the following 
URL address:

http://<domain>/crweb/craze5.rpt

NOTE: <domain> is the name of the domain for your web server.

An example of a domain name would be:

www.img.seagatesoftware.com

The report request is sent to the web server, the report is 
returned, and it appears inside your browser window.

NOTE: Depending on the web browser you are using, the report

may appear inside one of the Crystal Smart Viewers by default.

For complete information on using each of the Smart Viewers, see

How to view reports with the Crystal Smart Viewer/Java, Page 158,
How to view reports with the Crystal Smart Viewer/ActiveX, Page 159,
and How to view reports with the Crystal Smart Viewer/HTML, Page 
161.

3 Scroll down until you see the data for Competition Bikes. You 
should see total sales for three different competition bikes: 
Descent, Endorphin, and Mozzie.

NOTE: You can also use the Group Tree, if available, in the

Crystal Smart Viewer if your browser displays a Smart Viewer.

The Group Tree lets you easily navigate and drill-down through

report data.
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4 Click or double-click the Total sales value for the Descent 
bicycle model.

NOTE: Different viewers allow you to drill-down on data using

either a single click or a double click. If a single click does not

work, use a double-click.

A new page appears showing detail data for the different sizes 
of Descent bicycles, along with the summary sales values for 
each size.

If you are a Systems Administrator or IS Manager, you may want 
to use this drill-down feature to your advantage. Design reports 
for access by your users that show summary information only, but 
allow drilling down on detail data. This kind of a report will 
reduce network traffic by only delivering the data needed by users 
instead of delivering large reports with long sections of detail data.

Related Topics

How to drill down on summarized data, Page 88

Sorting, Grouping, and Totalling, Page 271

How to specify parameter field values

If a report contains parameter fields or is based on an SQL stored 
procedure, you will be prompted to provide a value for the 
parameter field.

1 Use your web browser to request a report that contains a 
parameter field. The Crystal Web Report Server returns a 
page requesting a value for the parameter field:
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2 In the text box that appears on the web page, enter a value for 
the parameter field.

3 Click OK at the bottom of the page.

NOTE: If a report contains more than one parameter field, you

will be asked to enter a value for each field.

4 The report is generated and appears inside your web browser. 
The value you specified for the parameter field restricts the 
values that appear in the report.

NOTE: Your web server administrator may design web pages that

handle parameter fields and stored procedures automatically. The

Crystal Web Report Server only prompts for parameter field

values when necessary.

Related Topics

Parameter Fields, Page 391

How to log on to a database

If a report is based on a secure database, a database that requires 
log on information before data is returned, the Crystal Web 
Report Server will require that you supply a log on name and 
password before displaying the report.

1 Use your web browser to request a report that is based on a 
secure database such as an SQL server database or a 
password-protected Microsoft Access database. The Crystal 
Web Report Server returns a page requesting log on 
information including user name and password.

NOTE: If the report is based on an SQL database, you may also

need to provide the name of the SQL server and database.

2 In the text boxes that appear on the web page, enter user name 
and password you normally use to log on to the database.

3 Click OK at the bottom of the page.

NOTE: If a report accesses more than one secured database, you

may be asked to log on to each database separately.
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4 The report is generated and appears inside your web browser. 

NOTE: Your web server administrator may design web pages that

handle log on information differently. The Crystal Web Report

Server only prompts for log on information when necessary.

How to view reports with the Crystal Smart Viewer/Java

Web browsers that support Java applets can display reports using 
the Crystal Smart Viewer/Java. Unless you indicate otherwise, 
the Netscape Navigator web browser, versions 2.x and later, will 
automatically use the Crystal Smart Viewer/Java by default when 
you request a report from the Crystal Web Report Server.

1 Type in the URL address for the report you want to view. Do 
not, however, press the Enter key to actually request the 
report yet. For information on how to request a report using a 
URL address, see How to request reports from a web browser, Page 
155.

2 Append the Crystal Web Report Server INIT command, 
preceded by a question mark (?), to the end of the URL 
address and specify the Crystal Smart Viewer/Java. For 
example:

http://<domain>/crweb/wsale.rpt?init=java

A new web page will appear containing the Crystal Smart 
Viewer/Java, and the first page of the requested report will 
appear inside the viewer. A Smart Navigation Group Tree is 
generated based on the groups in the report.

NOTE: You may not have access to Smart Navigation with the

Group Tree. Smart Navigation may be disabled for the report or

for the Smart Viewer itself. If Smart Navigation is available, you

can use the Smart Navigation button in the Smart Viewer to turn

on and off the Group Tree. This button will be disabled if Smart

Navigation is unavailable.

3 To page through the report, use the page controls.

4 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by groups.
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5 Click the Refresh button to refresh the report data.

The first time a report is requested, the Crystal Web Report 
Server generates the report and saves it in a directory cache. If 
someone else requests the same report, the Crystal Web Report 
Server can send them the existing report rather than regenerate 
the data, a time consuming process.

If the data that the report is dependent on changes, though, 
due to updates in the database, the cached report will no 
longer reflect accurate data. Use the Refresh button to force the 
Crystal Web Report Server to connect to the database and 
update the report.

6 To search for a specific value in the report, type the value into 
the Search text box, and click the Search button.

The Crystal Smart Viewer will locate the first matching value 
in the report, if it exists, and highlight that value for you. If you 
need to find the next instance of that value in the report, simply 
click the Search button again.

NOTE: You may experience minor problems scrolling through

reports in the Crystal Smart Viewer/Java. Such problems are a

result of the Java virtual machine implemented in certain web

browsers and can not be accounted for by the Crystal Smart

Viewer/Java. If you experience problems, click repeatedly on the

scroll buttons to scroll. Do not hold the scroll buttons down.

How to view reports with the Crystal Smart Viewer/ActiveX

The Crystal Smart Viewer/ActiveX is a powerful ActiveX control 
that allows you to view and work with reports in any web 
browser that supports ActiveX. Unless you specifically request a 
different Crystal Smart Viewer, versions 3.x and later of Microsoft 
Internet Explorer will open the Crystal Smart Viewer/ActiveX by 
default when you request a report from the Crystal Web Report 
Server.

1 Type in the URL address for the report you want to view. Do 
not, however, press the Enter key to actually request the 
report yet. For information on how to request a report using a 
URL, see How to request reports from a web browser, Page 155.
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2 Append the Crystal Web Report Server INIT command, 
preceded by a question mark (?), to the end of the URL 
address and specify the Crystal Smart Viewer/ActiveX. For 
example:

http://<domain>/crweb/wsale.rpt?init=actx

A new web page will appear containing the Crystal Smart 
Viewer/ActiveX control, and the first page of the requested 
report will appear inside the control. In addition, group names 
will appear in the Group Tree for Smart Navigation.

NOTE: You may not have access to Smart Navigation with the

Group Tree. Smart Navigation may be disabled for the report or

for the Smart Viewer itself. If Smart Navigation is available, you

can use the Smart Navigation button in the Smart Viewer to turn

on and off the Group Tree. This button will be disabled if Smart

Navigation is unavailable.

3 To page through the report, use the page controls.

4 Zoom in and out on the report using the Zoom button.

5 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by groups.

6 Click the Refresh button to refresh the report data.

To improve performance, reports are often cached by the web 
server. This means that the first time a report is requested, the 
Crystal Web Report Server generates the report and saves it. If 
someone else requests the same report, the Crystal Web Report 
Server will simply send them the saved report rather than 
regenerate the data.

However, the data that the report is dependent on may change 
while the report file is stored in the cache. If so, use the Refresh 
button to force the Crystal Web Report Server to update the 
report.

7 To search for a specific value in the report, type the value into 
the Search text box, and click the Search button.

The Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight it for you. Continue to click the 
Search button to find successive matching values in the report.
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8 To print the report to a printer available from your machine, 
click the Print button.

NOTE: If the report has been created using different printer

settings than those available from your system, you may

experience formatting problems when attempting to print a report

displayed by the Smart Viewer/ActiveX. The Smart Viewer Print
button uses printer settings saved with the report file. If you

experience problems printing a report, contact your web server

administrator.

How to view reports with the Crystal Smart Viewer/HTML

The Crystal Smart Viewer/HTML uses the features of HTML 
frames and forms to display reports on any of the most common 
web browsers. If your web browser does not support Java applets 
or ActiveX controls but does support the latest standards for 
HTML, you may want to use the Crystal Smart Viewer/HTML.

1 Type in the URL address for the report you want to view. Do 
not, however, press the Enter key to actually request the 
report yet. For information on how to request a report using a 
URL, see How to request reports from a web browser, Page 155.

2 Append the Crystal Web Report Server INIT command, 
preceded by a question mark (?), to the end of the URL 
address and specify the Crystal Smart Viewer/HTML. For 
example:

http://<domain>/crweb/hr.rpt?init=html_frame

A new web page will appear containing the Crystal Smart 
Viewer/HTML, and the first page of the requested report will 
be displayed. In addition, a Group Tree for Smart Navigation 
is generated based on group names in the report.

NOTE: You may not have access to Smart Navigation with the

Group Tree. Smart Navigation may be disabled for the report or

for the Smart Viewer itself. If Smart Navigation is available, you

can use the Smart Navigation button in the Smart Viewer to turn

on and off the Group Tree. This button will be disabled if Smart

Navigation is unavailable.
Printing, Viewing, and Exporting 161



3 To page through the report, use the page controls at the top of 
the Preview Tab.

4 Use the Smart Navigation features of the Group Tree, if it is 
available, to navigate through the report by groups.

5 Click the Refresh button to refresh the report data.

The Crystal Web Report Server can store requested reports in 
a cache directory to improve response time for future requests. 
If someone else requests the same report, the Crystal Web 
Report Server will simply send them the saved report rather 
than regenerate the data for the report.

When report data becomes old, no longer reflecting accurate 
data from the database, the cached report must be updated. 
Use the Refresh button to force the Crystal Web Report Server 
to update the report.

6 To search for a specific value in the report, type the value into 
the Search text box, and click the Search button.

The Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight it for you. Continue to click the 
Search button to find successive matching values in the report.

How to view plain HTML reports

Requesting reports as plain HTML files provides a convenient and 
easy-to-use method of accessing reports from a web server that is 
supported by all web browsers. Many common browsers display 
reports, by default, as plain HTML pages, including Netscape 
Navigator version 1.x as well as Internet Explorer versions 2.x and 
earlier.

1 Type in the URL address for the report you want to view. Do 
not, however, press the Enter key to actually request the 
report yet. For information on how to request a report using a 
URL, see How to request reports from a web browser, Page 155.

2 Append the Crystal Web Report Server INIT command, 
preceded by a question mark (?), to the end of the URL 
address and specify the plain HTML as the format for 
viewing. For example:
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http://<domain>/crweb/hr.rpt?init=html_page

The first page of the report will appear as a standard HTML 
page inside the web browser.

3 To page through the report, use the page controls at the top or 
bottom of the report page.

4 Click the Refresh button to refresh the report data.

The Crystal Web Report Server can store HTML pages for the 
requested report in a cache directory to improve response time 
for future requests. If someone else requests the same report, 
the Crystal Web Report Server will simply send them the 
saved HTML pages rather than regenerating the pages from 
the original report.

If database data changes, report data reflected in the HTML 
pages will no longer be accurate. Use the Refresh button to force 
the Crystal Web Report Server to update the report data and 
generate new HTML pages.

5 To search for a specific value in the report, type the value into 
the Search text box, and click the Search button.

The Smart Viewer will locate the first matching value in the 
report, if it exists, and highlight it for you. Continue to click the 
Search button to find successive matching values in the report.
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 7 Tutorial - Customer List

What you will find in this chapter...

Overview, Page 166

Before you begin, Page 166

Getting started, Page 167

Creating your report, Page 167

Selecting a database to use, Page 168

Inserting a field, Page 171

Adding additional fields, Page 175

Reviewing your work, Page 175

Saving your report, Page 181

Record Selection, Page 182

Grouping and sorting, Page 186

Completing the report, Page 189
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Overview

The following tutorial has been designed to give you confidence 
when creating your first report.

You begin by learning the basic concepts - calling up a database, 
placing some fields on your report, then selecting specific records 
to be included. You will also learn how to: 

●   insert and move database fields, 

●   add and format a title,

●   display your report in the Preview Tab so you can fine-tune 
your work,

●   use the Select Expert to ensure your report includes only the 
data you need,

●   move objects, 

●   group and sort data,

●   insert pictures, and

●   print your report.

Before you

begin

This tutorial assumes you are familiar with Microsoft Windows 
and uses conventional names and procedures common to the 
Windows environment. If you are not familiar with Windows, 
you may have trouble understanding basic procedures such as 
scrolling and clicking. Please refer to the documentation that came 
with Microsoft Windows for further explanation of these 
procedures. Also, see Command, button, key, and control conventions, 
Page 3, for a description of the conventions used in this manual.

The default font for all report sections in the program is set to 
Times New Roman, 10 point. If you have changed the default font, 
or if your printer does not support this font, the field size, field 
spacing, and screen shots will look different than those included 
in this tutorial. 

This tutorial has been designed using Microsoft Windows 95 and 
Win NT 4.0. Screen shots may vary slightly if you are using 
Windows 3.1, or NT 3.51.
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If you are not familiar with the Seagate Crystal Reports 
environment, please review the following sections before 
beginning this tutorial:

●   Getting to Know Seagate Crystal Reports, Page 51, which 
explains the main application window, the Design and 
Preview Tabs, the menu bar, standard and supplementary 
toolbars, format bar, and status bar, as well as many other 
features of the program.

●   How to add, delete, and move guidelines, Page 82, and How to 
move and position objects using guidelines, Page 83.

●   Other fundamentals, Page 76, which describes working with 
the grid, free form placement of objects using guidelines, as 
well as a description of how to work with sections and 
objects.

Getting started

In this tutorial you will get an introduction to the program as you 
create a Customer List report. The Customer List is one of the 
most basic business reports and typically has information such as 
Customer Name, City, Region, and Contact Name.

Creating your

report

1 Click the NEW button on the standard toolbar. The Report 
Gallery appears.

The Report Gallery contains a number of buttons. These 
buttons open the Experts that guide you through the creation 
of specific kinds of reports. Since you will be learning 
reporting concepts here, you can skip the Experts and build 
your report from scratch. After you have completed this 
tutorial, you may want to build some reports using the Experts 
to decide which method of report construction you are most 
comfortable with. 
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The Report Gallery expands to reveal several custom report 
options.

The Report Gallery disappears, and the Choose Database File 
dialog box appears.

NOTE: You can also create reports based on SQL/ODBC data

sources, dictionary files, or query files. See Queries, Page 467, and
Dictionaries, Page 491, for more information.

Selecting a

database to use

The next step in creating a report is to select a database. Select the 
CRAZE.MDB sample database for this tutorial.

1 In the Choose Database File dialog box, select the file 
CRAZE.MDB from the File Name list box. This file was 
installed in the \CRW directory (or the directory in which the 
program resides). 

2 Click the Custom button.

3 Click the Custom

Report button.

4 Click the Data

File button.
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2 Click OK to open the file. The Select Tables dialog box 
appears.

3 Because you are only dealing with customers in this tutorial, 
you will only need to select the Customer table. Click 
Customer to highlight it and click OK.

The Design Tab appears with the Insert Fields dialog box 
active.
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NOTE: If you choose more than one table in the Select Tables

dialog box, the Visual Linking Expert will appear. For more

information on linking, see How to add and link multiple tables, Page 
116, and search for Visual Linking Topics Index in Seagate Crystal

Reports online Help.

Report
sections

The Design Tab is divided into five sections: Report Header (RH), 
Page Header (PH), Details (D), Report Footer (RF), and Page Footer 
(PF). If at any time you are unsure of the report section you are 
working in, simply look to the shaded area to the left at the report 
which always displays the section names or the initials that 
designate the names. See Design Tab, Page 66.

●   If you have already toggled the Short Section Names in 
Design check box on in the File Options dialog box prior to 
reading this tutorial, the Report Header, Page Header, Details, 
Report Footer and Page Footer section names will appear as 
RH, PH, D, RF and PF respectively.

●   If you have not toggled the Short Section Names in Design 
check box on, follow these steps:

1 Choose the OPTIONS command on the File menu. The File 
Options dialog box appears with the Layout Tab active.
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2 Toggle the Show Short Section Names in Design check box on.

3 Click OK to return to your report.

Inserting a
field

The Insert Fields dialog box appears automatically with the 
Database Tab active because it is almost certain you will want to 
insert database fields when you create a new report. 

This dialog box is set to remain on screen until you click the Close 
button. All of the tables available for use in your report are listed 
in this box.

You can move the dialog box to another location on the screen by 
clicking on its title bar and dragging it to a new location. You can 
Tutorial - Customer List 171



also resize the dialog box by dragging any of its edges with the 
resize cursor. See Cursors, Page 64.

You will now start placing objects on your report by inserting the 
Customer Name field.

First, familiarize yourself with the Database Tab of the Insert 
Fields dialog box.

1 Highlight a field name in the dialog box by clicking the name 
once. When you highlight a field name, you can review the 
values for that field as well as the field type and size by 
clicking the Browse button. The Browse dialog box appears 
listing the field name, type, length, and a subset of field 
values. 

2 When you finish reviewing the data, click the Done button to 
return to the Insert Fields dialog box.

3 Highlight the Customer Name field and drag it into the 
Details section of your report.

The Customer table.

The fields in the

Customer table.
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4 An object frame appears with the arrow cursor as you drag 
the field onto your report.

●   The object frame represents the object you have just selected 
for placement. 

●   The size of the object frame approximates the size of the 
data in the field selected. 

5 Move the object frame as far to the left as you can in the 
Details section. If you move the field too far to the left, the 
arrow cursor will turn into a stop cursor indicating that you 
can not drag the field that far. See Cursors, Page 64. Keep in 
mind that you can not place any objects outside the page 
margin. 

The Design Tab should look similar to this:

Understanding

fields

Before you go any further, take a look at the field you just placed 
in the Details section. 

●   First of all, the object frame indicates that when your report 
is printed, a field value will appear where the box is 
positioned.

●   The X's in the object frame indicate that the database field 
contains a text string. Other data types have different 
character representations. For example, a currency data 
type is represented by $55,555.56.

●   The number of X's in the object frame is the data width, the 
maximum number of characters in the field as defined by 
the database. The width of the object frame is the field 
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width (the amount of space allocated to the field for 
printing). Initially it is set to the width needed to display the 
maximum number of characters in the field (using the font 
selected for the field). You can change this width by 
resizing the field. 

●   The size of the X's indicates the point size selected for the 
characters in the field. 

●   The font and style (Bold, Underline, etc.) used in displaying 
the X's indicate the font and style selected for the characters 
in the field. You will learn how to make changes to these 
attributes later in the tutorial.

●   The line spacing is adjusted to the point size selected for the 
characters in the field.

Selecting fields When a field is selected, the object frame appears with a handle 
(box) on its right, left, top, and bottom edge. These handles 
indicate that the field is selected, and therefore active. To do 
anything with a field (change the font, move it, etc.), you first have 
to select it.

●   Position the cursor inside the object frame and click once. 
The handles appear indicating the object is selected.

●   Move the cursor away from the object frame and click in an 
empty part of the window. The handles disappear. 

That’s all it takes to select and deselect objects.

Resizing fields As you can see, the Customer Name field takes up quite a bit of 
space on your report. To resize the field, follow these steps:

1 Click the Customer Name field to select it.

2 Press the Ctrl key and click the field heading. This selects both 
objects.

3 Move the cursor over the resizing handle on the right edge of 
the fields until the cursor turns into a resizing cursor. See 
Cursors, Page 64.

4 Resize the fields to the left until they are approximately two 
inches in length.
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Adding
additional

fields

Next, you will insert two additional fields in your report. This 
time, however, you will add them at the same time by using the 
Ctrl-click combination.

1 Highlight the City field in the Insert Fields dialog box, press 
the Ctrl key on your keyboard, and highlight the Country 
field. Release the Ctrl key. If you scroll through the field list, 
you will notice that both fields remain selected. 

NOTE: Using the Ctrl-click combination allows you to pick a non-

continuous range of fields. You can use the Shift-click

combination to pick several fields from the list that are

continuous.

2 Click the Insert button to place the fields. 

3 Move the cursor over your report. An object frame appears 
along with the arrow cursor. 

4 Place the fields to the right of the Customer Name field. Click 
once to insert the fields. Both fields appear in the Details 
section of your report in the same order they are listed in the 
Insert Fields dialog box. 

Reviewing
your work

Now let’s see how your report looks with three fields placed and 
positioned.

1 Click the PRINT PREVIEW button on the standard toolbar to 
activate the Preview Tab.

Your screen should look similar to this: 
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NOTE: The first time you preview your report, you must click the

PREVIEW button on the standard toolbar to activate the Preview

Tab. The Preview Tab appears to the right of the Design Tab. You

can then simply switch between designing and previewing your

report by clicking the corresponding tab.

You have the beginnings of a customer list report, but you still 
have several fields to add. 

2 When you are finished reviewing your report, return to the 
Design Tab by clicking once on the Design Tab. 

Displaying

field names

Field pictures have been discussed, but there will be times when 
you want to see the field names in the Design Tab.

1 Choose the OPTIONS command from the File menu. The File 
Options dialog box appears with the Layout Tab active.

Now in the Design Tab you will see the actual field names instead 
of field pictures (X, $, #, etc.).

2 Toggle the Show Field Names check

box on and click OK when finished.
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Combining
database fields

in a text object

Instead of adding the Contact First Name and Contact Last Name 
fields as separate objects, you can insert both fields in a text object. 
This allows you to control the formatting of both fields by making 
changes to only one object. When you insert fields in a text object, 
the fields are automatically trimmed (they do not have any extra 
white space on either side). This is important because a field is a 
fixed size but the data in the fields can vary in size leaving various 
amount of unwanted white space.

1 Click the INSERT TEXT OBJECT button on the standard toolbar. 
An object frame appears next to the arrow cursor as you move 
the cursor over your report.

2 Insert the field to the right of the fields in the Details section. 
The Design Tab automatically scrolls to the right, if necessary, 
as you drag the field. When you click to place the object, a text 
object appears and the horizontal ruler of the Design Tab 
changes to a ruler/tab selector that is used for editing the text 
object. When you click an empty area of the report or a field 
object, the standard Design Tab ruler appears. 

3 Click once on the border of the text object to select it for 
resizing. Handles appear on all sides of the object. 

4 Move the cursor over the right sizing handle of the text object 
and increase the width by about 1 inch. You may need to 
scroll to the right and continue resizing.

5 Double-click in the text object to select it for editing. Notice 
the insertion point is now flashing within the text object.

6 Highlight the Contact Last Name field in the Insert Fields 
dialog box. Remember, you can move the Insert Fields dialog 
box by dragging and dropping it by its title bar. 

7 Click the Insert button.

8 Move the cursor over the text object until your cursor 
becomes a drag and drop cursor. See Cursors, Page 64.

9 Click once to place the field in the text object. 

10 Your cursor now appears after the Contact Last Name field 
within the text object. Type a comma and a space after the 
Contact Last Name. 
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11 In the Insert Fields dialog box, highlight the Contact First 
Name field.

12 Click the Insert button.

13 Move the cursor over the text object until your cursor 
becomes a drag and drop cursor. Move the cursor to the right 
of the comma and space you just typed, and click once. The 
field will be inserted to the right of the comma and space.

14 You are finished inserting fields, so click Close in the Insert 
Fields dialog box.

15 Click the Preview Tab to look at the fields you just placed.

Your report should now look similar to this: 

Adding
summary
information

The next step is to add summary information to your report. 
Adding summary information allows you to specify the author, 
title, and subject of the report, as well as any keywords or 
comments you have related to the report. If a template is used 
when creating the report, you can specify that as well. When you 
add summary information, users can find information related to 
the report quickly. Summary information will also appear in the 
Reports at a Glance application. See the Reports at a Glance online 
Help (RPTGLANC.HLP) located in the \CRW directory (or 
directory in which the program resides).

1 Choose the SUMMARY INFO command on the File menu. The 
Document Properties dialog box appears with the Summary 
Tab active.
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2 Enter information about your report in the text boxes 
provided as shown above. Be sure to enter the title “Customer 
List” in the Title text box. This information will be used in the 
next section of the tutorial.

3 Click OK when finished.

Adding a title As you can see, the report looks incomplete without a title. 
Although you can add a title using a text object, you can also tell 
the program to take the title information directly from the Title 
text box of the Document Properties dialog box.

1 Click the Design Tab to activate it.

2 Choose the REPORT TITLE command from the Insert|Special 
Field menu.

3 Move the cursor over your report. An object frame appears.

4 Position the object frame in the upper left-hand corner of the 
Page Header (PH) section of your report and click once to 
place the object.

5 Click the Preview Tab to review your changes.

As you can see, the report title object displays the title that you 
entered in the Title text box of the Document Properties dialog 
box.
Tutorial - Customer List 179



Formatting
objects

Now you can format the report title. This time, however, you will 
remain in the Preview Tab to do the work. This will make it easier 
to see your work while you are formatting the title.

1 To center the title, you will first need to expand the title field 
box so it's about the same width as the data in your report. To 
do this, click the object to select it. 

2 Position your cursor on the right edge of the object until the 
cursor turns into a resizing cursor. Drag the right edge of the 
field box until it is even with the right edge of the data in the 
Contact Name field object. 

You have created a large field that extends from the left edge 
to the right edge of your report. 

3 With the report title object still selected, click the CENTER 
ALIGNMENT button on the format bar. The title is centered 
within the object.

4 Right-click the object and choose the CHANGE FONT command 
from the shortcut menu. The Format Editor appears with the 
Font Tab active. Search for Format Editor in Seagate Crystal 
Reports online Help.

5 Set the report title to a larger, bolder version of the active font 
by choosing Bold from the Style drop-down box and 16 (or a 
point size suitable to the font you are using) from the Size 
drop-down box.

6 Change the color of the text by choosing Maroon from the 
Color drop-down box. Notice that the Sample box shows an 
example of how the text will look. 

7 Click OK when finished. 

8 Resize the report title object vertically to accommodate the 
size of the report title.
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The title is now formatted to stand out on your report. 

Adding a field
heading

As you can see the Contact Name field is the only field without a 
heading. In this section you will create a heading using a text field.

1 Return to the Design Tab.

2 Click the INSERT TEXT OBJECT button on the standard toolbar. 
An object frame appears next to the arrow cursor as you move 
the cursor over your report.

3 Place the object in the Page Header (PH) section above the 
contact name object. 

4 Type “Contact Name” in the text object. 

5 While the text object is still in edit mode, highlight the field 
heading.

6 Click the UNDERLINE button on the format bar.

The Contact Name field now has a heading that looks just like the 
other field titles.

Saving your
report

1 Click the SAVE button on the standard toolbar to save your 
work. Since this is the first time you are saving the report, the 
File Save As dialog box appears displaying the default 
directory where the database resides. 

2 Type CUSTLIST.RPT in the Filename edit box and click Save. 
Your report is saved to the default directory where the 
program resides.
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3 Click the Preview Tab to view your report.

Your report should now look similar to the following: 

Congratulations! You have just created a basic listing report. You 
will continue to refine this report during the rest of the tutorial.

Record Selection

Seagate Crystal Reports allows you to limit or restrict the records 
that are to be included in a report. In this section you will learn 
how to:

●   select the records you want included in your report, and

●   save a report including your selection criteria.

For example, it may be useful to have a customer list that only lists 
customers from the USA. The sample data contains records from 
the United States and International customers. The program 
makes it easy to restrict lists like this using the Select Expert. See 
Record and Group Selection, Page 249.

Entering your
selection
criteria

When you scroll through your report, you will see that the report 
contains information for customers from many different 
countries. In this step, you will limit the number of countries 
displayed to the USA.

1 To begin, click the Design Tab to return to design mode.
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2 Click an empty area of your report to deselect any fields.

3 Click the SELECT EXPERT button on the standard toolbar. The 
Choose Field dialog box appears. 

This dialog box lists all the fields currently in the report in the 
Report Fields section and then lists all fields that are available 
from each table in the Database Fields section.

4 Since you are going to base record selection on the country 
field, choose {customer.COUNTRY} from the Fields list box 
and click OK. 

The Select Expert appears. 

5 Your job in this dialog box is to imagine that you are 
completing the following sentence:

Select all records where a customer’s COUNTRY 
is

You complete the sentence with the condition you want the 
program to use when selecting records for your report. Right 
now the condition is any value, clearly not a restrictive 
condition. 
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6 Click the arrow on the right drop-down box to see what other 
options you have.

7 Since you want only those records where the Country is USA, 
select the equal to condition. A new list box appears on the 
right. The dialog box sentence now reads:

Select all records where a customer’s Country 
is equal to

All that you need to complete the sentence is the value USA.

8 Click the arrow on the drop-down box. A list of all the 
country values appears. Select USA from the list.

Your sentence now reads:

Select all records where a customer’s Country 
is equal to USA

9 Click OK to return to the Design Tab.

10 Click the Preview Tab to review the results of your work.

11 A message box appears asking if you would like to use saved 
data or refresh data.

●   If you click Use Saved Data, the program will only select 
records from those saved with the report. This method is 
recommended if you simply add a new record or group 
selection formula.

●   If you click Refresh Data, the program will select records 
from the entire database. This method is recommended if 
you change an existing record or group selection formula.

12 Because you did not change a record selection formula, click 
the Use Saved Data button.

Now when you scroll through the report, you will see that only 
customers from the USA appear.

13 Save this version of the report without overwriting the 
original report by choosing the SAVE AS command from the 
File menu and giving the new report the name USA.RPT.

Congratulations! You have started formatting your report and 
added selection criteria to it. More than that, you have learned 
how to manipulate your data. By now, you have a good idea of the 
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powerful kinds of reports you can prepare. As you can see, it is an 
easy program to use.

Deleting a field Now that your report only contains records from the USA, 
displaying the Country field in the body of the report is not 
necessary. You will quickly delete this before continuing.

1 Select the Country field and the Country column heading 
using the Ctrl-click combination.

2 Press the Delete button on your keyboard. That is all it takes 
to delete fields from your report. 

Your report should look similar to this: 

Balancing field
spacing

Now that the Country field has been deleted, there is a large 
amount of white space between the City and Contact Name fields. 
You might be fine with the spacing as it stands, but it might be 
more readable if the columns were better balanced across the 
page. 

1 Return to the Design Tab. Select the Contact Name field and 
its field heading by using the Ctrl-click combination.

2 Place your cursor over one of the two highlighted text objects 
and drag them to the left, closer to the City field.

3 Click the Preview Tab and review your work again. 
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Your report should look similar to this: 

The spacing between the fields is much better, but it looks as if the 
report title is off center. 

4 Click the report title object to select it.

5 Position the cursor on the right handle of the object until the 
cursor turns into a resizing cursor. Drag the right edge of the 
object frame until it is even with the right edge of the data in 
the Contact Name field object.

The report title automatically recenters itself based on the size 
of the object.

Grouping and sorting

Reports can be grouped and sorted in a variety of ways. Sorting 
and grouping tools provide you with a great deal of flexibility for 
customizing your reports.

Grouping your
report

In many reports you need to break your data into groups to make 
it easier to read and understand. Seagate Crystal Reports lets you 
do this easily. For this customer list, you will group the customers 
by region and then sort the customers alphabetically within each 
group.

1 In the Design Tab, click the INSERT GROUP button on the 
supplementary toolbar. The Insert Group dialog box appears. 
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2 Select the Region field from the Customer table in the first 
drop-down box. The program will now take all records with 
the same value in the region field and place them together in a 
group on your report. 

3 Select in ascending order from the second drop-down box. The 
region grouping will be displayed on your report in 
alphabetic ascending order.

4 Click OK. 

Notice that two new sections now appear in the Design Tab: 
GH1 (Group Header) and GF1 (Group Footer). This is how the 
program shows that the report has been grouped.

5 Click the Preview Tab to see what your report looks like.
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6 If the group tree is not visible, click the TOGGLE GROUP TREE 
button on the format bar to see the groups included in the report.

You can view the group of interest by simply clicking on the 
group name in the Group Tree. For example, if you would like 
to see the Texas customer group, simply click TX in the Group 
Tree. The program will jump to the Texas group, displaying 
that group in the Preview Tab. The Group Tree allows you to 
quickly jump to a specific group of interest instead of scrolling 
through your report looking for the group. For more 
information on the group tree, see Group Tree view, Page 74.

NOTE: For many of your reports you will want to insert
summaries, subtotals and grand totals. For example, if you were
creating a sales report rather than a customer list, you would want
to calculate the total sales amount for each region. See Sorting, 
Grouping, and Totalling, Page 271.

Understanding
�live� group
headers

When you insert a group, a group name field is automatically 
inserted in the Group Header section of your report. The group 
name field displays the current group’s name. For example, if you 
group by region, when you preview your report, the group 
header for the CA (California) group will show “CA”.

The group field name is automatically formatted to stand out 
from the records in the group.

Sorting records In a typical customer list report, customer names are listed 
alphabetically. In this example, you will sort the customer names 
alphabetically within each region. 

1 In the Preview Tab, click the SORT ORDER button on the 
standard toolbar. The Record Sort Order dialog box appears.
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●   The Report Fields box lists all fields currently on your report. 
You can choose to sort based on any of these fields. 

●   The Sort Fields box displays the fields that are already sorted 
in the report. Because the region field is already sorted, the 
sorting you are about to do will be within each region, not 
for the entire report.

2 Highlight the Customer Name field and click the Add button. 
Notice that the Customer Name field now appears in the Sort 
Fields list box.

3 Click the Ascending option button for the Sort Direction and 
click OK.

Your report should now look similar to the following: 

Notice that the records within each group are in alphabetic order.

Completing the report

You have just one step left to complete your report. You are going 
to add a company logo on the first page of the report.

Inserting a
company logo

In this section, you will place a company logo at the top of the first 
page of your report.

1 In the Design Tab, click the INSERT PICTURE button on the 
supplementary toolbar. The Open dialog box appears. 
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2 Choose the CRAZEC.BMP file and click Open. An object frame 
appears as you move the cursor over your report. The object 
frame represents the logo you will place. 

3 Position the object frame in the upper left-hand corner of the 
Report Header (RH) section of your report and click once. 

Placing the logo in the Report Header (RH) section ensures 
that the logo is printed only on the first page of your report. See 
Area printing characteristics, Page 69.

NOTE: Although there does not appear to be enough room in the

Report Header (RH) section when you place the graphic, the

section will automatically expand to accommodate the picture.

4 Click the Preview Tab to view your report.

Your final report should look like this: 

5 Save your report by clicking on the SAVE button on the 
standard toolbar.

You have just completed your first report. It is a pretty impressive 
report, and Seagate Crystal Reports made it easy to do.

Related Topics

For information about distributing your report (printing, 
exporting, etc.) see Printing, Viewing, and Exporting, Page 135.
190 Seagate Crystal Reports User�s Guide



8 Reporting on OLAP data

What you will find in this chapter...

Introduction, Page 192

Arbor Essbase client drivers, Page 193

Selecting members for dynamic reporting, Page 193

Combining data using subreports, Page 195

Essbase database security, Page 196

The report definition and the Essbase outline, Page 197

Storing database outlines, Page 198

Saving reports without outlines, Page 198

Server independence of reports, Page 199

Updating Essbase server and database locations, Page 200

Efficient access of Essbase databases, Page 201

Optimizing for large Essbase databases, Page 201

HANDS-ON (Reporting on OLAP data), Page 202
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Introduction

Although relational databases such as SQL servers and PC 
databases are the most common source of data, Online Analytical 
Processing (OLAP) and Multi-Dimensional Data (MDD) are 
rapidly becoming popular data-storage and analysis formats. 
Seagate Crystal Reports provides the same access and reporting 
features for OLAP data sources that it provides for relational data.

NOTE: The term OLAP is used in this manual to refer to all
common forms of OLAP and multi-dimensional data storage and
access systems.

Many of the tools and dialog boxes Seagate Crystal Reports 
provides for working with OLAP data require a previous 
understanding of the OLAP concept. Make sure you are familiar 
with OLAP concepts and your OLAP software before attempting 
to design OLAP based reports. If you are already familiar with 
OLAP, this chapter provides the information you need to extend 
OLAP data with Seagate Crystal Reports, the most powerful 
solution to analyzing any data.

Working with Arbor Essbase data

Arbor Essbase has become one of the most popular OLAP systems 
available. Seagate Crystal Reports provides many features for 
working directly with Essbase data. This section provides 
conceptual information specific to creating reports based on 
Essbase databases. The section HANDS-ON (Reporting on OLAP 
data), Page 202, includes a tutorial for building a cross-tab report 
using Essbase data.

Essbase reports can be created using the Create Report Expert in 
Seagate Crystal Reports, just like any other report. Simply click 
the NEW button on the toolbar, select a report style from the 
Report Gallery, and begin designing your report in the Create 
Report Expert.

The Data Tab of the Create Report Expert includes a button for 
accessing Essbase databases. Once you select an Essbase 
application and database, use the Members Tab of the Create 
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Report Expert to specify dimensions and members to be included 
on your report. The Members Tab has been designed to resemble 
data selection dialog boxes that appear in Arbor Essbase client 
applications. If you have worked with Essbase before, you will 
quickly learn how to extract OLAP data in Seagate Crystal 
Reports.

Arbor Essbase

client drivers

To report on Essbase data, your system must have access to 
several Essbase client drivers. These drivers are installed if you 
have installed an Essbase client application, such as the Essbase 
Spreadsheet Client. If you do not have any Essbase client 
applications installed on your system, run the Seagate Crystal 
Reports setup program and toggle Custom installation on. Toggle 
the check box for the Arbor Client Files under Database access on 
in the Custom Installation Options dialog box. This does not 
install any Arbor client applications. It only installs the files 
necessary for Seagate Crystal Reports to access Essbase data.

Selecting

members for

dynamic

reporting

If database members frequently change and are updated in an 
Essbase database, you should consider carefully how you add 
members to a report during the design process. Rather than select 
specific members from the database outline, forcing the data to be 
filtered out by the Essbase server, you should consider including 
entire generations or levels and filtering out specific members 
from the Seagate Crystal Reports client.

For example, consider the Product dimension in the Essbase 
Sample Basic database:
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NOTE: This diagram displays only a portion of the Product
dimension in the Sample Basic database.

If new products are frequently added and older products 
discontinued, a report that includes this dimension should be 
designed to be easily refreshed whenever a product change 
occurs. As an example, consider the following scenario:

●   You have created a report that includes sales information 
for Cola, Diet Cola, Old Fashioned Root Beer, Birch Beer, 
Dark Cream Soda, and Vanilla Cream Soda. When you 
created the report, you selected each member individually 
from the database outline in an effort to exclude other 
products that you were not interested in.

●   A recent corporate decision has now eliminated Dark 
Cream Soda because of low sales figures. In addition, a 
recent marketing study has suggested that a new Cherry 
Cola be added to the company's product line, and you 
decide to include sales figures for this soda in your report. 

When you open the report and attempt to refresh the report data, 
Dark Cream Soda will no longer exist in the database, producing 
an error in your report. Furthermore, to add the Cherry Cola to the 
report, you must go through several steps to examine the new 
database outline, select the new member from the database, add 
the member to the report.

A different approach to designing this report would be to select 
the descendants of the Product dimension, generation 3 of the 
Product dimension, or level 0 of the Product dimension. Any of 
these methods produces similar results, without using specific 
members. When new members are added or old members 
eliminated, a simple refresh will update your report.

What if there are certain members you want to exclude from the 
report? In the above example, Caffeine Free Cola, Diet Root Beer, 
Sasparilla, and Diet Cream Soda are not used in the sales report. 
These members can be much more efficiently excluded using the 
Select Tab in the Create Report Expert or using the Select Expert. 
Once members are filtered out through record selection, those 
members will never appear in the report, even after refreshing the 
report. If one of the excluded members is removed from the 
original database, the report remains unaffected.
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Keep in mind, though, that more general methods of selecting 
data, as described here, force Seagate Crystal Reports to retrieve 
more data from the Essbase database, increasing network traffic 
and resources and increasing time spent generating the report on 
the local system.

Combining

data using

subreports

Subreports allow you to put secondary report objects inside a 
primary report. Subreports allow some extremely powerful 
reporting capabilities including:

●   linking detail reports to primary report records,

●   presenting different views of the same data in a single 
report, and

●   combining multiple reports containing unrelated data in the 
same report.

NOTE: For complete information on working with subreports, see
Subreports, Page 429.

Using subreports, you can include both relational data and OLAP 
data in the same report, called a heterogeneous report. Seagate 
Crystal Reports allows any of the following combinations:

●   A primary report based on relational data containing a 
subreport based on OLAP data.

●   A primary report based on OLAP data containing a 
subreport based on relational data.

●   A primary report based on either relational or OLAP data 
that contains several different subreports, some based on 
OLAP data and some based on relational data.

In other words, any combination is possible. In addition, data can 
be linked between a primary report and a subreport. This means 
the data in a subreport can be directly related to the values 
displayed in the primary reports. A useful example is a report that 
displays detail information in a subreport for a specific record in 
the primary report.
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Essbase

database

security

Seagate Crystal Reports fully supports Essbase security. There are 
no additional settings or layers that need to be invoked.

Since Seagate Crystal Reports forces users to log on to an Essbase 
server before accessing Essbase databases, the server is allowed to 
verify log on information. All security is turned over to the 
Essbase server, and access to data is controlled by the server.

If a user attempts to request member data from Essbase that they 
do not normally have rights to view, Essbase will not return the 
requested data to Seagate Crystal Reports. Only data that the user 
has rights to view is returned and displayed in reports. In place of 
data that the user does not have access to, Essbase returns the 
#NOACCESS value.

When Seagate Crystal Reports receives #NOACCESS from 
Essbase, it translates this message into a null data value. The 
database members that produce the #NOACCESS value still 
appear in the report, but a blank space appears where the actual 
data value would normally be.

Using the Suppress Missing Data check box of the Report Options 
dialog box or the OLAP Tab of the File Options dialog box, you 
can prevent Essbase from returning even the #NOACCESS value 
and any database member combinations that produce 
#NOACCESS.

To illustrate what happens to data that a user does not have access 
to, examine the following sample data:

Normally, Seagate Crystal Reports produces the following output 
on your reports:

Qtr1 33

Qtr2 #NOACCESS
Qtr3 55

Qtr1 33
Qtr2

Qtr3 55
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With the Suppress Missing Data check box toggled on, the 
following data will appear in the report:

The report

definition and

the Essbase

outline

A Seagate Crystal Reports file that reports on OLAP data is made 
up of a report definition, report data (optional), and an OLAP 
database outline (optional). The report definition is the core 
description of what data exists in the report, where that data 
comes from, and how the data looks when the report is printed or 
previewed on screen.

If you choose to store database data (actual data values stored in 
the database) with the report, you can save time generating the 
report when it is opened or printed in the future. However, if data 
values change in the original database, the report will not reflect 
these changes until you refresh the report data.

Additionally, an OLAP database outline can be saved with the 
report definition if the report, or a subreport, is based on an OLAP 
database. Having access to the OLAP database outline can be 
important when trying to view or edit existing report files. See 
Server independence of reports, Page 199. 

By default, Seagate Crystal Reports saves outline information of an 
OLAP database with any report that accesses it. Only information 
relevant to the data used by your report is saved, though.

NOTE: Information about Essbase alias tables is not saved with
the report file.

When outline information is stored with a report, Seagate Crystal 
Reports has access to the original design of OLAP database 
information used to design the report. Such information allows 
you to make formatting changes to the report without 
reconnecting to the Essbase database.

You can prevent the program from storing database outline 
information with your report using the OLAP Tab in the File 
Options dialog box. The OLAP Tab contains a Store Outline 
Information check box. By default, this check box is toggled on, but 
by toggling it off, you can keep database outlines from being 
stored with the report.

Qtr1 33
Qtr3 55
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NOTE: In most cases, you should allow the program to store
outline information with a report file unless drive space is a
critical issue. Outlines increase the size of a report file and,
therefore, require more disk space.

Storing

database

outlines

When you store a database outline with a report, the outline 
information is stored with the report definition file (your standard 
.RPT file). The database outline includes dimensions, members, 
consolidation attributes, expense attributes, any aliases defined in 
the Essbase Default alias table, and more.

NOTE: Seagate Crystal Reports does not store aliases from alias
tables other than the Essbase Default table. To access aliases in
other alias tables, you must use the EssbaseAlias function when
designing your report and you must be connected to an Essbase
server.

Storing this information allows Seagate Crystal Reports to easily 
determine member parents, children, generations, and levels. 

Although storing outline information with a report allows more 
flexibility and power when working with existing reports, 
changes to the database outline in the original Essbase database 
are not reflected in a report file until the report is updated. 
Without updating the report, Seagate Crystal Reports remains 
unaware of any discrepancies between the outline in the report 
file and the actual database outline in Essbase. You can update the 
outline stored with a report file using the VERIFY DATABASE 
command on the Database menu.

Saving reports

without

outlines

If you choose not to include the database outline from your 
Essbase databases with your reports, be aware that the lack of an 
outline forces the program to depend on connectivity to the 
Essbase server anytime changes are made to the report.

Most reports should be saved with database outline information 
unless disk space is a critical issue on your system. For more 
information about how report files can be dependent on or 
independent of the Essbase server, see Server independence of 
reports, Page 199. 
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Server

independence

of reports

When you first create a report based on Essbase data, you must 
connect to the Essbase server to access the Essbase database. 
However, after you generate your report, you can save the 
Essbase database outline with the report, as described in the 
previous section, thus eliminating, in many cases, the need to 
have a connection to the server the next time you open the report 
file.

On the other hand, some report features require that you 
reestablish the server connection before printing or scheduling the 
report. A server connection can be reestablished using the LOG ON 
SERVER command on the File menu, if no report is currently open, 
or the Database menu, if another report is already open. The 
independence of a report file, in regards to the Essbase server, is 
controlled by several factors.

You must have a connection to the Essbase server if:

●   the report contains a cross-tab, and the database outline has 
not been saved with the report file (see The report definition 
and the Essbase outline, Page 197), 

●   the report uses member aliases that are stored in an alias 
table other than the Default table, or

●   the report uses an Essbase related UFL function, such as 
EssbaseGeneration or EssbaseAncestor, and the database 
outline has not been saved with the report file (see The report 
definition and the Essbase outline, Page 197).

Otherwise, you do not need to have a connection to the Essbase 
server as long as you do not plan to refresh the database data 
values in the report. A good set of rules to follow is:

●   Cross-tabs require access to the database outline.

●   Essbase related UFL functions require access to the database 
outline.

●   Changes to database members that appear in the report 
require access to the server.

●   Access to member aliases stored in the Default alias table 
require access to the database outline.

●   Access to member aliases stored in an alias table other than 
the Default table require access to the original database.
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●   Changes to database data values that appear in the report 
require access to the original database.

Access to the database outline can be given either by saving the 
outline with the report (see The report definition and the Essbase 
outline, Page 197), or by having a connection to the Essbase server. 
Access to database data values that are not saved with a report can 
only be given through a connection to the Essbase server.

Updating

Essbase server

and database

locations

If the location of your Essbase server or database changes, you 
must update the information about the server and database in your 
report files. In addition, many reporting scenarios may require that 
you develop a report based on a smaller database that represents a 
subset or production version of the primary Essbase database.

In such cases, as long as the new database has the same structure 
as the original database that the report was based on, the report 
file can be easily updated to point to the new location. In addition, 
if a report contains one or more subreports, and the databases 
used for the subreports have changed name or location, you must 
update each of the subreports separately.

Seagate Crystal Reports provides several sample reports based on 
the Essbase Sample Basic database. By examining these sample 
reports, you may get ideas on how to design some of your own 
reports. Before you can use the subreports, though, you must 
update the location of the databases used for each one, based on 
the location of your Essbase server.

The following tutorial leads you through the process of updating 
the location of the databases used in the PL.RPT sample report 
located in the \CRW\REPORTS\ESSBASE directory.

With Seagate Crystal Reports running:

1 Choose the OPEN command from the File menu. The Open 
dialog box appears.

2 Locate and select the PL.RPT report file in the Open dialog 
box. By default, this report is installed in the 
\CRW\SAMPLES\ESSBASE directory. When you have 
selected the report file, click OPEN, and the report file is 
opened inside Seagate Crystal Reports.

3 Choose the REFRESH command from the Database menu. The 
Essbase Server Login dialog box appears.
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4 Log on to your Essbase server using the user name and 
password you normally enter to log on. The Essbase 
Application & Database dialog box appears.

5 Select the Sample application and the Basic database from 
your Essbase server. Click OK.

Seagate Crystal Reports will continue prompting you for each 
subreport. You will be asked to log on to your Essbase server.

6 Save your report.

Efficient access

of Essbase

databases

Normally, when Seagate Crystal Reports connects to an Essbase 
database, it loads the entire outline for that database into memory. 
This may create an initial delay while the outline is loaded, but 
once loaded, queries to the database are fast and changes to your 
report can be made easily and quickly in the Preview Tab.

Since the entire database outline is loaded into memory all at once, 
though, the size of the Essbase outline that can be accessed is 
limited by the size of the machine's memory and virtual memory. 
If you work with large Essbase databases that contain many 
dimensions and members, you may encounter problems when 
trying to connect to an Essbase database.

To solve this problem, Seagate Crystal Reports allows you to 
optimize its performance with large Essbase databases. When 
large database optimization is toggled on, Seagate Crystal Reports 
does not load the Essbase outline into memory ahead of time. So 
any size database outline may be accessed without regard to the 
machine’s available memory. The drawback is that Seagate 
Crystal Reports must retrieve outline information directly from 
Essbase each time it requires additional data, thus slowing 
database access time.

Optimizing for

large Essbase

databases

Use the following process to optimize Seagate Crystal Reports for 
working with large Essbase databases:

1 With Seagate Crystal Reports running, choose the OPTIONS 
command from the File menu. The File Options dialog box 
appears.

2 Click the OLAP Tab to activate it. This tab provides several 
options specific to OLAP databases.

3 Toggle the Optimize for Large Database check box on.
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4 Click OK.

5 Close Seagate Crystal Reports and then reopen. The program 
will now allow you to access any database, regardless of size.

NOTE: Any reports that are open when the Optimize for Large 
Database check box is toggled on will not be affected by this

option. Seagate Crystal Reports will continue to work with this

report with the database outline stored in memory.

HANDS-ON (Reporting on OLAP data)

The following tutorial demonstrates basic techniques for creating 
a cross-tab report based on the Arbor Essbase Sample Basic 
database. If you do not have access to this database, contact you 
Network Administrator. In addition to this tutorial, Seagate 
Crystal Reports online Help file contains several more tutorials for 
reporting on Essbase data. Search for Working with Essbase in 
Seagate Crystal Reports online Help.

How to create a cross-tab with Essbase data

A cross-tab report illustrates how one set of data relates to another 
set of data. Often, each set of data comes from a different 
dimension in the Essbase database, and the report can be viewed 
as a true dimensional report based on dimensional data.

Cross-tabs are the most natural types of reports to create with 
OLAP data, and you may find yourself using the Cross-Tab 
Report Expert for most of your reporting tasks. Because cross-tab 
data is laid out similar to a spreadsheet, you may already be 
familiar with many of the concepts illustrated here, and you will 
start building expert cross-tabs with very little training.

Cross-tab reports can actually be designed using any of three 
different methods in Seagate Crystal Reports:

1. Using generational data in the Cross-Tab Report Expert,

2. Using dimensional data or a combination of dimensional and 
generational data in the Cross-Tab Report Expert, or
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3. Using dimensional data in a columnar report and manually 
constructing the cross-tab by moving and formatting data 
fields in the application window.

Each method has advantages and disadvantages. For a complete 
description of each method for creating cross-tabs, search for 
Cross-Tab Options in Seagate Crystal Reports online Help. 

This tutorial takes you through the steps of creating a cross-tab 
report using generational data in the Cross-Tab Report Expert.

1 Start Seagate Crystal Reports, click the NEW button on the 
standard toolbar, then click the Cross-Tab button in the Report 
Gallery. The Create Report Expert appears.

2 On the Data Tab of the Create Report Expert, scroll down, and 
click the Essbase button. The Essbase Server Login dialog box 
appears. Log on to Essbase using your standard Essbase user 
name and password.

NOTE: If you have already logged on to Essbase while creating a

previous report, and have not yet exited Crystal Reports, you will

not need to log on again.

3 Click OK on the Essbase Server Login dialog box, and the 
Essbase Application & Database dialog box appears. 

Select the Basic database from the Sample application, and 
click OK. The Basic database will appear in the database list of 
the Data Tab.

Adding data
with the
Members Tab

In this tutorial, you will design a cross-tab report that displays Profit 
data over time. You will need to select members from the Measures 
dimension and the Year dimension in the Sample Basic database.

4 Click the Members Tab in the Create Report Expert. 

On the left side of the tab is the Database Fields list box 
displaying all available dimensions in the database, and on the 
right side of the tab is the OLAP Members list box.

5 First, select members from the Year dimension. This cross-tab 
will display Profit related data for each quarter, with a final 
column displaying data for the entire year. Select the Year 
dimension in the Database Fields list box, and click Add. Year 
appears in the OLAP Members list box.
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6 Select Year in the OLAP Members list box, and click the 
Properties button below the list box. The Member Properties 
dialog box appears.

7 Select This member's children, and click OK. Do not select This 
member and children. Although final Year totals for Profit data 
will appear in the cross-tab, this report will not get that data 
from the Essbase derived aggregate for Year. Instead, the 
program will calculate the result using smart aggregation.

8 After you click OK in the Member Properties dialog box, 
(children ONLY) appears next to the Year member in the OLAP 
Members list box. 

You also need to add data from the Measures dimension, the 
dimension that contains Profit related data.

9 Click the node next to the Measures dimension in the Database 
Fields list box. The Profit, Inventory, and Ratios members are 
displayed.

10 Select the Profit member, and click Add. Profit is added to the 
OLAP Members list box.

11 Select Profit in the OLAP Members list box, and click the 
Properties button. The Member Properties dialog box appears. 

12 This time, select the This member and descendants option, and 
click OK. 

Profit data is much more complex than the Year dimension, 
and it will be easiest if the report obtains all aggregates in the 
Measures dimension directly from Essbase. This time, the 
program will use smart aggregation to recognize that Profit is 
an aggregate derived from its descendants and will not 
calculate a Total for the members of the Measures dimension.

Using the
Cross-Tab Tab

Now that you have selected the data that will appear on your 
report, you need to design the cross-tab report itself.

13 Click the Cross-Tab Tab to begin designing your cross-tab 
report.

The list box at the lower left corner of the Cross-Tab Tab shows 
Essbase dimensions. If you selected members from a specific 
dimension on the Members Tab, that dimension appears here 
with a separate listing for each generation in that dimension. 
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However, only generations up to the highest generation you 
selected appear here.

For example, when you selected the Profit member and its 
descendants, each generation from the Measures dimension 
was added to the OLAP Generation Fields list. When you 
selected the children of Year, only generations 1 and 2 from the 
Year dimension were included in this list because you did not 
indicate any members from generation 3 of the Year 
dimension.

When you add a generation from a dimension to the Rows or 
Columns sections of a cross-tab, a band is created in the cross-
tab report for that generation, and only members that you 
specified on the Members Tab are included in the band. If you 
add Basic.Measures, Generation 2 to the Rows section, for 
instance, only the Profit member will appear in the cross-tab. 
Even though Inventory and Ratios are also generation 2 
members of Measures, you only included the Profit member 
from generation 2 when you selected members on the 
Members Tab.

Smart aggregates are created for any dimension generations 
appearing here that you did not specifically select. For 
example, you selected only the children (generation 2) of Year 
on the Members Tab, but generation 1 (Year itself) also appears 
in the OLAP fields list. If you include Basic.Year, Generation 1 
in your cross-tab, the program will create a Year band and 
calculate the aggregate based on generation 2 members.

This relationship between members selected on the Members 
Tab and generations added to the cross-tab on the Cross-Tab 
Tab is important to understand. Pay close attention to your 
database, the members you select, and the generations that are 
added to the cross-tab. Without careful consideration, you 
may have inaccurate results in your report.

Below the Report Fields list is the Database Fields list. This 
section of the list box allows you to select entire dimensions to 
place in the cross-tab. Like the generation list items, though, 
only members you actually selected on the Members Tab will 
appear for each dimension. Unlike the generation list items, 
members from different generations within the same 
dimension appear together in the same band of the cross-tab. 
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For more information on selecting dimensional data for cross-
tabs, search for Cross-Tab Options and the tutorial Dimensional 
Cross-Tabs in Seagate Crystal Reports online Help.

If you scroll to the bottom of the list box, you will notice that 
the last item in the list box is DATA. This field represents 
actual numeric data in your database (rather than members of 
a dimension).

The largest feature of the Cross-Tab Tab is the cross-tab layout 
section that fills the upper left corner of the tab. Use this section 
of the tab to design the actual layout of your report.

A cross-tab report consists of three features: rows, columns, 
and summary data. The rows and columns indicate how you 
are examining and comparing the summary data. Summary 
data is evaluated based on the comparisons between rows and 
columns. The cross-tab report you create in this tutorial will 
examine Profit data from the Measures dimension over a 
period of time represented by the members of the Year 
dimension.

14 Scroll to the bottom of the list box on the Cross-Tab Tab, and 
select the DATA field. In any cross-tab report you create with 
OLAP data, the cross-tab must summarize actual numeric 
values, not OLAP database members. These values can come 
directly from the DATA field of the OLAP database or can be 
generated by a formula or summary field.

15 Drag the DATA field to the Summarized Field list box in the 
cross-tab layout section. Basic.DATA appears in the 
Summarized Field list box.

16 Scroll back up in the list box, and select Basic.Year, Gen 2 from 
the list. Drag this generation field to the Columns list box of 
the cross-tab layout section.

17 Select Basic.Year, Gen 1 from the list box, and drag it to the 
Columns list box. 

A message box appears, indicating that you have not selected 
members from the Year dimension in the correct order.

When you add members to a cross-tab, you will naturally want 
to group generations in the same order that they are organized 
in the original database. For example, quarters from the Year 
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dimension should be grouped under the year. It would not 
make sense to group the year under individual quarters. The 
Cross-Tab Tab helps you organize generations correctly by 
making sure generation 2 data is grouped under generation 1 
data, generation 3 data is grouped under generation 2 and 
generation 1 data, etc.

18 Click Yes in the message box to have generations correctly 
organized in the cross-tab. If you click No, the program will 
not allow you to add Generation 1 data beneath Generation 2.

Remember, though, you did not actually select a generation 1 
member of the Year dimension on the Members Tab. Since you 
asked for generation 1 to appear in the columns section of the 
cross-tab, the program will use smart aggregation to recognize 
the missing member and calculate an aggregate value.

19 Drag the following generations from the list box to the Rows 
list box of the cross-tab layout section in order:

●   Basic.Measures, Gen 2

●   Basic.Measures, Gen 3

●   Basic.Measures, Gen 4

This cross-tab will not display generation 1 of the Measures 
dimension.

NOTE: The Cross-Tab Tab also provides the Add Row, Add 
Column, and Set Summarized Field buttons to move fields to the

Rows, Columns, and Summarized Field list boxes of the cross-tab

layout section. Use these buttons or the drag and drop technique,

whichever is more convenient for you.

Previewing the
report and
smart
aggregation

20 Click Preview Report on the Create Report Expert. The Expert 
disappears, and, after a few seconds, the program generates 
and displays your cross-tab data.

NOTE: You may need to adjust the size of report fields so that

member names are displayed correctly. To resize a field, simply

select the field and drag the handle at the right side until the field

is displayed correctly.

The first thing to notice in the cross-tab is that generations 
within the same dimension appear in separate bands of the 
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cross-tab. For instance, generation 2 members of the Year 
dimension appear together in a band of columns, while 
generation 1 of the Year dimension appears in a separate band 
above generation 2. Now you can clearly see why the program 
forces you to place generations in the cross-tab layout in a 
certain order.

Notice also that the program added a Year band and a Total 
column at the right hand side of the report for generation 1 of 
the Year dimension. When you see a column or row that is 
labeled Total, the program is calculating the aggregate values. 
If aggregate values are not labeled Total, the values are coming 
directly from the Essbase database. Since you did not select 
any generation 1 members for this dimension, these values do 
not come from the original Essbase database. Instead, this Year 
Total column contains the aggregates calculated by Seagate 
Crystal Reports. These aggregates were calculated simply by 
adding together the values for the generation 2 members that 
did come from the Essbase database.

To better understand smart aggregation and cross-tab 
aggregation, you will change the OLAP properties selected for 
the Year dimension.

NOTE: To avoid accidentally losing your work, you may want to

save the report as it currently stands before continuing with the

tutorial.

21 Select one of the members from the Year dimension in the 
cross-tab report. You can select any one of the quarters or 
select Year itself.

22 Choose the CHANGE OLAP MEMBERS command from the Edit 
menu. The OLAP Members dialog box appears.

23 Currently, Year (children ONLY) appears in the Current 
Members list box. Select this item, and click Properties. The 
Member Properties dialog box appears.

24 Change the properties for the Year member to This member and 
children, and click OK. Year (and children) now appears in the 
Current Members list box.

25 Click OK in the OLAP Members dialog box. Seagate Crystal 
Reports regenerates your cross-tab.
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Although the values in the last column of the report did not 
actually change, they are now being obtained directly from the 
Essbase database instead of being calculated by Seagate 
Crystal Reports. Notice that the Total label is now missing. As 
described before, if an aggregate value is calculated by Seagate 
Crystal Reports, the Total label will appear for the respective 
row or column. If no Total label appears, the values are being 
obtained directly from the Essbase database. 

Although the change you just made had no effect on the actual 
data in your report, understanding the difference is important 
in situations where not all members from the child generation 
are present. For instance, if you had only selected the Qtr1 and 
Qtr2 members of generation 2 of the Year dimension, the 
results for the Year would appear different based on smart 
aggregation. If you select the Year member as well, the Year 
total would come directly from the Essbase database and 
would represent the entire year. However, if you did not select 
the Year member, Seagate Crystal Reports would use smart 
aggregation to obtain a total from available data, Qtr1 and Qtr2 
values, in this case. Thus, the Year column would actually only 
represent the first two quarters of the year.

Formatting the
report

26 Select one of the data values that appears in the cross-tab. For 
example, select the value that appears at the intersection of 
the COGS member and the Qtr1 member. Notice that the 
value is selected and a gray box appears behind every other 
data value except the aggregate values for Year, Margin, Total 
Expenses, and Profit. This means that the formatting changes 
you are about to make will affect all of the selected data 
values in the cross-tab.

27 Click the CURRENCY button on the format bar.

A currency sign is added next to each selected value in the 
cross-tab.

28 Add a currency sign to the values that appear in the remaining 
rows and columns of the cross-tab. You may need to make 
several selections before all values are formatted correctly.

NOTE: You can use the Shift key to select several fields at the

same time.
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Highlighting
bands

29 Select the entire cross-tab report by clicking in the upper left 
hand corner of the cross-tab object, outside of any data fields 
or members. A selection rectangle appears around the entire 
cross-tab object.

30 Choose the FORMAT CROSS-TAB command from the Format 
menu. The Cross-Tab dialog box appears. This dialog box is 
similar to the Cross-Tab Tab in the Create Report Expert.

31 You will highlight certain rows and columns in the cross-tab 
report according to the generation within each dimension 
using the Cross-Tab dialog box. Select Basic.Year, Gen 1 in the 
Columns list box.

32 In the Background Color drop-down box, select Silver.

33 Now select Basic.Measures, Gen 2 from the Rows list box and 
select Silver as its background color.

34 Click OK in the Cross-Tab dialog box. The program highlights 
the Year band in the cross-tab columns and the Profit band in 
the cross-tab rows along with their respective aggregate 
values. This simple band highlighting capability allows you to 
easily format cross-tab reports to clarify data.

Pivoting the
cross-tab

After examining the cross-tab data produced in your report, you 
may decide that you need to make some changes.

35 Right-click in the upper left corner of the cross-tab and select 
the PIVOT CROSS-TAB command from the shortcut menu that 
appears.

The report has been completely pivoted on its axis.

Breaking the
report over
groups

36 Click the Design Tab again. Notice that the cross-tab is a 
single object that appears in the Report Header section of the 
report. In addition, you may have recognized that this cross-
tab only represents two dimensions in the Sample Basic 
database.

The following steps demonstrate how to add a third 
dimension to your report, group the report based on this third 
dimension, and split the cross-tab into multiple cross-tabs 
based on the grouping.
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Although it is possible to add a third dimension directly into 
the cross-tab object, adding the dimension as a group on the 
primary body of the report can often have better results, 
depending on the data you are presenting.

37 Choose the REPORT EXPERT command from the Report menu. 
A message box appears stating that the actions you are about 
to take can not be undone using the UNDO command on the 
Edit menu. Click Yes in response to the message box, and the 
Create Report Expert appears again.

38 Click the Members Tab to display available and selected 
database members.

39 Click the node next to the Scenario dimension in the Database 
Fields list box to view the children of Scenario.

40 Select the Actual member, and click Add, then select the 
Budget member, and click Add. These two members are now 
available to your report, but you will not add them to the 
actual cross-tab.

41 Click the Group Tab. You will create groups in the report 
based on the Actual and Budget members.

42 In the Report Fields list box, scroll down and select the Scenario 
dimension. This is the dimension containing the Actual and 
Budget members that we want to group on.

43 Click Add, and Basic.Scenario appears in the Sort Fields list 
box. The report will now contain groups for each of the 
selected members of this dimension.

44 Click Preview Report to generate the new groups in your 
report.

Notice that three separate cross-tabs now appear in the report.

45 Click the Design Tab to view the report in Design mode. Two 
new report sections now appear in your report, a Group 
Header and a Group Footer. In addition, a second cross-tab 
object now appears in the Group Header section.

When the program grouped the report based on the selected 
members of the Scenario dimension, it also copied the cross-
tab object to the Group Header section, resulting in a separate 
cross-tab for each group. Since the first grouping that appears 
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when you preview the report is for the Actual member, the 
cross-tab, likewise, contains Actual data. The second cross-tab 
for the second group, on the other hand, contains Budget data.

Seagate Crystal Reports also left the original cross-tab object in 
the Report Header section. This cross-tab represents summary 
information based on data from all groups. It acts as a type of 
grand total cross-tab. This way, your reports can display cross-
tab information specific to each group, along with a final 
summary cross-tab.

Since the groups you created here are for Actual vs. Budget 
data, a summary cross-tab does not make sense. You will 
remove the cross-tab that appears at the top of the report.

46 From the Design Tab, select the cross-tab object that appears 
in the Report Header section by clicking in the upper left hand 
corner, above the rows and to the left of the columns, and 
press Delete.

NOTE: You may want to resize the Report Header section to make

it smaller now that it does not contain a Cross-Tab object. To do

this, simply drag the boundary at the bottom of the section

upward until the section is an appropriate size.

47 Click the Preview Tab to see the results of the changes you 
made. Two cross-tabs now appear in your report, one for the 
Actual group containing Actual related data, and one for the 
Budget group containing Budget related data.

48 Choose the SECTION command from the Format menu, and 
the Section Expert appears.

49 Select the Group Footer #1: Basic.Scenario in the Sections list 
box, and toggle the New Page After check box on. 

50 Click OK when finished. The report is now split among two 
pages, one for each group and, therefore, one for each cross-
tab. You can finish the report by adding a title, date, and any 
other formatting appropriate to the data.

As you can see, designing cross-tab reports is exceptionally 
easy. OLAP data, by its inherent design, naturally fits the 
cross-tab concept. After designing a few reports using your 
own Essbase data, you will quickly master this powerful 
report design.
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9 Multiple Section Reports

What you will find in this chapter...

Using multiple sections in reports, Page 214

HANDS-ON (Multiple Section Reports), Page 215
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Using multiple sections in reports

Seagate Crystal Reports provides five design areas to use when 
building your report: Report Header, Page Header, Details, 
Report Footer, and Page Footer. 

Each area contains a single section when you first create a report. 
Certain reporting tasks are performed most efficiently by creating 
multiple sections within an area, such as:

●   keeping variable length objects from overwriting each other 
(see How to prevent variable length objects from overwriting each 
other, Page 215),

●   putting conditional messages in form letters (see How to 
print conditional messages in form letters, Page 225),

●   formatting objects/sections differently based on field 
values (see How to format objects conditionally, Page 224),

●   alternating background colors on a row-by-row basis (see 
How to alternate background colors for rows, Page 226),

●   eliminating blank lines when fields are empty (see How to 
eliminate blank lines, Page 227), or

●   adding blank lines under specific conditions (see How to add 
blank lines conditionally, Page 228).

When you understand the power of multiple sections, you will 
discover even more ways that you can use them to produce the 
report effects you want. 
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Related Topics

How to add, delete, move, and merge sections, Page 89

HANDS-ON (Multiple Section Reports)

How to prevent variable length objects from overwriting
each other

When you place subreports or other variable length objects above 
other objects in one section of your report and you have the Can 
Grow option for the variable length object toggled on in the 
Format Editor, that object may overprint objects below it unless 
you have:

●   expanded the section to fit the maximum size of the object, 
and

●   spaced the objects, allowing enough space for the first object 
to complete printing before the second one begins. See 
Types of formatting properties, Page 233.

You can eliminate this overprinting problem by creating multiple 
sections in an area and placing objects below the variable length 
object in their own section(s).

Now, when the report runs, the section with the variable length 
object will finish printing before the section below it prints and 
you will get the results you want. See TWO UNRELATED 
REPORTS, Page 440.
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NOTE: Memo and BLOB fields, as well as subreports, can cause
overprinting.

How to work with text objects

You will use many of the capabilities of text objects as you create 
form letters. A brief discussion of text objects should make it 
easier for you to create the form letter in the next section.

●   A text object can contain both text and fields; you will use 
both in this example. 

●   You can resize text objects; you will be resizing the text 
object so it prints as a letter. 

Text objects operate in two modes: 

1. the move/resize mode, and 

2. the edit mode.

Move/Resize

mode

When the object is in the move/resize mode, it appears as a 
broken line frame with resizing handles.

In this mode, you can resize it by dragging any of the resizing 
handles or move it by placing the cursor inside the object and 
dragging it to a new location. You can also insert fields in this 
mode but you can not insert text. You put a text object into the 
move/resize mode in one of two ways:

1. by clicking the text object when it is inactive, or

2. by clicking the frame when the object is in edit mode.

Edit mode When the object is in the edit mode, it appears as a broken line 
frame without sizing handles and with an in-place ruler at the top 
of the tab. 
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When you first place a text object, the program sets it in the edit 
mode. You can also put a text object into the edit mode by double-
clicking it if it is inactive or in the move/resize mode.

Each text object contains word processor capabilities including 
the ability to change the fonts for individual characters and fields, 
and automatic word wrap. In the edit mode you can insert text 
and such non-text objects as database fields and formulas. 
Whenever the object is in edit mode, it contains an insertion point, 
a flashing vertical line that indicates the position that typed text or 
inserted fields will begin. 

The insertion point moves as you type, automatically staying to 
the right of the last character. It also moves when you insert a 
field, automatically staying to the right of the field. It moves one 
character position at a time when you press the space bar. It 
moves down one line, to the inside left edge of the text object, 
when you press Enter. It moves to your cursor position when you 
click anywhere within the existing text.

As you work through the tutorials for multiple sections, it is 
always expected that you will type or place fields at the existing 
insertion point unless you are told otherwise.

●   To select text in a text object (to delete it, to change a font, 
and so on), position the cursor over the text and, when the I-
beam cursor appears, drag the cursor to highlight the text 
you want to select. See Cursors, Page 64.

●   To select a field in a text object, position the cursor over the 
field and, when the I-beam cursor appears, right-click.

●   To insert text, type in the text you want and it appears at the 
insertion point.

●   To insert a field, you must insert it using a menu command, 
a button, or a dialog box. You can not simply drag a field 
into a text object from elsewhere in the report. When the 
program displays the placement frame, move the frame to 
the text object. The placement frame changes to a drag and 
drop cursor when it is in a position where the field can be 
inserted in the text object. See Cursors, Page 64.
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NOTE: It is critical that you see the drag and drop cursor before

you place the field. If you do not see it, you might place the field

so it overlays the text object instead of being inserted in it. It may

appear to be inside the text object, but if you move the object the

field will not move with it.

●   The insertion point is tied into the drag and drop cursor. If 
you have existing text or fields in the text object, the 
insertion point moves as you move the drag and drop 
cursor, enabling you to pick the exact position where you 
want to place the field. The program always places the field 
at the insertion point.

Related Topics

How to insert text objects, Page 120

How to create a form letter using a text object

While form letters themselves are not necessarily multi-section 
reports, they are often used in multi-section reports to generate 
custom mailings. The topic, How to print conditional messages in 
form letters, Page 225, explains how to use multiple form letters or 
multiple versions of the same form letter for custom mailings. 
This topic shows you how to create a form letter.

You are going to use a text object to create a form letter. The form 
letter you create will be tied to a database table so that each letter 
is customized with company information from a different record.

As you move the drop cursor... the insertion point moves.
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If you have difficulty performing any of the steps in this tutorial, 
please see How to work with text objects, Page 216.

Creating the

form letter

The letter will consist of a date, an inside address, a salutation, a 
one paragraph letter body, and a closing section.

1 Create a report using the Customer Table of CRAZE.MDB. 
The Design Tab appears with the Database Tab active in the 
Insert Fields dialog box.

2 Since you do not want field titles to appear above the fields 
that you insert into the letter, toggle the Insert Detail Field 
Titles option off on the Layout Tab of the File Options dialog 
box.

3 Insert a text object in the Details section of your report. 

4 Click the text object frame to put the object in move/resize 
mode.

5 Drag the resizing handle on the right side of the object to the 
right edge of the Design Tab. This will make the object about 
eight inches wide, the approximate width of a page. You may 
have to stop resizing, scroll the window, and resize some 
more to accomplish this.
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6 Double-click inside the text object to place it in edit mode, 
ready for you to begin your work. When you do this, the 
insertion point will be positioned at the extreme left, inside 
the object.

DATE

1 To put a date into the letter, choose the PRINT DATE FIELD 
command from the Insert|Special Field menu, drag the 
placement frame into the text object, and place it at the 
insertion point.

NOTE: If you want to change the way the date is formatted in the

letter, click the border of the text object to put it in move/resize

mode, highlight the PrintDate field, choose FORMAT [PRINTDATE]
from the shortcut menu that appears, and make your

modifications on the Date Tab of the Format Editor when it

appears.

2 Press Enter twice to put some white space between the date 
and the inside address and move the insertion point down 
within the text object. 
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INSIDE ADDRESS

To create the inside address, drag database fields into the text 
object from the Customer table in the Insert Fields dialog box.

1 Drag in the Address 1 field, place it at the insertion point, and 
press Enter to place the field. The insertion point will move 
down to the line below.

2 Drag in the City field and place it at the insertion point.

3 Type a comma followed by a space.

4 Drag in the Region field and place it at the insertion point.

5 Type in two spaces.

6 Finally, drag in the Postal Code field, place it at the insertion 
point, and press Enter to place the field. The insertion point 
will move down to the line below.

7 Press Enter one more time to move the insertion point down 
one more line to the position where you want to start the 
salutation. This completes the inside address.

NOTE: When you place a field into a text object, it is

automatically trimmed on both the left and right sides so that it

contains no extra white space.
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SALUTATION

1 Press Enter four times to move the insertion point down. 

2 Type in the word “Dear” and a space. (Do not include the 
quotation marks.)

3 From the Insert Fields dialog box, highlight the Contact Title 
field from the Customer table and drag it into the text object, 
placing it immediately after the space.

4 Type in a space. The program positions the insertion point 
immediately after the space.

5 Again from the Insert Fields dialog box, drag the Contact Last 
Name field into the text object and place it at the insertion 
point. The insertion point moves to the right of the field.

6 Type a colon “:” at the insertion point (do not include the 
quotation marks) and press Enter to put in a carriage return 
and move the insertion point to the next line. 
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LETTER BODY

1 Now type “Your company” (do not include the quotation 
marks) and type a comma followed by a space.

2 Drag the Customer Name field into the text object and place it 
at the insertion point, just after the space.

3 Type a comma followed by a space.

4 Type the following text (do not include the quotation marks): 
“helped make 1995 an outstanding year for CRAZE Mountain 
Bikes. I want to thank you and your staff for your support. I 
hope 1996 will be a banner year for you.”

5 Press Enter twice.

6 Type “Sincerely yours” (do not include the quotation marks) 
followed by a comma, then press Enter four times.

7 Finally, to complete the form letter, type your name.

The Design Tab should look similar to this:
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8 Click the PRINT PREVIEW button on the standard toolbar to 
preview the form letter. 

It should look similar to the following: 

How to format objects conditionally

You may want to create a report that uses different formats based 
on field values. For example, you may want to print an 
international report that prints currency values for each country 
in the format that is common in that country. You can do that 
using multiple sections.

1 Create your report. See Tutorial - Customer List, Page 165, and 
Reporting 101, Page 95.
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2 Create one Details section for each country that requires a 
unique format. See How to add, delete, move, and merge sections, 
Page 89.

3 Make certain that each of the Details sections contains the 
same data. For example, every field that you place in the 
Details A section, you must also place in the Details B section, 
Details C section, etc.

4 In the Details A section, click the currency field to select it, 
then click the OBJECT PROPERTIES button on the 
supplementary toolbar. The Format Editor appears.

5 Set the currency values you want to use for the first country. 
See Formatting, Page 231.

6 Click OK to return to your report.

7 Click the SECTION EXPERT button on the standard toolbar. The 
Section Expert appears.

8 Select the Details A section in the Sections list box. Toggle the 
Suppress (No Drill Down) option on.

9 Click the Conditional Formula button to the right of the 
Suppress option and create a formula that specifies the 
conditions under which the section should be suppressed.

For example, if the Details A section contains currency values 
for the UK, you would create a formula that specified that the 
country value is not equal to UK. In other words, suppress the 
section when the country value is not UK. This would make 
the section print only when the record contained a UK value.

10 Repeat Steps 4 through 9 for each additional section.

Now when you print your report, the date and currency data for 
each country will appear in the format that is expected for that 
country. See Conditional formatting, Page 235.

How to print conditional messages in form letters

Many times you may want to print conditional messages in form 
letters. For example, you may want to encourage customers with 
available credit to buy more and those who are over their credit 
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limit to bring their accounts down below the limit once again. You 
can create both of these letters in a single report.

1 Insert a second Details section in your report using the Section 
Expert. See How to add, delete, move, and merge sections, Page 89.

2 Create two form letters. Place a letter that encourages 
customers to buy more in the Details A section of your report; 
place a letter that encourages customers to bring their balance 
down in the Details B section of your report. See How to create 
a form letter using a text object, Page 218.

3 Using the Section Expert, format the Details sections so that 
each is suppressed under certain conditions. For example:

Now, when a record indicates available credit, the buy more letter 
will print. When the account is over limit the over limit letter will 
print. And when the customer is right at the credit limit, nothing 
will print at all.

Related Topics

How to format objects conditionally, Page 224

Conditional formatting, Page 235

How to alternate background colors for rows

Another typical use of multiple sections is to vary the background 
color in alternating lines for the Details section of your report to 
improve readability (a greenbar-paper effect). 

Format this section to be
suppressed when the balance is
less than the credit limit.

Format this section to be
suppressed when the balance is
more than the credit limit.
226 Seagate Crystal Reports User�s Guide



1 Using the Section Expert, insert a second Details section. You 
should now have Details A and Details B sections. See How to 
add, delete, move, and merge sections, Page 89.

2 While in the Section Expert, highlight Details A in the Sections 
list box, click the Color Tab, and set the background color to 
White. See Formatting, Page 231.

3 Click the Common Tab, click the Conditional Formula button to 
the right of the Suppress (No Drill Down) option, and type the 
following formula in the Formula Editor when it appears:

Remainder (RecordNumber,2)<>0

«This formula divides the Record number by 2 and if the 
remainder is something other than zero (which will happen for 
every odd numbered record), it tells the program to suppress 
the section.»

4 Now select Details B and set the background color to Green.

5 Using the technique from Step 3, set the Suppress option 
conditionally for this section using the following formula:

Remainder(RecordNumber,2) = 0

«This formula divides the Record number by 2 and if the 
remainder is equal to zero, it tells the program to suppress the 
section.»

6 Create your report and make certain that the information and 
layout of each of the Details sections is identical. In other 
words, whatever you put in Details A, put it in Details B as 
well.

Now when you run the report, the program will print every even 
numbered line with a white background and every odd 
numbered line with a green background. 

How to eliminate blank lines

It is very common to have two address lines in a customer table, 
one (Address 1) for street address and one (Address 2) that can be 
used for suite number or mail stop. Address 1 usually contains a 
value but Address 2 is often blank. If you create a customer list 
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using this data and stack the fields on top of one another in 
mailing label format, those customer records with an empty 
Address 2 field will print with a blank line. You can eliminate this 
blank line using multiple sections.

1 Using the Section Expert, create two new Details sections so 
you have a total of three. See How to add, delete, move, and merge 
sections, Page 89.

2 Place the Address 2 field in the middle section and the other 
data above and below it as you want it to appear in your 
report.

3 Format the middle section to Suppress Blank Section. See How 
to hide parts of the report, Page 127.

Now, when the report prints, if the Address 2 section is blank, the 
program will not print it and you will not get unwanted blank 
lines in your report.

How to add blank lines conditionally

If you want to print a blank line on your report under specific 
conditions, you can do that using multiple sections. For example, 
you may want to insert a blank line after every fifth record in your 
report.

1 Create two Details sections. See How to add, delete, move, and 
merge sections, Page 89.

Before suppressing blank

lines, the Address2 field prints

a blank line if it is empty.

After suppressing blank lines,

the Address2 field does not

print if it is empty.
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2 Put the report detail data in the top section.

3 Leave the second section empty. 

4 Format the second section to be suppressed unless the 
following condition is met:

Remainder (RecordNumber,5) <> 0

«This formula divides each record number by 5. If the division 
produces a remainder, it suppresses the blank section. But if 
the division produces no remainder, a zero (which it will for 
every fifth record printed), the program prints the second 
section, thus inserting a blank line.»

NOTE: If you want to insert a blank line under different

conditions, you can modify your formula appropriately. See

Conditional formatting, Page 235.
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10 Formatting

What you will find in this chapter...

Formatting concepts, Page 232

Absolute formatting, Page 233

Types of formatting properties, Page 233

Conditional formatting, Page 235

HANDS-ON (Absolute Formatting), Page 238

HANDS-ON (Conditional Formatting), Page 244
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Formatting concepts

In this section, you will learn about formatting your report. 
Formatting refers to those things that you can do to change the 
layout and design of your report, as well as the appearance of text, 
objects, or entire report sections. 

You can use formatting to do many things:

●   separate sections of your report, 

●   call attention to certain data, 

●   change the presentation of dates, numbers, Boolean, 
currency values, and text (strings),

●   hide unwanted sections, or

●   give your report a professional appearance.

Seagate Crystal Reports gives you a wide range of formatting 
commands and properties that you can apply to various elements 
in your report.

●   Use formatting commands by choosing or setting options in 
dialog boxes that are specific to the kind of formatting you 
are doing. For example, if you want to change page 
margins, use a dialog box that lets you specify the top, 
bottom, right, and left margins.

●   Set formatting properties in either the FORMAT EDITOR (for 
objects) or the SECTION EXPERT (for sections) by toggling 
check boxes on and off or by supplying attribute values. In 
most cases, you can set the properties in one of two ways:

   Absolute (always apply the property), or

   Conditional (apply the property only if certain criteria 
are met).

You can use both kinds of formatting properties wherever you 
need them in your report. See Absolute formatting, Page 233, and 
Conditional formatting, Page 235.

In the topics that follow, you will learn about the kinds of formatting 
you can do with Seagate Crystal Reports, and you will get step-by-
step instructions for performing a variety of formatting tasks.
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Absolute formatting

Absolute formatting is formatting that applies under any 
condition. 

SELECT, THEN APPLY

Absolute formatting always follows a select then apply procedure:

●   you select what it is that you want to format (an object or a 
section), and then

●   you apply the formatting to your selection using property 
settings.

Use the following dialog boxes for formatting your reports:

●   Format Editor for formatting field values.

   Borders Tab of the FORMAT EDITOR for formatting 
objects, numbers, and text,

   Box Tab of the FORMAT EDITOR for formatting boxes, and

   Line Tab of the FORMAT EDITOR for formatting lines.

●   Section Expert for formatting entire sections.

Each of these dialog boxes contains a number of different 
formatting properties and the tools for turning the properties on 
or off, or for specifying attributes. Search for the dialog box by 
name in Seagate Crystal Reports online Help.
.

Types of formatting properties

Formatting properties fall into two general categories: 

●   On or Off Properties

●   Attribute Properties
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ON OR OFF PROPERTIES

An on or off property is a property that is set using a check box. 

●   When you toggle the check box on, the property is always 
applied. 

●   When you toggle the check box off, the property is never 
applied.

The Suppress property is one such on or off property; an object or 
section is either suppressed (on) or it is not (off). 

ATTRIBUTE PROPERTIES

An attribute property is a property that specifies one of many 
alternative attributes. The Color property, for example, gives you 
the opportunity to specify one of the 16 basic Windows colors or 
to specify a custom color and then create that color using the tools 
provided. Clearly such a property can not be handled with a 
simple on or off switch. 

You set an attribute property in one of several ways, depending 
on the property. You can set it:

●   by clicking an option button,

●   by selecting an attribute from a drop-down box,
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●   or, by typing an attribute in a text box.

Conditional formatting

Conditional formatting is formatting that applies only under 
certain conditions. For example, you may only want:

●   customer balances printed in red if they are past due,

●   the dates to appear in Day, Month, Year format if the 
customer is Canadian, or

●   background color to appear on every other line.

Seagate Crystal Reports makes it easy for you to apply formatting 
conditionally in these and hundreds of other situations. See How 
to format objects conditionally, Page 224.

With absolute formatting you follow the select then apply 
procedure. For conditional formatting you follow the same 
general procedure, but you go a step further and set up conditions 
that determine whether or not the formatting will be applied. You 
specify those conditions using simple formulas. See Formulas 101, 
Page 321.

NOTE: When you set up a conditional formatting formula, the

formula overrides any fixed settings you have made in the Format

Editor. For example, if you toggle the Suppress option on and then

you set up a conditional formula for the Suppress option, the
property will still apply only if the condition in the formula is met.

The program enables you to set both on and off properties and 
attribute properties conditionally. However, each of these 
requires a different kind of formula.

Conditional on

or off

properties

A conditional on or off property tests to see if a condition has been 
met. It is on if the condition is met, off if the condition is not met. 
There is no middle ground.
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Use Boolean formulas for this kind of formatting.

Value = condition

The program tests each value to see if it meets the condition and it 
returns a yes or no answer. It then applies the property to every 
value that returns a yes answer. 

Conditional

attribute

properties

A conditional attribute property tests to see which of two or more 
conditions are met. The program then applies the formatting 
appropriate to the condition. For example, assume that you want 
values under quota printed in red and all other values printed in 
black. The program tests to see whether the value is under quota 
or not. If it is under quota, it applies the red attribute, if it is not, it 
applies the black attribute. 

Use an If-Then-Else formula for this kind of conditional 
formatting. See How to create if-then-else formulas, Page 346.

If Condition A Then 
Red

Else
Black

NOTE: When you set up conditional attribute properties, the

program loads a selection of attributes into the Functions list in
the Formula Editor. You can double-click any of those attributes

to add them to your formula. For example, if you are setting

horizontal alignment conditionally, the Functions list box will

contain attributes such as DefaultHorAligned, LeftAligned,

Justified, etc.; if you are setting borders conditionally, the

Functions list box will contain attributes such as NoLine,

SingleLine, DashedLine, etc.

You can take this kind of property one step further. You can 
specify a list of conditions and a property for each; you are not 
limited to two or three conditions. For example, if you have a 
number field on your report that contains sales figures from 
countries around the world, you can specify the number 
attribute(s) that you want to apply to each country. In this case, 
your conditions would specify that if it is from Country A, apply 
the Country A attribute; Country B, apply the Country B attribute; 
Country C, apply the Country C attribute, and so on.
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With more than two alternatives, use this kind of formula:

If Condition A Then
Red

Else If Condition B Then
Black

Else If Condition C Then
Green

Else
Blue

Use a multi-condition If-Then-Else formula for this kind of 
conditional formatting. See How to create multi-condition if-then-else 
formulas, Page 348.

Values that do

not fit any

condition

With conditional on or off properties, values will either meet the 
condition you set or they will not. But conditional attribute 
properties are different. There may be some cases where values do 
not fit any of the conditions you set up. 

For example, if you set:

●   all sales figures that are more than 10% over quota to 
appear green, and 

●   all sales figures that are less than 10% over quota to appear 
red,

what is going to happen to values that are exactly 10%? The 
program takes care of that automatically. When a value does not 
fit any of the conditions in the formula (in this example, all values 
that are 10%), the program formats that value using the attribute 
setting in the dialog box. 

In this example, if the Color drop-down box on the Font Tab of the 
Format Editor is set to Blue for the sales field, all values that are 
exactly 10% will appear in blue. The dialog box setting does not 
override the formula setting; it simply provides an attribute when 
the formula does not.

Several Hands-On topics are included showing how to format 
sections and objects conditionally. While the topics detail specific 
reporting needs, they illustrate basic procedures as well.
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HANDS-ON (Absolute Formatting)

How to add color, shading, and borders

Seagate Crystal Reports allows you to add color, borders, and 
shading to fields on your report to emphasize important data and 
create professional looking reports.

1 Right-click the field you want to format and choose the 
CHANGE BORDER command from the shortcut menu that 
appears. 

2 The Format Editor appears. Click the Border Tab to activate it.

3 Select the border type (line style), color, placement, and 
background color you want and click OK when finished. 

The program formats the selected field to your specifications.

How to add/edit lines and boxes

Seagate Crystal Reports allows you to add lines and boxes to your 
report to emphasize important data and create professional 
looking reports.
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Adding lines Click the INSERT LINE button on the supplementary toolbar. A 
pencil-shaped cursor appears.

Editing lines Right-click the line you want to format and choose the FORMAT 
LINE command from the shortcut menu that appears. The Format 
Editor appears with the Format Line Tab active.

Adding boxes Click the INSERT BOX button on the supplementary toolbar. A 
pencil-shaped cursor appears.

Using the pencil

cursor, draw the line

where desired.

Make the desired

changes and click

OK when finished

to return to your

report.
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Editing boxes Right-click the box you want to format and choose the FORMAT 
BOX command from the shortcut menu that appears. The Format 
Editor appears with the Format Box Tab active. 

The program formats the selected box to your specifications.

How to change margins

1 Choose the PAGE SETUP command from the File menu. The 
Page Setup dialog box appears.

Using the pencil

cursor, draw the box

where desired.

Select the color, width,

style, and/or fill color you

want and click OK when

finished.
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All margins are calculated from the paper edge. Thus, a left 
margin of .25 inches causes the printing to start exactly one 
quarter inch in from the edge of the paper.

How to add/delete white space between rows

The height of a section in relation to the objects in it affects the 
amount of white space that appears between rows on your report.

The free form Design Tab allows you to add and delete white 
space two ways: 

1. by sizing the area in the Design Tab using the resizing cursor, or 

2. by changing options using the Section Expert.

Deleting white
space by
resizing

To delete unnecessary white space in a section, simply move the 
mouse pointer over the bottom section boundary line. The pointer 
will change to a resizing cursor.

2 Change the default

page margins to fit your

needs and clickOKwhen

finished.
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Deleting white
space using the
Section Expert

If an entire section is blank (i.e., if you are not putting anything 
into the Page Footer section of your report), you can eliminate the 
unnecessary white space by suppressing the section in the Section 
Expert.

1 Click the SECTION EXPERT button on the standard toolbar. The 
Section Expert appears.

2 Highlight the Page Footer section in the Sections list box.

3 Toggle the Suppress (No Drill-Down) option on.

The Page Footer section will no longer print.

NOTE: You can also right-click the shaded area to the left of the

section and choose the FIT SECTION command from the shortcut

menu that appears. The program automatically resizes the section

so the bottom boundary is even with the baseline of the bottom

object in the section. See How to eliminate blank lines, Page 227.

Adding white
space by
resizing

To add extra white space between rows in your report, simply 
move the mouse pointer over the bottom section boundary line. 
The pointer will change to a resizing cursor.

When the resizing cursor appears

drag the section boundary up to

remove extra white space.

Your report will print like this...
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NOTE: You can also add white space to a section by right-clicking

the shaded area to the left of the section and choosing the INSERT 
LINE command from the shortcut menu that appears. The

program resizes the section automatically, adding the amount of

space necessary to hold a line of typical database fields.

Related Topics

How to add, delete, move, and merge sections, Page 89

How to add blank lines conditionally, Page 228

How to set page orientation and paper size

You can print your reports using portrait or landscape orientation 
in a variety of paper sizes. You specify these options using the 
PRINTER SETUP command on the File menu.

1 Choose the PRINTER SETUP command from the File menu. The 
Print Setup dialog box appears.

When the resizing cursor appears

drag the section boundary down

to add extra white space.

Your report will print like this... 
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2 Activate the printer you want to use if it is not already the 
active printer. Your paper size options are directly related to 
the printer you have selected. 

For example, the HP LaserJet driver (PCL) offers a choice of 
letter, legal, executive or A4 paper sizes, whereas the 
PostScript printer driver lets you choose from letter, legal, 
note, A4, B5, letter small, and A4 small paper sizes.

3 Select either Portrait or Landscape orientation by clicking the 
appropriate option button in the Orientation section. 

4 Select the paper size desired and its source from the drop-
down boxes in the Paper section.

5 Click OK when finished.

HANDS-ON (Conditional Formatting)

How to create a footer that appears on all pages but the first

You can print a page footer on all pages except the first page. You 
do this by formatting the page footer section conditionally using 
an on or off property.
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1 Place the field you want to display as a page footer in the Page 
Footer section of your report.

2 Click the SECTION EXPERT button on the standard toolbar. The 
Section Expert appears.

5 Enter the following formula in the Formula text box:

PageNumber = 1

This formula suppresses the section on the first page but not on 
any of the other pages. 

6 Click the Accept button. 

●   If there is an error in your formula, a Formula Compiler 
Error will be displayed detailing your error. 

●   If there is no error in your formula, you will be returned to 
the Section Expert. Notice that the Formula button has 
changed. This indicates that a formula has been entered for 
that property.

Search for Formula Compiler Errors in Seagate Crystal Reports 
online Help.

4 Click the Conditional Formula button
to the right of the Suppress property to

open the Formula Editor.

3 Highlight the Page Footer
section from this list.
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7 Click the PREVIEW button on the standard toolbar to preview 
your report ensuring that the page footer appears on all pages 
but the first.

NOTE: If you have a multi-line page footer and you have put the

lines into separate Page Footer sections, you will need to suppress

each of those sections conditionally using the formula above.

NOTE: To create a page header that appears on all pages but the

first, put your header information in the Page Header section and

then suppress that section conditionally using the same formula

that was used for suppressing the Page Footer section.

How to flag values that meet certain conditions

You can flag field values that meet certain conditions by 
formatting the field conditionally using an attribute property.

For the purpose of this example, assume you have a Last Year’s 
Sales field in your report and you want the value to print in Red if 
sales were less than $10,000 and to print in Black in all other cases. 
In this way you are using color to flag values that fall below a 
certain threshold.

1 Right-click the Last Year’s Sales field and choose the FORMAT 
FIELD command from the shortcut menu that appears. The 
Format Editor appears. Click the Font Tab to activate it.
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3 Enter the following formula in the Formula text box:

If {customer.LAST YEAR’S SALES} < 10000 Then
Red

Else
Black

See How to create if-then-else formulas, Page 346.

4 Click the Accept button. 

●   If there is an error in your formula, a Formula Compiler 
Error will be displayed detailing your error. 

●   If there is no error in your formula, you will be returned to 
the Section Expert. Notice that the Formula button has 
changed. This indicates that a formula has been entered for 
that property.

Search for Formula Compiler Errors in Seagate Crystal Reports 
online Help.

5 Click OK to return to your report. 

Now, when you run your report, if the value in the Last Year’s 
Sales field is less than $10,000, the value will print in red.

2 Click the Conditional Formula button
to the right of the Color drop-down box

to open the Formula Editor.
Formatting 247



248 Seagate Crystal Reports User�s Guide



11 Record and Group Selection

What you will find in this chapter...

Record selection, Page 250

Group selection, Page 254

Record selection formula templates, Page 256

HANDS-ON (Record Selection)
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Record selection

Specifying

records/groups

to be included

When you select a field to appear on your report, field values from 
every record in the active table(s) are printed by default. In many 
cases, you may not want to include all the values, but only a 
subset of those values. For example, you may want to:

●   include records only for a specific group of customers,

●   include records for a specific range of account numbers out 
of the total number of records in the database, or

●   include values from only those records that fall within a 
particular date range. 

You can select records in one of two ways:

1. by using the Select Expert, or

2. by using the Formula Language.

Setting up

record

selection

USING THE SELECT EXPERT

Seagate Crystal Reports includes a very sophisticated formula 
language that you can use to specify virtually any kind of record 
selection that you want. Many times, however, you may not need 
the flexibility in record selection that the formula language 
provides. The Select Expert is designed for times like that. 

NOTE: You can use the Select Expert to set up record selection

and group selection requests. When you select either a group

name or a summary field, the program knows that the selection

criteria you set up is intended for group selection. In all other

cases, the program knows that you are setting up record selection.

The Select Expert makes it easy to specify the records you want 
included in your report. You simply highlight the field that you 
want to base your selection on and then set the selection criteria. 
If you want to set additional criteria for the selected field or if you 
want to base record selection on additional fields, the Select 
Expert provides the tools you need to do it. See How to set up record 
selection using the Select Expert, Page 263, and search for Select 
Expert in Seagate Crystal Reports online Help.
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Using the Expert you can set up simple record selection requests:

●   customers from Arizona,

●   orders in the first quarter, or

●   sales over $10,000.

You can also use it to set up some very sophisticated requests:

●   customers whose names start with “A”, “M”, or “S”, or

●   customers from California or Florida who ordered in July.

These are all range limit requests. One or more constants define 
the range. The program compares the field value in each record to 
the constant(s) and rejects records with values outside the range. 
The report is thus limited to values within the range. The Select 
Expert handles requests like this with ease.

NOTE: If you want to create a range limit request based on part of

a field value, you are limited as to what you can do in the Select

Expert.

You can set up all of these kinds of record selection requests 
without any previous knowledge of the formula language.

NOTE: You can use the formula language from within the Select

Expert if you wish, but that masks its main purpose. The Select

Expert�s purpose is to create powerful record selection requests

using simple point-and-click processes.

USING THE FORMULA LANGUAGE

If you are planning to create a selection formula using the formula 
language, you can go directly to the appropriate Selection 
Formula Editor using the EDIT SELECTION FORMULA command on 
the Report menu. Choose either the RECORD or GROUP command 
from the submenu when it appears.

When you are in the Selection Formula Editor, you can build your 
selection request using fields, functions, operators, and other 
formulas. Your only restriction is that the resulting formula must 
be Boolean, that is, it must return either a True or False value. 
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Related Topics

For complete instructions on creating formulas, see Formulas 101, 
Page 321. 

For sample record and group selection templates, see Record 
selection formula templates, Page 256, and How to use record/group 
selection templates, Page 266. 

Search the Record/Group Selection Templates topic in Seagate 
Crystal Reports online Help.

DETERMINING WHAT FIELD(S) TO USE

When you select records, you are basing your report only on those 
records that meet some conditions that you set. You base those 
conditions on what kind of information you want in your finished 
report. 

Assume, for example, that you want a report that only shows 
California data. Your challenge is to find the best way to identify 
those records that come from California.

●   If the table that you are using for your report has a State 
field or a Region field, you can specify in your request that 
the program use only those records where the value in the 
state field is equal to California (Region is equal to CA). This 
is clearly the easiest way. 

●   If the table does not have a State field and you still want to 
report only on California data, there may be a way to 
identify that data in some other way. 

   If the table has a Postal Code field, you could base you 
record selection on the range of ZIP codes that apply to 
California (Postal Code is between n and N).

   If the table has an Area Code field, you could base your 
record selection on California Area Codes (Area Code is 
one of x, y, ....z). 

NOTE: If the Area Code is stored in the telephone number field,

you will not be able to do this same record selection using the

Select Expert based on the Area Code. You will have to create a

record selection formula using the formula language to extract the

Area Code part of the phone number and then do record selection

on that. Search for Subscript in Seagate Crystal Reports online Help.
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Clearly you are not locked into any one method of record 
selection. Just because you are not locked into it, however, you 
should still use care when you set up your selection criteria. For 
details of some of the things you should consider, see Selection 
performance tips, Page 260.

NOTE: As a general rule, if you can base your record selection on

a number of fields (as in this example), select an indexed field

instead of a field that is not indexed. See Indexed tables, Page 518.

Interaction of

the Select

Expert and the

Selection

Formula Editor

The Select Expert and the Selection Formula Editor are interactive. 
That is, record selection criteria you enter via the Select Expert 
automatically generates a record selection formula that you can 
review and modify using the Show Formula button in the Select 
Expert or the Record Selection Formula Editor. Likewise, record 
selection formulas and modifications to existing record selection 
formulas automatically update the selection criteria in the Select 
Expert.

Because of this interactivity, you can use the two facilities together 
as a tutorial for learning the formula language.

1 Set up your selection criteria using the Select Expert.

2 Click the Show Formula button and the Select Expert expands 
so you can review the formula the program generated based 
on your criteria.

3 Click the Hide Formula button when you are done with your 
review.

4 Change your selection formula using the Select Expert.

5 Review the updated formula by clicking the Show Formula 
button again.

6 As you gain confidence and want to make changes using the 
formula language, click the Formula Editor button in the 
expanded Select Expert and make your formula changes 
using all the tools in the Record Selection Formula Editor.

7 Review the results of those changes in the Select Expert. Select 
each field used in the record selection formula and see how 
the program translates your formula into Expert selection 
criteria.
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NOTE: Selection formula components that do not fit any of the

fixed criteria in the Select Expert will not be translated. For

example, if part of your record selection formula extracts the last

four characters in a customer number, the section of the formula

code that does that extraction will not be converted to Select

Expert selection criteria. This is because there is no facility in the

Select Expert to make such an extraction by pointing and clicking.

Group selection

When you group or summarize data, all the groups in your report 
are included by default. There may be times, however, when you 
do not want to include all the groups. For example: 

●   You may only want to include those groups that have 
certain group names, or whose summarized values meet a 
certain condition. 

●   You might want to see only the groups with the highest 
summary values, or the lowest. 

You can select the groups that appear in your report in several 
different ways.

You can do some kinds of selection using either a record selection 
formula or a group selection formula. For example:

●   If you have a mailing list grouped by Region and your 
record selection formula specifies only California customers 
({customer.REGION} = “CA”), your report will have only a 
single group: California. 

●   If you have a group selection formula that specifies only 
groups with the group name “CA” 
(GroupName({customer.REGION}) = ”CA”) and no record 
selection formula, you will get an identical report, assuming 
that the California condition was the only selection test in 
both situations. When using the group selection method, 
however, it could conceivably take longer to get the report 
back.

●   Some kinds of selection you can do using either a record 
selection formula or a group selection formula. For 
example, if you have a mailing list grouped by Region and 
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your record selection formula specifies only California 
customers ({customer.REGION} = “CA”), your report will 
have only a single group: California. If you have a group 
selection formula that specifies only groups with the group 
name “CA” (GroupName({customer.REGION}) = ”CA”) 
and no record selection formula, you will get an identical 
report, assuming that the California condition was the only 
selection test in both situations. When using the group 
selection method, however, it could conceivably take longer 
to get the report back.

Select Expert You can select groups of records using the Select Expert just like 
you can select individual records.

Instead of basing your selection criteria on standard fields like 
you do for record selection, however, you base it on group name 
fields or summary fields when you are setting group selection 
criteria.

●   If you have simply grouped your data but you have not 
summarized it, you can only set up group selection based 
on the group name field. For example you may want to 
select only those groups whose Region is Massachusetts:

GroupName ({Customer.REGION}) = “MA”

●   If you have summarized your data, you can set up group 
selection based either on the group name field or on the 
summary field. For example:

Sum({Customer.LAST YEAR’S SALES}, 
{Customer.REGION}) > 10000

NOTE: You can use the Select Expert to set up record selection

and group selection requests. When you select either a group

name or a summary field, the program knows that the selection

criteria you set up is intended for group selection. In all other

cases, the program knows that you are setting up record selection.

Formula

language

You can select groups using the formula language. To do this you 
activate the Group Selection Formula Editor by choosing the 
GROUP command from the Report|Edit Selection Formula menu. 

In the Formula Editor you can build your group selection request 
using group fields, group name fields, and other formulas. As was 
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the case with record selection formulas, your only restriction is 
that the formula you create must be Boolean, that is, it must return 
either a True or False value. See Formulas 101, Page 321. 

Top N Many times, you might want to show only the “top” or “bottom” 
groups in a report: the fastest selling product lines, the least 
productive sales regions, the states that generate the most orders, 
etc. Because this kind of group selection is so popular, the 
program includes the Top N Sort Group Expert for setting it up 
easily.

You access the Top N Sort Group Expert by clicking the TOP N 
button on the supplementary toolbar. Using this Expert, you 
specify whether you want to display the Top N or Bottom N 
groups, and then you specify what number N is. 

For example:

●   if you want to report on the three fastest selling product 
lines, select the top N option in the Top N Sort Group 
Expert and set N to be equal to three, or

●   if you want to report on the five least productive sales 
regions, select the bottom N option in the Top N Sort Group 
Expert and set N to be equal to five.

The program will display those groups as specified.

But there is one other consideration with Top N group selection 
and that is what to do with all the records from other groups that 
do not fit the Top N or Bottom N criteria you set. You need to 
decide whether to eliminate those records from your report 
entirely or to lump them all together in a single group with the 
name you specify. The program enables you to do either. See How 
to select the top or bottom N groups, Page 267.

Record selection formula templates

Formula

templates

The following example formulas can be used as templates to help 
you create your own selection formulas using the Record 
Selection Formula Editor. The examples illustrate different kinds 
of selections that you can do, not necessarily the selection that is 
best to do from a performance standpoint. To help identify the 
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best way to set up your record selection, see Selection performance 
tips, Page 260.

NOTE: All of these formulas are available in Seagate Crystal

Reports online Help so you can copy them directly into the

Selection Formula Editor. Search for Record selection formula 
templates in Seagate Crystal Reports online Help.

Record

selection

templates

FOR SELECTING RECORDS USING CHARACTER STRINGS

“C” in {file.FIELD}[1]

«Selects those records in which the value in the {file.FIELD} 
field begins with the character “C” (includes values like 
CyclePath, Corp. and Cyclist’s Trail Co.; excludes values like 
Bob’s Bikes Ltd. and Feel Great Bikes, Inc.).»

not (“C” in {file.FIELD}[1])

«Selects those records in which the value in the {file.FIELD} 
field does not begin with the character “C” (includes values 
like Bob’s Bikes Ltd. and Feel Great Bikes, Inc.; excludes values 
like CyclePath, Corp. and Cyclist’s Trail Co.).»

“999” in {file.FIELD}[3 to 5]

«Selects those records in which the 3rd through 5th digits of 
the {file.FIELD} field is equal to “999” (includes values like 
10999, 70999, and 00999; excludes values like 99901 and 
19990).»

“Cycle” in {file.FIELD}

«Selects those records in which the value in the {file.FIELD} 
field contains the string “Cycle” (includes values such as 
CyclePath Corp. and CycleSporin, Inc.; excludes values like 
Cyclist’s Trail Co. and Feel Great Bikes, Inc.).»

FOR SELECTING RECORDS USING NUMBERS

Single values

{file.FIELD} > 99999 

«Selects those records that have a value in the {file.FIELD} field 
greater than 99999.»
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{file.FIELD} < 99999 

«Selects those records that have a value in the {file.FIELD} field 
less than 99999.»

Range of values

{file.FIELD} > 11111 and {file.FIELD} < 99999 

«Selects those records that have a value in the {file.FIELD} field 
greater than 11111 but less than 99999 (neither 11111 or 99999 
is included in the range of values).»

{file.FIELD} >= 11111 and 
{file.FIELD} <= 99999 

«Selects those records that have a value in the {file.FIELD} field 
greater than 11111 but less than 99999 (both 11111 and 99999 
are included in the range of values).»

FOR SELECTING RECORDS USING DATES

The Month, Day, and Year functions can all be used in examples 
like the following:

Year ({file.DATE}) < 1996 

«Selects those records where the year found in the {file.DATE} 
field is earlier than 1996.»

Year ({file.DATE}) > 1992 and 
Year ({file.DATE}) < 1996

«Selects those records where the year found in the {file.DATE} 
field falls between 1992 and 1996 (1992 and 1996 not included).»

Year({file.DATE}) >= 1992 and 
Year({file.DATE}) <= 1996

«Selects those records where the year found in the {file.DATE} 
field falls between 1992 and 1996 (1992 and 1999 are included).»

Month({file.DATE}) in 1 to 4

«Selects those records in which the month found in the 
{file.DATE} field is one of the first four months of the year 
(includes January, February, March, and April).»
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Month({file.DATE}) in [1,4]

«Selects those records in which the month found in the 
{file.DATE} field is the first or fourth month of the year 
(includes January and April, excludes February and March).» 

SELECTING RECORDS USING PRESET DATE RANGES

You can use preset date ranges to create selection formulas similar 
to these:

{file.DATE} in LastFullMonth

«Selects those records where the date found in the {file.DATE} 
field falls within the last full month. (If the month is May, this 
selects all records with an April date.)»

not({file.DATE} in LastFullMonth)

«Selects all records except those in which the date found in the 
{file.DATE} field falls within the last full month. (If the month 
is May, this selects all records except those with an April 
date.)»

{file.DATE} < Today

«Selects all records in which the date found in the {file.DATE} 
field falls before today's date.»

SELECTING RECORDS USING DATE/NUMBER/

CHARACTER COMBINATIONS

These formulas simply “mix and match” formulas from the 
categories above. 

“C” in {file.FIELD}[1] and Month({file.DATE}) 
in [1,4]

«Selects those records in which the value in the {file.FIELD} 
field begins with “C” and the month is either January or April. 
For example, if this kind of formula was used with an order 
database, you could be asking for a report showing all 
customers whose names begin with “C” and who placed 
orders in January or in April.»
Record and Group Selection 259



“AOK” in {file.HISTORY}[3 to 5] and 
{file.OPENCRED} >= 5000

«Selects those records in which the {file.HISTORY} field shows 
the characters “AOK” as the 3, 4, and 5 characters and the 
{file.OPENCRED} field (the amount of available credit) is at 
least 5000.»

You can use these templates as is (with your own data), or 
combine them to create complex formulas, or you can use the 
principles illustrated here plus Seagate Crystal Reports online 
Help topics for functions and operators to create powerful 
selection formulas for yourself. Search for functions or operators 
by name in Seagate Crystal Reports online Help.

Selection
performance
tips

There are a number of performance-related items that you should 
consider when you are setting up your selection requests:

●   Record selection will be faster if it is based on indexed fields 
instead of non-indexed fields. See Indexed tables, Page 518.

●   If you have based record selection on indexed fields, make 
sure the Use Indexes or Server for Speed option is toggled on in 
the Report Options dialog box. Search for Report Options 
dialog box in Seagate Crystal Reports online Help.

●   Avoid performing record selection based on formula fields 
if at all possible because it will result in less efficient 
reporting. For example, assume you have a formula field 
(@ExtendedPrice) in your report that returns the extended 
price of a line item (Quantity * Price). If you base your 
selection criteria on that formula (@ExtendedPrice > 1000, 
for example), the SQL server will not understand the 
formula so the program will not pass the selection criteria 
down to the server. Instead it will retrieve all of the records 
from the server, and then it will apply record selection on 
the client machine. This can tie up network resources and 
slow processing time considerably.

●   Try to avoid subscript ranges such as: 

{file.FIELD}[1 to 5]
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The program parses selection formulas and converts 
anything it can to SQL so that the bulk of the work can be 
off-loaded to the SQL server. Because there is no SQL 
equivalent to subscript ranges, SQL pass through will not 
occur. Subscripting of only the first character works, but 
subscripting multiple characters does not. Search for 
Subscript in Seagate Crystal Reports online Help.

●   When using SQL/ODBC data sources, if you are unsure if 
the record selection is passing through to SQL or not, check 
it by choosing the SHOW SQL QUERY command from the 
Database menu. If the SQL query does not have a WHERE 
statement or if the WHERE statement does not mention all 
of your fields that you are dealing with in your record 
selection, then you will need to work through the formula 
again since the translation did not occur properly.

   Make sure you have logged on to your data source 
before choosing the SHOW SQL QUERY command from 
the Database menu.

   SQL syntax will change with different drivers (ODBC or 
SQL) but the majority follow the Oracle SQL model as a 
guide. Consider the fact that your driver may use 
slightly different syntax. This is also the case for non-
SQL databases.

●   Do not perform any data type conversions in the record 
selection formula (for example, converting a number to a 
string using the ToText function). Such conversions can not 
be translated to SQL so SQL pass through will not occur. 
Search for ToText in Seagate Crystal Reports online Help.

Record
selection with
a group
selection
formula

If you need to perform record selection on indexed and non-
indexed fields, you can set up your record selection in two steps 
to maximize performance. You do this by creating a record 
selection formula and a group selection formula, and using them 
both to select records. A little explanation is called for here.

The Group Selection Formula Editor has the same functionality as 
the Record Selection Formula Editor. While its primary use is for 
setting up group selection, it can be used to set up record selection 
as well.
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While the two Formula Editors are fundamentally the same and 
the formulas they produce look the same, they each produce 
formulas that are evaluated at different times.

●   The formulas from the Record Selection Formula Editor get 
evaluated as the program reads records.

●   The formulas from the Group Selection Formula Editor get 
evaluated as the program is printing records. At this point, 
the only records that are saved with the report are those that 
passed record selection criteria.

Using this functionality:

●   You set up record selection based exclusively on indexed 
fields in a record selection formula.

●   You set up record selection based exclusively on non-
indexed fields in a group selection formula.

Since the program runs record selection when it reads records and 
it runs group selection when it prints records, the following 
events occur:

●   The record selection formula on the indexed fields quickly 
returns a subset of data from your database. For this 
example, lets say that it returns 5000 records out of 100,000 
and saves them in a buffer.

●   The group selection formula performs record selection but 
only on the subset of data (5000) records that is saved with 
the report. 

You accomplish the same record selection but do it in a more 
efficient manner. With really big databases, this technique can 
save you significant processing time.

Related Topics

Formulas 101, Page 321

Advanced Formulas, Page 345

Search for Functions in Seagate Crystal Reports online Help.

Search for Operators and Variables in Seagate Crystal Reports 
online Help.
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HANDS-ON (Record and Group Selection)

How to set up record selection using the Select Expert

When you work with the Select Expert, you select the field you 
want to apply selection conditions to and then you specify the 
conditions. 

1 You can begin your work in the Select Expert in one of two 
ways:

●   Highlight the field in your report on which you want to 
base record selection and then click the SELECT EXPERT 
button on the standard toolbar. The program opens the 
Select Expert, ready for you to set the conditions on the 
highlighted field. 

●   Without highlighting a report field, click the SELECT EXPERT 
button on the standard toolbar. The Choose Field dialog box 
appears with indexed fields identified with colored 
arrowheads. Select the field you want to base your selection 
on (preferably an indexed field, see Indexed tables, Page 518) 
and click OK. The Select Expert appears. See Selection 
performance tips, Page 260, and search for Choose Field dialog 
box in Seagate Crystal Reports online Help.

3 Use the drop-down boxes to enter your

selection criteria for the indicated field.

2 If you want to base your record selection on more

than one field, click the New Tab and choose your next

field from the Choose Field dialog box when it appears.
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4 Click OK when you are finished.

A selection formula will be generated based on your specifications 
which will limit the report to the records you indicated.

NOTE: To view or edit the selection formula, click the Show 
Formula button. The Select Expert expands to show the formula. If
you want to use the tools in the Formula Editor to modify the
formula, click the Formula Editor button. The formula will appear
in the Formula Editor.

How to set up group selection using the Select Expert

When you work with the Select Expert, you select the summary 
field you want to apply selection conditions to and then you 
specify the conditions. 

1 You can begin your work in the Select Expert in one of two 
ways:

●   In your report, highlight the summary field on which you 
want to base group selection and then click the SELECT 
EXPERT button on the standard toolbar. The program opens 
the Select Expert, ready for you to set the conditions on the 
highlighted group field.

●   Without highlighting a group field in the report, click the 
SELECT EXPERT button on the standard toolbar. The Choose 
Field dialog box appears. Select the group field you want to 
base your selection on and click OK. The Select Expert 
appears.

NOTE: Summary fields identify the location of the summary
value, the field that triggers a grouping when its value changes,
the kind of summary, and the field being summarized, and they
look similar to this in the Choose Field dialog box:

Group Footer #1: Customer.Region
Sum of Last Year’s Sales
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If you have not already previewed the report or refreshed the 
data, there will not be any data saved with the report. Without 
the data, the program can not calculate group values, thus no 
values appear when you click the arrow in the right drop-
down box. In this situation, you will have to type in the values 
you want. If you want real values to work with, you will need 
to preview your report first. This will calculate the actual 
summary values for you to work with. 

4 When you are finished, click OK in the Select Expert to return 
to your report.

How to create a record or group selection formula

NOTE: In order to create a selection formula, you need to have
some understanding of the formula language and the use of the
Formula Editors. For a thorough discussion of those tools, see
Formulas 101, Page 321, and Advanced Formulas, Page 345.

1 Choose the EDIT SELECTION FORMULA command from the 
Report menu. A submenu appears.

3 Use the drop-down boxes to enter your

selection criteria for the indicated field.

2 If you want to base your group selection on more

than one field, click the New Tab and choose your next

field from the Choose Field dialog box when it appears.
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2 Enter your selection formula in the Formula text box as you 
would any other formula. Since this is a selection formula, 
however, the formula must be Boolean (return either a True or 
False value).

3 Click OK when finished.

4 If the Formula Editor reports errors, debug the formula as 
necessary and click OK again. See How to debug a formula, Page 
370.

Now, when the program runs the report it will include only those 
records or groups of records that you specify. See How to set record 
selection using parameter fields, Page 396.

How to use record/group selection templates

1 Select the template you want to use. You can do this in one of 
two ways:

●   Review the list in Record selection formula templates, Page 256, 
and write down the formula of interest.

●   Find the Record/Group Selection Templates topic in Seagate 
Crystal Reports online Help and copy the formula of 
interest to the Clipboard.

2 Choose the EDIT SELECTION FORMULA command from the 
Report menu. A submenu appears.

Choose Record if you want to create a

record selection formula. The Record

Selection Formula Editor will appear.

Choose Group if you want to create a

group selection formula. The Group

Selection Formula Editor will appear.
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3 In the Formula text box, type in the formula you wrote down in 
Step 1 or paste it from the Clipboard.

4 Replace the values (fields, text, etc.) in the formula with the 
values you want. For example, if the example formula is:

{file.FIELD} > 99999

and you want to limit your report to records that have a value 
in the {orders detail.QUANTITY} field greater than 25, simply 
replace the existing values with the values you want so your 
selection formula reads:

{orders detail.QUANTITY} > 25

5 Click Accept when finished to accept the selection formula and 
return to your report.

6 Click the REFRESH button on the standard toolbar to preview 
the results.

How to select the top or bottom N groups

NOTE: Your report must contain a summary value to be able to
perform a top N or bottom N selection.

When you select top N or bottom N groups:

●   choose whether you want to show the top or the bottom 
groups,

●   specify how many groups to show, and

●   tell the program how to deal with the records that are not in 
one of the selected groups.

Choose Record if you want to create a

record selection formula. The Record

Selection Formula Editor will appear.

Choose Group if you want to create a

group selection formula. The Group

Selection Formula Editor will appear.
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1 Create your report and summarize the data as desired. When 
you summarize the data, the program breaks the data into 
groups and summarizes each group. 

●   With top N grouping, you are instructing the program to 
display those groups that have the highest summary values 
(Top N).

●   With bottom N grouping, you are instructing the program 
to display those groups that have the lowest summary 
values (Bottom N).

2 Click the TOP N EXPERT button on the supplementary toolbar. 
The Top N/Sort Group Expert appears with a tab for your 
group.

NOTE: If you have multiple group sections, the program will
display a tab for each of the groups.

The summary drop-down box (on the right) is for those cases 
in which you have multiple summaries in a single group 
section. For example, in an orders report, you may sum and 
average the orders for each customer and display both the sum 
and the average in the same group section. In such a case you 
would select the sum or the average from this drop-down box.

3 Choose Top N, Bottom N, or Sort All from this list.

4 Choose the summary that you

want to base your selection on.
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5 In the where N is text box, enter the number of groups you 
want to display. For example, if you want to display the top 
five groups, type “5” in this box.

6 All that is left is deciding what you want to do with all those 
records that do not fit into the selected groups.

●   Toggle the include Others, with the name check box off if you 
want the other records excluded from the report.

●   Toggle the check box on and name the group if you want to 
lump all the other records into a single group.

7 Click OK when you are finished. 

Now, when the program runs the report, it will include only those 
groups that you specified.
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12 Sorting, Grouping, and
Totalling

What you will find in this chapter...

Sorting, Grouping, and Totalling Overview, Page 272

Creating custom groups, Page 277

HANDS-ON (Sorting, Grouping, and Totalling), Page 280
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Sorting, Grouping, and Totalling Overview

Sorting, grouping, and totalling are the steps that turn 
disorganized data into useful information on a report. Following 
is an introduction to the concepts behind sorting, grouping, and 
totalling. Refer to the many Hands-On tutorials for detailed 
instructions for most of the things you want to be doing in these 
areas.

Sorting Sorting means putting values in some kind of order to help you 
find and/or evaluate them. For example, information in a phone 
book is sorted because it would have little usefulness if it was not 
sorted. Trying to find someone’s phone number in an unsorted 
book would entail a random search through tens of thousands of 
names, a true needle-in-a-haystack experience. With sorting, 
however, you can find the number you need in a hurry. For 
example, if you are looking for the phone number of a John J. 
Smith, you might use the following levels of sorting to find it.

●   The data is sorted by last name so you know the name 
Smith is in the S section of the book and you turn there 
immediately. 

●   When you find the Smiths, (and there are a lot of them) you 
see that they are sorted by first name so that John Smith 
comes after Bob Smith. You turn to the John Smiths.

●   Finally, when you find the John Smiths (and here again, 
there are several of them), you see that they are sorted by 
middle initial so the John J. Smiths come after the John D. 
Smiths. You turn to John J. Smith, find his phone number, 
and place the call.

Thanks to sorting you can find anybody’s listed phone number in 
seconds.

Sorting by

record

When you sort, the program asks you to select two things:

●   the field you want your sort to be based on (sort field), and

●   the sort direction.
272 Seagate Crystal Reports User�s Guide



SORT FIELD

A sort field is a field that determines the order in which data 
appears on your report. Seagate Crystal Reports sorts field data 
using rules specific to the Country you select in the International 
section of the Windows Control Panel (Windows 3.x, Windows 
NT 3.51 or 4.0) or the Regional section (Windows 95).

You can use any field as a sort field including formula fields. A 
field's data type determines the method in which the data from 
that field is sorted: 

●   String fields are sorted in the following manner:

   Single character values are sorted so that blanks have 
the lowest value, then punctuation, then numbers, then 
uppercase letters, and finally lowercase letters. 

   Then two character values are sorted, then three, etc., 
using the same rules. As a result:

   “BOB” comes before “bob”, 

   “123” comes before “124”, 

   “ “ (blank) comes before “a”, and 

   “aa” comes before “aaa”.

●   Currency fields are sorted in numeric order.

●   Number values (120 or 5555) are sorted in numeric order.

●   Date fields are sorted in chronological order.

●   DateTime fields are sorted in chronological order by date 
and same-date values are then sorted by time.

●   Time fields are sorted in chronological order.

●   Boolean comparison fields are sorted so that False values (0) 
come first, then True values (1). 

When you select a sort field, the program sorts the values from 
that field.

SORT DIRECTION

Direction refers to the order in which the values are displayed, 
once sorted. 
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●   Ascending
Ascending order means smallest to largest, 1 to 9, A to Z, 
False to True. The program sorts the records in ascending 
order based on the values in the sort and group by field you 
select, and then it begins a new group whenever the value 
changes (from Adams to Brown, for example).

●   Descending
Descending order means largest to smallest, 9 to 1, Z to A, 
True to False. The program sorts the records in descending 
order based on the values in the sort and group by field you 
select, and then it begins a new group whenever the value 
changes.

When you group data you have two more sort direction options:

●   Original
Original order means the order the data was originally 
saved in the database. The program leaves the records in 
the order in which they appear in their originating database 
table, and it begins a new group whenever the value 
changes in the sort and group by field you select.

●   Specified order
Specified order means a user-defined order. The program 
puts each record in the custom group you specify, and it 
leaves the records in each group in original order or it sorts 
them in ascending or descending order, depending on your 
instructions. See Creating custom groups, Page 277.

Single field

sorts

Single field sorts are sorts in which all the records used in the 
report are sorted based on the values in a single field. Sorting an 
inventory report by stock number or sorting a customer list by 
customer number are examples of single field sorts. See Results 
using different sorting and grouping operations, Page 275, and How to 
do a single field sort, Page 281.

Multiple field

sorts

In multiple field sorts, Seagate Crystal Reports first sorts the 
records based on the values in the first field selected, putting them 
in ascending or descending order as specified. When two or more 
records have the same field value in the first sort field, it then sorts 
those records only based on the value in the second sort field. For 
example, in a sort on last name and then first name (in ascending 
order), “Smith, Bob” would be returned before “Smith, John” no 
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matter which way the fields are listed in the database. It follows a 
similar process for three field sorts, four field sorts, and so on. See 
Results using different sorting and grouping operations, Page 275, and 
How to do a multiple field sort, Page 283.

Sorting and

grouping

Seagate Crystal Reports has the most powerful sorting and 
grouping capabilities of any Windows based report writer. When 
you select a grouping option, the program automatically sorts the 
data as part of the grouping operation. See Results using different 
sorting and grouping operations, Page 275.

Results using

different

sorting and

grouping

operations

The following chart shows the way data would appear after being 
manipulated using different sorting and grouping operations.

●   Column 1
 The data as it appears in the database table.

1 2 3 4 5 6 7 8 9

CO AZ WA AZ WA CO WA CA WA
WA CA WA WA CA CA WA

CA CA WA CA WA WA CA CA WA
CA CA CO CA CA CA CA

CA CA CO CA CO CA WA CA CA
AZ CA CA CA CO CA WA WA CA

WA CO CA CA CA CA WA CA
WA CO CA CA CA WA CA

CA WA CA CO CA AZ
CA WA CA CO CA CO AZ CO

CO WA AZ CA WA AZ CO CO
WA CA WA CO CO AZ

WA
WA AZ CA

CA

CO
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●   Column 2
The data from Column 1 sorted in ascending order (A to Z, 
1 to 9). There is no grouping.

●   Column 3
The data from Column 1 sorted in descending order (Z to A, 
9 to 1). There is no grouping.

●   Column 4
The data grouped in ascending order. The program 
automatically sorts the data in ascending order and then 
inserts a group break whenever the value changes.

●   Column 5
The data grouped in descending order. The program 
automatically sorts the data in descending order and then 
inserts a group break whenever the value changes.

●   Column 6
The data grouped in original order. The data is not sorted 
before it is grouped. The program inserts a group break 
whenever the group value changes. Note that similar values 
may appear in more than one group (for example, CA and 
CO have more than one group).

●   Column 7
The data grouped in specified order. This is one of 
thousands of possible custom groupings. In this example, 
the first group consists of Pacific states and the second 
group consists of Mountain states. The records in each 
group are sorted in original order.

●   Column 8
The same specified order grouping as Column 7, but the 
records in each group are sorted in ascending order.

●   Column 9
The same specified order grouping as Column 7, but the 
records in each group are sorted in descending order.

As you can see, your sorting and grouping choices can have a 
major impact on the way data appears on your report.
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Creating custom groups

Most of the time you sort and group your data based on the values 
in a field in your report. For example, if you have a customer list 
and you want to sort and group by state, the program first sorts 
the list by state and then breaks the list into state groups whenever 
the value in the State field changes.

Sometimes, however, you may not want to group based on the 
values found in one of the fields on your report. For example:

●   Your report may not contain the field you want to group on. 
For example, your report contains a City field and a State 
field but no Country field, but you want to group by 
country.

●   Your report may contain the field you want to group on, but 
you are not happy with the grouping based on the values in 
that field. For example, you have a Color field on your 
report that includes specific color names (Logan Green, Sky 
Blue, Emerald Green, Navy Blue, etc.) but you want all 
shades of each color to appear as a single group (Greens, 
Blues, Reds, etc.). In this case you can build custom groups 
and manually assign the records you want to be in each 
group.

●   Your report may contain the field you want to group on, but 
you want to select specific values or ranges of values for 
each group. For example, you might want one group to 
contain records where gross sales are less than a certain 
value, a second group where gross sales are greater than a 
certain value, and a final group where gross sales fall 
between two values. In this case, you can build your groups 
using the same range of selection facilities that are available 
to you for building record selection queries.

Specified order grouping provides a solution to these custom 
sorting and grouping challenges. Specified order grouping 
enables you to create the customized groups you want to appear 
on your report and the records that each group contains. Your 
only real limitation is that a record can be assigned to only one 
group.
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To create a custom grouping using specified order grouping, you 
select in specified order as your sort option (whenever the program 
provides you with that option). The program gives you the in 
specified order option whenever:

●   you create groups using the GROUP, SUBTOTAL, or SUMMARY 
command on the Insert menu, 

●   whenever you create groups while building a report using 
one of the Report Creation Experts, or 

●   whenever you choose the CHANGE GROUP EXPERT 
command from the Report menu.

Summarizing

group values

One of the primary reasons you might break your data into 
groups is so you can run some calculations on each group of 
records instead of on all the records in the report. When you do 
this, the program evaluates all of the values in each group and 
then summarizes them. For example:

●   For a customer list, you might want to determine the 
number of customers in each state. For this report, your 
summary would consist of counting the distinct customers 
in each state group.

●   For an order report, you might want to determine the 
average order placed each month. For this report, your 
summary would calculate the size of the average order for 
each month group.

●   For a sales report, you might want to determine the total 
sales per sales representative. For this report, your 
summary would sum or subtotal the order amounts for 
each sales representative group. 

As you can see, you can summarize your grouped data in a 
variety of ways to make useful reports.

When the program summarizes data it sorts the data, breaks it 
into groups, and then summarizes the values in each group. It 
does this all automatically; all you have to do is specify:

●   the field you want summarized, 

●   the type of summary operation to be performed on the field,
278 Seagate Crystal Reports User�s Guide



●   the field that is going to trigger a new group whenever its 
value changes, and

●   the sort order. 

The program handles all the details.

The program includes a number of summarizing options. 
Depending on the data type of the field you are planning to 
summarize, you can:

●   sum the values in each group, 

●   count all the values or only those values that are distinct 
from one another, 

●   determine the maximum, minimum, or average value, and

●   calculate two kinds of standard deviations and variances.

You can set up all of these summaries by clicking the INSERT 
SUMMARY button on the standard toolbar or by choosing the 
SUBTOTAL command from the Insert menu. Search for Subtotal 
command and Summary functions in Seagate Crystal Reports online 
Help. 

Sorting

summarized

group values

You can sort summarized group values in either ascending or 
descending order. In an orders report, for example, if you subtotal 
orders by state, you could have:

●   the group with the lowest subtotal first, then the next 
lowest, and so forth (ascending), or

●   the group with the highest subtotal first, then the next 
highest, and so forth (descending).

You can sort your report based on group values using the TOPN/
SORT GROUP EXPERT command on the Report menu. For more 
information on TopN/BottomN sorting and grouping, see How to 
select the top or bottom N groups, Page 267.

NOTE: To sort groups that are not summarized, choose the

CHANGE GROUP EXPERT command from the Report menu.
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HANDS-ON (Sorting, Grouping, and Totalling)

When you insert a database field into your report, the data within 
the fields appears in the order it was originally entered into the 
database.

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

As you can see, pinpointing information in this kind of report 
would be difficult. It would be much easier to review or find 
information when you can see it sorted in a logical format. For 
instance, you may want to have a customer list sorted 
alphabetically by name or by country. That is known as a single 
field sort.

NOTE: To see an example of the above report, open the

SGT01.RPT file in the \CRW directory.
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How to do a single field sort

1 To get started, create a report using the customer table in 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

2 Click the SORT ORDER button on the standard toolbar. The 
Record Sort Order dialog box appears.

NOTE: The following screenshot illustrates both a before and

after state of the dialog box. Typically, any fields you move to the

Sort Fields list box will no longer appear in the Report Fields list
box.

Records are sorted based on the values in the sort field.

For example, if you choose to sort the {customer.COUNTRY} field 
in ascending order, the report would appear as follows:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

3 Highlight the field

to be sorted from this

list.

4 Click the Add button.
5 The selected field will be

added to this list.

6 Specify the sort direction.

7 Click OK when

finished.
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Notice that the records are displayed in alphabetic order by 
country: all of Canada, then Spain, then the United States. There 
is no further sorting of these records, however. If you want your 
customers sorted by Country and then, for example, by Region, 
you need to do a multiple field sort.

NOTE: To see an example of the above report, open the

SGT02.RPT file in the \CRW directory.

Related Topics

Reporting 101, Page 95

How to do a multiple field sort, Page 283

How to sort records within groups, Page 287

Countries are now sorted

in alphabetic order.

The Regions within

each Country

remain unsorted.
282 Seagate Crystal Reports User�s Guide



How to do a multiple field sort

Using the report you created in How to do a single field sort, Page 
281, you can further organize your data sorting on multiple fields.

1 Click the SORT ORDER button on the standard toolbar. The 
Record Sort Order dialog box appears.

NOTE: The following screenshot illustrates both a before and

after state of the dialog box. Typically, any fields you move to the

Sort Fields list box will no longer appear in the Report Fields list
box.

Records are sorted by Country first and then by Region.

For example, if you choose to sort first by the 
{customer.COUNTRY} field and then by the {customer.REGION} 
field, both in ascending order, the report would appear as follows:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

2 Highlight the field you want the

data sorted by first and click the Add

button to add it to the Sort Fields list.

3 Highlight the field you want

the data to be sorted second and

add it to the Sort Fields list.

5 As you add each field to the Sort

Fields list, specify the sort direction.

4 The selected fields are

displayed in the order

they are sorted.

6 Click OK

when finished.
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Notice that the data is in order by Country, and where a country 
has customers in different regions, those regions are sorted in 
alphabetic order as well. 

NOTE: To see an example of the above report, open the

SGT03.RPT file in the \CRW directory.

Related Topics

Reporting 101, Page 95

How to do a single field sort, Page 281

How to sort records within groups, Page 287

The Regions

within each

Country are

sorted in

alphabetic

order.

Postal Codes

within each

Region are

unsorted.

Countries are sorted in

alphabetic order.
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How to group data

Sometimes sorting is not enough. You may want to break data 
into meaningful groups. Seagate Crystal Reports allows you to 
group data in one easy step.

NOTE: It is unnecessary to sort data before you group it. The

program does the necessary sorting automatically, as part of the

grouping procedure. If you just want your data sorted, follow the

sorting procedures outlined in How to do a single field sort, Page 
281, and How to do a multiple field sort, Page 283.

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

You will use this same data for the topic How to sort records within 
groups, Page 287, as well:

2 Click the INSERT GROUP button on the supplementary toolbar. 
The Insert Group dialog box appears. 

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.
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Notice that the values are grouped by Country, and the Country 
groups appear in ascending (A to Z) order. Notice too, however, 
that the records within each group remain unsorted. To remedy 
this, you need to sort the records within each group. See How to 
sort records within groups, Page 287.

3 Select the field

you want your data

grouped by from

this drop-down box.

4 Next, specify the

sort direction.

5 Click OK when

finished.

The Customers

are grouped by

Country.

The groups are

also sorted in

ascending(A-Z)

order.

But, the records

within each group

are unsorted.
286 Seagate Crystal Reports User�s Guide



NOTE: To see an example of the above report, open the
SGT04.RPT file in the \CRW directory.

Related Topics

Reporting 101, Page 95

How to sort records within groups, Page 287

How to group based on first letter of company name, Page 301

How to group data in intervals, Page 305

How to create group headers, Page 313

How to sort records within groups

Once you have grouped your data, you can easily sort the records 
within the groups to further organize the information. For this 
example, you must first group your data using the technique in 
How to group data, Page 285.

1 Once you have your data grouped, click the SORT ORDER 
button on the standard toolbar. The Record Sort Order dialog 
box appears.

NOTE: The following screenshot illustrates both a before and
after state of the dialog box. Typically, any fields you move to the
Sort Fields list box will no longer appear in the Report Fields list
box.
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NOTE: This example report has been designed to illustrate
concepts only, not the actual look of your finished report.

2 Highlight the field you want the records

in the groups sorted by and click the Add

button to add it to the Sort Fields list.

3 Specify the sort direction.4 Click OK when finished.

The selected fields are

displayed in the order

they are sorted.

NOTE: This field specifies the sort 
done automatically when you 
grouped the data. It can’t be moved.

The customers

within each

country are

sorted.

The data is grouped

by Country.
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NOTE: To see an example of the above report, open the
SGT05.RPT file in the \CRW directory.

Related Topics

Reporting 101, Page 95

How to do a single field sort, Page 281

How to do a multiple field sort, Page 283

How to summarize grouped data

Often you will want to summarize the data in each group and 
print the summaries in your report. You can use summaries to:

●   count the number of values in a group,

●   calculate the sum, average, standard deviation, or variance 
of values in a group, or

●   identify the minimum or maximum value in a group.

For more information on summarizing your data, search for 
Summary functions in Seagate Crystal Reports online Help.

For example, you may want to count the number of customers in 
each country. To do this, the data must be broken into country 
groups, and then the records in each group must be counted. 
Instead of grouping the data manually and then summarizing it, 
you can let the program group and summarize in a single step.

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

2 Click the Customer Name field (the field you want to 
summarize) and click the SUMMARY button on the standard 
toolbar. The Insert Summary dialog box appears. 
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NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

3 Select the desired summary

operation from this list.

4 Highlight the field you want

the data to be grouped by.

5 Specify the sort direction.

6 Click OK when finished.

This will

count the

records in

each group.

The data is

broken into

Country

groups.
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NOTE: To see an example of the above report, open the

SGT06.RPT file in the \CRW directory.

Related Topics

Reporting 101, Page 95

How to subtotal grouped data, Page 291

How to create multiple levels of subtotals, Page 297

How to extend prices and then subtotal the extensions, Page 293

How to calculate a percentage of the grand total, Page 310

How to create group headers, Page 313

How to subtotal grouped data

A subtotal is a special kind of summary. It totals or sums numeric 
values in a group. Like any summary, the program groups and 
subtotals in a single step. For more information on summary 
functions, search for Summary functions in Seagate Crystal Reports 
online Help.

In this example you will group the data by Country and subtotal 
Last Year’s Sales by Country. 

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}
{customer.LAST YEAR’S SALES}

2 Right-click the Last Year’s Sales field and choose the INSERT 
SUBTOTAL command from the shortcut menu that appears. 
The Insert Subtotal dialog box appears with the chosen field 
listed at the top of the dialog box.

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.
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NOTE: To see an example of the above report, open the

SGT07.RPT file in the \CRW directory.

Choose the field you want

the data grouped by, specify

a sort direction and then

click OK when finished.

The field you

selected to be

subtotaled.

Thevalues in

each group

are now

subtotaled.

Data is broken

into Country

groups.
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Related Topics

How to summarize grouped data, Page 289

How to create multiple levels of subtotals, Page 297

How to extend prices and then subtotal the extensions, Page 293

How to calculate a percentage of the grand total, Page 310

How to create group headers, Page 313

How to sort based on summarized group values

1 Click the TOP N button on the supplementary toolbar. The 
Top N Sort Group Expert appears with a tab for each of the 
groups in the report.

2 Click the tab for the group you want to sort.

3 Select the Sort All option from the left hand drop-down box.

4 In the top drop-down box on the right, select the summary 
you want to sort by (if you have more than one summary in 
the group section. For example, you might have both a sum 
and an average summary in a section).

5 Click the option button for the sort direction you want.

6 If you want to select a second sort group, repeat Steps 2-5.

When you run the report, the program will sort your data based 
on the group order(s) specified.

How to extend prices and then subtotal the extensions

In an orders report or invoice, you may need to extend the prices 
for individual line items and then subtotal the extensions. You do 
this using a simple formula to extend the prices, and then you 
subtotal the formula field.

1 To get started, create a report using the Orders Detail table in 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:
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{customer.CUSTOMER ID}
{orders detail.PRODUCT ID}
{orders detail.QUANTITY}
{orders detail.UNIT PRICE}

2 To create the formula for extending the prices, click the 
Formula Tab in the Insert Fields dialog box to activate it.

5 When you click OK, the Formula Editor appears. Enter the 
following formula into the Formula text box:

{orders detail.QUANTITY} * 
{orders detail.UNIT PRICE}

See Formulas 101, Page 321, for more information on formulas.

6 Click the Accept button when finished. The Formula Editor 
disappears and the program returns you to the Insert Fields 
dialog box with the name of your formula highlighted in the 
list box.

3 Click the

New button.

4 Type the name you want

to identify the formula.
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8 Place the formula field to the right of the Unit Price field in the 
Details section of your report. 

9 Click Close to close the Insert Fields dialog box.

Next you will subtotal the extensions.

NOTE: In the screenshot below, menus have been shortened by

removing some of the commands that are unrelated to the current

discussion.

The Insert Subtotal dialog box appears, already set to subtotal 
@Extension (the extended price field). For more information 
on summary functions, search for Summary functions in 
Seagate Crystal Reports online Help.

You are interested in weekly sales so you want to create a 
subtotal whenever the values in the Order Date field change 
from one week to the next.

7 Click the Insert button to place

the formula in your report.

The formula you

just created.

11 Choose the Insert

Subtotal command

from the shortcut

menu that appears.

10 Right-click the

formula field.
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12 Choose {orders.ORDER DATE} as the sort and group by field, 
and choose for each week as the date change that is going to 
trigger the grouping. 

NOTE: In order to do this, the Orders table must be linked to the

Orders Detail table before you preview the report. Search for

Visual Linking Topics Index in Seagate Crystal Reports online Help.

NOTE: The Section will be printed drop-down box will not be

activated until you choose the Order Date field.

Your dialog box should look like this: 

When you click OK, the program inserts the subtotal in the report.

Your final report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

Your data will be

sorted by date.

And grouped

whenever thedate

changes from one

week to the next.
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NOTE: To see an example of the above report, open the

SGT08.RPT file in the \CRW directory.

Related Topics

Formulas 101, Page 321

How to summarize grouped data, Page 289

How to subtotal grouped data, Page 291

How to calculate a percentage of the grand total, Page 310

How to create group headers, Page 313

How to create multiple levels of subtotals

Sometimes one level of subtotal will not do. For example, you may 
want to see sales for each region subtotaled, but within each 
region you may want to see sales for each sales representative or 
each postal code subtotaled as well. The program enables you to 
create these multiple subtotals with ease.
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There are two keys to effective reporting using multiple subtotals:

1. First, you need to make sure you enter the subtotals in the 
correct order. The rule to follow is to go from broad to 
narrow. For example, if you want to subtotal by country and, 
within each country, by region, you enter the country subtotal 
first and then the region subtotal.

2. The other key is to make sure you label the subtotals for 
clarity. When you have multiple subtotals, it can be difficult to 
tell which is which unless they are labeled properly.

If you want to subtotal Last Year’s Sales by Country and then by 
Region, here is how you do it:

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.COUNTRY}
{customer.LAST YEAR'S SALES}

NOTE: In the screenshot below, menus have been shortened by

removing some of the commands that are unrelated to the current

discussion.

4 When the Insert Subtotal dialog box appears, select Country 
as your sort and group by field and click OK. 

3 Choose the Insert

Subtotal command

from the shortcut

menu that appears.

2 Right-click the

database field.
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The program creates a group section (GH1, GF1) and places 
the subtotal in the Group Footer.

5 Now right-click the Last Year’s Sales field again and choose 
the INSERT SUBTOTAL from the shortcut menu that appears.

The field you are

going to subtotal.

Every time the value

in this field changes,

this will give you a

subtotal for each

country.

The country subtotal.
Sorting, Grouping, and Totalling 299



6 This time, select Region as your sort and group by field and 
click OK. The program creates a second group section (GH2, 
GF2) and places this subtotal in the second Group Footer 
(GH2). See How to group data, Page 285.

Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

You are subtotaling the

same field.

This will give you a

subtotal for each

region.

The country subtotal.

The region subtotal.
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NOTE: To see an example of the above report, open the

SGT09.RPT file in the \CRW directory.

Related Topics

For more information on summarizing your data, search for 
Summary functions in Seagate Crystal Reports online Help.

How to group based on first letter of company name

You might want to break your data into groups based on the first 
letter of the company name. In a customer list, for example, you 
might want all the “A” customers in a group, then all the “B” 
customers, and so forth. To do this requires the use of a formula. 

Do not worry if you are unfamiliar with formulas. This text will 
show you what formula you need here and how to enter it. You 
can learn more about creating and editing formulas in Formulas 
101, Page 321.

This report contains multiple

levels of subtotals.

Each

region is

subtotaled.

So is each

country.
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You are going to create a formula that will extract the first letter of 
each customer’s name. Then you are going to group the data using 
that formula field as the sort and group by field. The program will 
sort the data based on the first letter of each customer name and 
start a new group whenever the letter changes.

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}

2 Click the INSERT FIELDS button on the standard toolbar. When 
the Insert Fields dialog box appears, click the Formula Tab to 
activate it.

5 When you click OK, the Formula Editor appears. Type the 
following formula into the Formula text box:

{customer.CUSTOMER NAME}[1]

6 Click the Accept button. The Formula Editor disappears and 
you are returned to the Insert Fields dialog box with the name 
of your formula highlighted in the list box. 

7 Click the Insert button to place the formula object in the 
report.

3 Click the

New button.

4 Type the name you want

to identify the formula.
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9 Place the formula object temporarily in the Page Header 
section of your report.

You are going to move the formula object into a Group Header 
section, but the report does not have one yet. As soon as you 
group the data, you can move the formula object into the 
desired section.

10 Click the Insert GROUP button on the supplementary toolbar. 
The Insert Group dialog box appears.

You are returned to your report with the data grouped by the 
formula field as specified.

14 Finally, move the formula field into the Group Header #1 
(GH1) section where it will serve as a live group header, 
changing according to the value returned by the formula 
calculation. For more information on live headers, see Live 
headers, Page 315.

8 Place the formula object temporarily in

the Page Header section of your report.

11 Select the formula field as the field

you want your data grouped by.

12 Specify the sort

direction.

13 Click OK when finished.
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Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

NOTE: To see an example of the above report, open the

SGT10.RPT file in the \CRW directory.

Related Topics

Formulas 101, Page 321

Reporting 101, Page 95

How to group data, Page 285

How to group data in intervals, Page 305

How to create group headers, Page 313

The data is broken

into groups based

on the first letter

in the Customer�s

Name.

The formula

also provides a

live header for

every group.
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How to group data in intervals

You may want to group your data into intervals. Age groups, time 
periods, and sales categories are some of the interval groupings 
you can create using the process you will learn here. In this 
example, you will rank customers by the amount of business they 
did in the previous year.

This example uses in specified order grouping. This kind of 
grouping lets you specify the records that will be included in each 
group. You define the intervals you want and the program will do 
the rest.

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.POSTAL CODE}
{customer.COUNTRY}
{customer.LAST YEAR’S SALES}

2 Right-click the Last Year’s Sales field and choose the INSERT 
SUBTOTAL command from the shortcut menu that appears. 
The Insert Subtotal dialog box appears. You want to set up 
intervals based on the previous year’s sales so select Last 
Year’s Sales as the sort and group by field.
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3 Now click the down arrow in the Sort Order list box and select 
the in specified order option. The program creates a new 
Specified Order Tab in the dialog box.

4 Click the Specified Order Tab to activate it.

5 Click the New button. The Define Named Group dialog box 
appears.
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6 Type “Less than $10,000” in the Group Name edit box. This is 
the name that will appear as the Group Name field value for 
the group. 

7 Since the first group is to contain only those records that have 
a Last Year’s Sales figure less than $10,000, set the three drop-
down boxes so your condition reads:

is less than 10000

8 Click OK to return to the Specified Order Tab.

9 Click New again, and again the Define Named Group dialog 
box appears. This time set up a second group that contains 
values from $10,000 to $25,000. 

10 Type “$10,000 to $25,000” in the Group Name edit box.

11 Set the first two drop-down boxes so your condition reads:

is between
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The program creates a fourth drop-down box. There are now 
two drop-down boxes on the right, one above the other, with 
the word “and” separating them. Use these drop-down boxes 
to specify a range of values.

12 To specify the range:

●   type “10000” in the top drop-down box, and

●   type “25000” in the bottom drop-down box.

You have now set up the group to contain all values between 
$10,000 and $25,000.

13 Click OK to return to the Specified Order Tab.

14 To set up your final group, all those values over $25,000, click 
the New button again.

15 When the Define Named Group dialog box appears, type 
“Over $25,000” in the Group Name edit box.

16 Set the three drop-down boxes so your condition reads:

is greater than 25000

17 Click OK to return to the Specified Order Tab. 

18 Immediately to the right of the Specified Order Tab is the 
Others Tab. 
308 Seagate Crystal Reports User�s Guide



Use this tab to specify how you want it to handle all values that 
do not fit in any of the groups. Since all of the values in the Last 
Year’s Sales field fall in one of the three groups, you will not 
have to worry about your settings here, so click OK. The 
program returns you to your report.

Only one other thing remains in setting up your interval report 
and that is to insert group headers to identify each of the 
groups. If you insert the Group Name field into the Group 
Header (GH) section of your report, the program will use the 
name you assigned to each group to identify those groups in 
the report.

19 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box appears.

20 Click the Group Name Tab. There should only be one group 
name in the list: Group #1 Name.

21 Drag that name into the Group Header section.

Your report should look similar to this.

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.
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NOTE: To see an example of the above report, open the

SGT11.RPT file in the \CRW directory.

Related Topics

Formulas 101, Page 321

How to group based on first letter of company name, Page 301

How to create group headers, Page 313

How to calculate a percentage of the grand total

In some reports, you want to see what percentage of the grand 
total each group contributes. In this example, you will create a 
report that subtotals orders by country and then determines what 
percent of total worldwide sales each country generated. The 
process is simple and straightforward. It uses built-in subtotaling 
techniques plus one simple formula.

This report is grouped by

interval in a specified order.
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1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.REGION}
{customer.COUNTRY}
{orders.ORDER AMOUNT}

2 Right-click the Order Amount field and choose the INSERT 
SUBTOTAL command from the shortcut menu that appears.

3 When the Insert Subtotal dialog box appears, specify Country 
as your sort and group by field and click OK. 

4 Right-click the Order Amount field again and choose the 
INSERT GRAND TOTAL command from the shortcut menu that 
appears. When the Insert Grand Total dialog box appears, 
make sure that the function is set to sum and then click OK. 
Search for Summary functions in Seagate Crystal Reports 
online Help. 

This field will

be subtotaled...

whenever the

value in this

field changes.

This calculates the sales 
for each country. It 
breaks your data into 
country groups and 
subtotals each group.
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All that is left to do now is to determine the percentage of 
worldwide sales generated by each country. To do this you 
will need to create a simple formula.

5 Open the Formula Editor and enter the following formula in 
the Formula text box:

Sum ({orders.ORDER AMOUNT}, 
{customer.COUNTRY})/Sum ({orders.ORDER 
AMOUNT})*100

See Formulas 101, Page 321.

6 Place the formula in the Group Footer section of the report, 
just to the right of the Country subtotal.

After you add labels, headers, and formatting, and you run the 
report, the Design Tab should look similar to this:

The operation to

be performed on

the field.

The field that is

going to be totaled.

This calculates world 
wide sales, the total of all 
sales in the report.
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Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

NOTE: To see an example of the above report, open the

SGT12.RPT file in the \CRW directory.

Related Topics

Formulas 101, Page 321

How to create group headers

Whenever you create a group, a subtotal, or a summary, the 
program creates both a Group Footer (GF) section (where it places 
any subtotal or summary value), and a Group Header (GH) 

Each customer

is subtotaled.

Each country is

subtotaled.

The program calculates the percent of total sales

each customer and each country contributes.
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section (where it automatically places the group name/header). 
Group Headers are useful, even necessary, if you want your 
report data to be clear and easily understood. Though the 
program creates a group header automatically, you may find that 
you would like to change/modify the header to suit your needs. 
In this topic you will learn how to create the five most common 
kinds of group headers: 

●   Standard headers, Page 314, 

●   Live headers, Page 315, 

●   Live headers for groups based on a formula, Page 317, and

●   Headers for custom groups, Page 318. 

Standard

headers

A standard header is a block of text that is used to identify each 
group in a rather generic kind of way. “Customer”, “State”, and 
“Monthly Orders” are all examples of this kind of header.

While the header is somewhat descriptive (“Region Sales Figures” 
clearly means it is a regional group), you never know what region 
is in the group without first looking at the details in the group. 

Nonetheless, this kind of header has its place and it is easy to 
create.

1 To create a standard header, click the INSERT TEXT OBJECT 
button on the standard toolbar.

2 When the object pointer appears, move the object frame into 
the Group Header section where you want it to print.

3 Click inside the frame to select the object for editing, then 
enter the text you want to use for your header.
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4 Click outside the frame when finished to complete the 
process. Now when you run the report, the same header will 
appear at the beginning of each group. See How to insert text 
objects, Page 120.

Live headers A live header is a header that changes based on the content of the 
group. If you have your data subtotaled by region, for example, a 
live header would typically identify the region detailed in each 
group. Thus, the Arizona group would have a header identifying 
the data as Arizona data, the California group would have a 
header identifying the data as California data, and so on.

NOTE: When you create a group, the program automatically

inserts a group name field in the Group Header section unless you

have toggled the option off using the OPTIONS command on the

File menu. The information that follows details how you can

manually insert such a section (if you do not have the program

insert one automatically) and how to create different kinds of live

headers for different needs.

GROUP NAME ONLY

The easiest live header to create is simply an identifying field 
value. To create this kind of live header for region groups, for 
example, you simply insert a Group Name field in the Group 
Header section. This prints Arizona (or AZ) at the beginning of 
the Arizona group, California (or CA) at the beginning of the 
California group, and so on.

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Field dialog box appears.

2 Click the Group Name Tab to activate it.

3 Select the Group Name field that matches the group you are 
working with and drag it into the Group Header section for 
that group.

4 Format the field as desired.

Now, when you run the report, the region identifier will appear as 
the group header for each region group.
Sorting, Grouping, and Totalling 315



GROUP NAME WITH TEXT

A more complex kind of live header combines text and a field 
value. A typical group header of this kind for data broken down 
by region would be, “Sales for California” or “Customers in Postal 
Code 60606". To create these headers involves three steps:

1. Insert a text object in the Group Header section.

2. Type in the text you want to appear.

3. Enter the Group Name field in the text field where you want it 
to appear in the Group Header. 

For example, if you want your header to read “Sales for” and then 
the name of the region in the current group (Sales for AZ, Sales for 
CA, and so forth), follow these steps:

1 Click the INSERT TEXT OBJECT button on the standard toolbar.

2 Move the frame for that object in the Group Header section 
for the group.

3 Click inside the object to set the insertion point and type in 
“Sales for” and a space after it.

4 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Field dialog box appears.

5 Click the Group Name Tab to activate it.

6 Select the Group Name Field that matches the group, and 
drag it into the text object, immediately after the text and the 
space you entered.

7 Format the text object as you want it to appear.

Now, when you run the report, the program will create a live 
header (with text) for each of your groups.
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Live headers for

groups based

on a formula

When you create a group and use a formula field as a sort and 
group by field, the program automatically creates a group name 
field based on the value returned by the formula.

For example, if you create this formula:

{customer.CUSTOMER NAME}[1]

and then group on the formula, the program will group your data 
based on the first letter in the Customer Name field.

To create a live group header for a group based on a formula, 
simply insert the group name field in the Group Header section.

When you run the report, the “A” group will have the letter “A” 
as a header, the “B” group the letter “B”, and so on. For more 
information, see How to group based on first letter of company name, 
Page 301.

To create a more descriptive header such as “Customers 
beginning with the letter B”, you simply follow these four steps:

1 Insert a text object in the Group Header section. 

2 Type in this text:

Customers beginning with the letter 

3 Add a space. 

4 Insert the group name field into the text object and place it 
right after the space. 
Sorting, Grouping, and Totalling 317



NOTE: If the program automatically inserted a group name field

in the Group Header section, you will need to delete that field so

you do not have duplicate headers.

Headers for

custom groups

The final kind of header is a header for the kinds of custom groups 
you create when you group things in specified order. When using 
specified order grouping, you specify the name for each group 
and the records that belong in it. As in the other grouping 
situations, the program again creates a group name field for each 
group based on the group names you specified.

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Field dialog box appears.

2 Click the Group Name Tab to activate it.

3 Select the Group Name field for the custom group and drag it 
into the Group Header section for that group.

The program will automatically apply each of the group names 
you assigned to the appropriate group.

NOTE: Make certain that when you assign the names to the

groups using the Define Named Group dialog box, the names you

assign are the names you want to appear as group headers.
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13 Formulas 101

What you will find in this chapter...

What are formulas?, Page 322

How formulas are created - An introduction to the Formula Editor, Page 
327

Other formula conventions, Page 331

Formula syntax, Page 334

How formulas are evaluated - Order of precedence, Page 337

HANDS-ON (Formulas 101), Page 338
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What are formulas?

In many cases, the data you want to appear on your report already 
exists in fields in database tables. To prepare an order list, for 
example, you simply need to place the appropriate fields on your 
report. 

Sometimes, however, you need to put data on your report that 
does not exist in any of the data fields. In such cases, you need to 
create a formula. For example, to calculate the number of days it 
takes to process each order, you need a formula that determines 
the number of days between the order date and the ship date. 

By placing these fields...

You get this kind of report.
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Seagate Crystal Reports makes it easy for you to create such a 
formula. 

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box appears. 

2 Click the Formula Tab to activate it.

5 When you click OK in the Formula Name dialog box, the 
Formula Editor appears. Use the Formula Editor to create, 
test, and modify your formula. 

For more information on the Formula Editor, see How formulas 
are created - An introduction to the Formula Editor, Page 327.

6 To build the processing time formula, enter the Ship Date 
field, the Subtraction operator, and the Order Date field. 

3 Click the

New button.

4 Type the name you want

to identify the formula.
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NOTE: When you double-click an item in the Fields, Functions, or
Operators list box, it is placed in the Formula text box complete

with the brackets, punctuation, and other syntax items the

Formula Editor needs to process them correctly (see Formula 
syntax, Page 334). If you enter your formula manually, using the

keyboard, you have to make certain you enter those syntax items

yourself. It is generally safer and quicker to build a formula by

choosing list box items.

7 Double-click the Ship Date

field in the Fields list.

8 Double-click the

subtraction operator in the

Operators list.

9 Double-click

the Order Date

field from the

Fields list.

The formula components

are entered as you choose

them.

Automatically checks syntax

and accepts the formula for

insertion into report.

Checks the formula syntax

and identifies any errors.

Shows the values in a

highlighted field and lets

you paste values.

Inserts the highlighted list

item into the formula.
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NOTE: The list of values in the Browse Field Data dialog box

represents only a subset of the available records.

10 When you are finished, click the Check button. The program 
checks the formula syntax.

11 If the syntax is correct, click the Accept button. The Formula 
Editor closes and you are returned to the Insert Fields dialog 
box.

12 Click the Insert button to place the formula field object in your 
report. 

13 When the object frame appears, place it where

you want the formula to appear in your report.

You get this kind of report.
The formula subtracts the Order Date from the

Ship Date and then prints the result here.
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This is just one of many of ways you can use formulas to create 
powerful reports.

Some of the other typical uses for formulas are:

●   creating calculated fields to add to your report, 

{orders detail.UNIT PRICE}*.85

«Calculates a price discounted 15%.»

●   formatting text on a report,

UpperCase ({customer.CUSTOMER NAME})

«Changes all the values in the Customer Name field to 
uppercase. See How to format text with formulas, Page 349.»

●   pulling out a portion, or portions, of a text string, and

{customer.CUSTOMER NAME} [1]

«Extracts the first letter of the customer name. See How to 
group based on first letter of company name, Page 301, and 
search for Subscript in online Help.»

●   pulling out a portion of a date.

Month ({orders.ORDER DATE})

«Determines what month an order was placed.»

These examples just scratch the surface. If you have a need for 
specialized data manipulation, chances are you can do it with a 
formula.

Related Topics

Advanced Formulas, Page 345
326 Seagate Crystal Reports User�s Guide



How formulas are created -

An introduction to the Formula Editor

Creating a formula in Seagate Crystal Reports is much like 
creating one in your favorite spreadsheet application. You can 
use: 

●   fields:
 ({customer.CUSTOMER LAST NAME}, {customer.LAST 
YEAR'S SALES}, etc.),

●   numbers:
 (1, 2, 3.1416), 

●   text:
 (“Quantity”,   “,”, “:”, ’your text’, etc.), 

●   operators:
 (+, -, etc.), 

●   functions:
(TrimRight (x), Length (x), etc.),

●   group field values:
(Average (fld, condFld), Sum (fld, condFld, “condition”), 
etc.), or 

●   other formulas:
 (@GrossProfit, @QUOTA, etc.).

You combine these components into working formulas using the 
Formula Editor. The Formula Editor allows you to type the 
components into the formula directly, or, in the case of fields, 
functions, operators, group field values, and other formulas, to 
select them from lists of those items that are available.

The Formula Editor requires you to enter the various components 
according to a specific set of rules called syntax, such rules as: 

●   text enclosed in quotation marks, 

●   arguments enclosed in parentheses (where applicable), 

●   referenced formulas identified with a leading @ sign, 

●   and so on. 
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The Formula Editor checks the syntax and helps you debug (fix) 
problems before you enter the formula into the report.
 

Using the Formula Editor you combine elements to create a 
working formula. The three list boxes at the top of the Formula 
Editor contain the primary formula components.

Fields box The Fields box contains all the fields you can use as formula 
arguments.

HOW TO INSERT FIELDS IN YOUR FORMULA

You can insert fields in your formulas in two ways:

1. by placing the I-beam cursor where you want the field to 
appear in the Formula text box of the Formula Editor, setting 
the insertion point and then double-clicking the desired field 
in the Fields list box, or

Fields already used in the report.

Formulas used/defined in the report.

All active database fields.

Parameter fields used or

defined in the report.
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2. by placing the I-beam cursor where you want the field to 
appear in the Formula text box and then typing it in manually.

NOTE: Be sure to review the correct syntax for using fields in your

formulas. If you do not include the file name, leave out the

separating period, or fail to surround the field in braces, the

program will generate a Formula Compiler Error message

detailing your error. See Formula syntax, Page 334, and search for

Error Messages and Formula Compiler Warnings in Seagate Crystal

Reports online Help.

Functions box The Functions box lists the dozens of functions that are included 
with Seagate Crystal Reports. These functions are prebuilt 
procedures that return values. They perform such calculations as 
average, sum, count, etc. All functions available are listed in this 
box with their arguments and arranged by their use.

HOW TO INSERT FUNCTIONS IN YOUR FORMULA

You can insert functions in your formulas in the same manner as 
fields:

●   via the Functions box, or

●   by typing them in manually.

See HOW TO INSERT FIELDS IN YOUR FORMULA, Page 328.

NOTE: Be sure to review the correct syntax for using functions in

your formula. If a function has required arguments, all arguments

must also be entered. If any required arguments are not entered,

the program will generate a Formula Compiler Error message

detailing the error. See Formula syntax, Page 334, and search for

Error Messages and Formula Compiler Warnings in Seagate Crystal

Reports online Help.

Function name.

Arguments you

must supply.
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Operators box The Operators box lists the “action verbs” you can use in your 
formulas. Operators include such things as + (add), / (divide), -x 
(negate), etc. Search for Operators and Variables in Seagate Crystal 
Reports online Help.

HOW TO INSERT OPERATORS IN YOUR FORMULA

You can insert operators in your formulas in the same manner as 
fields and functions:

●   via the Operators box, or

●   by typing them in manually.

See HOW TO INSERT FIELDS IN YOUR FORMULA, Page 328.

Formula
text box

The Formula text box is where you actually enter the formula.

You can: 

●   enter the formula manually, using the keyboard, 

●   choose your formula components from the Fields, Functions, 
and Operators list boxes, or,

●   combine the two methods, choosing some of the 
components from the list boxes and entering other parts of 
the formula manually.

Model showing how

operator is used.

Operator name.
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HOW TO INSERT TEXT AND NUMBERS IN FORMULAS

You insert text and numbers in formulas by typing them directly 
into the Formula text box of the Formula Editor. You can also click 
the Browse Field Data button, highlight the value you want to insert 
from the list that appears, and select Paste to paste the value into 
your formula.

NOTE: Be sure to review the correct syntax for text and numbers
in formulas. See Formula syntax, Page 334.

Other formula conventions

The following is a description of the remaining elements available 
for use in assembling a formula.

Other formulas Just as you can enter fields in formulas, you can enter other 
formulas in formulas. Seagate Crystal Reports performs the 
calculations in the inserted formula, and then uses the value 
returned by the referenced formula in the same way it uses any 
other value.

For example, the formula:

1*(2+4*6/3-7*12-8) +2*(2+4*6/3-7*12-8) 
+3*(2+4*6/3-7*12-8) +4*(2+4*6/3-7*12-8)= -820

includes the expression (2+4*6/3-7*12-8) repeated many times.

If you create a formula for the repeated expression (@F = (2+4*6/
3-7*12-8)) and then reference that formula instead of entering the 
expression itself, you will get the same result.

1*{@F}+2*{@F}+3*{@F}+4*{@F} = -820

Every time the program sees the formula @F, it performs the @F 
calculation and returns the value -82, just as the expression 
underlying the formula (2+4*6/3-7*12-8) returns the value -82. See 
How formulas are evaluated - Order of precedence, Page 337.

HOW TO INSERT OTHER FORMULAS IN FORMULAS

You can insert other formulas into your formulas in the same 
manner as you did other fields:
Formulas 101 331



●   via the Fields box, or

●   by typing them in manually.

See HOW TO INSERT FIELDS IN YOUR FORMULA, Page 328.

NOTE: Be sure to review the correct syntax for using formula
fields in your formula. See Formula syntax, Page 334.

Group field
values

Group field values are values that summarize a group (a group 
subtotal, a group average, etc.). You can use them in formulas for 
many reasons. A typical reason would be to find out the 
percentage of the grand total that each group contributes. For 
example, what percentage of the $2,300,000 US sales figure did the 
Western Region contribute? 

HOW TO INSERT GROUP FIELD VALUES IN FORMULAS

You can insert group field values into your formulas in the same 
manner as you did other fields:

●   via the Fields box, or

●   by typing them in manually.

NOTE: Due to the syntax complexity of some group fields, it is
highly recommended that you enter group fields by selecting
them from the Fields list box versus manually typing them in. See
Formula syntax, Page 334.

Formula
comments

Formula comments are notes that you include with a formula to 
explain its design and operation.

Comments do not print and they do not affect the formula, but 
they appear in the Formula Editor. It is always a good idea to 
include comments with complex formulas for other users of your 
reports, especially those formulas that will be used again and 
again over time. 

HOW TO INSERT COMMENTS IN FORMULAS

Type your comments in the Formula text box in the Formula 
Editor. A comment must be preceded by two slashes (//). The 
comment can be above or below the formula, or it can even follow 
the formula on the same line. 
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Any of the following three placements are acceptable:

//This is an acceptable
//position for a comment.
//Note that when you forcethe line break, 
//you have to begin each new line 
//with double slashes. These comments
//refer to the formula below.

If {orders.ORDER AMOUNT} in (100.00 to 
250.00) Then

.10 * {orders.ORDER AMOUNT}
Else

0

//This is also an acceptable comment position
//for detailing the formula above.

If {orders.ORDER AMOUNT} > 10.00 Then
“” //This position is also acceptable.

Else
“Flag”

Formula

comment

considerations

The following are considerations when including comments with 
formulas:

●   The proper syntax for a comment is two forward slashes 
(//) followed by the comment. When the program sees the 
two slashes, it realizes that the text that follows for the rest 
of the line is comment only and not to be evaluated as part 
of the formula itself.

●   Seagate Crystal Reports treats everything that follows the 
slashes on the same line as a comment.

●   If your comment is long and automatically wraps to the 
next line, no additional slashes are necessary; the program 
treats it as one continuous comment.

●   If you break your comment into two or more lines using the 
Enter key, you must begin each new line with two slashes. 
If you do not begin each new line with two slashes (//), the 
program treats each unslashed line as part of the formula 
itself and displays an error message when you check the 
formula syntax.
Formulas 101 333



Formula syntax

Seagate Crystal Reports requires you to enter the various 
components of a formula according to a specific set of rules called 
syntax. Syntax, like the grammar of any language, takes practice 
to learn and perfect. Formula components must be written in a 
specific way and entered in specific order. The program uses 
syntax items (quotation marks, brackets, parentheses, etc.) to 
identify the various formula components, so it is very important 
that you stick to the rules in order for the program to recognize 
your formulas as well as have them work as you plan. 

The various components of formulas, and their syntax, are listed 
below: 

Text “Text” or ’Text’

(enclosed within single (’) or double quotes (”)) 

When using text in formulas, it must be enclosed within single (’) 
or double (”) quotes. Whatever text is within those quotes will be 
printed. If your text includes an apostrophe, you must use double 
quotes. 

For example:

CORRECT

“Last Year’s Sales”

INCORRECT

’Last Year’s Sales”

Numbers 23134.7

When using numbers in formulas, they must be entered without 
any comma separators or currency symbols.

Fields {table.FIELD}

When using fields in formulas, they must be enclosed within 
French braces { } with the table name to identify which database 
table you are referring to followed by a period and then the field 
name within that table.
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EXAMPLE

{customer.REGION}

This identifies the Region field from the Customer table.

Operators 1+1 

When using operators in formulas, you simply type in the 
operator where desired. You may place a space before and after 
the operator if you desire, but to do so is optional (i.e., 1 + 1).

Functions FunctionName(x)

When using functions in formulas, you simply type the function 
and supply the arguments (if any) as specified in the parentheses. 
For example, the Average (x) function requires a field or formula 
as its (x) argument. 

EXAMPLE

Average({order.AMOUNT})

This formula will calculate the average of all values in the Amount 
field. 

Brackets in

formulas

Seagate Crystal Reports uses three different types of brackets in 
writing formulas. Each one has a specific purpose and can be used 
only with certain formula elements. 

●   { } are called French braces and are placed around database, 
formula, and parameter fields:

{customer.REGION}, {@sum}, {?Region}

●   [ ] are called Square brackets and are placed when using the 
Subscript or Array Operator: 

{customer.CUSTOMER NAME} [1]

●   ( ) are called Parentheses and are placed around the 
arguments of a function:

Round(x, # places), Abs(x)
Formulas 101 335



NOTE: Parentheses can also be used to control the order in which

the formula elements are evaluated. See How formulas are 
evaluated - Order of precedence, Page 337.

HINT: A useful way to remember which brackets are used for

what is the following:

●  French { } = Fields

●  Square [ ] = Subscript (and Array)

●  Parentheses ( ) = Parameters

Whether you enter the formula manually or by double-clicking 
formula components from the component list boxes, you must use 
the correct syntax for your formula to work.

When you double-click this Sum

function, Seagate Crystal Reports

enters the function and required

syntax items.

Commas between

arguments

Quotes for

arguments

Parentheses

Sums the values in the

Order Amount field...

whenever the

date changes...

from one week

to the next.
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How formulas are evaluated - Order of precedence

When you are creating formulas that contain different kinds of 
operators, it is important to consider the order in which the 
program evaluates the separate parts of your formula. This order 
is called order of precedence.

Simple order of precedence follows basic math rules of 
precedence. Multiplication and division are performed first, from 
left to right, then addition and subtraction are performed. For 
example:

5 + 10 * 3 = 35

The multiplication 10 * 3 is performed first to get 30. Then, 30 is 
added to 5 to arrive at the final answer, 35.

Now, if your intention is to add 5 to 10 and then multiply the sum 
by 3, you have to modify the order of precedence with 
parentheses. You can do that as follows:

 (5 + 10) * 3 = 45

It is clear that parentheses have a higher precedence than the add, 
subtract, multiply, and divide operators. They redirect the order 
of calculation.

NOTE: When a formula contains other formulas such as:

@Extension * 107.5%

the program first evaluates the embedded formula, @Extension,

following order of precedence rules and then evaluates the rest of

the primary formula.
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HANDS-ON (Formulas 101)

How to insert a formula in your report

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box with the Database Tab active. Click 
the Formula Tab to activate it.

 

The Formula Name dialog box appears. 

The Formula Editor appears. 

2 Click the

New button.

3 Enter the name you want to

identify the formula in this edit box.

4 Click OK when finished.
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6 Click the Check button to check the syntax in your formula 
when finished and fix any syntax errors the Formula Checker 
identifies.

7 When the formula has the correct syntax, click the Accept 
button to return to the Insert Fields dialog box. Your formula 
appears in the Formula Name list box.

NOTE: When you click the Accept button, Seagate Crystal Reports
automatically checks the syntax of the formula before allowing

you to place it in the report.

8 Highlight the formula and click the Insert button to place the 
formula in your report.

9 When you place your cursor over your report, an object frame 
appears. Click once to set the field in the desired position.

5 Enter the formula by typing in the components
or selecting them from the scroll lists.
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How to delete formulas from your report

When you create a formula and add it to your report, Seagate 
Crystal Reports:

●   stores the specification for creating the formula, using the 
name you assigned it, and

●   places a working copy of that formula at the point you 
specify in the report. A working copy is any occurrence of 
the formula in the report.

In order to delete formulas, you must delete the specification and 
all working copies of the formula.

NOTE: You can not delete the specification without deleting all

working copies of the formula.

Deleting
individual
working copies
of a formula

1 Select the formula copy you want to delete in your report.

2 Press the Delete key.

NOTE: Even after you have deleted all of the working copies of a

formula from your report, the formula specification remains

unchanged. The specification is listed in the Formula Tab of the

Insert Fields dialog box, and it is available for immediate use

should you wish to enter the formula in your report again. Search

for Insert Fields dialog box in Seagate Crystal Reports online Help.

Deleting the
formula
specification

NOTE: This step can only be completed after you have deleted all

working copies of the formula from your report.

1 Once you have deleted all working copies of the formula, click 
the INSERT FIELDS button on the standard toolbar. The Insert 
Fields dialog box appears with the Database Tab active. 

2 Click the Formula Tab to activate it.

3 Highlight the formula specification you want to delete in the 
Formula name list.

4 Click the Delete button, and the program deletes the formula 
specification.
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NOTE: If the formula is being used in another formula the

program will delete the specification nonetheless.

NOTE: If you have not deleted all working copies of the selected

formula, the program displays the message: Formula Name in use. 
It cannot be deleted.

How to copy formulas from online Help

Windows allows you to copy text from online Help topics to the 
Clipboard. You can then paste this text wherever it is needed. 
Since the formulas you develop using the Formula Editor are 
simply text, you can save yourself a lot of time by copying useful 
formulas directly into the Formula Editor and then modifying 
them to fit your needs.

1 With the Formula Editor open, activate the online Help in any 
of the standard ways (Help menu, F1 function key, etc.).

2 Regardless of the topic that first appears, use the Search or 
Find facility to locate the topic that contains the formula of 
interest.

3 Scroll through the topic until you locate the formula you want 
to copy. 

4 Highlight the formula by dragging the I-beam cursor over it, 
and choose the Copy command from the Edit menu or press 
Ctrl-C when finished. Windows puts a copy of the selected 
text on the Clipboard.

5 Place the insertion point where you want the text to appear in 
the Formula text box of the Formula Editor and press Ctrl-V to 
paste the text from the Clipboard.

6 Modify the formula by changing the fields, formulas, group 
fields, conditional statements, and text strings as necessary for 
use with the data used in the new report.
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How to copy formulas from one report to another

You may find yourself wanting to copy a formula created in one 
report for use in another report. Copying formulas from one 
report to another is a simple procedure, but it requires careful 
attention to detail.

Since formulas are stored as text, it is a simple matter to copy the 
text formula from one report to another via the Clipboard. 

1 In your report, select the formula field you want to copy.

2 Choose the COPY command from the Edit menu or press Ctrl-
C.

3 Open the report you want to copy the formula to.

4 Choose the PASTE command from the Edit menu or press Ctrl-
V.

5 When the program displays the object frame, drag the 
formula where you want it.

6 Change the fields, formulas, group fields, conditional 
statements, and text strings if necessary for use with the data 
used in this report.

To make these changes (if necessary), right-click the formula 
and choose the EDIT FORMULA command from the shortcut 
menu that appears. The Formula Editor appears.

7 Delete the old values and type in the new values, or select 
them from the Fields, Functions, and/or Operators list boxes. 
When making changes, use the following points as a guide:

●   All fields, formulas and group fields referenced in the 
formula copy must actually exist in the new report. This 
means that any database referenced in the original formula 
(or a database with the same structure, field names, and 
alias) must be active in the new report.

   If such a database is not active, you must change the 
field, formula, and group field references in the formula 
copy to correspond to elements in your new report.
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●   If the formula contains conditional elements, make certain 
that the conditions apply to the data in the new report. For 
example, if the formula in your old report performed an 
action when the quantity was greater than 100, make sure 
that the greater than 100 condition makes sense in the new 
formula. When modifying a formula, you may find that 
greater than 10 or greater than 2000 makes more sense with 
your new data.

●   If you are using the formula with new data, and if your 
report contains statements similar to the following: 

If {file.FIELD} = “text string”

Make sure that the text strings used in the formula match 
values that actually exist in the new data.

8 Click Accept when finished.

Related Topics

HOW TO INSERT FIELDS IN YOUR FORMULA, Page 328

HOW TO INSERT FUNCTIONS IN YOUR FORMULA, Page 329

HOW TO INSERT OPERATORS IN YOUR FORMULA, Page 330
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14 Advanced Formulas

What you will find in this chapter...

How to create if-then-else formulas, Page 346

How to print Time or dateTime values conditionally, Page 347

How to create multi-condition if-then-else formulas, Page 348

How to format text with formulas, Page 349

How to use variables in formulas, Page 349

How to declare a variable, Page 353

How to assign a value to a variable, Page 354

How to combine a variable declaration and assignment expression, Page 
356

How to declare and assign values to multiple variables, Page 357

How to conditionally assign values to variables, Page 357

How to use an array in a formula, Page 358

How to use a range in a formula, Page 361

How to use semicolons in formulas, Page 363

How to fine tune group selection formulas, Page 364

How to fine tune record selection formulas, Page 366

How to debug a formula, Page 370
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How to create if-then-else formulas

If-Then-Else formulas are conditional formulas: if a condition is 
met, then a certain consequence, an action, takes place. If the 
condition is not met, a different action takes place. If-Then-Else 
formulas are created using the If-Then-Else operator. Search for If-
Then-Else in Seagate Crystal Reports online Help.

Example ●   If a sales representative has already earned the maximum 
allowable bonus, print the amount of the maximum bonus 
allowed; if he has not yet earned the maximum, calculate 
the bonus actually earned and print it.

●   If the value in the title field is “Mr.”, print “Dear Mr.” as the 
beginning of the salutation; if it is not “Mr.”, print “Dear 
Ms.” as the salutation.

●   If the quantity on hand of a part is less than or equal to the 
reorder amount, reorder according to the reorder 
instructions; if the quantity is greater than the reorder 
amount, do nothing.

These are just a few of the kinds of conditional formulas you can 
create using the If-Then-Else operator.

When using the If-Then-Else operator, remember that there must 
be three separate parts to any If-Then-Else formula:

1. If 
This portion sets the condition.

2. Then 
This portion sets the action that takes place when the If 
condition is met.

3. Else 
This portion sets the action that takes place when the If 
condition is not met.

NOTE: The data types (text, number, currency, date, time,
dateTime, or Boolean) for the Then and Else parts of your formula
must be the same.
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Thus, if the action that takes place if the condition is met (Then) is 
to print a text string, the action that takes place if the condition is 
not met (Else) must also be to print a text string, even if that text 
string is empty. For example:

If {file.FIELD} = 5 Then
“Text String”

Else
“Another Text String”

OR

If {file.FIELD} = 5 Then
0

Else
1

NOTE: You can not create If-Then-Else formulas that use a Time
or dateTime data type as a Then action and a null or empty Time
or dateTime as an Else action because there are no null or empty
values for those data types. You can print Time or dateTime values
conditionally. See How to print Time or dateTime values 
conditionally, Page 347.

How to print Time or dateTime values conditionally

If you want to print Time or dateTime values conditionally (print 
the field if the condition is met, print the field in another color if 
the condition is met, etc.), you can not do it using an If-Then-Else 
formula because there is no such thing as an empty or null value 
for the Time or dateTime data type. Instead, you insert the field 
itself in your report and set its Suppress property conditionally.

1 Place the dateTime field where you want it to print on your 
report.

2 Select the field and click the OBJECT PROPERTIES button on the 
supplementary toolbar. The Format Editor appears.

3 Click the Common Tab to activate it. 

4 Click the Formula button to the right of the Suppress property.
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5 Type the following formula in to the Formula Editor when it 
appears.

{employee.LAST NAME} <> “Fuller” 

Now when you run the report, the program will print the 
dateTime field whenever the employee last name is Fuller and it 
will suppress the field when the last name is anything but Fuller.

How to create multi-condition if-then-else formulas

You can create powerful multi-condition formulas using the If-
Then-Else operator. 

Multi-condition and nested If-Then-Else formulas can be set up in 
this general pattern: 

●   If the X (first) condition is met, Then, go to the Y (second) 
condition. 

●   If the Y condition is met, Then perform the Y action.

●   If the Y condition is not met (Else), perform the Y 
alternative. 

●   If the X condition is not met (Else), perform the X 
alternative. Thus:

If {file.FIELD1} = “X” Then 
If {file.FIELD2} = “Y” Then 

“Y Action” 
Else 

“Y Alternative” 
Else 

“X Alternative”

See How to create if-then-else formulas, Page 346.

This formula checks the field FIELD1 first. 

●   If the value of that field is “X,” the FIELD2 field is checked. 

   If the value of that field is “Y,” “Y Action” is printed. 

   If the value of FIELD2 is not “Y,” “Y Alternative” is 
printed.
348 Seagate Crystal Reports User�s Guide



●   If the value of FIELD1 is not “X,” “X Alternative” is printed.

While multi-condition formulas look complex at first, after you 
have worked through one or two you will find that they are not as 
intimidating as they seem, especially given the work they perform.

How to format text with formulas

You can use formulas to format text. For instance, functions are 
included with the program for removing unnecessary leading or 
trailing spaces from text stings as well as converting text entirely 
to upper or lower case. 

Example TrimLeft(“   Al/4520/B12”)

«Returns “A1/4520/B12”.»

TrimRight(“A1/4250/B12   “)

«Returns “A1/4250/B12”.»

LowerCase(“Ronald Black”)

«Returns “ronald black”.»

Related Topics

Formatting, Page 231

How to use variables in formulas

Variables can be used to solve many formula problems, but they 
have two primary uses:

1. streamlining formulas, and

2. expanding formula capabilities.

Unlike a constant value which is fixed and unchanging, a variable 
can be repeatedly assigned different values. You assign a value to 
a variable and the variable maintains the value until you later 
assign a new value. Then the variable maintains the new value 
until you later assign a newer value, etc.
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Using variables

to streamline

formulas

Using variables, you can write formulas much more efficiently 
than you can without them. For example, to evaluate the 
{customer.FAX} field to determine if the area code is for 
Washington state (206, 360, 509) or British Columbia, Canada (604, 
250), without the benefit of variables, you must write a formula 
similar to the following: 

If {customer.FAX}[1 to 3] = “604” or
{customer.FAX}[1 to 3] = “250”

Then
“BC”

Else
If {customer.FAX}[1 to 3] = “206” or
{customer.FAX}[1 to 3] = “509” or
{customer.FAX}[1 to 3] = “360” Then

“WA”
Else

“”

See How to create if-then-else formulas, Page 346, and search for 
Subscript in Seagate Crystal Reports online Help.

You have to write out the instructions for extracting the area code 
from the telephone number field ({customer.FAX} [1 to 3]) every 
time you want the formula to use the area code from the current 
record.

By using a variable (for example, AreaCode), you write those 
instructions one time. Using those instructions, the program 
automatically extracts the area code from the {customer.FAX} 
field, and stores it in the variable each time it reads a new record. 
You simply reference the variable AreaCode whenever you want 
to use the area code from the current record in your formula. 
Here's an example of the formula using a variable:

StringVar AreaCode:={customer.FAX}[1 to 3];
If AreaCode = “604” or AreaCode = “250”
Then

“BC”
Else If AreaCode = “206” or AreaCode = “509” 
Then

“WA”
Else

“”
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Not only does the streamlined version take less time to write, but it 
takes less time to process as well, so your report prints more quickly.

Using variables

to expand

formula

capabilities

Besides their impact on streamlining formulas, variables allow 
you to expand your formula writing capabilities. Before 
discussing the specifics of using variables in formulas, it is 
important to understand some things about the way the Formula 
Editor reads formulas.

SPECIAL REQUIREMENTS FOR USING VARIABLES IN

FORMULAS

Through the discussion thus far, formula elements that have been 
narrowly defined:

●   a given operator only works in certain situations and with 
certain kinds of text and/or data,

●   a function only works with a specific number of arguments, 
and each argument must be a specific data type, and

●   If-Then-Else formulas work only if the data type of the Else 
part of the formula matches the data type of the Then part.

Such narrow definition allows you to create formulas, in many 
cases, simply by filling in the blanks, with the formula checker 
pointing out any mistakes you make.

Variables, however, are not narrowly defined. They are extremely 
flexible; you make them what you want them to be. You create 
them at will and include them in formulas as needed. 

Because of this flexibility, it is necessary for you to define the 
variables before using them so that the program:

●   is aware of them,

●   understands how you intend to use them, and

●   can set aside and set up the memory space they require.

You also need to assign values to the variables so the program 
knows what values they are to return.

Seagate Crystal Reports knows only what you tell it about the 
variables. The fail-safe formula-checker routines that work 
automatically with the other formula elements work with 
variables only after you define them.
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To use a variable in a formula, you must do three things:

1. declare the variable,

2. set the value of the variable, and

3. enter the variable in the formula.

Declaring the

variable

Seagate Crystal Reports requires you to declare all variables prior 
to using them. When you declare a variable, you tell the program:

●   the name you intend to use for the variable, and 

●   the type of data you want the variable to hold. 

The program uses this information to set aside a piece of memory 
for receiving and storing the values that are assigned to the 
variable.

NOTE: If you declare a variable with the same name and data type

in two or more formulas, the formulas share the same variable.

Thus, if one formula sets the value of the variable, the variable in

the second (and additional formulas) reflects the change.

Naming the

variable

You can name the variable anything you wish with the following 
qualifications:

●   the variable name must not exceed 254 characters, and

●   it can not have the same name as an operator or built-in 
function. Search for Functions and Operators and Variables in 
Seagate Crystal Reports online Help.

NOTE: As a general rule, you are probably better off if you keep

the variable name short, easy to remember, and unique (not so

close to the name of another variable as to cause confusion).

Variable data

types

The data type of a variable determines the type of data that can be 
stored as a value in that variable. You can create a variable with 
one of seven data types:

1. number (100000)

2. currency ($30,000.00)

3. Boolean (TRUE)

4. date (January 1, 1996)
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5. string (’Hello’)

6. time (11:59:01)

7. dateTime (96/12/31 11:59:59 P.M.)

How to declare a variable

You must declare a variable at the beginning of the formula that 
uses the variable.

NOTE: You can not declare variables globally. If you are using a

variable that was declared in another formula, you must declare it

again.

NOTE: If you declare a variable with the same name and data type

in two or more formulas, the formulas share the same variable.

Thus, if one formula sets the value of the variable, the variable in

the second (and additional formulas) reflects the change.

To declare a variable you must enter:

●   the datatype and the variable name,

●   followed by a semicolon to mark the end of the declaration.

For example, to declare a number variable named Amount, enter 
the following declaration statement:

NumberVar Amount;

If you want to declare a Boolean variable named Outstanding, 
enter the following declaration statement:

BooleanVar Outstanding;

If you want to declare more than one variable, you can list them. 
Each variable is separated by a semicolon. For example:

NumberVar Amount;
BooleanVar Outstanding;
DateVar MonthEnd;

The program uses your declaration statement to set aside a block 
of memory that holds each of the variable values and assigns a 
default value to each memory block. The default value assigned 
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depends on the data type you declare for the variable. The default 
values assigned are as follows:

How to assign a value to a variable

You assign a value to a variable using an assignment statement. 
The assignment statement consists of:

●   the variable name, 

●   the assignment operator, and 

●   the value you want to assign to the variable.

Variable name The variable name is the name used to declare the variable.

Assignment

operator

The assignment operator is a colon followed by an equals sign (:=). 
Search for Assignment operator in Seagate Crystal Reports online 
Help.

Variable value The variable value is any value that matches the data type of the 
variable. For example, you can assign a number to a number 
variable. You can also assign an expression that results in a 
number or even a sequence of expressions. For a string variable 
you could assign a character, a word, a sentence, or an expression 
that results in a string. A variable value can be a constant, an 
expression, or a sequence of expressions. 

Data type To Default value

number NumberVar 0
currency CurrencyVar 0

Boolean BooleanVar False (No, 0)
date DateVar date (0, 0, 0)

string StringVar empty string (“”)
dateTime DateTimeVar No default1

time TimeVar No default1

1 Since Time (00:00:00) is midnight, you can not use 00:00:00 as 
a default time and you can not use this time value as part of a 
default dateTime either. Thus, a default is not assigned here.
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EXAMPLE ASSIGNMENT STATEMENT

Following are the assignment statements for assigning different 
kinds of values to variables:

Amount:= 0

«Assigns (initializes) the variable Amount to zero.»

Amount:= 100

«Assigns the value 100 to the variable Amount.»

Amount:= Amount + {orders detail.QUANTITY}

«Assigns the result of a calculation to the variable Amount. 
The calculation adds the value of the quantity field {orders 
detail.QUANTITY} to the current value of the Amount 
variable. This type of expression is useful in running total 
situations where each running total consists of the current 
amount plus an additional value. See Advanced Totalling, Page 
377.»

Amount:= {file.QUANTITY1} + {file.QUANTITY2} + 
{file.QUANTITY3}

«Adds the three quantity fields and assigns the result to the 
variable Amount.»

Customer:= “Westside Motors”

«Assigns the string “Westside Motors” to the variable 
Customer.»

Customer:= {customer.FIRST NAME} + 
{customer.LAST NAME}

«Adds (concatenates) two string fields and assigns the 
concatenated value to the variable Customer.»

Customer:= TrimRight({customer.FIRST NAME}) + 
{customer.LAST NAME}

«Trims the trailing blanks from the First Name field 
({customer.FIRST NAME}), concatenates that field to the Last 
Name field ({customer.LAST NAME}), and assigns the 
concatenated value to the variable Customer.»
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Customer:= “Mr. “ + {customer.LAST NAME}

«Concatenates the string “Mr. “ with the value of the Last 
Name field {customer.LAST NAME}, and assigns the 
concatenated value to the variable Customer.»

Amount:= 100; 
Customer:= “Westside Motors”;

«Assigns the constant 100 to the number variable named 
Amount, and assigns the string “Westside Motors” to the 
variable Customer. You can assign values to multiple variables 
by separating the assignment statements with semicolons.»

How to combine a variable declaration and assignment

expression

For efficiency, you can declare a variable and assign it a value in a 
single line of formula code. To do this, simply declare the variable, 
allow a blank space, enter the assignment operator, and assign the 
value. 

For example, to declare a currency variable SellPrice and assign 
the value of the Cost field ({product.PRICE (SRP)}) times two (a 
100% markup), use the following expression:

CurrencyVar SellPrice:={product.PRICE(SRP)} 
* 2;

To declare a Boolean variable OverQuota and assign the result of 
the comparison {file.SALES}>{file.QUOTA}, use the following 
expression:

BooleanVar OverQuota:= 
{file.SALES}>{file.QUOTA};
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How to declare and assign values to multiple variables

There may be times that you want to declare multiple variables 
and assign values to each of them. To do this in the most efficient 
manner, simply chain the declaration/assignment expressions 
together, separating them with semicolons. 

For example, to declare two variables (a number variable 
Quantity, and a currency variable SellPrice) and then assign 
values to each variable (the number 5 to the variable Quantity, 
and {file.COST} * 2 to the variable SellPrice), use expressions 
similar to the following: 

NumberVar Quantity:= 5;
CurrencyVar SellPrice:= {file.COST} * 2;

How to conditionally assign values to variables

Seagate Crystal Reports formula language gives you the ability to 
assign different values to variables based on conditions being met 
or not met. Consider the following formula:

NumberVar Total;
NumberVar Result;

Total:= Total + {invoices.ITEM TOTAL};

If Next ({invoices.CUST#})<>{invoices.CUST#} 
Then

(Result:= Total; Total:= 0)
Else

Result:= 0;
Result;

The If-Then-Else part of this formula says that when the If 
condition is met (if the customer numbers [{invoices.CUST#}] are 
not equal), the program is to do two separate things:

1. Assign the value stored in the variable Total (the running 
total) to the variable Result.

2. Reset the value in the variable Total to 0.
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When the If condition is not met (if the customer numbers are 
equal), the program is to assign the value 0 to the variable Result.

How to use an array in a formula

An array is a special type of variable that can hold several values 
at once. The entire array can be passed to a summary function for 
evaluation, or separate elements of the array can be extracted 
using the Subscript operator. Search for Subscript in Seagate 
Crystal Reports online Help.

A common use for an array is to store the names of the days of the 
week:

StringVar array Weekdays:= [“Sunday”, 
“Monday”, “Tuesday”, “Wednesday”, “Thursday”, 
“Friday”, “Saturday”];

There are five parts to declaring an array variable:

1. A variable declaration operator specific to the type of data the 
array will hold, StringVar in this example. 

2. The word array follows the variable declaration operator.

3. The name you assign to the array follows the word array, 
Weekdays in this example.

4. The Assignment operator follows the name and is used to 
assign values to the array variable.

5. Square brackets follow the assignment operator and are used 
to enclose the values (elements) stored by the array. Each 
element is separated by a comma. 

Search for Assignment in Seagate Crystal Reports online Help.

An index value is assigned to each element in the array according 
to the order of the elements. 

●   The first element is assigned index 1, 

●   The second element is assigned index 2, and so on. 
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To extract an element from the following array in your code:

StringVar array Weekdays:= [“Sunday”, 
“Monday”, “Tuesday”, “Wednesday”, “Thursday”, 
“Friday”, “Saturday”];

use the Subscript operator with the index number for the element 
you want to extract:

Weekdays[5]

«Returns “Thursday”.»

Negative numbers can also be used to extract array elements:

Weekdays[-4]

«Returns “Wednesday”.»

You can create an array of values for any valid data type. 
However, arrays have the following restrictions:

●   All elements must be of the same data type.

●   You must declare the array with one of the variable 
declaration operators.

●   There can be a maximum of 100 elements in an array.

●   Each element in an array of string values can have a 
maximum of 254 characters (the standard limit of any string 
value in Seagate Crystal Reports).

Examine the following examples of array declarations to become 
more familiar with arrays:

NumberVar array x := [1, 10, 44];

CurrencyVar array Cost := [$19.95, $79.50, 
$110.00, $44.79, $223.99];

DateVar array PayDays := [Date(1999, 05, 15), 
Date(1999, 05, 31)];
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Arrays can also be used without being assigned to array variables. 
For example:

[“One”, “Two”, “Three”][2] 

«Returns “Two” because it is the second item in the array.»

In some situations, you may prefer to use arrays dynamically like 
this. However, most formula situations that require arrays can be 
handled more easily by defining the array as an array variable.

Using arrays

with summary

functions

Summary functions accept arrays as parameters without 
requiring the array be declared as a variable. For example:

Average([5, 10, 15]) = 10

Use the square brackets to indicate that an array is being used 
with the function. Search for Summary Functions in Seagate Crystal 
Reports online Help.

A formula

example

To better understand how arrays can be used in formulas, 
examine the following formula example:

StringVar array Weekdays := [“Sunday”, 
“Monday”, “Tuesday”, “Wednesday”, “Thursday”, 
“Friday”, “Saturday”];

Weekdays[DayOfWeek({orders.SHIP DATE})]

«If DayOfWeek is 2, Monday will be returned because it is the 
second item in the array.»

This formula prints the name of the day of the week that each 
order was shipped. First, the Weekdays array is declared and 
assigned string values for each day of the week. Search for 
DayOfWeek in Seagate Crystal Reports online Help.

Next, the DayOfWeek function evaluates the date stored in the 
{orders.SHIP DATE} field and returns a number representing the 
day of the week (1 for Sunday, 2 for Monday, etc.).

Finally, the Subscript operator is used with the Weekdays array to 
retrieve the name of the day of the week according to the number 
returned by the DayOfWeek function. The name of the day is 
returned by the formula and appears in the report. Search for 
Subscript in Seagate Crystal Reports online Help.
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How to use a range in a formula

A range is designed to conveniently handle entire spectrum of 
values, values that fall between a minimum and a maximum 
value. 

For example, you would declare a number range variable as 
follows:

NumberVar Range GradeA;

A range variable is declared much like an array. 

1. A variable declaration operator appropriate to the type of 
values stored by the range, NumberVar in this example.

2. The word Range follows the variable declaration operator.

3. The name of the range variable follows the word Range, Grade 
A in this example.

4. The Assignment operator follows the name and is used to 
assign the range of values the range variable will store. 

Search for Assignment in Seagate Crystal Reports online Help. 

The range is indicated using the Make Range operator with a 
minimum and a maximum value for the range. 

Search for Make Range in Seagate Crystal Reports online Help.

Ranges have two principle uses:

●   To extract a range of values from all possible values, and

●   To extract a range of characters from a string value.

Extracting a

range of values

Consider the following example:

NumberVar Range GradeA := 90 to 100;
NumberVar Range GradeB := 80 to 89;
NumberVar Range GradeC := 70 to 79;
NumberVar Range GradeD := 60 to 69;
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If {student.TEST SCORE} in GradeA Then
“A”

Else If {student.TEST SCORE} in GradeB Then
“B”

Else If {student.TEST SCORE} in GradeC Then
“C”

Else If {student.TEST SCORE} in GradeD Then
“D”

Else
“F”

This formula starts by creating four range variables. Each contains 
a range of possible test scores. Notice that, unlike an array, no 
brackets are used to set off the range of values assigned to each 
range variable. Only the Make Range operator is used with the 
minimum and maximum test scores for each range.

The multiple If-Then-Else statement repeatedly evaluates the 
value in the {student.TEST SCORE} field to determine if it falls 
within a specific grade range. The formula prints letter grades in 
the report that are appropriate to the test scores received by each 
student.

See How to create multi-condition if-then-else formulas, Page 348.

Extracting a

range of
characters

The following formula demonstrates how to use ranges to extract 
characters from a string value:

StringVar AreaCode := {customer.FAX}[1 to 3];

If AreaCode = “604” Then
“BC”

Else If AreaCode = “206”
or AreaCode = “509” 
or AreaCode = “360” Then
“WA”

Else
“”

This formula creates a variable that holds the first three characters 
in the string value of the {customer.FAX} field. For instance, if the 
value in {customer.FAX} is “6045551234”, then:

{customer.FAX}[1 to 3]
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«Returns “604”. Notice that square brackets are used to 
indicate a range of characters in a string (unlike the range of 
numeric values seen in the previous example).»

The variable AreaCode is assigned the value “604”. The multiple 
If-Then-Else statement evaluates the value in the AreaCode 
variable to determine which region the fax number is in.

A range can be applied to a constant string value, as well:

“6045551234”[1 to 3] 

«Returns “604”.»

When referring to characters in a string, negative numbers can 
also be used:

“abcdef”[-3 to -1]

«Returns “def”.»

NOTE: You can not use a range as an element or as part of an

element in an array.

See How to create if-then-else formulas, Page 346, and search for 
Subscript in Seagate Crystal Reports online Help.

How to use semicolons in formulas

In a formula with multiple statements, the result of the final 
statement is the result that is returned (gets printed). When you 
have multiple statements in a formula, you must separate the 
statements using a semicolon so that the program knows where 
one statement ends and the next begins. Without semicolons, the 
entire formula is treated as a single statement. In a multiple 
statement formula, this can result in an incorrect result or an error 
message.
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How to fine tune group selection formulas

You may run into situations when using a group selection formula 
in which no values print, even though there are values that match 
the selection criteria. Typically, in these cases:

●   the group selection formula references another formula, 
and 

●   the referenced formula is one that calculates the value of 
each group as a percentage of the total value of all groups 
(i.e., a subtotal as a percentage of a grand total).

1 Using CRAZE.MDB, create a report that includes the 
following fields:

{customer.CUSTOMER NAME}
{customer.REGION}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

For each order, the report shows the company that placed the 
order, the state in which that company is located, the order 
number, and the amount of the order.

2 Subtotal the {orders.ORDER AMOUNT} field using 
{customer.REGION} as the sort and group by field to see the 
orders coming from each state. (The program sorts the data by 
state and calculates a subtotal in the {orders.ORDER 
AMOUNT} field every time the state changes.) See How to 
subtotal grouped data, Page 291.

3 Insert a grand total on the {orders.ORDER AMOUNT} field to 
see the total value of all orders placed.

4 Create a formula (Percent) that calculates each subtotal as a 
percentage of the grand total to see the value of orders for 
each state group as a percentage of all orders placed. Place the 
formula in the Group Footer section of your report.

Sum({orders.ORDER AMOUNT}, 
{customer.REGION}) % Sum({orders.ORDER 
AMOUNT})
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5 Reference the formula (@Percent) in a group selection formula 
that selects only those groups for which the percentage (of 
subtotal to grand total) is less than 5% to find out which states 
individually contributed less than 5% of total sales:

{@Percent} < 5

When you click the Check or Accept button you will receive the 
following error message: 

This formula cannot be used because it must be 
evaluated later.

How to correct
this problem

The problem can be corrected easily. Instead of using the formula 
name (in this case @Percent) in the group selection formula, enter 
the formula itself (the formula named @Percent). Thus, instead of 
using the group selection formula:

{@percent} < 5

use the group selection formula:

Sum({orders.ORDER AMOUNT}, 
{customer.REGION}) % Sum({orders.ORDER 
AMOUNT}) < 5

Now when you print, only the states that contributed less than 5% 
will print.

Speeding up

the process

To speed the process and minimize the chance for mistakes, you 
can copy the formula into the group selection formula using 
Windows' Copy and Paste commands. 

1 Select the formula you want to use in the group selection 
formula.

2 Choose the FORMULA command from the Edit menu. The 
Formula Editor appears with the formula in the Formula text 
box.

3 Copy the formula to the Clipboard using the Copy command 
(Ctrl-C).

4 Click Accept to close the Formula Editor.

5 Choose the GROUP command from the Report|Edit Selection 
Formula menu. The Formula Editor appears.
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6 Paste the formula into the Formula text box using the Paste 
command (Ctrl-V).

Add additional formula elements as needed.

How to fine tune record selection formulas

You may have run into a situation in which you create a record 
selection formula (using the RECORD command on the 
Report|Edit Selection Formula menu), and, while header and 
footer information prints on your report, no detail information 
appears. The problem is a selection formula that is rejecting all 
records, and this usually occurs because of some inadvertent error 
in the creation of the selection formula.

There are several things that you can look for as the cause of your 
problem in the selection formula:

●   Uppercase/lowercase inconsistencies, Page 366

●   Number in text object not in quotes, Page 367

●   Unwanted spaces appear in selection formula, Page 368

Uppercase/
lowercase

inconsistencies

Record selection formulas are case sensitive. That is, “Bob” 
matches only with “Bob”. It does not match with “bob”, “BOB”, 
“BoB”, “bOB”, “boB”, or “BOb”. Thus, if your selection formula is 
set to include only those records with “BOB” in the 
{customer.CONTACT FIRST NAME} field, but all the entries in 
the {customer.CONTACT FIRST NAME} field are mixed case 
(“Bob”, for example), the selection formula will find no matches 
and thus not print any details for the report.

You can solve this problem by using the UpperCase (str) or 
LowerCase (str) functions in your selection formula to convert 
field data to a consistent case before the program begins its 
selection. For example, if you were using this formula:

{customer.CONTACT FIRST NAME} = “BOB”

you can change the formula to this:

UpperCase({customer.CONTACT FIRST NAME}) = 
“BOB”
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This last formula first converts the value of the 
{customer.CONTACT FIRST NAME} field to upper case 
characters and then checks to see if the value in that field is equal 
to “BOB”. Using this formula, any instance of the three letters “b” 
“o” “b” will be a match, regardless of case, because the case will 
be converted first to uppercase for consistency.

You could use the LowerCase function in a similar manner to 
match with “bob”.

Check your selection formula closely and make sure you have the 
case correct on any text you are trying to match. If in doubt, use 
the UpperCase (or LowerCase) function to assure consistency and 
proper matches.

Another formula that does much the same as that above is:

“BOB” in UpperCase({customer.CONTACT FIRST 
NAME})

Number in text

object not in
quotes

When a number is stored in a text object, it is text even though it 
looks like a number. Whenever a value from a text object is used in 
a record selection formula, you must surround the value with 
single or double quotation marks. If your selection formula is set 
to look for a number in a text object and you fail to surround the 
number with quotes in the selection formula, the selection 
formula will find no matches and thus not print any details for the 
report.

For example, this selection formula:

{customer.CUSTOMER ID} = 12345

will not find any matches, even though the value 12345 appears in 
the {customer.CUSTOMER ID} field of many records.

To select records with the characters 12345 in a string field, you 
must put quotes around the characters you are attempting to 
match, like this:

{customer.CUSTOMER ID} = “12345”

Check your selection formula closely, and make sure that any 
numbers you are attempting to match in a text object are 
surrounded by single or double quotation marks.
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Unwanted
spaces appear

in selection

formula

Spaces are characters, and when you include spaces in the search 
key of a record selection formula, the formula looks for records 
with the exact match in the selected field, spaces and all. For 
example, the following formula:

“Mr . “ in {customer.TITLE}

will not find any matches with the form of address “Mr.” because 
there is an extra space in the search key between the letter “r” and 
the period. Likewise, “Ph. D” will not match “Ph.D”.

Check your selection formula closely, and make sure that the 
spaces in the selection formula match the spaces in the fields you 
are trying to match.

Troubleshooting

record selection

formulas

To troubleshoot your selection formula, you will first begin 
making sure that all of the fields referenced in the selection 
formula are placed on your report, then delete the selection 
formula, and test it as you rebuild it, step by step.

1 Write down the record selection formula on paper. You will 
use the written copy of the selection formula to help you 
reconstruct the selection formula a step at a time.

2 Remove the record selection formula from your report by 
deleting the formula from the Formula text box in the Formula 
Editor.

3 Click Accept when finished.

4 Make certain that all fields referenced in the record selection 
formula (the selectors) are on the report physically and not 
hidden. 

For example, if one of the selectors is:

{customer.POSTAL CODE} > “80000”

but the {customer.POSTAL CODE} field is not used on your 
report (as in the case of a sales report that uses the zip code to 
define territories but does not include the postal code in the 
report data), then insert the {customer.POSTAL CODE} field in 
an obvious place on the report. 

Or, if one of the fields referenced in the selection formula is on 
the report but hidden, unhide it by toggling the Hide when 
Printing option off in the Format Editor for that field.
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5 Print the report and make certain that the data in those fields 
referenced by the selection formula prints satisfactorily. Make 
certain that all the data prints. For example, if there are x total 
records in the database you should have x records printing for 
each of the referenced fields. This establishes a baseline 
against which you can compare the results of printing with 
the selection formula.

6 When you are sure you are getting satisfactory results without 
the selection formula, enter the selection formula using only 
one of the selectors. 

For example, if you want to use this as your final selection 
formula:

{customer.POSTAL CODE} > “80000” and 
{customer.CONTACT LAST NAME}[1] = “C” and 
{customer.LAST YEAR'S SALES} >= 5000

this formula will select all of those records that show a Postal 
code greater than 80000, a value in the {customer.CONTACT 
LAST NAME} field beginning with “C”, and a value in the 
{customer.LAST YEAR'S SALES} field greater than or equal to 
5000.

You might start with this as your first test selection formula:

{customer.LAST YEAR'S SALES} > “80000”

Print the report and evaluate the data that prints with only one 
selector activated. In your example, evaluate the data in the 
{customer.POSTAL CODE} field. Does the field show only ZIP 
codes greater than 80000? 

●   If it does, then you know that this part of the selection 
formula is working.

●   If it does not, then troubleshoot this part of the selection 
formula.

7 Once the selection formula with one selector activated is 
working properly, add a second selector. In your example, the 
new selection formula might look like this:

{customer.POSTAL CODE} > “80000” and 
{customer.CONTACT LAST NAME}[1] = “C”
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8 Print the report and evaluate the data that prints with the two 
selectors activated. In your example, evaluate the data in the 
{customer.CONTACT LAST NAME} field (since you already 
evaluated {customer.POSTAL CODE} in the last step).

Does the {customer.CONTACT LAST NAME} field show only 
text strings beginning with the letter “C”?

●   If it does, then you know that this part of the selection 
formula is working.

●   If it does not, then troubleshoot this part of the selection 
formula. 

9 Once the selection formula with two selectors activated is 
working properly, add a third selector, then a fourth, etc., 
until you have tested each selector in the selection formula. By 
the time you have troubleshot the entire selection formula, 
you should have uncovered the source of your problem and 
the formula should be selecting records according to your 
wishes.

How to debug a formula

Follow the example below to practice the necessary steps to debug 
a formula. After completing this exercise, use the same principles 
to debug your own formula. 

NOTE: This tutorial uses the CRAZE.MDB sample database

located in the \CRW directory or the directory in which Seagate

Crystal Reports was installed.

The following formula is the formula you will test for errors:

If ({customer.CUSTOMER NAME} [1 to 2 = “Bi” 
and ToText({customer,CUSTOMER ID}) [1] = “6”) 
Or ({customer.CUSTOMER NAME} [1] = 'Ro” and 
ToText({customer.CUSTOMER ID}) [1] = “5”) 

“PREFERRED CUSTOMER” 
Else 

“DOES NOT FIT CRITERIA” 
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If correct, this formula should pick out all customers whose names 
begin with “Bi” and whose customer IDs begin with “6” and those 
companies whose names begin with “Ro” and whose customer 
IDs begin with “5”. When printing the field, those selections will 
read “PREFERRED CUSTOMER”, while the rest will read “DOES 
NOT FIT CRITERIA.”

You will now break down the formula to check and see that each 
condition of the formula is working individually. 

Formula1 1 To get started, create a report using the Customer table in 
CRAZE.MDB and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER ID}
{customer.CUSTOMER NAME}

For each portion of the formula you will place a new formula 
field next to these two fields in the report to check the 
condition.

2 Create a new formula called Formula1.

3 Type the following in the Formula text box of the Formula 
Editor: 

If {customer.CUSTOMER NAME} [1 to 2 = “Bi” 
Then 

“TRUE” 
Else 

“FALSE” 

4 Click the Check button to test for errors. You will receive the 
following error message: 

The ] is missing.

5 Correct the formula by inserting the missing “ ] “ after the 2. 

6 Click the Check button again. You will receive the following 
message:

No errors found.

7 Click Accept to return to the Insert Fields dialog box. 
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8 Place the corrected formula field to the right of the two data 
fields in the Details section of your report.

9 Click the PRINT PREVIEW button on the standard toolbar to see 
the values in the report and compare the fields to see if the 
field values returned by @Formula1 are correct. 

You will find “TRUE” listed next to the customer names that 
begin with “Bi” and “FALSE” next to all the others. Now you will 
check the other portions of the formula. Create Formula2, 
Formula3, and Formula4 following Steps 1 - 9 using the formulas 
specified below for each. Insert each formula field on the same line 
of the Details section for easy comparison. Check each one for 
errors, fix as needed, and make sure the values returned are 
correct before moving on to the next formula. 

Formula2 1 Create a new formula called Formula2.

2 Type the following in the Formula text box of the Formula 
Editor: 

If ToText({customer,CUSTOMER ID}) [1] = “6” 
Then 

“TRUE” 
Else 

“FALSE”

3 Click the Check button to test for errors. You will receive the 
following error message: 

This field name is not known.

4 Correct the formula by replacing the comma (,) with a period 
(.) in the field name. 

5 Click the Check button again. Your formula should now be 
error-free. 

6 Place the formula to the right of the @Formula1 field.

7 Click the PRINT PREVIEW button on the standard toolbar to see 
the values in the report and compare the fields to see if the 
field values returned by @Formula2 are correct. 

You should see “TRUE” next to all customer numbers that begin 
with 6 and “FALSE” next to all customer numbers that do not 
begin with 6.
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Formula3 1 Create a new formula called Formula3.

2 Type the following in the Formula text box of the Formula 
Editor: 

If {customer.CUSTOMER NAME} [1 to 2] = 'Ro” 
Then 

“TRUE” 
Else 

“FALSE”

3 Click the Check button to test for errors. You will receive the 
following error message: 

The matching ' for this string is missing.

4 Correct the formula by changing the single quote (’) before Ro 
to a double quote (“).

5 Click the Check button again. Your formula should now be 
error-free. 

6 Place the formula to the right of the @ Formula2 field.

7 Click the PRINT PREVIEW button on the standard toolbar to see 
the values in the report and compare the fields to see if the 
field values returned by @Formula3 are correct. 

You should see “TRUE” next to all Customer names that begin 
with “Ro” and “FALSE” next to all Customer names that do not 
begin with “Ro”.

Formula4 1 Create a new formula called Formula4.

2 Type the following in the Formula text box of the Formula 
Editor: 

If ToText({customer.CUSTOMER ID}) [1] = “5”
“TRUE” 

Else 
“FALSE” 

3 Click the Check button to test for errors. You will receive the 
following error message: 

The word 'then' is missing.
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4 Correct the formula by typing in the word “Then” at the end 
of the first line after “5”.

5 Click the Check button again. Your formula should now be 
error-free. 

6 Place the formula to the right of the @Formula3 field.

7 Click the PRINT PREVIEW button on the standard toolbar to see 
the values in the report and compare the fields to see if the 
field values returned by @Formula4 are correct. 

You should see “TRUE” next to all Customer IDs that begin with 
5 and “FALSE” next to all Customer IDs that do not begin with 5.

Now that the formulas are error-free and the field values returned 
are correct, you will create a formula that links the separate 
components together. You will begin by linking the first two 
formulas (@Formula1 and @Formula2) and then add @Formula3 
and @Formula4 to create the final formula @FinalFormula. 

Formula1+2 1 Create a new formula called Formula1+2.

2 Type the following in the Formula text box of the Formula 
Editor: 

If {customer.CUSTOMER NAME} [1 to 2] = “Bi” 
and ToText({customer.CUSTOMER ID}) [1] = “6” 
Then 

“TRUE” 
Else 

“FALSE”

3 Place the formula to the right of the @Formula4 field. 

You should see “TRUE” next to each customer whose name 
begins with Bi and Id begins with 6, and “FALSE” next to all 
Customer IDs that do not meet this criteria.

If this formula is working correctly, you can create one last 
formula adding the code from @Formula3 and @Formula4.

FinalFormula 1 Create a new formula called FinalFormula.

2 Type the following in the Formula text box of the Formula 
Editor: 
374 Seagate Crystal Reports User�s Guide



If ({customer.CUSTOMER NAME} [1 to 2] = “Bi” 
and ToText({customer.CUSTOMER ID}) [1] = “6”) 
or ({customer.CUSTOMER NAME} [1 to 2] = “Ro” 
and ToText({customer.CUSTOMER ID}) [1] = “5”) 
Then 

“PREFERRED CUSTOMER” 
Else 

“DOESN'T FIT CRITERIA”;

3 Place the formula where you want it to appear in the Details 
section of your report. You can now delete all other formula 
fields from your report. See How to delete formulas from your 
report, Page 340.

Use this same process of condition-by-condition testing for any 
formulas as a means of systematically checking them.
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15 Advanced Totalling

What you will find in this chapter...

Introduction, Page 378

HANDS-ON (Advanced Totalling), Page 378
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Introduction

Advanced totalling is any kind of report totalling that requires the 
extensive use of formulas. Tutorials included in this chapter 
demonstrate the techniques needed to produce many of the most 
common reports that require advanced totalling. Each tutorial 
takes you step-by-step through the process of creating the report 
and adding the necessary formulas.

The topics covered in this chapter are advanced techniques. 
Before starting, you should be familiar with how to design reports 
in Seagate Crystal Reports, how to group values in a report and 
how to summarize data. You should also know how to use the 
formula language, including variables, to create formulas and add 
them to a report.

Related Topics

Sorting, Grouping, and Totalling, Page 271

Formulas 101, Page 321

Advanced Formulas, Page 345

Search for Functions Index in Seagate Crystal Reports online Help.

HANDS-ON (Advanced Totalling)

How to maintain running totals in a list

Running totals are totals that are displayed generally on a record 
by record basis. They total all records (in the report, in the group, 
and so forth) up to and including the current record. For example, 
if your first three records have values of 2, 4, and 6, the running 
total for each of the three records would be as follows: 

Values Running Total

2 2 = 0 + 2
4 6 = 2 + 4

6 12 = 6 + 6
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The most basic form of running total is a single running total 
maintained throughout a list. In this tutorial you will create that 
kind of report, setting up a running total for a list of order 
amounts.

To set up this report, you will create two formulas:

1. ResetTotal
This formula resets the Amount variable to $0.00 at the 
beginning of the report.

2. @RunningTotal
This formula adds the value of the current record to the 
Amount variable and displays the current total as the running 
total.

NOTE: To see an example of this report, open the report file

RTO1.RPT located in the \CRW directory.

1 To get started, create a report using the sample data, 
CRAZE.MDB, link the Customers and Orders tables, and 
place the following fields from left to right in the Details 
section:

{customer.CUSTOMER NAME}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

2 Create a formula named ResetTotal and enter the following in 
the Formula Editor:

ResetTotal (“Amount”)

This formula says:

Reset the value in the Amount variable to 
$0.00.

3 Place the formula in the Report Header section of your report. 
Since it’s in the Report Header section, it will run only once, at 
the beginning of the report.

4 Right-click the @ResetTotal field and choose the FORMAT 
FIELD command from the shortcut menu that appears. The 
Format Editor appears.

5 Click the Common Tab to activate it.
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6 Toggle the Suppress option on to hide the field from view 
when printing, and click OK when finished to return to your 
report.

7 Create a formula named RunningTotal and enter the following 
into the Formula Editor:

RT (“Amount”, “Sum”, ToNumber ({orders.ORDER 
AMOUNT}), {customer.CUSTOMER NAME})

This formula says:

Convert the value in the {orders.ORDER 
AMOUNT} field to a number (if necessary), add 
the value in that field to the Amount 
variable, and keep track of the customer name.

NOTE: If you have NULL values in the field you are performing a

running total on, you will have to add code to check for NULL

values or toggle the Convert NULL field value to default check box
on using the Reporting Tab of the File Options dialog box. Search

for File Options dialog box in online Help.

8 Place this formula in the Details section of your report, just to 
the right of the Order Amount field.

NOTE: When you place @RunningTotal in the Details section of

the report, the formula executes for every record, thus keeping a

running total of the Order Amount field. See Area printing 
characteristics, Page 69.

Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.
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Related Topics

How to subtotal running totals within groups, Page 381

Formulas 101, Page 321

Advanced Formulas, Page 345

Reporting 101, Page 95

How to subtotal running totals within groups

Another common use of running totals is for tallying items in a 
group. The running total starts with the first item in the group and 
ends with the last. Then it starts all over again for the next group, 
then the next, and so on.

The value in each record is added to the
sum of the previous value in the report.

The total continues, unbroken,
throughout the running list.
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In this example, you will create a report that:

●   maintains a running total of customer orders,

●   groups customer orders and resets the running total for 
each group, and

●   displays the subtotal for each order (the last running total 
for that order). 

To set up this report, you will create three formulas: 

1. ResetTotal
Sets the value of the Amount variable to $0.00 at the 
beginning of each group.

2. RunningTotal
Adds the value of the current record to the Amount variable, 
and displays the current total as the running total.

3. PrintTotal
Prints the final running total value for the group as the group 
subtotal.

NOTE: To see an example of this report, open the report file

RTO2.RPT in the \CRW directory.

1 To get started, create a report using the sample data, 
CRAZE.MDB, link the Customers and Orders tables and place 
the following fields from left to right in the Details section:

{customer.CUSTOMER NAME}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

2 Create a formula named ResetTotal and enter the following in 
the Formula Editor:

ResetTotal (“Amount”)

This formula says:

Reset the value in the “Amount” variable to 
$0.00.

3 Place this formula in the Group Header section of your report. 
Since it’s in the Group Header section, it will run each time a 
new group is started. See Area printing characteristics, Page 69.
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4 Right-click the @ResetTotal field and choose the FORMAT 
FIELD command from the shortcut menu that appears. The 
Format Editor appears.

5 Click the Common Tab to activate it.

6 Toggle the Suppress option on to hide the field from view 
when printing, and click OK when finished to return to your 
report.

7 Create a formula named RunningTotal and enter the following 
into the Formula Editor:

RT (“Amount”, “Sum”,ToNumber({Orders.Order 
Amount}),{Customer.Customer Name})

This formula says:

Convert the value in the {orders.ORDER 
AMOUNT} field to a number (if necessary), add 
the value in that field to the Amount 
variable, and keep track of the customer name.

NOTE: If you have NULL values in the field you are performing a

running total on, you will have to add code to check for NULL

values or toggle the Convert NULL field value to default check box
on using the Reporting Tab of the File Options dialog box. Search

for File Options dialog box in online Help.

8 Place this formula in the Details section of your report, just to 
the right of the Order Amount field. 

NOTE: When you place @RunningTotal in the Details section of

the report, the formula executes for every record, thus keeping a

running total of the Order Amount field. See Area printing 
characteristics, Page 69.

Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.
Advanced Totalling 383



Related Topics

How to create group headers, Page 313

Formulas 101, Page 321

Advanced Formulas, Page 345

Reporting 101, Page 95

How to subtotal without grouping

There may be times when you have a list of values that are 
ungrouped, and you only want to subtotal some of the values in 
the list. For example:

●   you have a list that contains both Canadian and US 
customers,

●   you want to keep customer records sorted alphabetically 
based on customer name,

●   you do not want to break the data into groups based on the 
country, but

This report
displays the

running total
in each group.

The value in
each record is
added to the
sum of the
previous value
in the report.

The running
total starts
freshwith each
new group.

The final
running total
for each group
becomes the
subtotal for
that group
(Header total).
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●   you want a total of the values from just the Canadian 
records, and

●   you also want a total of the values from just the US records.

To do this you will need to create three formulas, one to keep track 
of US and Canadian records, one to print the US total, and one to 
print the Canadian total.

1. USCan 
Maintains separate running totals of US and Canadian 
records.

2. PrintUSA 
Prints the grand total of US records.

3. PrintCanada 
Prints the grand total of Canadian records.

NOTE: To see an example of this report, open the SUBTOTL.RPT

file in the \CRW directory.

1 To get started, create a report using the sample data, 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.COUNTRY}
{customer.LAST YEAR'S SALES}

2 Sort the records based on the {customer.CUSTOMER NAME} 
field.

3 Create the formula USCan and enter the following in the 
Formula Editor:

If {Customer.Country} = “Canada” Then 
RT (“CanadaAmount”, “Sum”,
ToNumber({Customer.Last Year's Sales}),
{Customer.Customer Name})

Else If {Customer.Country} = “USA” Then 
RT (“USAAmount”, “Sum”,
ToNumber({Customer.Last Year's Sales}),
{Customer.Customer Name})

Else 
0
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This formula says look at each record:

●   If the value in the {customer.COUNTRY} field is “Canada”, 
add the value in the {customer.LAST YEAR’S SALES} field 
to the value in the CanadaAmount variable.

●   If the value in the {customer.COUNTRY} field is “USA”, 
add the value in the {customer.LAST YEAR’S SALES} field 
to the value in the USAAmount variable.

●   If the value is something other than “Canada” or “USA”, 
print 0.

4 Place this formula in the Details section, just to the right of the 
{customer.LAST YEAR’S SALES} field.

NOTE: It is critical that you place this formula in the Details

section. Since the formula has to evaluate each record, it has to

run every time the program prints a record and that happens only

if you place it in the Details section. See Area printing 
characteristics, Page 69.

5 Create the PrintCanada formula and enter the following in the 
Formula Editor:

RT (“CanadaAmount”, “Fetchsum”, 
ToNumber({Customer.Last Year's Sales}),““)

This formula says to print, as a total, the value in the 
CanadaAmount variable.

6 Place this formula in the Report Footer section, just below the 
Last Year’s Sales field.

NOTE: It is critical that you place this formula in the Report Footer

section so it gets evaluated and printed just once, at the end of the

report. This will provide you with a total of all the US values for

the entire report. See Area printing characteristics, Page 69.

7 Create the PrintUSA formula and enter the following in the 
Formula Editor:

RT (“USAAmount”, “Fetchsum”, 
ToNumber({Customer.Last Year's Sales}),““)

This formula says to print, as a total, the value in the 
USAAmount variable. 
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●   Place this formula in the Report Footer section, just to the 
right of the @PrintCanada formula.

NOTE: Just as before, it is critical that you place this formula in

the Report Footer section.

Your report should look similar to the following:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

How to subtotal true A to B, A to C reports

The term A to B, A to C report has been used to refer to any report 
in which a primary table is linked to two lookup tables (see 
Methods of looking up tables (direct access databases), Page 532). 
However, in a true A to B, A to C link, a single field in the primary 
table is used to link to both of the lookup tables.

In a true A to B, A to C relationship, one of the two lookup tables 
usually has more records than the other. If you group these 
records based on a field in the primary table, values in the smaller 
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lookup table are repeated for each value in the larger lookup table. 
The following table shows data for an A to B, A to C relationship. 
The Customer table is linked to the Credits table and again to the 
Orders table. Notice that Jones has only one Credit ID, but that 
credit and its amount are repeated, once for each of Jones’ two 
orders. 

Using a standard subtotal on these groups for both the Order 
Amount field and the Credit Amount field, the single credit for 
Jones is counted twice, and the subtotal displays an inaccurate 
value of -20.00. It should only count this value once and display a 
subtotal of -10.00 because that is the total credit Jones has. 

NOTE: Notice that the total Credit Amount for Jones is incorrect.

This problem would also occur in the Order Amount field if, for 
instance, Jones had two different Credit Amounts and only one 
Order Amount. You can avoid this problem by creating a formula 
for each field you want subtotaled, and placing the formula in the 
Group Footer (GF).

Name Credit ID
Credit
Amount

Order ID
Order
Amount

Jones 1 -10.00 1 10.00
Jones 1 -10.00 2 12.00

Smith 2 -23.00 3 20.00

Smith 3 -45.00 4 30.00

Name Credit ID
Credit
Amount

Order ID
Order
Amount

Jones 1 -10.00 1 10.00

Jones 1 -10.00 2 12.00
-20.00 22.00

Smith 2 -23.00 3 20.00

Smith 3 -45.00 4 30.00
-68.00 50.00
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NOTE: For an example of this report, open the TRUEABAC.RPT

file in the \CRW directory.

1 To get started, create a report using the sample data, 
ORDRCR.MDB, and place the following fields from left to 
right in the Details section:

{cust.NAME}
{credits.CREDIT ID}
{credits.CREDIT AMOUNT}
{orders.ORDER ID}
{orders.ORDER AMOUNT}

NOTE: The sample data in ORDRCR.MDB has been specially

designed to demonstrate a true A to B, A to C link. Make sure that

the {credits.CUST} field is linked to both the {orders.CUSTOMER}

and {cust.NUMBER} fields in the Visual Linking Expert.

2 In the Design Tab, highlight the {orders.ORDER AMOUNT} 
field and insert a subtotal, grouping on the {cust.NAME} field.

3 Create a second subtotal for {credits.CREDIT}, again grouping 
on {cust.NAME}.

4 Click the Preview Tab, and notice that the {credits.CREDIT 
AMOUNT} subtotal for Jones is twice as large as it should be 
(there is only one credit for Jones, but it appears twice, once 
for each order).

5 Create a new formula, named Credits Subtotal. Enter the 
following in the Formula Editor:

DistinctCount({credits.CREDIT ID}, 
{cust.NAME}) * Average({credits.CREDIT},
{cust.NAME})

This formula says:

Count the number of actual credits given to 
the customer in {cust.NAME}. Multiply this 
value by the average of all credit amounts 
displayed in the report for the customer in 
{cust.NAME}.
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Jones has only one credit. The average of all of the credit 
amounts displayed for Jones is -10.00 (-10.00 + -10.00 = 
-20.00, -20.00 / 2 = -10.00).

6 Click Accept in the Formula Editor and place the formula in 
the Group Footer (GF) section next to the subtotal on the 
{credits.CREDIT AMOUNT} field.

7 Notice that the new formula-based subtotal produces the 
correct result. Delete the original, incorrect subtotal for the 
{credits.CREDIT AMOUNT} field.

Related Topics

Formulas 101, Page 321

Advanced Formulas, Page 345

Reporting 101, Page 95
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16 Parameter Fields

What you will find in this chapter...

Parameter field objects overview, Page 392

Multiple parameter fields, Page 393

Parameter field considerations, Page 393

HANDS-ON (Parameter Field Objects), Page 394
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Parameter field objects overview

Parameter fields are fields that prompt you to specify a value each 
time you refresh the data in your report. When you supply a 
value, the program runs the report using that value. By using 
parameter fields in formulas, selection formulas, and in the report 
itself, you can create one report that you can modify quickly as 
your needs change. See Formulas 101, Page 321.

Imagine that you are creating a report and you want to include 
only California records. Without parameter fields, you would 
enter a record selection formula similar to this:

{customer.REGION} = “CA”

This formula always tests the {customer.REGION} field to see if it 
holds the value “CA”. If it does, it uses the record in the report. If 
it does not, it rejects the record. The report runs exactly the way 
you want it. This is fine if you always want to run the report using 
only California records. But if you want to run it using records 
from other states, you have to edit the formula and hard code your 
changes (for example, if you want to run the report using Arizona 
records, you would have to change “CA” to “AZ” in the Record 
Selection Formula Editor or the Select Expert). See How to set up 
record selection using the Select Expert, Page 263.

Using a parameter field in place of the state field value, however, 
lets you make changes “on the fly”, without hard coding a new 
value. Here is how it works...

1 Set up a parameter field by choosing the PARAMETER FIELD 
command from the Insert menu. For the purpose of this 
example, call that parameter field Region.

2 Use the parameter field in your selection formula. Instead of 
using the formula:

{customer.REGION} = “CA”

Create a formula similar to this:

{customer.REGION} = {?Region}
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NOTE: {?Region} is the parameter field you created in Step 1. The
program uses the {?ParameterFieldName} format for parameter
fields in formulas and Experts.

3 Whenever you refresh the data in your report, the program 
prompts you to supply a value for the parameter field or to 
accept the default value. When you do, the program selects 
the records for the report using the value you specified.

Using parameter fields, you can create one report that can be 
customized quickly to meet a variety of needs.

Multiple parameter fields

Formulas and record selection formulas can contain multiple 
parameter fields. When using multiple parameter fields, the 
program prompts you for each parameter before it refreshes the 
data. Thus, you can use a selection formula similar to the 
following:

{customer.REGION} = {?Region} AND 
{customer.LAST YEAR’S SALES} <= {?Sales}

This formula will prompt you first for the region you want to 
report on and then, for the amount that you want to compare last 
year’s sales against.

Parameter field considerations

There are a number of things to keep in mind when you are 
working with parameter fields.

●   You do not have to place a parameter field in your report in 
order to use it in a record or group selection formula. You 
just create the parameter field and then enter it in your 
formula as you would any other field.

●   The program supports parameter fields in the following 
data types: string, number, currency, Boolean, and date.
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●   Parameter field prompts can be up to two lines long with 
approximately 40-50 characters per line (depending on 
character width, up to 255 character limit). The program 
performs automatic word wrap on prompts more than one 
line long.

●   A parameter field can have only one default value. 

●   You can use parameter fields in compiled reports to prompt 
for record selection criteria that you normally would not be 
prompted for in a compiled report. In this way, the 
program gives you the opportunity to specify values in 
compiled report selection formulas that contain fields and 
operators only. But if you place a parameter field in your 
selection formula, the program will prompt you for its 
value, even if that value is not a field.

HANDS-ON (Parameter Field Objects)

This section includes Hands-On tutorials for performing a 
number of different tasks using parameter fields. How to create a 
parameter field, Page 394, How to use a parameter field in a formula, 
Page 398, and How to respond to parameter field prompts, Page 399, are 
sequential; they provide an overview of a typical process using 
parameter fields. The remaining tutorials can be read 
individually, as needed.

How to create a parameter field

1 Click the INSERT FIELDS button on the standard toolbar. The 
Insert Fields dialog box appears. Click the Parameter Tab to 
activate it.
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3 The Create Parameter Field dialog box appears. Enter the 
following information into the fields provided:

●   Parameter Name: Enter the name you want to use to identify 
the parameter field.

●   Prompting Text: Enter the text you want to appear when the 
program prompts you.

●   Value Type: Enter the data type of the parameter field.

●   Default Prompting Value: Enter the value you want the 
program to use if you do not supply a new value.

●   Browse Table: Use this drop-down box to specify a default 
table.

●   Browse Field: Use this drop-down box to specify a default 
field.

Your dialog box should look like this:

2 Click the

New button.
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4 Click OK to return to the Insert Fields dialog box. The new 
parameter field is name displayed in the Parameter Fields list.

How to set record selection using parameter fields

You can easily use parameter fields for record selection. In this 
example, you will create a parameter field that selects regions to 
include in the report.

1 To get started, create a report using the Customer table in 
CRAZE.MDB, and place the following fields from left to right 
in the Details section:

{customer.CUSTOMER NAME}
{customer.LAST YEAR’S SALES}

2 With the Insert Fields dialog box still active, click the 
Parameter Tab to activate it.

The Create Parameter Field dialog box appears.

3 Click the

New button.
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4 Enter the following information into the corresponding edit 
boxes:

●   Type “Region” in the Parameter Name text box.

●   Type “Enter the region you would like to see sales for” in 
the Prompting Text text box.

●   Select String from the Value Type drop-down box.

●   Type “CA” in the Default Prompting Value drop-down box.

●   Select Customer from the Browse Table drop-down box.

●   Select Region from the Browse Field drop-down box. 

5 Click OK. You are returned to the Insert Fields dialog box. The 
parameter field you just created now appears in the list box.

6 Click the SELECT EXPERT button on the standard toolbar. The 
Choose Field dialog box appears.

7 Select Region and click OK. The Select Expert appears.

8 Leave the first drop-down box set to is. Choose equal to from 
the second drop-down box. A third drop-down box appears.

9 Click the arrow on the drop-down box to display the list of 
regions. The prompting variable that you created now 
appears at the top of the list. 

10 Select the prompting variable from the list and click OK.
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Now, when you refresh your data, the program will prompt you 
for the parameter values and base record selection on the values 
you provide. See How to create a record or group selection formula, 
Page 265.

How to use a parameter field in a formula

1 In the Insert Fields dialog box, click the Formula Tab to 
activate it.

2 Click the New button and type a name for the formula in the 
Formula Name dialog box when it appears. 

3 Click OK when finished. The Formula Editor appears.

4 Create your formula using the parameter field as you would 
any constant value. For example, instead of creating a formula 
that hard-codes the region name:

{customer.REGION} = “CA”

Use a parameter field in place of “CA”:

{customer.REGION} = {?ParameterFieldName}

When you click Accept, the program returns you to the Insert 
Fields dialog box with the name of the formula you just created 
highlighted in the Formula list box.

5 Click the Insert button and place the formula where you want 
it to appear in your report.

6 Click Close to exit the Insert Fields dialog box.

7 To see how this field works, click the PRINT PREVIEW button 
on the standard toolbar to run the report. 

A dialog box will appear prompting you for values. See How to 
respond to parameter field prompts, Page 399.

NOTE: The program automatically puts a question mark before

the field name to identify it as a parameter field. See Formulas 101, 
Page 321.
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How to respond to parameter field prompts

Previewing a

report for the

first time

When you preview a report for the first time, the Enter Parameter 
Values for Main Report dialog box appears prompting you for a 
value.

●   If you specified a default value when you created the 
parameter field, the program will use that value unless you 
specify a new one.

●   If you did not specify a default value, you must supply a 
value before the program will refresh the data.

Refreshing

report data

When you refresh data from the Preview Tab, the Refresh Report 
Data dialog box appears.

●   Click the Use current parameter values button if you want to 
use the current parameter value.

●   Click the Prompt for new parameter values button if you want 
to enter a new parameter value. If you choose this option 
and click OK, the Enter Parameter Values for Main Report 
dialog box appears.

   Date values are entered using the following format: 
Date (Year, Month, Day). For example, Date (1997, 5, 
21).

   Boolean values are entered using the following format: 
TRUE or FALSE.

   String values are entered exactly as they appear in the 
field.
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The program will now run the report using the new value you 
specify.

How to use wildcards with parameter fields

You can use wildcards in your parameter field values to increase 
their flexibility. When prompted for a value, simply respond with 
a value using a wildcard.

NOTE: You can only use a wildcard in a parameter field value if

the wildcard would have been appropriate in the non-

parameterized value (for example, in formulas using the Like
operator or the LooksLike function). Search for Functions and
Operators and Variables in Seagate Crystal Reports online Help.

Putting your parameter field in a selection formula using the Like 
operator, for example, and then responding to the prompt using a 
wildcard, you can create record selection requests like this:

{customer.REGION} like “A?”

«The program uses all the records that have a value in the 
Region field beginning with A, regardless of what the second 
character is. This kind of request would return records from 
Alaska (AK), Alabama (AL), Arizona (AZ), and so forth.»

{customer.REGION} like “?A”

If you want to use a different value than the default

displayed, type a new value in the text box, and click OK.

If you want to use the default value, simply click OK.
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«The program uses all the records with Region values ending 
in A, regardless of what the first character is. In this case, the 
request would return records from California (CA), 
Pennsylvania (PA), Washington (WA), and so forth.»

You can also use the * wildcard to create record selection requests 
like this:

{customer.POSTAL CODE} like “8*”

Here the program uses all the records with Postal Code values 
beginning with 8. Because you are using a wildcard to designate 
any and all missing characters, the request would return both five 
digit and nine-digit (ZIP plus 4) postal codes.

You can restrict your report to a smaller postal code range by 
increasing the number of constant characters before the wildcard. 
For example:

{customer.POSTAL CODE} like “84*”

In this case the program uses all the records with Postal Code 
values beginning with 84.

Related Topics

Record and Group Selection, Page 249

How to conditionally format using parameter fields

You can create conditional formatting formulas using parameter 
fields that you can customize whenever you refresh the data in the 
report. A typical use for such a formula would be for color- 
flagging data if it meets certain conditions. For example:

●   sales representatives who have sales more than 10% over 
quota,

●   customers who have not ordered in the last quarter, and

●   inventory items that have not had any movement in the last 
month.

If the conditions under which you flag these items never changes, 
you do not need to use parameter fields. You can just use formulas 
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(for text flags) or conditional formatting (for color or border flags). 
But if you want to change the conditions from report to report, 
you can use parameter fields in formulas and conditional 
formatting formulas to do it.

1 Create the parameter field in the data type you need for the 
formula.

2 Create the formula and use the parameter field in place of the 
fixed value you would normally use.

3 For example, to print the names in red of all the customers 
who had sales last year over a certain value (that you want to 
be prompted for), select the Last Year’s Sales field and click 
the OBJECT PROPERTIES button on the supplementary toolbar. 
The Format Editor appears.

4 Click the Conditional formula button next to the Color property 
on the Font Tab, and format the field using a conditional 
formatting formula like this:

If {customer.LAST YEAR’S SALES} > 
{?ParameterFieldName} Then 

Red
Else

Black

Now when you refresh the data, the program will prompt you for 
the value that triggers the color flag (know as the threshold value). 
It then runs the report and flags all the customers that had sales 
last year over the threshold figure. You can change the figure if 
you wish every time you run the report and the program will flag 
a different set of Customer Names each time.

Related Topics

How to create if-then-else formulas, Page 346

Conditional attribute properties, Page 236

Conditional formatting, Page 235

How to format objects conditionally, Page 224
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How to set a report title using parameter fields

Using a parameter field, Seagate Crystal Reports allows you to 
create a Report Title that can be changed each time the report is 
refreshed.

1 From the Insert Fields dialog box, click the Parameter Tab to 
activate it. 

2 Click the New button. The Create Parameter Field dialog box 
appears.

3 Type a name for the parameter field in the Parameter Name 
edit box. Type any prompting text you want to appear in the 
Prompting Text edit box. Select String in the Value Type drop-
down box. 

4 Click OK when finished. You are returned to the Insert Fields 
dialog box. The parameter field you created appears in the 
list.

5 Select the parameter field and click the Insert button.

6 Place the parameter field in the Page Header section of your 
report if you want the title to appear on every page, or in the 
in Report Header section if want the title to appear on only 
the first page of the report.

Now when you refresh the data, the program will prompt you for 
a report title. You can change the title if you wish every time you 
run the report.

How to set sort order using parameter fields

To set the sort order using parameter fields, you need to create a 
formula that includes a parameter field and then sort on that 
formula. For example, assume that you have a customer list report 
based on the Customer table. For each customer, you show the 
Customer Name, City, Region, Country, and Phone Number. You 
want to be able to sort the report by Country, by Region, or by 
City, depending on your needs at the time. 
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1 Create a parameter field and name it SortField. See How to 
create a parameter field, Page 394.

2 In the Prompting Text edit box, type a prompt similar to this:

Type R to sort by Region or C to sort by City, 
otherwise data will be sorted by Country.

3 Create a formula similar to this and call it Sort:

If {?SortField} = “C” Then 
{customer.CITY}

Else
If {?SortField} = “R” Then

{customer.REGION}
Else

{customer.COUNTRY}

«This formula prompts for a value for the parameter field 
{?SortField}. If you enter “C”, the formula will sort by the City 
field. If you enter “R” it will sort by the Region field. If you 
enter anything else, or do not enter anything at all, the formula 
will sort by the Country field. See How to create multi-condition 
if-then-else formulas, Page 348.»

4 Place the formula in the Report Header section of your report 
and toggle its Suppress option on in the Section Expert so it 
does not print. Search for Section Expert in Seagate Crystal 
Reports online Help.

5 Click the SORT RECORDS button on the standard toolbar, 
choose your formula, @Sort, as your sort field. See How to do a 
single field sort, Page 281.

Now when you run the report, the program will prompt you for a 
sort field, the formula will return a value based on your selection, 
and the sort facility will use that value as your sort field.
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17 Graphing

What you will find in this chapter...

Graphing Overview, Page 406

Where to place your graph, Page 407

Data you can graph on, Page 408

Before you create your graph, Page 408

HANDS-ON (Graphing), Page 408
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Graphing Overview

Seagate Crystal Reports enables you to include sophisticated, 
colorful charts and graphs in your reports. You can use graphs 
any time you want to improve the usability of your report. For 
example, you can use graphs to show 1995 fiscal results or the 
sales within the fiscal quarters.

Choosing a graph or chart type

Seagate Crystal Reports provides 12 graph/chart types. Different 
sets of data are particularly suited to a certain graph/chart type. 
The following is an overview of main graph/chart types and their 
most popular uses.

●   Side by Side bar graph
A Side by Side bar graph (also known as a column graph) 
displays a series of vertical bars. This type of graph is best 
suited for showing data for several groups over a period of 
time (for example, last year’s sales figures for CA, AZ, OR, 
and WA). Also available is a 3D Side graph.
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●   Stacked Bar
A Stacked Bar graph displays data as a series of vertical 
bars. This type of graph is best suited for representing three 
series of data, each series displayed as a different color 
stacked in a single bar (for example, sales for 1994, 1995, 
and 1996). Also available are a 3D Stacked graph, Percent 
Bar graph, and a 3D Percent Bar graph.

●   Line
A Line graph displays data as a series of points connected 
by a line. This type of graph is best suited for showing data 
for a large number of groups (for example, total sales over 
the past several years).

●   Area
An Area graph displays data as areas filled with color or 
patterns. This type of graph is best suited for showing data 
for a limited number of groups (for example, percentage of 
total sales for CA, AZ, OR, and WA).

●   Pie
A Pie chart displays data as a pie, split and filled with color 
or patterns. This type of chart can only be used with one 
group of data (for example, the percentage of sales for 
entire inventory). Also available are a Multiple Pie chart 
and a Weighted Pie chart.

Where to place your graph

Where you place your graph determines what data gets displayed 
and where it is printed. For example, if you place a graph in the 
Report Header section, the graph includes data for the entire 
report. If you place it in a Group Header or Group Footer section, 
it displays group specific data.

NOTE: If your report contains subreports, you can place graphs in
those subreports as well. See Subreports, Page 429.

Drill down
with graphs

Not only is a graph a powerful way of presenting data, it is also a 
powerful analysis tool. When you place your mouse pointer over 
a segment of the graph in the Preview Tab your mouse will 
become a drill down cursor. You can double-click to see the details 
supporting that section of the graph. 
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Data you can graph on

You can graph on the following:

●   summary and subtotal fields (see How to graph on a summary 
or subtotal field, Page 408),

●   detail fields (see How to graph on a details field, Page 409).

●   formula fields (see How to graph on a formula field, Page 411), 
and

●   cross-tab summaries (see How to graph on cross-tab 
summaries, Page 412),

Before you create your graph

By default, graphing is performed on summarized data at the 
group level. In other words, you are graphing summary and 
subtotal information. Before you can create a graph, you must 
have at least one group and one summary or subtotal in your 
report.

For example, if you have a sales report grouped by Region and a 
subtotal of Last Year’s Sales for each Region, you can quickly 
create a graph that will display sales by Region.

HANDS-ON (Graphing)

How to graph on a summary or subtotal field

Many of the graphs/charts you will create will be based on 
summary or subtotals within your report. In order to create these 
graphs/charts, you must have a summary or subtotal already 
inserted in your report. For more information on inserting 
summaries or subtotals, see How to summarize grouped data, Page 
289 and How to subtotal grouped data, Page 291.
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1 With the summary or subtotal field selected, click the INSERT 
CHART button on the standard toolbar. The Graph/Chart 
Expert appears with the Type Tab active. Twelve graph/chart 
types appear as buttons.

2 Click the type of graph/chart that will best illustrate your 
data (see Choosing a graph or chart type, Page 406). 

3 Click the Group button on the Data Tab to specify that your 
graph/chart will be based on grouped data.

NOTE: When you summarize or subtotal a field the data is
automatically grouped. For more information, see Sorting, 
Grouping, and Totalling, Page 271.

4 Specify the data you want to graph on using the appropriate 
drop-down boxes.

5 If desired, add text to your graph using the Text Tab and add 
a legend, grid lines, etc., using the Options Tab.

6 Click the Graph Done button when you are finished. An object 
frame appears. Position the frame where you want the graph 
to print and click once to place it.

NOTE: When you insert a graph/chart, it may cover a portion of
your report. You will need to move the graph/chart and possibly
resize it to fit in your report the way you want.

How to graph on a details field

A Detail Graph/Chart allows you to create a graph or chart based 
on specific values. Often, graphs are created based on some type 
of summary field in your report where the values plotted in the 
chart are dependent on the values in the summary field. With a 
Detail Graph/Chart, you can create a graph or chart without the 
need for a summary field by using values that appear in the 
Details section of your report.

To create a Detail Graph/Chart, you need to specify two things:

1. Condition.

2. Value.
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Condition The Condition is used to indicate when to plot the point. For 
example, the graph showing last year’s sales for your customers 
uses the Customer Name field as the condition. Each time the 
condition changes (the customer name changes), a point is 
plotted.

Value The Detail Graph/Chart uses the Value to indicate what is plotted 
as the points on your graph. For example, if you want to create a 
graph showing last year’s sales for your customers, the Last Year’s 
Sales field would be the value. Each time a point is plotted, it will 
be plotted at the point representing the corresponding value in the 
Last Year’s Sales field.

Creating and modifying your Detail Graph/Chart is easy with the 
use of the Graph/Chart Expert. The Expert walks you through the 
creation of your graph step-by-step. 

1 Highlight the details field you want to graph on and click the 
INSERT CHART button on the standard toolbar. The Graph/
Chart Expert appears.

2 Choose the type of graph/chart you want to create by clicking 
the corresponding button on the Type Tab.

3 Click the Data Tab to activate it.

4 Click the Detail, Formula button to specify a Detail graph/
chart.

5 Enter the condition (when values will be plotted) and value 
(what values will be plotted) in the appropriate boxes.

6 Enter a title, headings, etc., if desired using the Text Tab.

7 Add a legend, grid lines, and other elements to your graph/
chart using the Options Tab.

8 Click the Graph Done button when you are finished. An object 
frame appears. Position the frame where you want the graph 
to print and click once to place it.

NOTE: When you insert a graph/chart, it may cover a portion of
your report. You will need to move the graph/chart and possibly
resize it to fit in your report the way you want.
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How to graph on a formula field

Seagate Crystal Reports allows you to create a graph based on a 
formula field. Graphing on a formula field is much like graphing 
on a details field (see How to graph on a details field, Page 409). 

To create a graph/chart for a formula field you need to specify 
two things:

1. Condition.

2. Value.

Condition The Condition is used to indicate when to plot the point. For 
example, the graph showing last year’s sales by Country uses the 
Country field as the condition. Each time the condition changes 
(the country changes), a point is plotted.

Value The Value is used to indicate what is plotted as points on your 
graph. For example, if you want to create a graph showing a 
calculation for last year’s sales (i.e., a budget projection for next 
year of last year’s sales plus 10%), the Last Year’s Sales field would 
be the value. Each time a point is plotted, it will be plotted at the 
point representing the corresponding value in the Last Year’s 
Sales field.

1 Highlight the formula field you want to graph on and click 
the INSERT CHART button on the standard toolbar. The Graph/
Chart Expert appears.

2 Choose the type of graph/chart you want to create by clicking 
the corresponding button on the Type Tab.

3 Click the Data Tab to activate it.

4 Click the Detail, Formula button to specify a graph/chart for 
formulas.

5 Enter the condition (when values will be plotted) and value 
(what values will be plotted) in the appropriate boxes.

6 Enter a title, headings, etc., if desired using the Text Tab.

7 Add a legend, grid lines, and other elements to your graph/
chart using the Options Tab.
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8 Click the Graph Done button when you are finished. An object 
frame appears. Position the frame where you want the graph 
to print and click once to place it.

NOTE: When you insert a graph/chart, it may cover a portion of
your report. You will need to move the graph/chart and possibly
resize it to fit in your report the way you want.

How to graph on cross-tab summaries

Seagate Crystal Reports allows you to include a graph/chart 
based on summary values in your cross-tab report. For example, 
with a cross-tab that shows the total number of a certain product 
sold in each region of the United States, you may want to include 
a graph that shows what percentage of the total sales of the 
product were provided by each region. 

To create a cross-tab graph/chart you must of course have a cross-
tab inserted in your report. For more information, see Cross-Tab 
Objects, Page 445.

1 With the cross-tab highlighted, click the INSERT CHART button 
on the standard toolbar. The Graph/Chart Expert appears.

2 Click the Graph Tab to activate it.

3 Click the Cross-tab button to specify you want to create a 
cross-tab graph/chart.

4 Specify the summarized field you want your graph based on 
using the Graph on drop-down box.

5 Specify the primary row or column you want your graph 
based on using the By drop-down box.

6 If desired, specify the secondary row or column you want 
your graph based on using the Subdivided By drop-down box.

7 Click the Graph Done button when you are finished. An object 
frame appears. Position the frame where you want the graph 
to print and click once to place it.

NOTE: When you insert a graph/chart, it may cover a portion of
your report. You will need to move the graph/chart and possibly
resize it to fit in your report the way you want.
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How to edit a graph/chart using the Graph/Chart Expert

Once you have created your graph/chart, you may want to add a 
title, headings, legend, change fonts, or even the type of graph 
itself. Modifying your graphs is easy with the use of the Graph/
Chart Expert.

1 Right-click the graph/chart you want to edit and choose the 
FORMAT CHART command from the shortcut menu that 
appears.

2 The Graph/Chart Expert appears with all the details of the 
selected graph/chart.

3 Make the desired changes and click the Graph Done button 
when finished to update your graph/chart

How to edit graphs using PGEditor

The PGEditor is a powerful graph editor offering you 80 graph 
types and full formatting control of every graph element. The 
PGEditor is commonly used to format the graph title, change the 
colors of graphs, and resize portions of the graph. 

A very popular feature of the PGEditor is the ability to save graph 
formatting templates. These templates are like stylesheets for 
graphs. They contain custom formatting instructions that can be 
applied instantly to new graphs. If you continually create pie 
charts, for example, and you need the charts to appear in custom 
colors, you can create a template with those colors. Then, 
whenever you create a new graph, you simply apply the template 
and the graph is formatted to your template specifications.

See PGEDITOR.HLP (located in the \CRW directory or directory 
in which the program resides) for more information on the 
PGEditor application.
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How to use the underlay feature with graphs

Because graphs can only print in certain areas and sections of your 
report (see Area printing characteristics, Page 69), the underlay 
feature makes graphing more powerful than ever before. Now, 
instead of having a graph print before the data it represents, you 
can have the graph appear beside it, to make the data more 
understandable. 

1 Create your graph and place it in the Report Header section. 
For more information see How to graph on a summary or subtotal 
field, Page 408.

2 Click the OBJECT PROPERTIES button on the standard toolbar. 
The Section Expert appears

3 Highlight the Report Header section in the Sections list box 
and toggle the Underlay Following sections option on.

4 Click OK.

5 You are returned to your report, and the graph will underlay 
the sections below it. Move/resize the graph as desired.

Related Topics

How to make an object underlay a following section(s), Page 124
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18 OLE

What you will find in this chapter...

OLE Objects Overview, Page 416

Inserting OLE objects in your reports, Page 418

Linked vs. Embedded Objects, Page 419

The dynamic OLE menu commands, Page 420

OLE and the Picture command, Page 421

General OLE considerations, Page 421

HANDS-ON (OLE Objects), Page 422
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OLE Objects Overview

Often when you insert a graphic, spreadsheet, or some other 
object into a report, you may later find it necessary to change that 
object. Normally to make the changes, you would have to:

●   exit Seagate Crystal Reports, 

●   open the original application, 

●   change the object, 

●   return to Seagate Crystal Reports, 

●   delete the object originally inserted, and 

●   insert the newly revised object. 

All of these steps can be avoided using Object Linking and 
Embedding (OLE). OLE allows you to insert objects (OLE objects) 
into a report from other applications (OLE server applications) 
and then use those applications from within Seagate Crystal 
Reports to edit the objects if necessary.

To better understand the program’s use of OLE, some 
terminology may be helpful:

●   OLE
OLE is an acronym for Object Linking and Embedding. It 
refers to the ability to create compound reports, that is, 
reports that contain elements from other applications that 
can be edited using the original application.

●   OLE Object
An OLE object is, broadly speaking, a presentation of data 
that was created in another application and that maintains a 
relationship with the application that was used to create it. 
A bitmap created in a paint program, an Excel spreadsheet, 
or a graph from MS graph may all be OLE objects if they are 
inserted in the receiving document as OLE objects. If they 
are not inserted as OLE objects, they retain no relationship 
with the originating application.
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●   OLE Container Application
An OLE container application is one that can contain and 
process OLE objects created in other applications (such as 
Paint or Excel). Seagate Crystal Reports is a container 
application. 

●   Container Document
A container document is a document created using the 
container application and one that contains an OLE object.

●   OLE Server Application
An OLE server application is one that can create OLE 
objects that can then be placed in documents created by 
container applications. Microsoft Word and Excel are 
examples of applications that are both OLE servers and 
OLE containers. That is, they can create OLE objects and 
they can contain OLE objects created elsewhere. 

●   Server Document
A server document is the file created in the server 
application that stores the original OLE object.

●   Linked object
A linked object contains a presentation of the object and a 
pointer to a defined part of the server document. When you 
modify the original object in the server document, the links 
assure that the object in your report is modified 
automatically as well. Conversely, if you modify the object 
in the container document, the original object file is 
modified as well. As a general rule, use linked objects when 
the data in the server document is changing and you want 
the object in the container document to be updated when 
changes occur.

●   Embedded object
An embedded object contains a presentation of the object, all 
of the data that pertains to the object, and information about 
the application used to create it. When you modify the 
original object in the server document, nothing happens to the 
embedded object unless you specifically update that object. 
Likewise, when you modify the embedded object, nothing 
happens to the original. As a general rule, use embedded 
objects when you want to be able to edit the object in the 
container application without affecting the original object.
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●   In-place editing
In-place editing is the ability to change an OLE object’s 
properties while in Seagate Crystal Reports (or another OLE 
container application). The container application’s menu 
items change to provide the editing tools from the server 
application so that you can make the changes easily.

●   Static OLE Object
A static OLE object is a picture of an object that is stored in a 
document when it is saved. The picture can be displayed or 
printed by a user who does not have the application in 
which the original object was created. The object can not be 
edited in place, however, without first converting it to an 
editable type of object. Static OLE objects offer better online 
and print performance than do standard bitmaps.

When you place an OLE object in a report, the object becomes part 
of your report. If you want to edit the object, you simply double-
click it and modify it using the editing tools from the application 
used to create the object in the first place (or a similar application 
that allows such editing). This applies to all but static OLE objects. 
Using OLE objects in your report enables you to create robust 
documents that are easy to maintain.

Inserting OLE objects in your reports

There are several ways of inserting OLE objects into your 
application.

●   You can cut the object from an OLE server application and 
paste it in your report using the PASTE SPECIAL command on 
the Edit menu. If the object can be pasted in multiple 
formats, you decide which format to use. For example, 
when you’re inserting text from a Microsoft Word 
document, you can paste the text as Microsoft Word 
document text (which can be edited in Word) or as a 
metafile which is simply a non-editable picture of the text. 
Using the PASTE SPECIAL command you can place either 
embedded or linked objects.
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●   You can create a new object or import an existing one using 
the OLE OBJECT command on the Insert menu. You can 
place either embedded or linked objects this way.

●   Finally, you can drag and drop an object from an OLE 
server application. You do this by opening Seagate Crystal 
Reports in one window and the OLE server application in 
another, then dragging the object between the two. When 
you drag an object into a report, the object is embedded, not 
linked.

NOTE: Using the COPY and PASTE SPECIAL commands on the Edit

menu or drag and drop are most appropriate when you are

inserting selected information (pieces of larger files). The OBJECT

command on the Insert menu is most appropriate when you are

inserting entire files.

Linked vs. Embedded Objects

Since linked and embedded objects each have different properties, 
it is important for you to consider the capabilities of each when 
deciding which OLE format to use.

Linked objects When you insert a linked object, Windows copies a snapshot of 
the data from a file that already exists. Only the image of the object 
is added to your report. The actual data remains with the original 
file.

When you open the object from within your report, the original 
file is opened inside the application that was used to create it. Any 
changes you make directly change the original file.

If you want the data in your object to remain available to other 
applications, and to always reflect the most current changes to the 
data, link the object to your report.

NOTE: When you have a linked object and you break the link

using the Links dialog box, you are breaking all connections to the

original data in the server document. A linked object in a

container application is simply a presentation of an object and a

link between the object and the server document. When you break

the link you�re left with simply the representation and no
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relationship to the original data or to the editing capabilities of

the server application. In such a situation, Seagate Crystal Reports

turns the object into a picture (a metafile), a stand alone object

that can not be edited using OLE capabilities or converted into an

editable OLE object.

Embedded
objects

You can create an embedded object from within Seagate Crystal 
Reports, or you can create one using a file that already exists. The 
data, as well as the image of the object, is saved with your report.

If you want to create a new object for your report from scratch, or 
if you want to copy the information from an existing file and edit 
the data without ever affecting the original file, embed the object 
in your report.

●   If you change the original object, the embedded object does 
not change. 

●   If you edit an embedded object, changes you make to the 
object are stored with the report file; the changes do not 
affect the original.

The dynamic OLE menu commands

The OBJECT command on the Insert menu is dynamic. It changes 
to reflect the properties of the selected object and your options 
with that object.

The object may be described as a Document object, a Bitmap 
Image object, a Picture object, a Worksheet object, or something 
similarly descriptive.

●   If the object is embedded, the Insert menu displays those 
commands that are available to that type of embedded 
object.

●   If the object is linked, the Insert menu displays commands 
for that type of linked object. 

Commands on the shortcut menus change in a similar fashion.

These dynamic commands are provided to give you more control 
when working with OLE objects.
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OLE and the Picture command

If you place pictures in your report using the OBJECT command on 
the Insert menu, the picture can be treated as either an embedded 
or linked object. 

If you place pictures in your report using the PICTURE command on 
the Insert menu, however, Seagate Crystal Reports converts them 
into static OLE objects to enhance online and printing performance. 

Static objects do not support in-place editing. If you want to edit 
the object in place, you will have to convert it to an editable type 
of object using the CONVERT command on the Edit menu.

While Seagate Crystal Reports automatically converts bitmaps to 
static OLE objects if you insert them using the OBJECT or PASTE 
SPECIAL commands on the Insert menu, it does not convert 
bitmaps that are stored as BLOB field values in databases. If you 
place database bitmap fields into your report, the program 
displays them as normal bitmaps with no OLE characteristics.

General OLE considerations

There are several points to keep in mind when utilizing OLE 
functionality.

●   When you double-click an embedded OLE object, Seagate 
Crystal Reports changes its menus and toolbars to those of 
the object’s server application. When you are finished 
editing, click outside the object and the Seagate Crystal 
Reports toolbars reappear.

●   When you double-click a linked OLE object, the program 
opens the object’s server application with the object 
displayed, ready for editing. You can not edit a linked 
object in place in Seagate Crystal Reports because you are 
working on the original object. Since the object could be 
linked to multiple documents, and since, conceivably more 
than one person could want to edit it at a given time, 
displaying the original in the server application limits 
access to one editor at a time.
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●   Windows 3.x shipped Microsoft Paintbrush (PBRUSH.EXE) 
as the native bitmap editor. Windows 95 is shipping 
Microsoft Paint (MSPAINT.EXE) as the new bitmap editor. 
While Windows 95 knows to register and convert 
PBRUSH.EXE OLE bitmaps as MSPAINT OLE bitmaps, the 
opposite is not true. You can open a report created in 
Windows 3.1 containing OLE bitmaps using Windows 95, 
however you can not open a Windows 95 OLE bitmap 
report in Windows 3.x. Thus, if you are going to be working 
back and forth between these two operating systems, it is 
best to create the reports under Windows 3.1 instead of 
under Windows 95.

HANDS-ON (OLE Objects)

How OLE objects are represented in your report

An OLE object can be displayed in your report in several different 
formats depending on the choices available in the Insert Object 
dialog box and how you choose to insert the object.

●   If you have chosen to display your object as an icon, the 
icon will appear in your report. You may want to use this 
capability if you have large bitmaps to speed up report 
processing. Users can choose to load the bitmap later if they 
desire by double-clicking the icon. 

●   If you have created your object from an existing file, the 
data from that file (or an icon) will be displayed in your 
report. You can edit that data if you wish by double-clicking 
the object or its icon.

●   If you are creating a new object, the object application for 
the object type that you chose will open, and you can begin 
creating your object. When finished, close or exit the 
application. Your object or its icon will be displayed in your 
report.

Related Topics

Search for Insert Object dialog box in online Help.
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How to use OLE - General Overview Tutorial

The easiest way to understand the OLE concepts is to create a 
sample report that uses static, embedded, and linked objects in 
order to show their differences.

Static
OLE object

1 To begin, create a report using the sample data, CRAZE.MDB, 
and place any field in the Details section of the report. This is 
simply done to set up the report; since you're only interested 
in the OLE objects, the field you insert is unimportant.

2 Choose the PICTURE command from the Insert menu, choose 
CRAZEOLE.BMP from the \CRW directory, and when the 
placement rectangle appears, place the picture in the Report 
Header section, as far to the left as it will go.

3 Right-click the picture. When the shortcut menu appears you 
will see that the picture is identified as an OLE object. 

4 Double-click the object and nothing happens. A static OLE 
object can not be edited in place.

Embedded
OLE object

1 Choose the OLE OBJECT command from the Insert menu. The 
Insert Object dialog box appears.

2 Click the Create From File option. The dialog box changes 
allowing you to type in the name of an object or browse for an 
object. 

3 Click Browse and choose CRAZEOLE.BMP from the CRW 
directory.

4 Click OK to return to your report. A placement rectangle 
appears.

5 Place the object in the Report Header section, just to the right 
of the first picture.

6 Right-click this picture and you'll see that it too is identified as 
an OLE Object on the shortcut menu. The second command 
from the bottom of the shortcut menu identifies it as a Bitmap 
Image Object. It is an embedded OLE object.

7 Now double-click the object. Note how you have remained in 
Seagate Crystal Reports but all of the menus and tools have 
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changed to those in Microsoft Paint. Using those tools you can 
edit the bitmap in place if you wish. Even though you are 
working with the tools of the OLE server application, you are 
not working on the original object; you are working with a 
copy of the object and nothing you do here will affect the 
original. 

8 Click the first object you placed, the static OLE object. Note 
that when you click the object, the tools and menus change 
back to those from Seagate Crystal Reports. This confirms that 
the static object can't be edited in place. It also shows you how 
to stop editing an embedded object; when your editing is 
finished, simply clicking outside the edited object will return 
you to Seagate Crystal Reports.

Linked bitmap
image object

1 Choose the OBJECT command from the Insert menu. The Insert 
Object dialog box appears. 

2 Click the Create From File option. The dialog box changes 
allowing you to type in the name of an object or browse for an 
object. 

3 Click Browse and choose CRAZEOLE.BMP from the CRW 
directory.

4 This time toggle the Link check box on. 

5 Click OK to return to your report. A placement rectangle 
appears.

6 Place the object just to the right of the embedded object.

7 Right-click this object and you’ll see that it too is identified as 
an OLE object. The second command from the bottom of the 
shortcut menu identifies this as a Linked Bitmap Image 
Object.

8 Double-click the object. Note how Microsoft Paint opens 
displaying the original version of the object. Any changes you 
make to the original will be reflected in the version that 
appears in your report.

9 Close Microsoft Paint and return to your report.
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Converting a
static OLE
object to a
linked bitmap
image object

1 Right-click the first object you placed, the static OLE object.

2 When the shortcut menu appears, choose CONVERT PICTURE 
OBJECT. The Convert dialog box appears.

3 Select Paintbrush Picture from the Object Type list, and click 
OK. You have just converted a static OLE object to an editable 
OLE object.

4 Right-click the object you just converted and note that the 
second command from the bottom of the shortcut menu is 
now BITMAP IMAGE OBJECT, the same command that appeared 
with the center object you embedded.

5 Now double-click the object. Note that Microsoft Paint opens 
just as it did for the linked bitmap image object. 

6 Click the SAVE button on the standard toolbar and save the 
report as OLE.RPT.

Dragging and
dropping OLE
objects

One more procedure needs to be demonstrated: dragging an 
object from a server application and dropping it in Seagate Crystal 
Reports. For this example, you'll work with a spreadsheet object 
instead of a graphic object. 

NOTE: This procedure assumes that you have Microsoft Excel on

your computer or another spreadsheet program which is an OLE

server application.

1 Open both Seagate Crystal Reports and Microsoft Excel and 
size (tile) the program windows so they both are visible at the 
same time. You need to be able to see where the object is 
coming from and where it is going to.

2 In Seagate Crystal Reports, open OLE.RPT if it's not already 
open.

3 Create a simple spreadsheet in Microsoft Excel by placing the 
numbers one through ten (1-10) in cells A1 through A10.

4 Highlight cells A1 through A10.

5 Move the pointer to the left edge of the highlighted cells until 
you get an arrow pointer.

6 Press the mouse button and hold it down. This sets up the 
cells to be moved.
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7 Since you're only going to copy the cells, press the Control key 
and hold it down too. 

8 Now drag the cells into the Details section of the report in 
Seagate Crystal Reports and release the mouse button and 
Control key when you have the cells positioned. That's all 
there is to it. You have just dragged an OLE object into your 
report.

9 Save the file you created in Excel and close the application.

10 Right-click the spreadsheet object in the report and when the 
shortcut menu appears you will see that it's identified as an 
OLE object and the second command from the last identifies it 
as a Worksheet Object.

11 Double-click the spreadsheet object and the menus and tools 
change to those from the OLE server application so you can 
edit the object in place. The object is an embedded object. Any 
changes you make to the object won't affect the original.

12 Click outside the object when you're finished. The menus and 
tools change back to those from Seagate Crystal Reports.

You now have a working understanding of OLE. You can use 
these capabilities with Seagate Crystal Reports to make your work 
more efficient.

How to insert a graphic/picture as an OLE object

You can add already existing graphics/pictures to your reports as 
OLE objects or you can create new graphics/pictures from 
scratch.

1 Choose the OLE OBJECT command from the Insert menu. The 
Insert Object dialog box appears. You have two options when 
it comes to OLE objects. You can:

●   insert an existing object, or 

●   create a new object directly in Seagate Crystal Reports using 
in-place editing. 
426 Seagate Crystal Reports User�s Guide



A frame approximating the size of the object (or icon) appears.

Type in the full path of the

object you want to insert.

If you do not know the

path, click the Browse

button to locate the object.

Select the

Object Type

you want to

create.

The associated program will take

control of Seagate Crystal

Reports allowing you to create

the object in place.

When finished, click

anywhere on your report to

exit the graphic program.

Toggle this option on if

you want the object

automatically updated.

When you choose the 
Create New option...

When you choose 
the Create from 
File option...

Position the OLE object (icon

shown here) where you want it to

appear in your report.
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19 Subreports

What you will find in this chapter...

What are subreports?, Page 430

Unlinked vs. linked subreports, Page 430

Unlinked, Page 430

Linked, Page 431

Database links vs. subreports in one-to-many situations, Page 433

Linking to/from a formula field, Page 442

Linking unindexed tables, Page 443

HANDS-ON (Subreports), Page 433
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What are subreports?

A subreport is a report within a report. You create it in much the 
same way as you create a regular report. A subreport has most of 
the characteristics of a report, and it can have its own record 
selection criteria. The only differences between a subreport and a 
primary report are that a subreport:

●   is inserted as an object in a primary report; it can not stand 
on its own, 

●   can be placed in any report section and the entire subreport 
will print in that section, and 

●   can’t itself contain a subreport.

There are four times that you would typically use a subreport:

1. When you want to combine unrelated reports into a single 
report. See How to combine unrelated reports using subreports, 
Page 439.

2. When you want to coordinate data that can not be otherwise 
linked. 

3. When you want to present different views of the same data in 
a single report. See How to show different views of the same data 
in one report, Page 444.

4. When you are performing one-to-many lookups from a field 
that is not indexed on the lookup field. See ONE-TO-MANY 
RELATIONSHIPS, Page 522.

Unlinked vs. linked subreports

Unlinked Unlinked subreports are freestanding; their data is not 
coordinated with the data in the primary report in any way. 

This does not mean that an unlinked subreport has to use the same 
data as the primary report; it can use the same data source or a 
different data source entirely. It also does not mean that the 
subreport is limited to reporting on a single table. A linked 
subreport can be based on a single table or on multiple tables.
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What it does means is that there is no attempt to match up the 
records in one report with the records in the other. Regardless of 
the underlying data sources, the reports are treated as unrelated.

Linked Linked subreports are just the opposite; their data is coordinated. 
The program matches up the records in the subreport with the 
records in the primary report. If you create a primary report with 
customer information and a subreport with order information 
and link them, the program creates a subreport for each customer 
and includes in that subreport all the orders for the customer.

For more information on linking, search for Visual Linking Topics 
Index in Seagate Crystal Reports online Help.

How subreport linking works

When you link a subreport to a primary report, the program creates 
the link using a parameter field. See Parameter Fields, Page 391.

When you select a subreport link field:

●   the program creates a parameter field in the subreport that 
is used to retrieve values passed to it by the primary report. 

●   the program also creates a record selection formula for the 
subreport using the parameter field. 

   the selection formula limits the subreport to those 
records in which the link field is equal to the parameter 
field value. 

When you run the report, the program finds the first primary field 
record it needs and passes the value in the link field to the 
parameter field in the subreport. The program then creates the 
subreport with record selection based on the parameter field 
value. Here is an example:

●   You create a report that shows customer data and a 
subreport that shows order data and you link the two 
reports using the Customer ID field.

●   When you run the report, the program finds the first 
customer record it needs and passes the Customer ID value 
from that record to the subreport parameter field.
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●   The program runs the Orders subreport. Since the subreport 
selection formula selects only those records in which the 
Customer ID value is equal to the parameter field value, 
and since that parameter field value is equal to the 
Customer ID in the first record in the primary report, the 
subreport contains only those records that have the same 
customer ID, namely, those records that are orders for the 
first customer.

●   When the subreport finishes, the program goes to the 
second record it needs in the primary report, prints the 
customer data, and then passes this customer’s ID number 
to the parameter field. 

●   The program then runs a subreport including only those 
order records for the second customer.

●   The process continues until the report is finished.

●   All of this parameter field manipulation takes place behind 
the scenes. You simply pick the fields you want to use to 
link the primary report with the subreport and the program 
does the rest. The values are passed without the parameter 
field prompting you for a value.

NOTE: If you have a linked subreport and you click the PRINT 
PREVIEW button on the standard toolbar from the Subreport

Design Tab, the program runs the subreport on its own, without

first receiving a parameter field value from the primary report. In

this case, the program displays the Enter Parameter Values for

Subreport dialog box prompting you for a value.

Type in a value and the program runs the subreport using that

value.
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Database links vs. subreports in one-to-many situations

When two tables in your report have a one-to-many relationship, 
the program retrieves the data in different ways depending on:

●   the data source, 

●   the index situation, 

●   the record selection criteria, and 

●   whether you are creating a single report based on linked 
tables or a primary report that contains a subreport.

When you are considering whether to use linked tables or a 
subreport, you need to understand the ramifications of each. 
These issues are discussed fully in the Performance considerations in 
one-to-many links, Page 522.

As a general rule, if you:

●   have indexed tables, 

●   are linking on the indexed fields, and 

●   have range limiting record selection criteria based on the 
indexed fields, 

the program needs to read the same number of records whether 
you are linking tables in a single report or using subreports. Since 
each subreport is run as a separate report, however, there may be 
a performance advantage using linked tables. See Indexed tables, 
Page 518.

HANDS-ON (Subreports)

How to insert a subreport, Page 434, and How to link a subreport to the 
data in the primary report, Page 436, explain in detail how to perform 
the two basic subreporting tasks. You will do one or both of these 
tasks every time you set up a subreport. All other subreport 
tutorials, deal with subreport specifics: how to create specific kinds 
of reports using subreports. These are explained in broad terms 
(create a subreport, link these two fields, and so forth). Refer back 
to the first two topics for the specifics of performing those tasks.
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How to insert a subreport

1 Click the SUBREPORT button on the supplementary toolbar. 
The Insert Subreport dialog box appears. 

2 Click OK. The program displays a rectangular placement 
frame. 

●   If you imported your subreport, the program creates a 
subreport Design Tab labelled with the subreport name.

   If you do not need to edit your report, you are finished.

   If you want to edit your report, click the Subreport 
Design Tab and make your modifications.

To choose an existing subreport, click this option button and type the

name into the text box. If you do not know the name, click the Browse

button and locate it in the dialog box that appears.

To create a new subreport, click this option button and type a name into

the text box. If you would like assistance in creating the subreport, click

the Report Expert button.

3 Move the frame where you

want it to appear in your report

and click once to place it.
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●   If you are creating a new report, the program creates a 
Subreport Design Tab labeled with the subreport name.

   If you want to do more to your report than you did in 
the Expert, click the Subreport Design Tab and finish 
your subreport as you would any other report.

   If you do not want to do more to your report, you are 
finished.

How to preview your subreport

There may be times that you want to preview a subreport by itself 
instead of previewing it as a part of the main report. For example, 
you might want to preview the subreport to view and analyze the 
data for a significant set of parameter values. While most 
Windows report designers do not allow you to preview 
subreports alone, Seagate Crystal Reports makes it easy.

1 Click the Design Tab corresponding to the subreport of 
interest.

2 Click the PRINT PREVIEW button on the standard toolbar.

The program displays a preview of the selected subreport.

Click the Preview Tab to

see your parent report.

Click the Subreport Preview

Tab to see your subreport.
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How to link a subreport to the data in the primary report

Many times the data in a subreport supplements the data in the 
primary report. You might, for example, have customer data in a 
primary report and use subreports to show the orders for each 
customer.

In such a case, you will need to coordinate the data in the primary 
report and subreport so the orders in each subreport match up 
with the correct customer.

To do this, you need to specify a field in the subreport and one in 
the primary report that contain common data. Seagate Crystal 
Reports uses these companion fields to coordinate the data. You 
coordinate the data in the subreport with the data in the primary 
report using the Subreport Links dialog box. You get to that dialog 
box in one of two ways:

1. If you are importing a report as a subreport or creating one 
from scratch, you get to it by clicking the Subreport Link button 

Primary Report Data Linked Subreport Data
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in the Insert Subreport dialog box. Thus you can build or 
import your subreport and link it to the primary report in one 
coordinated process.

2. If you already have a subreport in your primary report and 
you did not link it when you were setting it up, you can get to 
the Subreport Links dialog box by choosing the SUBREPORT 
LINKS command on the Edit menu.

Once you are in the Subreport Links dialog box, follow these 
steps:

6 Repeat Steps 1 and 2 for each additional link as desired. 

7 Click OK when finished. Now, when you run the report, the 
program will coordinate the data in the primary report and 
the subreport.

1 Highlight the field you want

to use as the link field in the

primary (containing) report.

2 Click the

Add button.
The field will be

added to the

Linking list box,

thus selecting it

as a link field.

3 Choose the subreport you want

to link from this drop-down list (if

it is not already selected).

5 Choose the subreport field you

want to use to link to the containing

report from this drop-down list.

4 Choose the

subreport table

to link to the

containing

report.
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How to link a subreport to the main report without
modifying the selection formula

There may be times that you want to use a linked parameter field 
in a subreport but you don't want that parameter field used as part 
of the selection formula for that subreport. For example, you may 
want the main report to pass in a summary value that can be used 
in calculations by the subreport, or you may want the main report 
to pass in the title of the subreport.

You can do these things with Seagate Crystal Reports, but you 
need to understand the way the program handles subreport 
linking in order to have it work the way you want to.

Seagate Crystal Reports uses a parameter field mechanism to link 
subreports to main reports.

If you link a field in the main report to a field in the subreport that 
is not a parameter field, the program:

●   automatically creates a parameter field to complete the link, 
and 

●   modifies the subreport record selection formula to select 
those records where the subreport field is equal to the 
parameter field value. 

The need for a parameter field is implied, thus this is called an 
“Implicit Link” situation.

When you link a field in the main report to a parameter field that 
you have created in the subreport, the Expert accepts the link you 
have specified. It:

●   does not create any additional parameter fields, and it 

●   does not modify the subreport record selection formula. 

When you so specify a link, it is called an “Explicit Link” situation.

Thus, if you want to link a subreport to the main report but you 
don't want to modify the selection formula, you need to use an 
Explicit link:

1 Create a parameter field in the subreport.
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2 Then, link a field in the main report to that parameter field 
using the Subreport Linking Expert.

How to combine unrelated reports using subreports

There may be times when you want to combine unrelated reports 
into a single report. For example, you may want to create a single 
report that presents:

●   sales by sales representative, and

●   sales by item.

While both reports deal with sales data, there is no real linear 
relationship between the reports. 

NOTE: This example report has been designed to illustrate
concepts only, not the actual look of your finished report.

You can combine unrelated reports into a single report like this 
using subreports. While the reports could be based on the same 
data set, they do not have to be. They could each be based on 
entirely different data sets.
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Each of these reports is freestanding; the data in any of the reports 
is not linked in any way to the data in any of the other reports. 
This is the easiest of the subreport options to work with.

TWO UNRELATED REPORTS

If you want your report to consist entirely of two unrelated 
reports: 

1 Create the report you want to print first as the primary report. 

2 Import an existing report for use as a subreport or create one.

THREE OR MORE UNRELATED REPORTS

If you want your report to consist of three or more unrelated 
reports: 

1 Create the report you want to print first as the primary report.

2 Import or create each of the other reports you want to use as 
subreports. 

3 Using the Section Expert, insert enough Report Footer 
sections to match the number of subreports that you are 
using. For example, if you want to use three subreports, insert 
two new Report Footer sections so you have a total of three 
Report Footer sections.

4 Place the subreport you want to print immediately after the 
primary report in Report Footer A, the subreport you want to 
print next in Report Footer B, and so forth. The primary report 
will print and the subreports will print in the order you 
placed them on your report.

3 Place the report you want to

print first in the Details section.

4 Place the subreport into the

Report Footer and it will print

immediately after the primary

report.
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NOTE: You can also place the subreports side-by-side in the same

Report Footer section. They will print next to each other at the

end of the report.

Related Topics

Area printing characteristics, Page 69

How to add, delete, move, and merge sections, Page 89

How to use subreports with unlinkable data

You can link tables in a report as long as the following criteria are 
met:

●   the link fields are both database fields, 

●   the link fields contain similar data, 

●   the link fields are the same length, and

●   the link field in the link to (lookup) table is indexed (PC 
databases only).

Linking tables is rarely a problem.

There are some circumstances, however, where you can not 
coordinate data in different tables because your situation does not 
fit the linking criteria. 

5 Place the report you want to

print first in the Details section.

6 Place the subreports into the

Report Footer sections and

they will print sequentially

after the primary report.
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For example:

●   if you want to link to or from a formula field, or 

●   if you want to link two unindexed tables, 

you can not do it in a single report. You have to use subreports.

Linking
to/from a
formula field

There are situations where you may need to link to or from a 
formula (calculated) field. For example, an employee ID could be 
an 11 character value that consists of a two character department 
code followed by the employee’s nine character Social Security 
number (for example, HR555347487). Using the formula 
language, it is easy to extract the Social Security number from this 
field:

{employee.EMPLOYEE ID} [-9 to -1]

OR

{employee.EMPLOYEE ID} [3 to 12]

For the value HR555347487, either formula would return the 
value 555347487. 

While the return value is a valid Social Security number, the fact 
that it comes from a formula prevents you from using the field to 
link to a Social Security number field in another table. You can 
report on and coordinate the values in the two tables, however, 
using a subreport. Search Subscript in Seagate Crystal Reports 
online Help. 

LINKING TO A FORMULA FIELD

1 Create the primary report using a table that includes the 
Social Security Number field (for this example, {file.SSN}).

2 Create (or import) a subreport using the formula that extracts 
the Social Security Number from the Employee ID field (for 
this example, {@EXTRACT}). See How to insert a subreport, Page 
434.

3 Insert the subreport where you want it to appear in the 
primary report.

4 Link the subreport to the primary report by linking the Social 
Security Number field in the primary report ({file.SSN}) with 
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the formula that extracts the number in the subreport 
({@EXTRACT}). See How to link a subreport to the data in the 
primary report, Page 436.

LINKING FROM A FORMULA FIELD

1 Create the primary report using the formula that extracts the 
Social Security Number from the Employee ID field (for this 
example, {@EXTRACT}).

2 Create (or import) a subreport using a table that includes the 
Social Security Number field (for this example, {file.SSN}). See 
How to insert a subreport, Page 434.

3 Insert the subreport where you want it to appear in the 
primary report.

4 Link the subreport to the primary report by linking the 
formula that extracts the Social Security Number in the 
primary report ({@EXTRACT}) with the Social Security 
Number field in the subreport ({file.SSN}). See How to link a 
subreport to the data in the primary report, Page 436.

Linking
unindexed
tables

When using PC databases (not SQL or ODBC), the link field in the 
lookup database needs to be indexed to create a valid link. When 
two tables contain related data yet neither is indexed on the field 
you want to use as a link field, or if the primary table is indexed 
but the lookup table is not, you can not link the tables in a single 
report. You must use subreports if you want to coordinate the 
data in both tables. 

NOTE: It is important to note that linking unindexed tables or

linking from an indexed primary table to an unindexed lookup

table makes for inefficient reporting. If your data set is large,

expect this kind of report to take a considerable time to run. Use

this technique only if you do not have any other options.

1 Create your primary report.

2 Create (or import) the subreport and insert it into the primary 
report. See How to insert a subreport, Page 434.

3 Link the subreport to the primary report using the unindexed 
fields (or the indexed field in the primary table and the 
unindexed field in the lookup table). See How to link a 
subreport to the data in the primary report, Page 436.
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How to show different views of the same data in one report

You can use subreports to provide a different view of the same 
data as the primary report. For example, assume you want to 
show summary values at the top of your report and details at the 
bottom, like this:

NOTE: This example report has been designed to illustrate

concepts only, not the actual look of your finished report.

You can do this in different ways. The two easiest ways are:

1. Create the summary report as the primary report and the 
details report as the subreport. If you do this, you can place 
the details subreport in the Report Footer section.

2. Create the summary report as the subreport and the details 
report as the primary report. If you do this, you can place the 
summary report in the Report Header section.

Coordinate the data in the two reports by linking the report using 
the appropriate link fields.
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20 Cross-Tab Objects

What you will find in this chapter...

Cross-tab overview, Page 446

Cross-tab components, Page 451

HANDS-ON (Cross-Tab Objects), Page 452
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Cross-tab overview

A cross-tab is an object that summarizes data and then presents 
the summaries in a compact row and column format that makes it 
easy to make comparisons and identify trends. 

Report examples are provided to demonstrate the power of a 
cross-tab in those situations in which the cross-tab is an option. 
Those are often situations in which the word by is included in your 
report description:

●   sales by state,

●   products sold by color and size, or

●   orders by customer.

While there are certainly many ways to create these kinds of 
reports, cross-tabs generally present more data in a more compact, 
easier to understand form than other reporting methods.

NOTE: You can insert as many cross-tab objects in your report as

you need. You can even place them in subreports. Thus, you can

use cross-tabs to show summarized data in a report that presents

the details in another form.

In the following examples, the goal is to analyze the unit sales of 
five different bicycle locks in four different regions (a unit sales of 
locks by region report). For clarity, only the most essential 
information in these reports has been included:

●   the region the order came from, 

●   the name of the lock, and 

●   the quantity ordered. 

The first way of looking at the data is in the most basic of all 
reports, a columnar report with no grouping or sorting.
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Report of
order data -

no sorting/

grouping

This report presents nothing but details. Each row represents an 
individual order. There are many orders from each of the regions 
for different locks. But because there is no summary information, 
it is nearly impossible to get any useful information out of a report 
like this.

The next logical step is to group the data in some way. You can 
group it by region, or by product line. You will take a look at both 
of these options.

Report of

order data -

grouped by
region

This report uses the data seen in the first report, but here the data 
is grouped by Region. All the orders for each Region are grouped 
together, but each regional group contains orders for different 
kinds of locks. Because the groups contain different kinds of data, 
summarizing the Quantity field will determine the total number 
of locks sold per Region, but not the total of each kind.
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Report of

order data -
grouped by

product

This report groups the data by product. Each group displays all 
the orders for a specific product. At first it appears that this might 
be useful, but then it becomes clear that each product group 
includes orders from several different regions. The information is 
helpful, and it brings you closer to your goal, but you are still a 
long way from having the information you need. 

Each Region

group contains

orders for

different kinds

of locks.

Each product

group contains

orders for many

regions.
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Report of
order data -

grouped by

region and
product

This report is the logical next step. If the By Region report contains 
multiple products in each region group, and the By Product report 
contains multiple regions in each product group, then it seems to 
make sense to combine the two. Doing that, you group first by 
Region and then by Product. 

But the data is all spread out and remains difficult to analyze. The 
information is useful, and with a little work you can use a report 
like this to get the comparison information you need. But a cross-
tab offers a better solution.

Order data in a
cross-tab object

Using a cross-tab, all the information you need is provided in a 
compact format. The report shows what products were sold in 
which regions and what the unit sales were. It is easy to see, for 
example, that Guardian Mini Locks are not popular at all in 
California but they are the biggest seller in BC or that Florida is 
being outsold by Alabama in every lock category. 

Each group

contains orders

for one product

for one region.
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In this cross-tab:

●   Product names make up the row headings.

●   Regions make up the column headings. 

●   The value at each row/column intersection is the sum of all 
the orders for a particular product from a particular region, 
for example, the total number of Guardian Mini Locks 
ordered in British Columbia. 

●   The total at the end of each row is the total of all of the 
purchases for one product in all regions, for example, the 
total number of Guardian ATB Locks ordered in Alabama, 
British Columbia, California, and Florida combined.

●   The total at the bottom of each column is the total number 
of all kinds of locks ordered in one region, for example, the 
number of locks of all kinds purchased in California. 

●   The total in the bottom right corner is the grand total 
showing the total unit sales of all five locks in all four 
regions.

The report is compact, and you can compare your customers' 
purchasing habits in a hurry. Clearly this is a worthwhile report 
in situations such as this.

Product names.

Regions.

Total - one product

in all regions.

Total - all products

in one region.
Total - all products

in all regions.

Total - one product

in one region.
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Cross-tab components

A cross-tab is an object that summarizes data and then presents 
the summaries in a compact row and column format that makes it 
easy to make comparisons and identify trends. A cross-tab is 
made up of three elements:

●   rows,

●   columns, and

●   summary fields.

●   The rows in a cross-tab run horizontally (from side to side); 
in the example above, “Gloves” is a row.

●   The columns in a cross-tab run vertically (up and down); in 
the example above, “USA” is a column.

●   The summary fields are found at the intersection of rows 
and columns. The value found at each intersection 
represents a summary (sum, count, etc.) of those records 
that meet the row and the column criteria. In the example 
above, the value is 4 at the intersection of “Gloves” and 
“USA”, the number of gloves sold in the USA.

A cross-tab also includes several totals.
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●   At the end of each row is a total for that row. In the example 
above, this total represents the number of a single product 
sold in all countries. At the end of the “Gloves” row is the 
value 8, the total number of gloves sold in all countries.

●   At the bottom of each column is a total for that column. In 
the example above, this total represents the number of all 
products sold in a single country. At the bottom of the 
“USA” column is the value 4, the total number of products 
(gloves, belts and shoes) sold in the USA.

●   At the intersection of the Totals column (totals for the 
products) and the Totals row (totals for the countries) is a 
grand total. In the example above, the value at the 
intersection is 12, the total number of all products sold in all 
countries.

HANDS-ON (Cross-Tab Objects)

How to create a cross-tab object

In this tutorial you will create a simple cross-tab using 
CRAZE.MDB (located in the \CRW directory or the directory in 
which the program resides). 

The Craze database contains several tables; for this example use 
the following tables:
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●   Customer

●   Product

NOTE: Make certain that the Customer table is linked to the

Product table via the Orders and Orders Detail tables for this

example. Search for Visual Linking Topics Index in Seagate Crystal

Reports online Help.

The Customer and Product tables contain records for a variety of 
products and sales regions. To keep the report a manageable size, 
you will create a cross-tab that shows just a subset of those 
products and regions. You will restrict the report to: Craze Mtn, 
Craze Rhino, and Craze Titan locks sold in California, Florida, 
Illinois, and Oregon. To do this, you will limit the number of 
regions and products using record selection tools.

The Select Expert makes it easy to specify the records you want 
included in your report. Simply highlight the field you want to 
base your selection on and then select the desired records. See 
Record and Group Selection, Page 249.

Selecting
regions

1 Highlight the Region field of the Customer Table and, using 
the Select Expert, select the following records:

●   CA

●   FL

●   IL

●   OR

Selecting
products

2 Highlight the Product Name field of the Products Table and, 
using the Select Expert, select the following records:

●   Craze Mtn Lock

●   Craze Rhino Lock

●   Craze Titan Lock

Now you are ready to create your cross-tab.

3 Click the INSERT CROSS-TAB button on the supplementary 
toolbar. The Cross-Tab dialog box appears. Using this dialog 
box you will add the rows, columns, and summary fields that 
will make up your cross-tab.
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Adding rows 4 In the Fields list box, highlight the {product.PRODUCT 
NAME} field found listed under the Report Fields heading 
and click the Add Row button. The highlighted field will be 
added to the Rows list box.

Adding
columns

5 In the Fields list box, highlight the {customer.REGION} field 
found listed under the Report Fields heading and click the 
Add Column button. The highlighted field will be added to the 
Columns list box.

Adding
summarized
fields

6 In the Fields list box, highlight the {product.PRODUCT 
NAME} field, click the Set Summarized Field button. The field 
will be added to the Summarized Fields list.

NOTE: You can also drag the desired fields from the Database

Fields section of the Fields list box to the Rows, Columns, and
Summarized Fields list boxes using the drag-and-drop feature.

Your dialog box should look similar to the following:

7 Click OK. A placement frame will appear. Position the cross-
tab in the Report Header section of your report.
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NOTE: Placing your cross-tab in different sections of your report

will produce different results. For example, cross-tabs placed in

the Report Header will contain data for the entire report and will

print only once at the beginning of the report while cross-tabs

placed in a Group Header will contain data for that group only

and will print every time the group changes. See Design Tab Areas, 
Page 67, and Area printing characteristics, Page 69.

8 Click the PRINT PREVIEW button on the standard toolbar to 
preview your cross-tab. It should look similar to the 
following:

NOTE: You can independently format rows and columns of your

cross-tab with background colors, shading, borders, and fonts to

emphasize important data and create professional-looking

reports. See How to format a cross-tab, Page 463.

How to create a cross-tab with multiple rows/columns

You will often want to create reports that contain multiple levels 
of information. For example, you may have a report that contains 
the sales data for a single product sold to all customers in the USA. 
You may then want to break your report down further into a 
region by region analysis for an easy comparison of sales between 
regions within the USA. Seagate Crystal Reports enables you to 
create cross-tabs with multiple rows and/or columns to 
accommodate multiple levels of information such as these. 
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In this tutorial you will create a cross-tab with multiple rows using 
CRAZE.MDB (located in the \CRW directory or the directory in 
which the program resides). 

The Craze database contains several tables; for this example you 
will use the following tables:

●   Customer

●   Orders

●   Orders Detail

NOTE: The Customer table must be linked to the Orders and

Orders Detail tables for this example. For more information on

linking tables, search for Visual Linking Topics Index in Seagate

Crystal Reports online Help.

The Customer, Orders, and Orders Detail tables contain records 
for a variety of products, countries, and sales regions. To keep the 
report a manageable size, you will create a cross-tab that shows a 
subset of the products, regions, and countries included in the 
sample data. You will restrict the report to: Craze Adult, Triumph 
Pro, and Triumph Vertigo helmets sold in the USA in California 
and Oregon only. To do this, you will limit the number of 
products, regions, and countries using record selection tools.

The Select Expert makes it easy to specify the records you want 
included in your report. Simply highlight the field you want to 
base your selection on and then select the desired records. For 
more information on record selection, see Record and Group 
Selection, Page 249.

Selecting
countries

1 Highlight the Country field of the Customer Table and, using 
the Select Expert, select the following record:

●   USA

Selecting
regions

2 Highlight the Region field of the Customer Table and, using 
the Select Expert, select the following records:

●   CA

●   OR
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Selecting
products

3 Highlight the Product Name field of the Products Table and, 
using the Select Expert, select the following records:

●   Craze Adult Helmet

●   Triumph Pro Helmet

●   Triumph Vertigo Helmet

Now you are ready to create your cross-tab.

4 Click the INSERT CROSS-TAB button on the supplementary 
toolbar. The Cross-Tab dialog box appears. Using this dialog 
box you will add the rows, columns, and summary fields that 
will make up your cross-tab.

Adding
multiple rows

5 In the Fields list box, highlight the {customer.COUNTRY} and 
click the Add Row button. The highlighted field will be added 
to the Rows list box. 

6 Repeat Step 5 adding the {customer.REGION} to the Rows list 
box as well.

NOTE: The order in which you add rows, columns, and summary

fields affects their placement in the cross-tab. The first row or

column added will remain outermost in the cross-tab. Consecutive

rows will be added inside (to the right of the first row and below

the first column). Consecutive summary fields will be added

below the first summary field. For more information on multiple

summary fields, see How to create a cross-tab with multiple summary 
fields, Page 459.

Adding the
column

7 In the Fields list box again, highlight {product.PRODUCT 
NAME} and click the Add Column button. The highlighted 
field will be added to the Columns list box.

NOTE: To create a cross-tab with multiple columns, simply add

the desired columns to the Columns list box by following the
instructions for adding multiple rows.

Adding the
summarized
field

8 In the Fields list box again, highlight {orders 
detail.QUANTITY} and click the Set Summarized Field button. 
The highlighted field will be added to the Summarized Fields 
list box.
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Your dialog box should look similar to the following:

9 Click OK. A placement frame will appear. Position the cross-
tab in the Report Header section of your report.

NOTE: Placing your cross-tab in different sections of your report

will produce different results. For example, cross-tabs placed in

the Report Header will contain data for the entire report and will

print only once at the beginning of the report while cross-tabs

placed in a Group Header will contain data for that group only

and will print every time the group changes. For more information

see Design Tab Areas, Page 67, and Area printing characteristics, 
Page 69.

10 Click the PRINT PREVIEW button on the standard toolbar to 
preview your cross-tab. It should look similar to the 
following:
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NOTE: You can independently format rows and columns of your

cross-tab with background colors, shading, borders, and fonts to

emphasize important data and create professional-looking

reports. For more information on formatting your cross-tab, see

How to format a cross-tab, Page 463.

How to create a cross-tab with multiple summary fields

You will often find it useful to include multiple summaries in your 
reports. For example, you may have a report that shows the total 
number of orders for each of your California and Oregon 
customers. You may then want to show what the average dollar 
amount of each customer's order is in order to compare the 
purchasing habits of your customers. Seagate Crystal Reports 
enables you to create cross-tabs with multiple summary fields to 
accommodate situations such as these. 

In this tutorial you will create a cross-tab with multiple summary 
fields using CRAZE.MDB (located in the \CRW directory or the 
directory in which the program resides). 

The Craze database contains several tables; for this example you 
will use the following tables:

●   Customer

●   Orders
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NOTE: The Customer table must be linked to the Orders table for

this tutorial. For more information on linking tables, search for

Visual Linking Topics Index in Seagate Crystal Reports online Help.

The Customer and Orders tables contain records for a variety of 
customers, regions, and orders. To keep the report a manageable 
size, you will create a cross-tab that shows a subset of the 
customers and regions included in the sample data. You will 
restrict the report to: Sporting Wheels Inc., The Cyclists 
Incorporated, and XYZ Company customers in California and 
Oregon only. To do this, you will limit the number of customers 
and regions using record selection tools.

The Select Expert makes it easy to specify the records you want 
included in your report. Simply highlight the field you want to 
base your selection on and then select the desired records. For 
more information on record selection, see Record and Group 
Selection, Page 249.

Selecting
regions

1 Highlight the Region field of the Customer Table and, using 
the Select Expert, select the following records:

●   CA

●   OR

Selecting
customer

2 Highlight the Customer Name field of the Customer Table 
and, using the Select Expert, select the following records:

●   Sporting Wheels Inc.

●   Xtreme Cycle

Now you are ready to create your cross-tab.

3 Click the INSERT CROSS-TAB button on the supplementary 
toolbar. The Cross-Tab dialog box appears. Using this dialog 
box you will add the rows, columns, and summary fields that 
will make up your cross-tab.

Adding rows 4 In the Fields list box, highlight {customer.REGION} and click 
the Add Row button. The highlighted field will be added to the 
Rows list box. 
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Adding
columns

5 In the Fields list box again, highlight the 
{customer.CUSTOMER NAME} field and click the Add 
Column button. The highlighted field will be added to the 
Columns list box.

Adding
multiple
summary fields

6 In the Fields list box again, highlight {customer.CUSTOMER 
NAME} and click the Set Summarized Field button. The 
highlighted field will be added to the Summarized Fields list 
box.

7 Repeat Step 6 and add the {orders.ORDER AMOUNT} to the 
Summarized Fields list box as well.

NOTE: The order in which you add rows, columns, and summary

fields affects their placement in the cross-tab. The first row or

column added will remain outermost in the cross-tab. Consecutive

rows will be add inside (to the right of the first row and below the

first column). Consecutive summary fields will be added below

the first summary field.

Your dialog box should look similar to the following:

8 Click OK. A placement frame will appear. Position the cross-
tab in the Report Header section of your report.
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NOTE: Placing your cross-tab in different sections of your report

will produce different results. For example, cross-tabs placed in

the Report Header will contain data for the entire report and will

print only once at the beginning of the report while cross-tabs

placed in a Group Header will contain data for that group only

and will print every time the group changes. For more

information, see Design Tab Areas, Page 67, and Area printing 
characteristics, Page 69.

9 Click the PRINT PREVIEW button on the standard toolbar to 
preview your cross-tab. It should look similar to the 
following:

The first summary operation in your cross-tab is the count of orders 
for each of the three customers. The second summary operation is 
the sum of all the orders made by each company. For this example, 
instead of a sum of all orders, you want to calculate the average 
order amount for each customer. To do this you will need to change 
the summary operation for the {orders.ORDER AMOUNT} field.

NOTE: If the first summary operation is not a count, follow the

directions below to change the summary operation to count.

Changing the
summary
operation
(aggregate
function)

10 Right-click the summary field that you want to change 
{orders.ORDER AMOUNT} and choose the CHANGE 
SUMMARY OPERATION command from the shortcut menu. The 
Change Summary Operation dialog box appears.

11 Select the desired function from the Summary Operation drop-
down box and click OK when finished. For this example, 
select average. The summary operation will be changed as 
specified.
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For more information on summary functions search for Summary 
Functions Index in Seagate Crystal Reports online Help.

12 Click the PRINT PREVIEW button on the standard toolbar again 
to preview your cross-tab. It should now look similar to the 
following:

The first summary operation in your cross-tab is the count of 
orders for each of the three customers and now the second 
summary operation is the average order amount for each 
customer. 

By creating cross-tabs with multiple summary fields such as these, 
you can pinpoint customer information and easily identify 
purchasing trends.

NOTE: You can independently format rows and columns of your
cross-tab with background colors, shading, borders, and fonts to
emphasize important data and create professional-looking
reports. For more information on formatting your cross-tab, see
How to format a cross-tab, Page 463.

How to format a cross-tab

Seagate Crystal Reports has powerful formatting capabilities that 
can be applied to your cross-tab: You can:

●   format the background color of an entire row/column at 
one time,

●   format fields individually,
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●   format several fields at one time, and 

●   print cross-tabs that span multiple pages.

By applying such formatting as background color, borders, and 
fonts you can emphasize important data and create professional-
looking and easier-to-understand cross-tabs.

Formatting

background

color of entire

rows/columns

1 Right-click the cross-tab and choose the CHANGE FORMAT 
command from the shortcut menu. The Cross-Tab dialog box 
appears.

2 Highlight the row (from the Rows list box) or column (from 
the Columns list box) that you want to change the background 
color for and select the desired color from the Background 
Color drop-down box.

3 Click OK when finished to return to your cross-tab. The row/
column will be formatted as specified.

A cross-tab with a single row highlighted will look similar to 
the following:

Formatting

fields

individually

1 Right-click the field you want to format and choose the 
FORMAT FIELD command from the shortcut menu. The Format 
Editor appears.

2 In the Format Editor, select the font, background, borders, 
numbering, currency symbols, printing characteristics, etc., as 
desired using the corresponding tab(s).

3 Click OK when finished to return to your cross-tab. The field 
will be formatted as specified.
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A cross-tab with a single field formatted will look similar to the 
following:

Formatting

several fields

at one time

1 Select the desired fields using the Shift-click method.

2 Once all the fields are selected, right-click any of them and 
choose the FORMAT OBJECTS command from the shortcut 
menu. The Format Editor appears.

3 In the Format Editor, select the font, background, borders, 
numbering, currency symbols, printing characteristics, etc., as 
desired using the corresponding tab(s).

4 Click OK when finished to return to your cross-tab. The fields 
will be formatted as specified.

A cross-tab with several fields formatted will look similar to 
the following:
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How to print cross-tabs that span multiple pages

When you create a cross-tab that is wider or longer than the 
specified page size, the program will automatically span the 
printing across enough pages to accommodate the size of the 
cross-tab. For ease in reading, row and column headings will be 
repeated on subsequent pages.
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21 Queries

What you will find in this chapter...

The Crystal Query Designer, Page 468

Why use a query?, Page 468

Using the Query Designer, Page 469

HANDS-ON (Queries), Page 470
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The Crystal Query Designer

A query is simply a request for specific information from a 
database. If you are requesting that information from an SQL 
database (or from a database that you access via ODBC), your 
query must be written using the Structured Query Language 
(SQL). The SQL language is not difficult to learn, but mastering 
the fine points of creating and retrieving data using SQL can take 
quite a while. Since the Crystal Query Designer eliminates the 
need to understand SQL, it can get you building effective queries 
right away.

The Crystal Query Designer has been designed to meet the needs 
of individuals with little or no query background as well as the 
needs of experienced SQL professionals.

●   If you are new to querying, you will enjoy the way the 
Query Designer helps you create queries. By answering a 
few questions on a set of sequential tabs, you give the 
program all the information to generate a query that fits 
your needs and it will do all the work for you. 

●   If you are an SQL professional, you will appreciate the 
facility that enables you to fine tune the queries that the 
Query Designer generates. If you are more comfortable 
writing your own SQL queries, you will find it easy to enter 
your queries directly or even paste them in from another 
source.

The Crystal Query Designer can be a powerful tool for many of 
your information gathering needs.

NOTE: The Query Designer can only access data stored in an

ODBC data source. Any SQL or other type of database mentioned

in this chapter must be accessed through an ODBC data source.

Why use

a query?

Query files provide a means of off-loading much of the data 
generating tasks normally performed by Seagate Crystal Reports 
on to an SQL or other database server. The set of data returned 
represents a subset of the actual data in the database - only the 
data you specifically need.
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If you are an experienced SQL programmer, the Crystal Query 
Designer allows you to reuse your existing queries, quickly and 
easily. All of your existing work becomes convenient query files 
that can be used to design reports with Seagate Crystal Reports.

In addition, a Query file provides full ANSI SQL compatibility. 
Although Seagate Crystal Reports supports powerful SQL pass-
through reporting, it does not support the full SQL language or 
allow you to edit every part of an SQL statement. By using the 
Query Designer to create data sets to base your reports on, you get 
all of the power of SQL, including complex joins, sorts, and 
aggregate functions.

NOTE: Many of the topics in this chapter refer to specific SQL

clauses. If you are experienced with SQL, use this information to

better understand how the Query Expert generates an SQL

statement. If you are new to SQL, you can ignore this information

and continue to use the Query Expert.

Using the

Query Designer

The Query Designer has two primary uses:

1. Designing and developing data sets for building reports in 
Seagate Crystal Reports, and

2. Retrieving and analyzing current information on an “as 
needed” basis to facilitate informed decision making.

SEAGATE CRYSTAL REPORTS AND QUERY DATA SETS

Seagate Crystal Reports allows you to design a report based on a 
query data set rather than tables and fields. Since the query 
contains a predefined set of data, the tables and fields necessary 
for the report are already included. 

The set of data produced by the SQL query works just like a 
database table when you design your report. The name of the 
query, along with fields it accesses, appear in the Insert Field 
dialog box. Aggregate functions and SQL expressions act like 
fields, providing data values corresponding to each record in the 
SQL query.

DATA ANALYSIS AND DECISION MAKING

You may not always need to produce finished reports based on 
your data; sometimes you just need numbers in a hurry (to 
prepare for a meeting, to help you make projections, etc.). The 
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Query Designer makes it easy for you to get the information you 
need.

Sometimes you may need to retrieve the same data on a recurring 
basis (weekly, every month end, etc.). By setting up and saving a 
single query, you can retrieve updated data quickly, whenever 
you need it, with minimal effort.

NOTE: The Query Designer can not retrieve any number value

larger than 20 characters or calculate a formula with a value

larger than 20 characters. Values larger than 20 characters will be

truncated.

HANDS-ON (Queries)

How to use an SQL query that you designed elsewhere

1 Copy your SQL statement to the Windows Clipboard. Many 
SQL editors will let you copy the SQL statement to the 
Clipboard using the Ctrl-C key combination.

2 Click the NEW button on the toolbar in the Crystal Query 
Designer. 

The New Query dialog box appears.

3 Click the Enter SQL
statement directly button.
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4 Select the desired SQL server for your SQL statement, and 
click OK. The SQL Server Login dialog box appears.

5 Enter your user ID and password to log on to the SQL server, 
and click OK.

6 After a message appears indicating the success of your log on 
(assuming you logged on correctly) the Enter SQL Statement 
dialog box appears. 

9 If you need to log on to another server or ODBC data source, 
click the Log On Server button. All data sources that you are 
logged on to will appear in the Data Source drop-down box.

10 Use the Title text box to give a title to your query that 
describes its purpose.

11 Enter your SQL statement in the large SQL edit box. Click 
anywhere inside the box to place an insertion point.

12 Press Ctrl-V or click the Paste button in the dialog box to paste 
your SQL statement into the SQL edit box.

7 Specify the ODBC data source from this drop-down box.

8 If you are not already logged on to an SQL Server, click

the Log On Server button and log on using the Log On

Server dialog box.
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13 The SQL edit box allows you to make any changes you wish 
to your SQL statement. You can even enter an entirely new 
SQL statement if you wish. Make any changes you need and 
click the OK button when you are finished.

Your old SQL statement becomes a new SQL query that can be 
used with Seagate Crystal Reports just like any other SQL query 
file.

Alternatively, you can import an SQL statement saved in an ASCII 
text file. To do so, disregard Step 1 above, follow Steps 2 through 
6 to open the Enter SQL Statement dialog box and log on to the 
ODBC data source, then click Import to import the SQL statement 
from the text file.

How to create a new query

1 Click the NEW button in the Crystal Query Designer. 

The New Query dialog box appears.

Edit your SQL query in this box.

Paste button.
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The Create Query Expert consists of several tabs. The tabs are 
numbered to lead you step-by-step through the query creation 
process.

NOTE: The Links Tab only appears if you select two or more

database tables on the Tables Tab.

The remaining sections in this chapter explain how to perform 
specific tasks with the Crystal Query Designer.

NOTE: Once you select at least one field for the query on the

Fields Tab, you can view the data retrieved by your query at any

time, by clicking the Preview Query button at the bottom of the

dialog box. After you are done viewing the query data, use the

Edit button to return to the Query Expert.

How to add tables to a query

Generates FROM clause

The FROM clause specifies the sources (tables) of the database 
fields indicated in the SELECT statement.

1 Click the Tables Tab in the Crystal Query Expert.

2 Click the Use Crystal

Query Expert button.
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2 Click the SQL/ODBC or Dictionary button.

●   If you click SQL/ODBC:

   Highlight an SQL or ODBC data source in the Log On 
Server dialog box.

   Choose one or more database tables in the Choose SQL 
Table dialog box. Click Add to add each table to your 
SQL query. Click Done when finished.

●   If you click Dictionary:

   Highlight Dictionary (.DC5) in the File Open dialog box, 
and click OK.

   All ODBC database tables accessible from the dictionary 
will be added to your SQL query.

NOTE: Dictionary files must be based on an ODBC data source.

See Dictionaries, Page 491, for further information.

How to link tables and specify a join type

Generates WHERE clause

The WHERE clause indicates how two database tables are joined.

NOTE: Some links can be generated in the FROM clause.
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1 Click the Links Tab and click the Smart Linking button. The 
Create Query Expert will make any possible links it can detect 
between tables. These links are represented by an arrow 
between fields in two tables, called a link line.

2 Click one of the link lines between tables. The link line 
becomes highlighted, along with the fields in each table that it 
is linking.

3 Click the Options button to open the Link Options dialog box. 
This dialog box describes the link between the tables in more 
detail. Search for Link Options dialog box in Crystal Query 
Designer online Help.

Link line.
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Related Topics

SQL join types (ODBC data sources), Page 537

WHERE, Page 552

How to add fields to a query

Generates SELECT clause

The SELECT clause selects specific data items to retrieve from the 
database tables indicated by the FROM clause.

1 Click the Fields Tab in the Create Query Expert.

4 Select an SQL join type.
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Related Topics

SELECT, Page 551

How to identify unique values in a query

Generates DISTINCT clause

DISTINCT forces the query to retrieve only unique (distinct) sets 
of data.

1 Click the Fields Tab of the Create Query Expert.

2 Highlight the fields you want to

appear in your query from this list.

3 Click the

Add button.

The field(s)

will be added

to this list.

Click Remove to remove any fields

from the Query Fields list box.
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Related Topics

DISTINCT, Page 551

How to summarize data with aggregate functions

Generates GROUP BY clause

The GROUP BY clause retrieves a set of summary data.

Aggregate functions

Use aggregate functions to obtain summary information on all 
records or on groups of records. Aggregate functions are most 
useful when you do not need the detail information and only want 
to examine totals.

For example, you might need to know the total number of orders 
made and the average amount of each order. For this kind of 
query, you apply the COUNT function to the Order ID field, and 
the AVG (average) function to the Amount field. The query 
calculates the summary information and provides the results you 
need.

1 Click the Fields Tab of the Create Query Expert.

2 Click the Select Distinct Values option to active it.
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3 In the Total drop-down box, choose an aggregate function to 
apply to the highlighted field.

●   COUNT( ) counts the number of values within a group.

●   SUM( ) adds together the values within a group for a total.

●   AVG( ) finds the average value of all values within a group.

●   MIN( ) finds the minimum value within a group.

●   MAX( ) finds the maximum value within a group.

4 The query summarizes the field that the aggregate function is 
applied to. Any other fields that appear in the Query Fields list 
box are used to sort the data.

Related Topics

GROUP BY, Page 553

How to sort records according to field values

Generates ORDER BY clause

The ORDER BY clause indicates that the database records 
retrieved be sorted according to the values in a specific field.

2 Highlight the field you want

to summarize from this list.
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Query data can be grouped either by sorting data, so that records 
with like data appear grouped in the sorted list, or by 
summarizing data with aggregate functions, so that summary 
data appears in your query for each group of records. For 
information on using aggregate functions in your query, see How 
to summarize data with aggregate functions, Page 478. This section 
shows you how to group data by sorting.

1 Click the Sort Tab in the Create Query Expert.

Related Topics

ORDER BY, Page 552

How to specify records to be included in a query

Generates WHERE clause

The WHERE clause can specify record selection criteria.

1 Click the Select Tab of the Create Query Expert.

2 Highlight the field you

want sorted from this list.

3 Click the

Add button.

The field will

be added to

the Group

Fields list.

Use up/down arrows to

move fields up/down the list.

4 Select the order in which you want the data sorted.
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These choices work much like the Select Expert in Seagate 
Crystal Reports. Search for Select Expert in Crystal Query 
Designer online Help.

4 Repeat Steps 2 and 3 for every field that appears in the Select 
Fields list box.

Related Topics

WHERE, Page 552

How to select groups to be included in a query

Generates GROUP BY and HAVING clauses

The HAVING clause creates selection criteria for the summary 
information produced by the GROUP BY clause.

1 Click the Fields Tab of the Create Query Expert.

2 Highlight the field

which contains the data

youwant to base selection

criteria on from this list.

3 Click the Add button. The field will be added to

the Select Fields list.

Use these controls to specify the selection criteria to be

applied to the field highlighted in the Select Fields dialog box.
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4 Click the Select Tab.

2 Highlight the field you want

to summarize in this list.

3 Select the aggregate function from this drop-down

list that you want to apply to the highlighted field.

5 Select the aggregate

function from this list box.

6 Click the Add button...

The field will

be added to

the Select

Fields list.

7 Use the selection criteria controls to specify which

group summary values based on the aggregate

function should appear in the result.
482 Seagate Crystal Reports User�s Guide



Related Topics

GROUP BY, Page 553

HAVING, Page 553

How to create an SQL expression

NOTE: You must have some familiarity with the SQL language

and SQL expressions before trying to add an expression to your

query file.

1 Click the Fields Tab in the Create Query Expert.

3 Type a name for your new

expression and then click OK.

2 Click the Expression button. The

SQL Expression Name dialog box

will appear.
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6 When you are finished designing your SQL expression, click 
OK, you are returned to the Fields Tab.

How to create a query from another Crystal Query

1 Click the NEW button in the Crystal Query Designer.

The New Query dialog box appears.

4 Double-click a field in

this list to add it to your

expression.

5 Edit the expression

in this edit box.

7 Highlight the new SQL expression.

It will be indicated by an @ sign.

8 Click the Add button.

The field will

be added to

the Query

Fields list.
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3 Use the File Open dialog box to highlight the query (*.QRY) 
file that you want to use to base a new query on, and click OK. 
The program runs the existing SQL query and displays the 
data set.

4 Click the EDIT button. 

The Create Query Expert appears with the specifications for 
the selected query already in place.

5 Use the Create Query Expert to make any changes necessary 
to the query. Click Preview Query when finished to display the 
new query results.

2 Click the Start from

existing Crystal Query

button.
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6 Choose the SAVE AS command from the File menu to save the 
new query under a different name. The new query is saved in 
a separate file; your source query remains unchanged.

How to select a query for a report

1 In Seagate Crystal Reports, click the NEW button on the 
standard toolbar. The Report Gallery appears.

2 Click a Report Expert from the Report Gallery. The Create 
Report Expert appears.

3 On the Tables Tab, click the Query button. The File Open 
dialog box appears.

4 Use the controls in the File Open dialog box to locate and 
highlight the query (.QRY) file you want to use to create a 
new report.

5 Click OK. The query is opened for your report. Use the tools 
in the Create Report Expert to design a new report. Your 
query fields will appear in each section of the Expert just as 
any other database fields would. However, the name of the 
query file will appear above the fields in list boxes where you 
would normally see the name of a database table.

NOTE: You can not use more than one query file in a report.

How to create a parameter field for use in a query

A parameter field can be created while previewing a query in the 
Query Designer.

1 Choose the PARAMETER FIELD command from the Edit menu. 
The Parameter Field dialog box appears. 
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2 Enter the following information in the fields provided:

●   Parameter Name: Enter the name you want to use to identify 
the parameter field.

●   Prompting Text: Enter the text you want to appear when the 
program prompts you.

●   Value Type: Enter the data type of the parameter field.

●   Default Prompting Value: Enter the value you want the 
program to use if you do not supply a new value.

●   Browse Field: Use this drop-down box to specify a default 
field.

3 Click OK.

The parameter field can now be used in your query. See How to use 
a parameter field in a query, Page 487.

How to use a parameter field in a query

1 After you have created a parameter field in the Query 
Designer (see How to create a parameter field for use in a query, 
Page 486), return to the Create Query Expert by choosing the 
QUERY command on the Edit menu.

2 Click the Select Tab to activate it.
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3 Select the database field you would like to select records for 
from the Database Fields list box. 

4 Click the Add button. The field now appears in the Select Fields 
list box and two drop-down boxes appear.

5 When you select equal to, one of, less than, greater than, between, 
starting with, or like from the second drop-down box, one or 
more additional drop-down boxes appears. 

The parameter field you created will appear in the field drop-
down box.

6 Select the parameter field from the field drop-down box.

7 Click to the SQL Tab to activate it. 

You will see exactly how the parameter field is used in the SQL 
statement.
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22 Dictionaries

What you will find in this chapter...

Dictionaries Overview, Page 492

Why use a dictionary?, Page 492

HANDS-ON (Dictionaries), Page 493
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Dictionaries Overview

A dictionary is a structured and simplified view of data that you 
can create for some or all of the individuals in your organization 
that are using Seagate Crystal Reports. 

Unlike some systems that force users to access data through a data 
distribution metalayer, dictionaries are optional components. 
Data can still be accessed directly by the user. Dictionaries simply 
provide all of the convenience without the restrictions.

Dictionaries let you:

●   design a single, dynamic view of all the data that is 
necessary to create organizational reports and queries, 

●   organize the data and rename tables and fields to make it 
easier for users to understand the content and purpose of 
the data, and

●   create complex data-manipulation formulas that users can 
access without the need to understand formula concepts.

Dictionaries reduce support cost and time, increase user 
productivity, and reduce data misuse, loss, and damage. They are 
a powerful component of Seagate Crystal Reports.

Why use a

dictionary?

Dictionaries are often designed and distributed by Information 
System (IS) Managers or Network Administrators who control 
and manage a company’s databases. These databases are often 
complex collections of data spread throughout several tables with 
hundreds or even thousands of fields. A user, trying to locate and 
use a small set of data for a report, can easily get lost among 
database, table, and field names.

By creating a customized dictionary that contains a small amount 
of data specific to the work performed by a small group of users, 
you provide those users with clear and easy access to all of the 
data they need. For example, the Accounting department’s 
dictionary can be different than the Sales department’s dictionary, 
or the Personnel department’s dictionary. Some data may overlap 
between dictionaries, but it can be named and organized in a 
fashion that best suits the users accessing it.
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HANDS-ON (Dictionaries)

How to create a new dictionary

1 Click the NEW button on the standard toolbar. The 
Dictionaries Expert appears.

 

This Expert contains several tabs. Each tab is numbered to lead 
you through the development process step-by-step. 

NOTE: The Links Tab appears only when you have added more

than one table to your dictionary.

2 To access the options on each tab, simply click the tab. 
Information and controls needed for the selected step will be 
displayed in the dialog box. You may also use the Next>> and 
<<Back buttons to go to the next (right) and previous (left) tab, 
respectively.

NOTE: Certain steps must be performed before others in the

creation process. For example, you must select tables before you

can select fields from those tables. For that reason, some tabs may

not be available until you perform the required steps prior to

selecting those tabs.

3 Click Save at the bottom of the Expert to save at any time.
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NOTE: Since a dictionary must contain some database data, the

Save button will be disabled until you add at least one field to the

Headings & fields in View list box on the View Tab.

How to add a data file

1 While in the Dictionaries Expert, click the Tables Tab to 
activate it.

The Choose Database File dialog box appears.

3 Use the options in the Choose Database File dialog box to 
highlight a database file.

4 Click Add to add the file. All tables from that file will appear 
in the list box on the Tables Tab.

5 Repeat Steps 3 and 4 for each database file you want to add to 
the dictionary.

6 Click Done when you are finished adding database files.

NOTE: When you add a database file, the tables and fields from

that file will not necessarily appear to the user who opens the

dictionary from Seagate Crystal Reports. The tables that appear

on the Tables Tab are only the tables available to the creator of

the dictionary. To add specific fields, see How to select tables and 
fields for users, Page 498.

2 Click the Data File button.
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You may also need to pick an index file to be used by one of the 
database tables. This is done in the Tables Tab:

The Choose New Location dialog box appears. 

9 Use the controls in this dialog box to highlight a new index 
file, and click OK when finished.

NOTE: By default, Crystal Dictionaries will use any index file it

finds with the same name as the database file. You only need to

select an index file if you want to use an index with a different

name than the database file. For more information on indexes, see

Indexed tables, Page 518.

NOTE: You can mix data files and ODBC data sources in the same

dictionary file. However, if you wish to link data files and ODBC

data sources together, you can only use string fields to perform

the links.

8 Click the Index button.7 Highlight the database table you

want to pick a specific index for.
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How to open an SQL or ODBC data source

1 While in the Dictionaries Expert, click the Tables Tab to 
activate it.

The Log On Server dialog box appears.

4 If the data source requires any log on information, such as 
user name and password, the SQL Server Login dialog box 
will appear. Use this dialog box to log on to the ODBC data 
source just as you normally do from your Database 
Management System application.

5 Click OK, and the Choose SQL Table dialog box appears.

6 Highlight a database table in the Choose SQL Table dialog 
box, and click Add to add it to your dictionary.

7 Repeat Step 6 for each table you want to add to the dictionary.

2 Click the SQL/ODBC button.

3 Select an SQL

or ODBC data

source and click

OK when finished.
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8 Click Done when finished.

NOTE: When you add an SQL or ODBC data source from the

Tables Tab, the tables and fields from that data source will not

necessarily appear to the user who opens the dictionary. The

tables that appear on the Tables Tab are only the tables available

to the creator of the dictionary, for adding to the dictionary. See

How to select tables and fields for users, Page 498.

NOTE: You can mix data files and ODBC data sources in the same

dictionary file. However, if you wish to link data files and ODBC

data sources together, you can only use string fields to perform

the links.

How to link multiple tables

1 If you have added more than one database table to your 
dictionary, click the Links Tab in the Dictionaries Expert.

●   If a link is possible between two tables, you can create a new 
link by dragging a field name from one table to the other. 
The application will draw a new link arrow between the 
tables. See Linking tables, Page 520.

Click Smart Linking to let the

program create logical links

between tables in your dictionary.

To create a link manually, drag a field

name from one table to the other.

Click the Options button for a

detailed description of a

highlighted link.
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●   If you select a link and click the Options button, the Link 
Options dialog box appears. You can use the controls in this 
dialog box to make any necessary changes to the highlighted 
link. Search for Link Options dialog box in online Help.

How to select tables and fields for users

After you add tables to your dictionary using the Tables Tab, 
those tables, and the fields in them, are not automatically available 
to your users. You must expose the fields using the View Tab. The 
View Tab lets you design the actual view of the data that your 
users will see.

1 While in the Dictionaries Expert, click the View Tab to 
activate it.

NOTE: The following screenshot illustrates both a before and

after state of the dialog box. Typically, any fields you move to the

Sort Fields list box will no longer appear in the Report Fields list
box.

●   To make a table and all its fields available to users, select the 
table name from the Tables & fields from database list box, and 
click Add. The table name becomes a field heading in the 
Headings & fields in View list box. All fields from the table 
appear as fields under the new field heading.

2 Highlight the field you want to

make available to users from this list.

4 The field will be

added to this list.
3 Click the

Add button.
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●   To make a single field available to users, select the field in 
the Tables & fields from database list box and click Add. The 
field is added to the end of the list in the Headings & fields in 
View list box.

When adding and organizing tables and fields in the View Tab, 
keep in mind the following points:

●   Tables are not displayed to the dictionary user as database 
tables. Table names become field headings. These headings 
appear just like tables when the user designs a report based 
on your dictionary. However, field headings do not 
necessarily represent database tables that actually exist.

●   Field headings can be added anywhere in the Headings & 
fields in View list box to provide clearer organization of data 
for your users. See How to add a new field heading, Page 503.

●   Fields can be added to the View list box as many times as 
necessary. A field does not have to appear under a field 
heading that matches the table the field exists in. Organize 
fields in any order and under any field headings that will 
work best for your users.

●   Fields must be grouped under field headings. If you add a 
single field to the Headings & fields in View list box and no 
field heading appears in the list box (the list box is empty), 
the application will provide a default field heading for you 
and will add the field you selected underneath that 
heading.

●   Field names and field headings that appear in the Headings 
& fields in View list box can be renamed to anything you 
want. See How to rename field headings, fields, and formulas, 
Page 501.
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How to add/create formulas

1 While in the Dictionaries Expert, click the View Tab to 
activate it.

The Insert Formula dialog box appears.

The Formula Editor appears.

4 Use the Formula Editor to create a formula for the Dictionary, 
just as you would create a formula for a report. See Formulas 
101, Page 321, or search for Formula Editor in online Help.

5 Click Accept when finished. The new formula is added to the 
Tables & fields from database list box.

Next, you will need to add the formula to the view.

NOTE: The following screenshot illustrates both a before and after

state of the dialog box. Typically, any fields you move to the Tables 
& fields in view list box will no longer appear in theHeadings & fields 
in view list box.

2 To create a formula, click the New Formula button.

3 Type a name for

your formula and click

OK when finished.
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NOTE: Normally, formulas are represented with an @ symbol. The

formula name appears in the Headings & fields in View list box

without the @ symbol to hide the fact that this is a formula.

How to rename field headings, fields, and formulas

1 While in the Dictionaries Expert, click the View Tab.

6 Highlight the formula you

just created from this list.

The field will be

added to this list.
7 Click the

Add button.

8 Highlight the formula and click the Edit button

if you would like to modify your formula.

2 Highlight the heading or field you want to rename from this list.

3 Click the Alias button.
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A Set Alias dialog box appears. 

●   If you chose a heading, the Set Table Alias dialog box 
appears. 

●   If you chose a field, the Set Field Alias dialog box appears.

See Aliases, Page 515.

NOTE: This process does not actually rename tables or fields.

Only the alias name that appears to the user opening the

dictionary is changed. The original database file is not affected.

How to move fields/field headings within the list

1 While in the Dictionaries Expert, click the View Tab to 
activate it.

2 Highlight the heading or field that you want to move from the 
Headings & fields in View list and drag it up or down to the 
desired position.

The order that the fields and field headings appear in this list 
box is the order that they will appear to users.

NOTE: When organizing fields and field headings, remember that

field headings take the place of database tables. Because of this

organization, the first item in the list box must be a field heading.

4 Type the new name into this text

box and click OK when finished.
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How to update the location of a database table

1 While in the Dictionaries Expert, click the Tables Tab to 
activate it.

NOTE: Remember, the table names that appear here are aliases

rather than the actual database table names. See Aliases, Page 515.

●   If the table is from a data file, the Choose New Location 
dialog box appears.

●   If the table is from an SQL server or other ODBC data 
source, the Choose SQL Table dialog box appears.

4 Highlight the new name or location of the database table from 
the dialog box that appears, and click OK.

How to add a new field heading

1 While in the Dictionaries Expert, click the View Tab to 
activate it.

2 Highlight the table or field that has

changed name or location from this list.

3 Click the Location button.
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 The Insert Field Heading dialog box appears.

The new field heading appears in the Headings & fields in View 
list box with the new name.

2 Highlight the field that will be the first to

appear under the new field heading from this list.

3 Click the Heading button.

4 Type the new name into this text

box and click OK when finished.

The new field heading appears as specified.
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How to add Help text

To maximize the efficiency of your dictionary, Seagate Crystal 
Reports allows you to add Help text. Whenever anyone needs 
clarification on what the elements of your dictionary are, they can 
point to the item in question and Help text will appear in a pop-
up window to assist them.

1 While in the Dictionaries Expert, click the View Tab to 
activate it.

The Edit Help Text dialog box appears.

When the user selects a field or field heading and holds the 
cursor over the selected item, the Help text will appear in a 
pop-up window.

2 Highlight the field that you want

to add Help text to from this list.

3 Click the Help Text button.

4 Enter the Help text and click OK

when finished.
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How to add a graphic

1 While in the Dictionaries Expert, click the Graphic Tab to 
activate it.

The File Open dialog box appears.

3 Use the controls in the File Open dialog box to highlight a 
graphic image file, and click OK to add it to your dictionary. 

Dictionaries support the Windows bitmap (.BMP), PC 
Paintbrush (.PCX), Tiff (.TIF), and TARGA (.TGA) graphic 
formats. The image file appears in the list box of the Graphic 
Tab.

You may now want to change the alias name, update the 
location, or delete a graphic. Simply highlight the desired 
graphic and click the appropriate button for your needs.

2 Click the Add button.
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●   If you clicked the Alias button, the Set Graphic Alias dialog 
box appears.

●   If you clicked the Location button to set the new location of 
the image, the Choose New Location dialog box appears. 
Use this dialog box to find the new name and/or location of 
the graphic file.

How to create sample data for users to browse

The Sample Data Tab in the Dictionaries Expert lets you create a 
set of custom sample data that appears to users when they browse 
field data. The data they see may or may not reflect actual data in 
the database, depending on the sample data you design.

1 While in the Dictionaries Expert, click the Sample Data Tab to 
activate it.

4 Highlight the desired

graphic in this list box.

5 Click the Alias button

to change the name.

Or, click the Location button

to change the location.

Or, click Delete to delete

the graphic from the list.

6 Type a new name for the

graphic in this text box and

click OK when finished.
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If you clicked the Edit button, the Edit Value dialog box 
appears.

The new value will appear in the Browsed data list box.

NOTE: Deleting and editing values in the Browsed data list box of

the Sample Data Tab does not change the database file. It only

changes the list of values that appears to a user whenever the

Browse and Paste dialog box is opened. This allows you to

customize the look of the data when users browse data, without

actually changing the data that is reported on.

2 Highlight a field that you want

to make browseable from this list.

3 Click the

Collect button.

To delete a highlighted field

value from the list above,

click the Delete button.

If the data has changed, click

theRefresh button to retrieve

a list of the new data.

To edit a highlighted value from

this list, click the Edit button.

The field values will

appear in this list.

Enter the new value in this text box

and click OK when finished.
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How to edit an existing dictionary

1 Click the OPEN button on the standard toolbar. The File Open 
dialog box appears.

2 Use the Drives, Directories, and File Name controls to highlight 
the existing dictionary file and click OK. The Dictionaries 
Expert appears.

3 Use the Dictionaries Expert to make changes to your 
dictionary file.

How to convert a 3.x or 4.x dictionary file

1 Click the OPEN button on the standard toolbar. The File Open 
dialog box appears.

2 Use the Drives, Directories, and File Name controls to highlight 
the old dictionary (*.DCT) file and click OK. The Select View 
dialog box appears, listing the names of all views from the old 
dictionary file. 

3 Highlight the view you want to convert to a new dictionary 
file, and click OK. The Dictionaries Expert appears with the 
data from the view you selected.

NOTE: This version of Crystal Dictionaries provides an easier and

more powerful method for controlling data access than older

versions. However, each view from an older dictionary file is

handled as a separate dictionary in this version. An older

dictionary file, on the other hand, held several views. To convert

an entire dictionary 3.x or 4.x file, you must open each view in the

file separately and save it as a new dictionary file.

4 Use the Dictionaries Expert to make changes to your new file.

5 When you save your file, it will be saved in the new 
dictionary format (*.DC5).
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How to select a dictionary for a report

When creating a new report in Seagate Crystal Reports, you can 
specify a dictionary as your data source. By using a dictionary for 
your report, administrators can monitor company information 
being disclosed and users are not burdened by extra data they will 
not be using in their reports.

1 Click the NEW button on the standard toolbar in Seagate 
Crystal Reports. The Report Gallery appears.

An additional section will be added to the dialog box, 
revealing custom report options.

5 Use the Drives, Directories, and File Name controls from the 
dialog box that appears to highlight the dictionary (*.DC5) file 
that you want to use, and click OK.

6 To add items from the dictionary to your report, click the 
INSERT FIELDS button on the standard toolbar, and use the 

2 Click the Custom button.

3 Click the Custom Report, Custom Cross-

Tab, or Custom Multi-Column button.

4 Click Dictionary.
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Insert Fields dialog box to highlight fields and images for 
your report. 

●   Field headings from the dictionary appear as tables in the 
Insert Fields dialog box.

●   Fields from the dictionary appear as fields for each table.

NOTE: You can not use more than one dictionary file in a report

at a time. Also, you can not link fields from dictionary files to

fields in other database tables.
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23 Working With Databases

What you will find in this chapter...

Databases Overview, Page 514

Relational Database basics, Page 514

Aliases, Page 515

Locating files, Page 517

Indexed tables, Page 518

Linking tables, Page 520

Using SQL and SQL databases, Page 545

HANDS-ON (Working With Databases), Page 554
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Databases Overview

Though there are hundreds of Database Management Systems 
(DBMS) available, Seagate Crystal Reports eliminates many of the 
differences once it connects to the actual database files. The 
process of working with database files, tables, fields, and records 
is much the same regardless of the actual type of data being 
accessed.

This section discusses several concepts and tasks common to 
working with database files. Using database aliases, locating 
moved or renamed database files, working with indexed tables, 
and linking tables are subjects common to anyone who designs 
reports in Seagate Crystal Reports. The topic, Using SQL and SQL 
databases, Page 545, is especially important for anyone who 
accesses data in SQL databases and other database formats that 
are accessed through ODBC.

Relational

Database basics

The most popular architecture for database files used in the 
corporate world is based on the relational model. Applications 
that allow you to create databases with the relational model are, 
therefore, often referred to as Relational Database Management 
Systems (RDBMS).

In a relational database, data is organized in a system of rows and 
columns. The rows are called records, and the columns are called 
fields. Each record contains a collection of related data, all 
information relating to a specific customer, for example. Each 
field refers to a common type of data that exists in all records, the 
names of the customers, for example. Records and fields are 
stored in a database table. The following diagram illustrates the 
basic relational database model:

Customer ID Customer Name Address 1

Customer Table

City Region Postal Code

Row

1
2
3
4
5
6
7
8
9
10

Bike-O-Rama
The Pedellars Inc.
Bikes 'R Us Enterprises
Cycle Sporin Corporation
Sporting Wheels Inc.
The Cytclists Company
Ride 'Em Cowboy Corp.
XYZ Enterprises
Trail Blazer's Place
The Cyclists Incorporated

7464 St. Georges Way
410 Eighth Avenue
7429 First Boulevard
8287 St Georges Way
480 Grant Way
1984 Sydney Street
8194 Pender Avenue
3802 Georgia Court
6938 Second Street
4861 Second Road

Sterling Heights
Dekalb
Blacklick
Huntsville
San Diego
Austin
Eden Prairie
Des Moines
Madison
Newbury Park

MI
IL
OH
AL
CA
TX
MN
LA
WI
CA

48358
60148
4300
35818
92160
78770
55360
5030
53795
9134

Column
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Often, data in two different tables can be related by a common 
field. For example, a Customers table will have a Customer ID for 
each customer, and an Orders table will have the Customer ID of 
each customer who placed an order. This demonstrates a 
relationship between tables. The two tables can be linked (Linking 
tables, Page 520) by their common field. Examine the following 
diagram to understand how two tables can have a relationship: 

Aliases For a variety of reasons, database names and locations get 
changed. If you create a report, then change the name or location 
of a table or file, Seagate Crystal Reports must be able to find the 
new name or location. This is especially important when you 
create formulas in your report that access a table that has been 
renamed or moved. To fix the reference for a single field would 
not be difficult, but to find every formula that uses that field could 
be a difficult and time consuming task.

To solve this problem, Seagate Crystal Reports uses aliases to refer 
to database tables and files. Aliases are pointers, internal devices 
that tell the program where it should look for a database field. 

Customer ID Customer Name Address 1

Customer Table

City Region Postal Cod

1
2
3
4
5
6
7
8
9
10

Bike-O-Rama
The Pedellars Inc.
Bikes 'R Us Enterprises
Cycle Sporin Corporation
Sporting Wheels Inc.
The Cytclists Company
Ride 'Em Cowboy Corp.
XYZ Enterprises
Trail Blazer's Place
The Cyclists Incorporated

7464 St. Georges Way
410 Eighth Avenue
7429 First Boulevard
8287 St Georges Way
480 Grant Way
1984 Sydney Street
8194 Pender Avenue
3802 Georgia Court
6938 Second Street
4861 Second Road

Sterling Heights
Dekalb
Blacklick
Huntsville
San Diego
Austin
Eden Prairie
Des Moines
Madison
Newbury Park

MI
IL
OH
AL
CA
TX
MN
LA
WI
CA

48358
60148
4300
35818
92160
78770
55360
5030
53795
9134

1
41
77
18
64
7
32
11
25
34
71
66
28
8
72
64
38
37
30
25

Customer ID Order ID Order Amount Order Data Ship Via

Order Table
Relationships

between tables
based on a

common field

1
1001
1003
1004
1005
1006
1007
1008
1009
1010
1011
1012
1013
1014
1015
1016
1017
1018
1019
1020

$41.90
$5,060.27
$186.86
$823.05
$0.00
$64.90
$49.50
$2,214.93
$29.00
$14,872.28
$0.00
$10,259.10
$1,142.12
$0.00
$0.00
$563.70
$72.00
$115.50
$0.00
$67.80

94/12/02
94/12/02
94/12/02
94/12/02
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/03
94/12/04
94/12/04
94/12/04
94/12/05
94/12/05
94/12/05
94/12/05

UPS
Pickkup
UPS
Pickup
Loomis
Purolater
Parcel Post
Purolator
Loomis
UPS
Purolator
Loomis
Parcel Post
Purolator
UPS
FedEx
Purolator
Loomis
Parcel Post
FedEx
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Now, if you change the name or location of the database, you 
simply reset the pointer. See Locating files, Page 517. The name of 
the alias does not change, so your formulas are not affected. 
Seagate Crystal Reports looks to the alias for the location and 
name, goes to the new location for the database field, and executes 
the formula without a problem.

Seagate Crystal Reports automatically assigns default alias names 
to database tables when you first select the table or file. By default, 
an alias matches the original name of the table. In databases where 
the database table is a separate file (for instance, dBASE), the 
name of the database file is used without the file name extension. 
For example, if you are using the dBASE database file 
COMPANY.DBF, the program will assign a default alias name of 
COMPANY to the file. You can accept the default alias or assign a 
new one to the database table.

OLDNAME.DBF

MY_ALIAS

NEWNAME.DBF

MY_ALIAS

MY_ALIAS

NEWNAME.DBF
(in new location)
516 Seagate Crystal Reports User�s Guide



You can change an alias at any time using the SET ALIAS command 
on the Database menu. However, if you have already created 
formulas in your report using the original alias name, you will 
need to edit the formulas to use the new alias.

Locating files When a database file is moved or renamed, Seagate Crystal 
Reports will not be able to find the data the next time the report is 
printed. On other occasions, a report may be created on one 
machine where all of the database data is stored in a certain 
directory, then the report is copied or moved to another machine 
that stores the same data in a different directory. In any of these 
events, you need to verify the location of the database files 
accessed by the report and reset the alias pointers to the new 
database location or name.

MYFILE.DBF

ALIAS

ALIAS

ALIAS

Database file
in original
location.

MYFILE.DBF

Database file
has been
moved.

Use the Set
Location command
to change the
location pointed to
by the alias.

MYFILE.DBF
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The VERIFY DATABASE command on the Database menu checks the 
alias pointers stored in a report file to verify that the database files 
expected are located in the indicated directories. If the databases 
are not found in the specified location, the program notifies you of 
the discrepancies. Search for Verify Database command in Seagate 
Crystal Reports online Help.

Use the SET LOCATION command on the Database menu to change 
the alias pointers stored by Seagate Crystal Reports. The SET 
LOCATION command provides a simple way to indicate the new 
name or location of database files. In addition, the SET LOCATION 
command can be used to change the ODBC data source used by a 
report. See How to change the ODBC data source accessed by a report, 
Page 570, and search for Set Location command in Seagate Crystal 
Reports online Help.

Indexed tables Creating indexes for database tables can increase the speed of data 
access and reduce the time it takes for the program to evaluate 
data. Some DBMS applications automatically index your database 
tables, while others require that you create an index yourself. For 
the best report generation performance, make sure each of your 
database tables has a corresponding index.

NOTE: Some DBMS applications do not support indexed tables.

Refer to the documentation for your DBMS to find out if it

supports indexes and how to create them. If your DBMS

documentation does not mention indexed tables, it may not

support them, and you should link tables based on common fields.

The Visual Linking Expert can also help you determine if your

tables include indexes. Search for Visual Linking Expert in Seagate

Crystal Reports online Help.

Indexes organize the records in a relational database table so that 
data can be located easier. For example, assume you have a table 
with the following data: 

Order# Customer Amount

10444 Allez Distribution 25141.50
10470 BG Mountain Inc. 19164.30

10485 Sierra Mountain 8233.50
10488 Mountain Toad 24580.50

10495 SFB Inc. 7911.80
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The information in this table is organized according to the Order# 
field. This is fine anytime you want to look up information in the 
table based on order numbers. However, what if you want to look 
up information specific to a certain customer?

Say you want to look up all orders made by Sierra Bicycle Group. 
The database engine must begin by looking at the first order 
number in the list and checking to see if the customer name 
matches the request. If not, it goes to the second order number, 
and checks that customer name. When an order number is 
reached that contains the correct customer name, the database 
engine retrieves the information, then continues to the next order 
number. Using this technique, both the Order# field and the 
Customer field must be read for every single record in the table. 
This takes a long time and a large amount of computer processing 
effort for examining extensive database tables with thousands, or 
even millions of records.

Instead, you can create an index for the table based on the 
Customer field. Such an index might look like this:

10501 La Bomba de 
Bicicleta

1956.20

10511 BG Mountain Inc. 1683.60
10544 Sierra Bicycle 

Group
19766.20

10568 Mountain Tops 
Inc.

29759.55

10579 Sierra Bicycle 
Group

12763.95

Customer Pointer to Order#

Allez Distribution 10444
BG Mountain Inc. 10470

BG Mountain Inc. 10511
La Bomba de Bicicleta 10501

Mountain Toad 10488
Mountain Tops Inc. 10568

SFB Inc. 10495

Order# Customer Amount
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In this index, information is organized by customers, not order 
numbers. Also, notice that the second column actually contains 
pointers to specific order numbers in the original table. By using 
this index, the database engine can search just the information in 
the Customer column until it finds the customer you are 
interested in, Sierra Bicycle Group.

For each correct customer entry the database engine finds in the 
index, it looks up the matching order in the table according to the 
pointer in the second column of the index. Only the orders for the 
correct customer are read. Finally, since information in the index 
is organized according to the customer names, the database 
engine does not need to continue searching through the index or 
the table as soon as it finds an index entry that does not match the 
requested customer.

The result of this highly organized search through a database 
table according to an index is speed. Using indexes speeds up data 
retrieval and report generation, important factors when reporting 
on large database files.

Linking tables You link tables so records from one table will match related 
records from another. For example, if you activate an Orders table 
and a Customers table, you link the tables so that each order (from 
the Orders table) can be matched up with the customer (from the 
Customer table) that made the order.

When you link, you are using a field that is common to both 
tables. Seagate Crystal Reports uses the link to match up records 
from one table with those from the other. In this example, the link 
assures that the data in each row of the report refers to the same 
order.

Link from and link to

When you link two tables, you link from one table to another table. 
When linking tables, you must understand this concept. The from 
table is used as a primary table, while the to table acts as a lookup 

Sierra Bicycle Group 10544

Sierra Bicycle Group 10579
Sierra Mountain 10485

Customer Pointer to Order#
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table where records are looked up by the primary table. In a 
simple link, Seagate Crystal Reports examines the first record in 
the primary table and finds all matching records in the lookup 
table. Once all matches have been found in the lookup table for the 
first record in the primary table, all matches in the lookup table for 
the next record in the primary table are found.

NOTE: Seagate Crystal Reports can link two records based on a

partial match of string data. This is called a partial link. To enable

partial linking in Seagate Crystal Reports, toggle the Allow partial 
text matches check box on using the Link Options dialog box. As an

example of a partial link, a record with a field value of �Chris� can

link to a record with a field value of �Christopher�. However,

partial linking only works when the value in the lookup table is

longer than the value in the primary table. In other words, the

value �Chris� can link to the value �Christopher�, but the value

�Christopher� can not link to the value �Chris�. Search for Link 
Options dialog box in Seagate Crystal Reports online Help.

Link relationships

When you link records from one table to another table, the records 
will typically fall under one of two relationship types: 

1. one-to-one

2. one-to-many

ONE-TO-ONE RELATIONSHIPS

In a one-to-one relationship between records in two linked tables, 
for every record in the primary table there is only one matching 
record in the lookup table (based on the linked fields). For 
example, in the CRAZE.MDB database, the Employee table can be 
linked to the Employee Addresses table based on the Employee ID 
field in each table. The Employee table contains information about 
employees at the company, the positions they hold, their salaries, 
hiring information, etc. The Employee Addresses table contains 
each employee's home address. There is only one record for each 
employee in each of these tables. Therefore, if the Employee table 
is linked to the Employee Addresses table, only one record will be 
found in the Employee Addresses table for each record in the 
Employee table. This is a one-to-one relationship.
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ONE-TO-MANY RELATIONSHIPS

In a one-to-many relationship between records in two linked 
tables, for every record in the primary table, there may be more 
than one matching record in the lookup table, based on the linked 
fields. In the CRAZE.MDB database, the Customer table can be 
linked to the Orders table based on the Customer ID field in each 
table. The Customer table contains information about each 
customer that has placed an order with the company. The Orders 
table contains information about orders that customers have 
placed. Since customers can place more than one order, there may 
be more than one record in the Orders table for each customer 
record in the Customers table. This is a one-to-many relationship.

Performance considerations in one-to-many links

The information provided in this section is intended to help you 
maximize processing time and minimize network traffic when 
you are running your reports. You will learn about the best ways 
to use selection formulas and indexes in one-to-many situations to 
make your reporting more efficient. If you do not use the 
information in this section, your reports may end up processing 
dozens or even hundreds more records than necessary. 

When a one-to-many situation exists between two database tables 
and the program matches up records from the tables, there are a 
number of factors that determine how many records the program 
reads and evaluates. Understanding this information will help 
you avoid those situations that require excessive processing time 
or that generate unnecessary network traffic.

The tables that follow show the effects of the different factors on 
the number of records the program ultimately has to read. The 
charts are based on these assumptions:

●   Table A contains 26 records (one for each letter in the 
alphabet).

●   Table B contains 2600 records (100 matching records for 
every record in Table A).

●   The scenario is to produce a report that finds two specific 
records in Table A and the 200 records (100+100) in Table B 
that match those two records in Table A.
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   In a best case scenario, the program would only have to 
read about 200 records to accomplish the task.

   In a worst case scenario the program would have to read 
about 67,600 records to accomplish the same task.

NOTE: The performance considerations for data files are different

from the considerations for SQL databases. A data file is any non-

SQL database that is accessed directly from Seagate Crystal

Reports. For the purpose of this discussion, an SQL database is

any SQL database accessed directly from Seagate Crystal Reports

or through ODBC as well as any other database types that are

accessed through ODBC. For a better understanding of the

difference between direct access databases and ODBC data

sources, see Data Sources, Page 583.

EXTENDED DESCRIPTIONS OF CHART COLUMNS

The performance charts use the following columns:

●   Linking or Subreport
Are you creating a report from linked databases or are you 
inserting a subreport and binding it to the data in your 
primary report?

●   Selection Formula
Does your primary report include a record selection 
formula that sets range limits on the key (indexed) field in 
Table A?

●   Index A
Is Table A indexed on the field you are going to use to 
match up the records?

●   Index B
Is Table B indexed on the field you are going to use to match 
up the records?

●   Reads A
How many records does the program have to read out of 
Table A to find the two records it is looking for?

●   For each A reads in B
How many records does the program have to read in Table 
B to find the 200 records it is looking for?
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●   Total Records Read
What is the total number of records the program has to 
process to complete the task?

PC Data

Linking/
Subreport

Selection
Formula

Index A Index B Reads A
For each
A reads
in B

Total
Records
Read

Linking No Yes or No Yes 26 100 
(26*100)

2600

Linking Yes No Yes 26 100 
(26*100)

2600

Linking Yes Yes Yes 2 100 
(2*100)

200

Subreport No No No 26 2600 
(26*2600)

67,600

Subreport No Yes No 2 2600 
(26*2600)

67,600

Subreport No Yes Yes 26 100 
(26*100)

2600

Subreport Yes No No 2 2600 
(2*2600)

5200

Subreport Yes No Yes 26 100 
(26*100)

2600

Subreport Yes Yes Yes 2 100 
(2*100)

200

SQL Data

Linking/
Subreport

Selection
Formula

Reads A
For each A
reads in B

Total Records
Read

Linking No 26 100 (26*100) 2600

Linking Yes 2 100 (2*100) 200
Subreport No 26 100 (26*100) 2600

Subreport Yes 2 100 (2*100) 200
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Data file considerations

When working with data files, one-to-many links can occur when 
linking tables in a single report or when adding a subreport to 
your report. 

LINKING DATA FILES

The process the program follows in retrieving data from linked 
data files in one-to-many situations is as follows:

●   If there is a selection formula, the program parses the 
selection formula and passes what it can down to the 
database DLL. This is generally range limit information. For 
example, consider the following record selection formula:

{customer.REGION} in “CA” to “IL” AND
Remainder ({customer.CUSTOMER ID},2)=0

In this formula, the part before the “and” operator contains 
range selection criteria on the Region field. The region must 
fall alphabetically between “CA” and “IL”. The program 
passes this kind of condition down to the database DLL (for 
PC data) or the server (for SQL data). See Record and Group 
Selection, Page 249.

The second half of the selection formula, however, requires 
processing that must be done in the Report Engine. It uses a 
built-in function to manipulate and evaluate a field value 
and it can not be done in the database DLL or the server. 
The program does not pass this condition to the database 
DLL.

●   If there is an index on Table A, and the range limit selection 
condition is based on the indexed field {customer.REGION} 
in this example, the program goes directly to the record it is 
seeking in Table A (the first CA record) and reads it.

   For that record, it locates the first matching record in 
Table B, using the Table B index.

   It passes this merged record (A+B) back to Seagate 
Crystal Reports which tests it against the entire selection 
formula.
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   It then reads the second matching record and passes the 
merged record on, then the third matching record, and 
so on, until it has read all of the matching records.

   Then it returns to Table A and reads the next record. 
There is no need to test the record to see if it meets the 
CA condition; the field is indexed and the records are in 
alphabetic order. But it tests the record to see if it goes 
beyond the “IL” condition (for example, could the next 
record be from Mississippi or Tennessee?). If the record 
is still within the specified range, it begins the matching 
process again for that record.

   It continues the process until it has located all targeted 
Table A records and the matching Table B records.

To find two records in Table A and the 100 records in Table 
B that match the Table A records, the program reads 200 
records.

NOTE: The lookup table in a link (Table B) must always be

indexed or you will not be able to link the tables.

●   If there is no index on Table A, or if there is an index but the 
range limit selection condition is not based on the indexed 
field, the program reads the very first record that it finds.

   For that record, it locates the first matching record in 
Table B, using the Table B index.

   It passes this merged record (A+B) back to the Report 
Engine which tests it against the entire selection 
formula.

   It then locates the second matching record in Table B 
and passes that merged record back, then the third 
record and so on, until it has located, merged, and 
passed back all the records in Table B that match the 
first record in Table A.

   It then returns to the next record in Table A and begins 
the matching and merging process all over again.

To find two records in Table A and the 100 records in Table 
B that match the Table A records, the program reads 2600 
records.
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SUBREPORTS AND DATA FILES

If your primary report is based on Table A and the subreport is 
based on Table B and the records are linked, your primary 
considerations are as follows:

●   The number of subreports that are run is determined by the 
index and selection formula situation in the primary report.

   If Table A is indexed and if the primary report has a 
selection formula that passes down range limit 
conditions for the indexed field, the program runs 2 
subreports.

   If Table A is not indexed, or if Table A is indexed but the 
selection formula does not pass down range limit 
conditions for the indexed field, the program runs 26 
subreports.

●   The number of records that get read for each subreport is 
determined by the index situation on Table B.

   If you have an index on Table B, the program will read 
only the matching records (100) each time it runs a 
subreport.

   If you do not have an index on Table B, the program will 
always read every record in Table B (2600) every time it 
runs a subreport.

SQL database considerations

Since indexes are not critical with SQL data, your primary concern 
with both linked tables and with subreports is whether or not 
there is a selection formula in the primary report that puts range 
limits on Table A. See LINKING DATA FILES, Page 525.

LINKED SQL TABLES

If there are range limit conditions in the selection formula, the 
program passes those conditions down to the server. 

●   If there is a selection formula that puts range limits on Table 
A, the server locates the records in Table A that satisfy the 
selection criteria (2), matches them up with the appropriate 
records in Table B (100), and returns 200 merged records to 
the Report Engine.
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●   If there is no selection formula or if there is a selection 
formula that does not put range limits on Table A, the 
server matches up each record in Table A (26) with the 
appropriate records in Table B (100), and returns 2600 
merged records to the Report Engine. 

In both cases, the Report Engine then applies the entire selection 
formula to the merged records.

SUBREPORTS AND SQL DATABASES

If you are creating a primary report from Table A and a subreport 
from Table B:

●   The number of subreports that are run is determined by the 
selection formula situation in the primary report.

   If there is a selection formula and it passes down range 
limits on Table A, the program runs a subreport only for 
those records that satisfy range limit conditions (2).

   If there is no selection formula, or if the selection 
formula does not pass down range limits on Table A, 
the program runs a subreport for every record in Table 
A (26).

●   The number of records read by each subreport is the same 
whether or not there was range limit selection on Table A. 
Each subreport will read only those records in Table B that 
match each record read in Table A (100).

Performance considerations for all reports

CONSIDERATION #1

With both data files and SQL databases, the program parses the 
entire selection formula and passes down whatever it parts of the 
criteria it is able to translate (pass), wherever they may physically 
appear in the formula. Thus, if the formula finds criteria it can 
pass, then criteria that it can not, then criteria that it can, it passes 
down the first part, skips the second, and then passes down the 
third.

●   In the case of data files, it passes down the criteria that it can 
to the database translation layer.
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●   In the case of SQL databases, it passes down to the server 
the criteria that it can in the form of a WHERE clause.

While there are exceptions, as a general rule the program can pass 
down any part of the record selection formula that compares a 
field with a constant. Typically, this means that it can pass down 
any kind of record selection criteria that can be set up in the Select 
Expert (field equal to, one of, less than, greater than, less than or 
equal, greater than or equal, between, starting with, or like 
constant).

There are two special selection formula situations that need to be 
considered. In these situations, there are multiple conditions in 
the record selection formula and some can be passed down while 
others can not.

●   AND situations

({customer.REGION} = “CA” and
{customer.CUSTOMER ID}[3 to 5] = “777”)

In this situation, the program sees that it can pass down the 
condition before the and operator but not the condition 
after. Since the only records that will meet the second 
condition will have to meet the first as well, it passes down 
the first condition, retrieves the data set that satisfies the 
condition, and then applies the second condition to only the 
retrieved data. The rule for AND situations is that the 
program passes down whatever conditions it can.

NOTE: If all of the conditions in an AND situation can be satisfied

on the server or in the database DLL, the program passes them all

down.

●   OR situations

({customer.REGION} = “CA” or
{customer.CUSTOMER ID}[3 to 5] = “777”)

In this situation, the program also sees that it can pass 
down the condition before the Or operator but not the 
condition after. Since there are records that can satisfy the 
second condition without satisfying the first, passing the 
first condition down does not make any sense because it 
will retrieve an incomplete data set. In other words, even if 
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it retrieves all the data that satisfies the first condition, it 
will still have to retrieve all the data in the table(s) so it can 
apply the second condition in Seagate Crystal Reports. 
Thus, instead of duplicating parts of the data retrieval, the 
program passes nothing down. It retrieves all the data and 
then runs both tests in Seagate Crystal Reports. The rule for 
OR situations is that the program passes down all the tests 
or none of the tests.

NOTE: If all of the tests in an OR situation can be performed on

the server or in the database DLL, the program passes them all

down.

CONSIDERATION #2

To make certain the program can use the index on Table A to 
enhance performance, make certain that:

●   there is a selection formula,

●   there are range limits in the selection formula on the key 
(indexed) field in Table A, and

●   the Use Indexes option is toggled on in the File Options 
dialog box. Search for File Options dialog box in Seagate 
Crystal Reports online Help.

CONSIDERATION #3

If the fields you are using from Table A are not indexed, but there 
is an indexed field that you can use in your record selection 
request, use it. For example, assume that you have three products 
(Product 1, Product 2, and Product 3) and you want to identify all 
sales of Product 2 in the US. There is no index on the Product field 
but there is an index on the Order Date field. Since you know that 
Product 2 did not begin shipping until July of 1995, you can 
improve speed by limiting your report to orders in and after July 
1995 using the selection formula. In such a case, the program uses 
the Order Date index to retrieve only those orders from July 1995 
forward (a small subset of the entire database) and then searches 
for the occurrences of Product 2 in that subset, not in the entire 
database.
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The Visual Linking Expert

The Visual Linking Expert lets you easily link two or more tables 
together. When you choose the ADD DATABASE TO REPORT 
command from the Database menu and select an additional 
database table, the Visual Linking Expert appears and displays 
the additional database table. Search for Visual Linking Expert and 
Add Database To Report command in Seagate Crystal Reports online 
Help.

The easiest way to link database tables is to click the Smart Linking 
button in the Visual Linking Expert. Smart Linking automatically 
chooses links for your tables based on common fields in tables or 
indexed fields (if your database supports indexed fields).

Linking indexed tables

When you are linking direct access database tables, you must link 
from the primary table to an indexed field in the lookup table. The 
link field in the primary table can be indexed, but does not have to 
be. The link field in the lookup table, however, must be indexed.

In addition, the fields used to link two tables must have the same 
data type. For example, you can link a string field in one table to a 
string field in another table, or a numeric field in one table to a 
numeric field in another table, but you can not link a numeric field 
in one table to a string field in another table.

NOTE: Some DBMS applications allow you to convert the value in

a field to another data type in the index. For instance, the field in

the table can be numeric, while the index converts the field value

to a string. However, if you choose to use that field to link to

another table, you must link to a field of the original data type.

You can not link a string value to the numeric field that has been

converted to a string in the index.

NOTE: If you are linking tables from two different ODBC data

sources, MS SQL Server and Oracle, for example, you can only

use string fields to link the tables. String fields are stored in

databases in the same manner, regardless of the data source.

Other types of values, however, may not be stored the same way

in different data sources, so you can not link different data

sources in Seagate Crystal Reports using anything other than

string values.
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CHANGING INDEX USED IN LINKING

When using the Smart Linking feature to link tables using a field 
that is a component of multiple indexes (two or more), Seagate 
Crystal Reports selects one of the indexes for the link. That index 
may or may not be the one you want to use. To determine the 
index in use and to change it if you wish, use the Index section of 
the Link Options dialog box. 

To call up the dialog box, either:

●   double-click the link line of interest,

●   select the link line of interest and click the Options button at 
the bottom of the Visual Linking Expert, or 

●   select the link line of interest, right-click, and choose the 
OPTIONS command from the shortcut menu that appears.

The Index section of the Link Options dialog box has two parts:

1. An Index In Use drop-down box displays the index that is 
currently in use. If you click the arrow, it also lists the other 
indexes that are available for the link as well as the option no 
specific index. If you are using an indexed database table and 
you do not see a particular index that you expect to see on the 
list, use the Add Index button.

2. A Fields in Index list box displays the fields that are included in 
the index that is currently selected in the Index In Use box.

If you select the no specific index option, the program will select an 
index for you the next time you print the report to the Preview 
Tab.

NOTE: Not all DBMS applications support indexed tables. Verify

that your database uses indexes before trying to select an index

for linking. Refer to your DBMS documentation to find out if your

DBMS can use indexes and how to create them.

Methods of looking up tables (direct access databases)

When a single table is linked to two or more tables, Seagate 
Crystal Reports needs to know in what order it should look up 
and link data from the primary table to data in the second, third, 
etc., lookup table. 
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Seagate Crystal Reports offers three different options for looking 
up records in two or more lookup tables from a single primary 
table:

1. LOOK UP BOTH AT THE SAME TIME, Page 533.

2. LOOK UP ALL OF ONE, THEN ALL OF OTHERS (A TO B, A 
TO C), Page 534.

3. LOOK UP ALL THE COMBINATIONS OF THE TWO FILES, 
Page 535.

NOTE: These options are not available if you are using data from

an ODBC data source.

These options are only available when you have a single table, a 
primary table, that is linked to two or more lookup tables. The 
primary table must be the link from table in each of the links. For 
instance, if you link from the Customer table to the Orders table 
and from the Customer table to the Credit table, these lookup 
options are available. However, if you link from the Customer 
table to the Orders table and from the Credit table to the Customer 
table, these options are not available.

In this example, for each method demonstrated three fields from 
three different linked tables will be shown. In each case, the 
Customer table is linked to the Credit table and the Orders table. 
The fields displayed are the Customer Name field from the 
Customer table, the Amount field from the Credit table, and the 
Order Amount field from the Orders table. These are not 
necessarily link fields for the tables, but the data in these fields 
illustrates how data is retrieved using each of the three lookup 
methods.

LOOK UP BOTH AT THE SAME TIME

For each record in the Customer table, this option looks for a 
matching record in the Credit table and a matching record in the 
Orders table. Then it looks for the next matching record in the 
Credit table and the next matching record in the Orders table, etc. 
Once it finds all the matching records, it repeats the process with 
the next record in the Customer table.
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Notice that for each line in the report, the value in the Amount 
field of the Credit table does not necessarily have any connection 
to the value in the Order Amount field of the Orders table. 
However, for each record in the Customer table, one record is 
selected from the Credit table, and one record is selected from the 
Orders table at the same time. 

Also notice that when the Credit table runs out of records for a 
given record in the Customer table, blanks are left in place of 
values until all related records from the Orders table are found. 
The same holds true when the Orders table runs out of records, 
but the Credit table still has some.

LOOK UP ALL OF ONE, THEN ALL OF OTHERS (A TO B,

A TO C)

For each record in the Customer table, this option looks for all the 
matching records in the Credit table (Table B) and then all the 
matching records in the Orders table (Table C). Then it repeats the 
process with the next record in the Customer table, then the next, 
etc.

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56) $1529.70

Cyclists 
Incorporated

($1260.12) $23.50

CyclePath Corp. ($1958.03) $49.50

CyclePath Corp. ($1076.43) $1702.60
CyclePath Corp. ($75.04)

The Great Bike 
Shop

($138.98) $3269.70

The Great Bike 
Shop

$5219.55

The Great Bike 
Shop

$1538.20
534 Seagate Crystal Reports User�s Guide



NOTE: If you want Table C data (the Orders table in this example)

to appear in your report before Table B data (Credit table), you

will need to change your links so the A to C link comes first, then

the A to B link. You do this via the Visual Linking Expert. To

change the order of the links, delete the existing links and set up

new links in the order you want.

LOOK UP ALL THE COMBINATIONS OF THE TWO FILES

For each record in the Customer table, this option looks for a 
matching record in the Credit table, then it finds all the matching 
records in the Orders table. Once it finds all the matching records 
in the Orders table, it repeats the process with the next record in 

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56)

Cyclists 
Incorporated

($1260.12)

Cyclists 
Incorporated

$1529.70

Cyclists 
Incorporated

$23.50

CyclePath Corp. ($1958.03)

CyclePath Corp. ($1076.43)
CyclePath Corp. ($75.04)

CyclePath Corp. $49.50
CyclePath Corp. $1702.60

The Great Bike 
Shop

($138.98)

The Great Bike 
Shop

$3269.70

The Great Bike 
Shop

$5219.55

The Great Bike 
Shop

$1538.20
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the Credit table, then the next, etc. When it finds matching Orders 
records for all the Credit records that match the first Customer 
record, it moves to the next Customer record and repeats the 
process.

NOTE: If you want the program to look up the first matching

record in Table C (Orders table in this example), then find all

matching records in Table B (Credit table), the reverse of the

current process, you will need to change your links so the A to C

link comes first, then the A to B link. You do this via the Visual

Linking Expert. To change the order of the links, delete the

existing links and set up new links in the order you want.

Customer Table Credit Table Orders Table

Customer Name Amount Order Amount

Cyclists 
Incorporated

($1088.56) $1529.70

Cyclists 
Incorporated

($1088.56) $23.50

Cyclists 
Incorporated

($1260.12) $1529.70

Cyclists 
Incorporated

($1260.12) $23.50

CyclePath Corp ($1958.03) $49.50

CyclePath Corp ($1958.03) $1702.60
CyclePath Corp ($1076.43) $49.50

CyclePath Corp ($1076.43) $1702.60
CyclePath Corp ($75.04) $49.50

CyclePath Corp ($75.04) $1702.60
The Great Bike 
Shop

($138.98) $3269.70

The Great Bike 
Shop

($138.98) $5219.55

The Great Bike 
Shop

($138.98) $1538.20
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SQL join types (ODBC data sources)

Seagate Crystal Reports enables you to specify the type of join you 
want to use when SQL tables are linked. An SQL join indicates 
how linked fields in two SQL tables are compared when records 
are read. The SQL Join Type options are specified using the Link 
Options dialog box.

NOTE: When linking using SQL joins, no indexed fields are

required.

The join types are:

●   Equal [=] join, Page 537

●   Left Outer [=(+), *=] join, Page 538

●   Right Outer [(+)=, =*] join, Page 539

●   Greater Than [>] join, Page 540

●   Less Than [<] join, Page 541

●   Greater Than Or Equal [>=] join, Page 542

●   Less Than Or Equal [<=] join, Page 543

●   Not Equal [!=, <>] join, Page 544

Equal [=] join

The result set from an Equal join includes all the records where the 
linked field value in both tables is an exact match. In the following 
example, the Customer table is linked to the Orders table by the 
Customer ID field. When a Customer ID is found in the Orders 
table that matches a Customer ID in the Customer table, 
information is displayed for the corresponding records in both 
tables.

SQL uses the following syntax to describe an Equal join:

SELECT Customer.’Customer ID’,
Customer.’Customer Name’,
Orders.’Order Amount’

FROM ’Customer’ Customer,
’Orders’ Orders

WHERE Customer.Customer ID =
Orders.Customer ID
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This statement produces the following data:

Left Outer [=(+), *=] join

The result set from a Left Outer join includes all the records where 
the linked field value in both tables is an exact match. It also 
includes a row for every record in the primary (left) table whose 
linked field value has no match in the lookup table. For instance, 
you can use a Left Outer join to view all customers and the orders 
they have placed, but you also get a row for every customer that 
has not placed any orders. These customers appear at the end of 
the list with blanks in the fields that would hold order 
information:

Customer Table Customer Table Orders Table

Customer ID Customer Name Order Amount

52 Allez Distribution 25141.50
53 BG Mountain Inc. 19164.30

53 BG Mountain Inc. 1683.60

57 Hansen MTB Inc. 15716.40
58 La Bomba de 

Bicicleta
1956.20

60 Mountain Toad 24580.50
62 SFB Inc. 7911.80

63 Sierra Bicycle 
Group

19766.20

63 Sierra Bicycle 
Group

12763.95

64 Sierra Mountain 8233.50

Customer Table Customer Table Orders Table

Customer ID Customer Name Order Amount

52 Allez Distribution 25141.50
53 BG Mountain Inc. 19164.30

53 BG Mountain Inc. 1683.60
57 Hansen MTB Inc. 15716.40
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NOTE: Left Outer and Right Outer joins are handled differently in

the SQL language from other join types. If the database is

accessed through ODBC, Seagate Crystal Reports will use ODBC

syntax in the SQL statement. If you are connecting to an SQL

database directly (not through ODBC), Seagate Crystal Reports

will use a syntax native to the database. For complete information

on what an Outer join looks like in a SQL statement, refer to

Microsoft ODBC documentation or the documentation for your

SQL database.

Right Outer [(+)=, =*] join

The result set from a Right Outer join includes all the records 
where the linked field value in both tables is an exact match. It also 
includes a row for every record in the lookup (right) table whose 
linked field value has no match in the primary table. If you link 
the Customer table to the Orders table, you get a row in the table 
for every order a customer has placed, just like an Equal join. You 
also get a row for every order found that can not be linked to a 
customer. Theoretically, this should not happen, but if an 
inexperienced sales person forgot to assign a customer ID to an 
order, you can quickly locate that order with a Right Outer join. 
The resulting table leaves a blank in any Customer fields for the 
order without a customer:

58 La Bomba de 
Bicicleta

1956.20

60 Mountain Toad 24580.50

62 SFB Inc. 7911.80
63 Sierra Bicycle 

Group
19766.20

63 Sierra Bicycle 
Group

12763.95

64 Sierra Mountain 8233.50

54 Bicicletas Aztecas
55 Deely MTB Inc.

Customer Table Customer Table Orders Table

Customer ID Customer Name Order Amount
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NOTE: Left Outer and Right Outer joins are handled differently in

the SQL language from other join types. If the database is

accessed through ODBC, Seagate Crystal Reports will use ODBC

syntax in the SQL statement. If you are connecting to a SQL

database directly (not through ODBC), Seagate Crystal Reports

will use a syntax native to the database. For complete information

on what an Outer join looks like in an SQL statement, refer to

Microsoft ODBC documentation or the documentation for your

SQL database.

Greater Than [>] join

The result set from a Greater Than join includes all records in 
which the linked field value from the primary table is greater than 
the linked field value in the lookup table. As an example, a 
company may want to compare the salaries made by all of their 
sales representatives to the salaries made by all of their sales 
managers. The company executives want to make sure no sales 
representative is making more money than any manager. With 
this in mind, you can link the SalesRep table to the Manager table 
by the Salary field in each table using a Greater Than join:

SELECT SalesRep.’Last Name’,
SalesRep.’Salary’,

Customer Table Orders Table Orders Table

Customer ID Order ID Order Amount

52 6 25141.50
53 11 19164.30

53 21 1683.60

57 4 15716.40
58 20 1956.20

60 16 24580.50
62 19 7911.80

63 28 19766.20
63 32 12763.95

64 14 8233.50
25 10320.87
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Manager.’Last Name’,
Manager.’Salary’

FROM ’SalesRep’ SalesRep,
’Manager’ Manager

WHERE SalesRep.’Salary’ >
Manager.’Salary’

This SQL statement might produce data similar to this: 

In this table, there is no relationship between sales representatives 
and sales managers established. Since all managers have seniority 
over all sales representatives, a company might find it necessary 
to check if any representatives make more money than any 
managers, evidence of a salary problem that needs to be 
remedied.

Less Than [<] join

The result set from a Less Than join includes all records in which 
the linked field value from the primary table is less than the linked 
field value in the lookup table. Using the Less Than join, you can 
compare sales representative and manager salaries in a different 
direction. Once again, the Salary field in each table is used as the 
link field. This time, though, you link from the Manager table to 
the SalesRep table using a Less Than join on the linked Salary 
fields:

SalesRep Table SalesRep Table Manager Table Manager Table

Last Name Salary Last Name Salary

Davolio $35,000.00 Fuller $32,000.00
Davolio $35,000.00 Brid $30,000.00

Davolio $35,000.00 Buchanan $29,500.00
Dodsworth $48,300.00 Hellstern $45,000.00

Dodsworth $48,300.00 Fuller $32,000.00
Dodsworth $48,300.00 Brid $30,000.00

Dodsworth $48,300.00 Buchanan $29,500.00
Dodsworth $48,300.00 Martin $35,000.00

Patterson $30,000.00 Buchanan $29,500.00
Working With Databases 541



SELECT Manager.’Last Name’,
Manager.’Salary’,
SalesRep.’Last Name’,
SalesRep.’Salary’

FROM ’Manager’ Manager’,
SalesRep’ SalesRep

WHERE Manager.’Salary’ <
SalesRep.’Salary’

This SQL statement produces a slightly different table than the 
Greater Than join:

Greater Than Or Equal [>=] join

The result set from a Greater Than Or Equal join includes all 
records in which the linked field value from the primary table is 
greater than or equal to the linked field value in the lookup table. 
The example here is identical to the example for the Greater Than 
join, but it uses the Greater Than Or Equal join:

SELECT SalesRep.’Last Name’,
SalesRep.’Salary’,
Manager.’Last Name’,
Manager.’Salary’

FROM ’SalesRep’ SalesRep,
’Manager’ Manager

WHERE SalesRep.’Salary’ >=
Manager.’Salary’

Manager Table Manager Table SalesRep Table SalesRep Table

Last Name Salary Last Name Salary

Fuller $32,000.00 Davolio $35,000.00
Fuller $32,000.00 Dodsworth $48,300.00

Brid $30,000.00 Davolio $35,000.00
Brid $30,000.00 Dodsworth $48,300.00

Buchanan $29,500.00 Davolio $35,000.00
Buchanan $29,500.00 Dodsworth $48,300.00

Buchanan $29,500.00 Patterson $30,000.00
Martin $35,000.00 Dodsworth $48,300.00

Hellstern $45,000.00 Dodsworth $48,300.00
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This statement might produce data such as this:

Less Than Or Equal [<=] join

The result set from a Less Than Or Equal join includes all records 
in which the linked field value from the primary table is less than 
or equal to the linked field value in the lookup table. The example 
here is identical to the example for the Less Than join, but it uses 
the Less Than Or Equal join:

SELECT Manager.’Last Name’,
Manager.’Salary’,
SalesRep.’Last Name’,
SalesRep.’Salary’

FROM ’Manager’ Manager’,
SalesRep’ SalesRep

WHERE Manager.’Salary’ <=
SalesRep.’Salary’

This SQL statement produces data like the following:

SalesRep Table SalesRep Table Manager Table Manager Table

Last Name Salary Last Name Salary

Davolio $35,000.00 Fuller $32,000.00

Davolio $35,000.00 Brid $30,000.00

Davolio $35,000.00 Buchanan $29,500.00
Davolio $35,000.00 Martin $35,000.00

Dodsworth $48,300.00 Hellstern $45,000.00
Dodsworth $48,300.00 Fuller $32,000.00

Dodsworth $48,300.00 Brid $30,000.00
Dodsworth $48,300.00 Buchanan $29,500.00

Dodsworth $48,300.00 Martin $35,000.00
Patterson $30,000.00 Brid $30,000.00

Patterson $30,000.00 Buchanan $29,500.00
Working With Databases 543



Not Equal [!=, <>] join

The result set from a Not Equal join includes all records in which 
the linked field value from the primary table is not equal to the 
linked field value in the lookup table. This type of join can be used 
to find possible combinations of items when a table is joined to 
itself (a self-join). For example, a company can have a table listing 
all products they sell. When they decide to hold a sale where their 
customers buy one item and get the second item half price, they 
may need a list of all possible two item combinations:

SELECT Product1.’Product Name’,
Product2.’Product Name’,

FROM ’Product’ Product1
’Product’ Product2

WHERE Product1.’Product Name’ !=
Product2.’Product Name’

In this SQL statement, the Product table is opened twice. The first 
time, it is given the alias name Product1. The second time, it is 
given the alias name Product2. Then, the Product Name field is 
used to link from the Product1 table to the Product2 table. This is 
the same table, but since it has been opened twice using different 
aliases, Seagate Crystal Reports will consider it as two separate 

Manager Table Manager Table SalesRep Table SalesRep Table

Last Name Salary Last Name Salary

Fuller $32,000.00 Davolio $35,000.00

Fuller $32,000.00 Dodsworth $48,300.00
Brid $30,000.00 Davolio $35,000.00

Brid $30,000.00 Dodsworth $48,300.00
Brid $30,000.00 Patterson $30,000.00

Buchanan $29,500.00 Davolio $35,000.00
Buchanan $29,500.00 Dodsworth $48,300.00

Buchanan $29,500.00 Patterson $30,000.00
Martin $35,000.00 Davolio $35,000.00

Martin $35,000.00 Dodsworth $48,300.00
Hellstern $45,000.00 Dodsworth $48,300.00
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tables. A Not Equal join is used to link the tables by the Product 
Name field. As a result, each product is paired with every other 
product offered, but is not paired with itself: 

NOTE: The symbol != is used to represent a Not Equal join if the

ODBC data source driver for the data being accessed supports this

symbol. If not, the default symbol <> is used to represent a Not

Equal join. Search for Self join in Seagate Crystal Reports online

Help.

Using SQL and

SQL databases

Perhaps the most popular and most powerful database formats 
are DBMS applications based on the Structured Query Language 
(SQL). SQL databases usually work over a client/server network 
architecture, providing an SQL Server to create, store, and 
manipulate database files, tables, fields and records, and an SQL 
Client interface allowing workstation users to not only design and 
work with database files, but to also retrieve useful and 
meaningful data that will help them in their everyday work.

What is SQL?

SQL is a query language designed for organizing, managing, 
developing and querying large relational databases over 
computer networks. SQL is a common language in the 

Product1 Product2

Product Name Product Name

Craze Adult Helmet Craze Mtn Lock

Craze Adult Helmet InFlux Lycra Glove
Craze Adult Helmet Roadster Micro Mtn Saddle

Craze Mtn Lock Craze Adult Helmet
Craze Mtn Lock InFlux Lycra Glove

Craze Mtn Lock Roadster Micro Mtn Saddle
InFlux Lycra Glove Craze Adult Helmet

InFlux Lycra Glove Craze Mtn Lock
InFlux Lycra Glove Roadster Micro Mtn Saddle

Roadster Micro Mtn Saddle Craze Adult Helmet
Roadster Micro Mtn Saddle Craze Mtn Lock

Roadster Micro Mtn Saddle InFlux Lycra Glove
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Information Science (IS) and Information Management industry. 
The language has been standardized by the American National 
Standards Institute (ANSI) and the International Standards 
Organization (ISO), meaning that there are specific features that 
must be present in any version of SQL produced by a software 
company for that version to be officially called SQL. Many 
software vendors add more advanced features to their version of 
SQL in an effort to improve the language and attract customers, 
but it must retain the original standards established by ANSI and 
ISO.

You should realize that SQL is not a true computer language. It 
can not be used to create stand-alone computer applications or 
operating systems. SQL is often referred to as a sublanguage that 
can be used from within other languages or applications. Most 
importantly, the purpose of the SQL language is specific to 
working with relational databases.

The syntax of the SQL language is built on a system of sending 
SQL statements to the SQL database server. Each statement is a 
request to perform a database operation such as creating a 
database file, adding tables and fields to the database, adding 
records to tables, or retrieving data from databases. The SQL 
server analyzes the SQL statement and performs the required 
operation. If the statement is a request for data, the server gathers 
the data and returns it to the client workstation for the user to 
view.

An SQL query is a SQL statement designed specifically to request 
data from one or more SQL databases. Some SQL applications 
require that you type in an SQL query directly using a text editor, 
while others provide graphical user interfaces that lead you 
through the process of querying an SQL database. In the latter 
case, the application must create an SQL statement based on the 
information you provide. This statement is the actual SQL query, 

SQL statement executes
and queries database

SQL Statements

Create database table

Add data to a table

Return data set

Examples of executed SQL
statement results
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and it is the SQL query that is used to request the data. Seagate 
Crystal Reports falls into this latter category of SQL-compliant 
applications.

CLIENT/SERVER ARCHITECTURE

One of the most powerful features of SQL DBMS applications is 
their ability to efficiently use the client/server architecture of a 
network.

A simple network structure consists of one or more network 
servers that provide a common location for all users on the 
network to obtain data and applications. Many network servers 
also provide network security, automated services such as 
backing up data, and network resource monitoring to provide the 
best service possible to all workstations on the network. Because 
of the high processing demands required by a network server, the 
computer used as the server is often a high powered, fast machine 
that may contain multiple processors, multiple hard drives, and 
multiple CD-ROM drives.

A network client is a single computer workstation that is used 
regularly by one or more company employees. A user works on 
the client and accesses data and applications from the server over 
the network. Large processing jobs that require a lot of time and 
resources are handled by the server, and the finished results are 
sent back to the client. This provides more efficient time 
management for users because the local workstation has less 
processing time and more “up” time available to the user.

Workstation

Workstation

Workstation Workstation

Server
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Many modern computer applications are based on this client/
server architecture. A simple client/server application has two 
parts, a server based application that is located on a network 
server machine, and a client based application that is located on a 
user’s workstation. The server application handles complex, time 
consuming, or power demanding processes, taking advantage of 
the network server computer’s power and resources, while the 
client application provides an easy-to-use user interface designed 
to help get work done faster and better than it could be done 
otherwise.

Often, a client/server application will be made available with a 
certain number of seats, depending on how much is paid for the 
application. Each seat is a single client workstation, or a single 
client user, depending on what the software vendors choose, that 
can be connected to and use the client/server software. Software 
vendors often sell additional seats for their applications, each seat 
coming with a complete set of client application software.

Do not confuse server applications with a network server 
computer. Both are often referred to as servers. However, a server 
application resides on a network server, taking advantage of the 
hardware and operating system capabilities of the server 
machine. A network server is a physical machine that network 
clients are connected to by cables or some other connection device.

Client
Application

Client
Application

Client
Application

Client
Application

Server
Application
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THE SQL DBMS

An SQL Database Management System is a common example of a 
client/server software package. A standard SQL DBMS will 
include an SQL server application that handles all of the actual 
work of building and working with databases and database data. 
The DBMS will also include at least one set of SQL client software 
(one seat) that can connect to the SQL server over your network. 
SQL client software usually consists of, at the very least, an SQL 
statement editor that you can use to write and execute SQL 
statements and an underlying communications layer that works 
with the SQL server application over the network.

When you execute an SQL statement, the client software passes 
the statement to the communications layer, which sends the 
statement over the network to the server software. The SQL server 
analyzes the statement, performs the requested operation, and 
returns any data requested to the client software. If the client 
software receives back any data, it displays the data to the user.

STORED PROCEDURES

In addition to the common relational database attributes, tables, 
fields, records, etc., many SQL DBMS systems support stored 
procedures. A stored procedure is a compiled SQL program, 
consisting of one or more SQL statements. A stored procedure can 
be used to define an SQL query that you can use over and over 
again. Furthermore, variables, conditional expressions, and 
variable arguments can be defined in the stored procedure so that 
you are prompted to provide information before the procedure is 
executed.

Server
Appli-
cation

1.SQL statement
   executes

4.Data is returned
   to the client

2.Server queries
   database

3.Requested data
   is retrieved by the
   server

Client
Appli-
cation

Workstation running
SQL client application

Server system running
SQL server application

SQL Client communicating with SQL server

SQL database
Working With Databases 549



Since stored procedures can return a result set, they can provide a 
specific set of data when executed. In fact, Seagate Crystal Reports 
allows you to execute a stored procedure on an SQL database and 
use the returned data to design a report. If the stored procedure is 
designed to prompt a user for information to base its query on, 
Seagate Crystal Reports will prompt you for that information 
when you select the stored procedure for your report. See How to 
select a stored procedure from an SQL database and change stored 
procedure parameters, Page 573.

How does Seagate Crystal Reports use SQL?

When you connect to an SQL database, or any ODBC database, 
Seagate Crystal Reports acts as an SQL client application, 
connecting to your SQL server through your network.

When you design a report that accesses SQL data, Seagate Crystal 
Reports builds an SQL query. This query can be edited if you 
know SQL and you feel that the query can be further optimized. If 
you choose the SHOW SQL QUERY command from the Database 
menu, the Show SQL Query dialog box displays the SQL query 
that Seagate Crystal Reports has designed.

This SQL query is a representation of the SQL statement that 
Seagate Crystal Reports sends to the SQL server. By interpreting 
as much as possible from your report design into an SQL query, 
Seagate Crystal Reports can offload much of the report processing 
onto the server machine. Rather than having to sift through an 
entire database to find the specific data you requested, Seagate 
Crystal Reports lets the server do the sifting and gets back a much 
smaller set of data, thus reducing the time and resources your 
workstation must use to finish the report.

Stored procedure
that contains one
or more SQL
statements

SQL
Statement

Executes Queries Database Returns Data Set

Data Set

Returns data set
based on the values
supplied by the user.

Dialog box that appears
to the user requesting
values for parameters in
the stored procedure.
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The SQL language

Since Seagate Crystal Reports uses the SQL language to access 
client\server databases through ODBC, you can better 
understand the report generating process by understanding some 
of the SQL clauses (commands) used:

SELECT

The SELECT clause indicates specific data items to retrieve from 
database tables. The item retrieved may be the values in a 
database field (column) or it may be the result of a calculation 
performed while gathering the data. For example:

SELECT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

DISTINCT

The DISTINCT clause can be added to an SQL statement just after 
the SELECT clause. DISTINCT forces the query to retrieve only 
unique (distinct) sets of data. A row of results will only be 
retrieved once. The previous SELECT statement can be changed to 
use the DISTINCT clause:

SELECT DISTINCT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

FROM

The FROM clause specifies the sources of the database fields 
indicated in the SELECT clause. FROM lists actual database tables 
that contain the fields and records containing the requested data. 
The FROM clause generated by Seagate Crystal Reports precedes 
the name of each table with the alias it uses to identify the table in 
your report. The following illustrates the FROM clause with the 
SELECT clause:

SELECT
TABLEA.’CUSTNAME’,
TABLEA.’STATE’

FROM
‘TABLEA’ TABLEA
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WHERE

The WHERE clause has two purposes:

1. WHERE can specify record selection criteria.

2. WHERE can specify how two database tables are joined.

When WHERE is used to specify record selection criteria using a 
search condition to use to determine which records (rows of data) 
are to be retrieved. For example:

SELECT
MYTABLE.’SALESPERSON’,
MYTABLE.’SALESTOTAL’

FROM
‘MYTABLE’ MYTABLE

WHERE
MYTABLE.’SALESTOTAL’ < 10000.00

If WHERE is used to specify how two tables are linked, an SQL 
join operator sits between the two table names. See SQL join types 
(ODBC data sources), Page 537. The following is an example of the 
WHERE clause joining two tables:

SELECT
CUSTOMER.’CUST_ID’,
CUSTOMER.’CUST_NAME’,
ORDERS.’AMOUNT’

FROM
‘CUSTOMER’ CUSTOMER,
‘ORDERS’ ORDERS

WHERE
CUSTOMER.’CUST_ID’ = ORDERS.’CUST_ID’

ORDER BY

The ORDER BY clause indicates that the database records 
retrieved be sorted according to the values in a specific field. If the 
ORDER BY clause is not used, records are retrieved in the order 
that they appear in the original database. If more than one field is 
specified after the ORDER BY clause, the records are sorted 
according to the values in the first field specified, then, within that 
sort, they are sorted by the values in the second field, specified, and 
so on. The following SQL statement uses the ORDER BY clause:
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SELECT
MYTABLE.’COMPANY’,
MYTABLE.’CITY’,
MYTABLE.’STATE’

FROM
‘MYTABLE’ MYTABLE

ORDER BY
MYTABLE.’STATE’ ASC,
MYTABLE.’CITY’ ASC

NOTE: ASC indicates that the values in the field are sorted in

ascending order rather than descending order (DESC). Ascending

order sorts letters from A to Z and numbers from 0 to 9.

GROUP BY

The GROUP BY clause retrieves a set of summary data. Instead of 
retrieving the data itself, GROUP BY groups the data and 
summarizes each group according to an SQL aggregate function. 
Only the summarization information for each group is returned to 
Seagate Crystal Reports. For example:

SELECT
MYTABLE.’STATE’,
MYTABLE.’ZIPCODE’,
SUM (MYTABLE.’SALES’)

FROM
‘MYTABLE’ MYTABLE

GROUP BY
MYTABLE.’STATE’,
MYTABLE.’ZIPCODE’

HAVING

The HAVING clause creates selection criteria for the summary 
information produced by the GROUP BY clause. The function of 
the HAVING clause is similar to the record selection function of 
the WHERE clause, but HAVING applies to summary data 
produced by the GROUP BY clause. For this reason, you will 
always see a GROUP BY clause just before the HAVING clause in 
any Seagate Crystal Reports SQL statement that produces 
summary results. This can be seen in the following example:
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SELECT
TABLE.’CUSTOMER’,
SUM (TABLE.’ORDERAMOUNT’)

FROM
‘TABLE’ TABLE

GROUP BY
TABLE.’CUSTOMER’

HAVING
SUM (TABLE.’ORDERAMOUNT’) > 20000.00

For additional information

This chapter has only touched on some of the more important 
aspects of database access, relational databases, and SQL. If you 
are interested in learning more about database topics, refer to the 
documentation provided with your DBMS application.

In addition, there are hundreds of books available on the market 
that discuss database theory and design in depth. Look for the 
computer related section at your local bookstore.

HANDS-ON (Working With Databases)

This section provides step-by-step instructions for performing 
several common procedures related to accessing database files 
from within Seagate Crystal Reports. Use these procedures to get 
started working with the program quickly.

How to open Access queries through DAO

Microsoft Access queries can be used in Seagate Crystal Reports 
as separate data sets, just like Access tables. When opening an 
Access database through the DAO engine (Microsoft Access, Page 
591), any queries in the database can be automatically read.
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1 Click the NEW button on the standard toolbar. The Report 
Gallery appears.

The Report Gallery expands.

The Choose Database File dialog box appears.

5 Locate and highlight the Microsoft Access database (*.MDB) 
file that contains the query you want to use in your report.

6 Click OK. The Design Tab appears in the application window 
with the Insert Fields dialog box.

7 All of the tables and queries from your Access database 
appear in the list box on the Database Tab of the Insert Fields 
dialog box. Queries appear at the end of the list, after tables. 
Locate your query on the Database Tab, and double-click the 
name of the query in the list. The query expands to display all 
fields it contains.

8 Select any fields you want to use in your report, and add them 
to the Design Tab.

NOTE: You can not use Access action queries or update queries in

Seagate Crystal Reports. You can use Access select queries and

cross-tab queries.

2 Click the Custom button.

3 Click the Custom

Report button.

4 Click the Data

File button.
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How to open Access queries through ODBC

ODBC gives you more control over what parts of a database you 
want to use. For this reason, using an Access query through 
ODBC requires a few extra steps.

1 Choose the OPTIONS command from the File menu. The File 
Options dialog box appears. Click the SQL Tab to display SQL 
and ODBC options.

●   The Views option automatically displays any available 
queries in your Access database.

●   The Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC 
data source. This dialog box provides the same options as 
the Allow Reporting On section of the File Options dialog 
box, but provides those options for every ODBC data source 
you log on to.

2 Make sure either the Views or the Prompt

on every table check box is toggled on.
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3 In addition, you can specify Table name LIKE and Owner LIKE 
options if you wish.

●   Table name LIKE is based on the SQL LIKE clause. This 
option allows you to specify the kinds of table names you 
want to appear in the Choose SQL Table dialog box. Use the 
underscore character (_) or the percent sign character (%) as 
wildcards with this function. The underscore character 
specifies any single character, while the percent sign 
signifies any character string. For example, DAV_ matches 
DAVE only, while DAV% matches DAVE and DAVID. 
Table name LIKE C% would display only those tables that 
have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The 
Owner LIKE option allows you to select the Owner (or 
Creator or Alias) of the table, not the table name itself. For 
example Owner LIKE C% would display only those tables 
that had an owner beginning with the letter C.

4 Click OK to exit the File Options dialog box.

5 Create a new report. When you choose SQL/ODBC as the 
source of your data, the Log On Server dialog box appears.

7 If you did not specify a particular Access database file with 
your Access ODBC data source, the Select Database dialog 
box will appear. Locate and select the database containing the 
Access query you want to use, and click OK.

8 If you selected the Prompt on every table check box in the File 
Options dialog box, the Allow Reporting On dialog box now 
appears. Otherwise, skip to Step 10.

6 Choose the ODBC

data source for your

Access database,

then click OK.
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The Choose SQL Table dialog box appears.

11 The Design Tab appears with the Insert Fields dialog box. 
Your Access query, and all fields associated with that query, 
appear on the Database Tab of the Insert Fields dialog box.

NOTE: You can not use Access action queries or update queries in

Seagate Crystal Reports. You can use Access select queries and

cross-tab queries.

How to open Access parameter queries

Access parameter queries can only be opened when an Access 
database is opened via ODBC. Make sure you have an ODBC data 
source set up for your Access database before attempting this 
procedure. See How to set up an ODBC data source, Page 562.

9 Make sure the

Views check box

is toggled on and

click OK when

finished.

10 Highlight your query in

this list box, then click OK.
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NOTE: When you design a parameter query in Access, you must

provide a prompt for the query and specify a data type for the

parameter. First, with your query open in Design View in

Microsoft Access, enter a prompt in the Criteria cell for the field
that will act as a parameter. Then, choose the PARAMETERS

command from the Query menu in Access, and specify a data type

for the parameter you just created. Make sure the prompt appears

exactly as it does in the Criteria cell. For complete instructions,

refer to your Access documentation. If you do not set up your

parameter query correctly, Seagate Crystal Reports will not be

able to use it.

1 In Seagate Crystal Reports, choose the OPTIONS command 
from the File menu. The File Options dialog box appears. 
Click the SQL Tab to activate it.

●   The Stored Procedures option automatically displays any 
available stored procedures when you log on to an ODBC 
data source. Seagate Crystal Reports treats Access 
parameter queries much like it treats SQL stored 
procedures. So, to use a parameter query, the Stored 
Procedures option must be toggled on.

2 Make sure either the Stored Procedures or the

Prompt on every table check box is toggled on.
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●   The Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC 
data source. This dialog box provides the same options as 
the Allow Reporting On section of the File Options dialog 
box, but provides those options for every ODBC data source 
you log on to.

3 In addition, you can specify Table name LIKE and Owner LIKE 
options if you wish.

●   Table name LIKE is based on the SQL LIKE clause. This 
option allows you to specify the kinds of table names you 
want to appear in the Choose SQL Table dialog box. Use the 
underscore character (_) or the percent sign character (%) as 
wildcards with this function. The underscore character 
specifies any single character, while the percent sign 
signifies any character string. For example, DAV_ matches 
DAVE only, while DAV% matches DAVE and DAVID. 
Table name LIKE C% would display only those tables that 
have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The 
Owner LIKE option allows you to select the Owner (or 
Creator or Alias) of the table, not the table name itself. For 
example Owner LIKE C% would display only those tables 
that had an owner beginning with the letter C.

4 Click OK to exit the File Options dialog box.

5 Create a new report. When you choose SQL/ODBC as the 
source of your data, the Log On Server dialog box appears.

7 If you did not specify a particular Access database file with 
your Access ODBC data source, the Select Database dialog 
box will appear. Locate and highlight the database containing 
the Access parameter query you want to use, and click OK.

6 Choose the ODBC

data source for your

Access database, then

click OK.
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8 If you selected the Prompt on every table check box in the File 
Options dialog box, the Allow Reporting On dialog box now 
appears. Otherwise, skip to Step 11.

10 The Choose SQL Table dialog box appears. Access parameter 
queries appear in the SQL Tables list box as:

Proc(QueryName)

The Stored Procedure Input Parameters dialog box appears.

9 Make sure the

Stored Procedures

check box is

selected and click

OK when finished.

11 Highlight your query in

this list box, then click OK.
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14 The value displayed in the Name list box will be updated.

15 Repeat Steps 12 and 13 for each parameter in your Access 
parameter query.

16 Click OK when finished. You can change parameter values at 
any time by choosing the STORED PROCEDURE PARAMETERS 
command on the Database menu.

17 Create your report using the fields in the parameter query. 
Only the records that satisfy the parameter values you 
specified in the Stored Procedure Input Parameters dialog box 
are used in your report.

NOTE: You can not use Access action queries or update queries in

Seagate Crystal Reports. You can use Access select queries and

cross-tab queries.

How to set up an ODBC data source

To set up an ODBC data source, you must have an ODBC driver 
installed for the type of data you want to use. Many DBMS 
applications automatically install and set up ODBC drivers. If you 
are not sure whether ODBC drivers have been installed for your data, 
refer to the documentation that came with your DBMS application.

1 From the Program Manager, double-click the ODBC 
Administrator icon in the appropriate program group. The 
ODBC Data Source Administrator dialog box appears.

12 Highlight a parameter from this list box.

13 Assign a value

by typing into the

Parameter Value

text box and click

the Update

button.
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 The Add Data Source dialog box appears.

If a driver does not appear for your data type, an ODBC driver 
has not been correctly installed. Refer to the documentation for 
your DBMS application.

4 When you click OK. An ODBC Data Source Setup dialog box 
appears that is specific to the ODBC driver you selected.

NOTE: If an error message appears instead of the Setup dialog

box, you do not have the correct ODBC drivers installed on your

system for the type of data you selected.

2 Click the Add button to add

a new ODBC data source.

3 Choose the ODBC driver appropriate

for your data type from this list.
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This is the name that you select when you log on to the data 
source from Seagate Crystal Reports.

NOTE: The dialog box that appears may look different than the

one shown here, depending on the type of data you are using. This

dialog box is specific to the Access 7.0 ODBC driver. For complete

information on using the dialog box that appears for your data,

click the Help button.

6 Click OK in the ODBC Data Source Setup dialog box when 
you are finished setting up your data source. The new ODBC 
data source will appear in the Data Sources dialog box.

5 Type the name for your new ODBC data source here.

Your new data source will now appear in this list.

7 Click Close

when finished.
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How to check settings for an ODBC data source

1 From the appropriate program group, or folder in Windows 
95, run the ODBC Administrator application. The Data 
Sources dialog box appears. 

The ODBC Data Source Setup dialog box appears.

2 Highlight the appropriate

data source from this list.

3 Click

Configure.
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4 The ODBC Data Source Setup dialog box is specific to the data 
source you selected, and contains controls and information for 
setting up your data source. Check the settings in this dialog 
box to make sure the information matches your system and 
database.

NOTE: The dialog box that appears may look different than the

one shown here, depending on the type of data you are using. This

dialog box is specific to the Access 7.0 ODBC driver. For complete

information on using the dialog box that appears for your data,

click the Help button.

5 Make any changes that are necessary, and click OK.

6 Close the ODBC Administrator Data Sources dialog box.

How to log on to an ODBC data source

1 Choose the LOG ON SERVER command from the Database 
menu. The Log On Server dialog box appears.

3 If the data source requires a user name and password, or any 
other log in information, a login dialog box appears. Type in 
the information you usually use to access this database, and 
click OK.

●   If you did not specify a database with the ODBC data 
source, the Select Database dialog box appears. Use the 
Drives, Directories, and Database Name controls to highlight 
the database file, and click OK.

4 The Choose SQL Table dialog box appears. Choose a database 
table from the SQL Tables list and click OK to add the table to 
your report.

2 Choose the ODBC

data source appropriate

for the database file you

want to open and click

OK when finished.
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How to add an ODBC database table to a report

1 Choose the ADD DATABASE TO REPORT command from the 
Database menu. The Choose Database File dialog box 
appears.

The Log On Server dialog box appears.

4 If the data source requires a user name and password, or any 
other log in information, the SQL Server Login dialog box 
appears.

6 If the data source you selected includes a database file 
specification, or if you specified a database table in Step 3, 
skip to Step 8.

2 Click the SQL

Table button.

3 Choose the

ODBC data source

appropriate for the

database file you

want to open, then

click OK when

finished.

5 Enter the required

information then clickOK

when finished to log in.
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7 The Select Database dialog box appears. Use the Drives, 
Directories, and Database Name controls to select the database 
file, and click OK.

8 The Choose SQL Table dialog box appears.

●   Choose a database table from the SQL Tables list and click 
OK to add the table to your report, or

●   Click the Log On Server button to log on to another ODBC 
data source.

How to log on to MS SQL Server via ODBC

NOTE: This section is intended as an example of how to log on to

a Microsoft SQL Server data source from Seagate Crystal Reports.

Your SQL server application or other password protected data

source may require different steps. This is intended only as an

example of one type of SQL database.

1 Verify the settings for the Microsoft SQL Server data source 
using ODBC Administrator. See How to check settings for an 
ODBC data source, Page 565.

2 From Seagate Crystal Reports, choose the LOG ON SERVER 
command from the Database menu. The Log On Server dialog 
box appears.

The ODBC - CRSS data source is automatically created during 
Seagate Crystal Reports setup procedure. This data source 
allows you to open MS SQL Server databases.

The SQL Server Login dialog box appears.

3 Choose the ODBC -

CRSS data source and

click OK when finished.
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The Options section of the SQL Server Login dialog box 
appears.

7 Verify the name of the SQL Server database you want to open, 
the database language you want to use, the name of the 
application you are using (Seagate Crystal Reports), and the 
name of your computer workstation. Make any changes that 
are necessary.

8 Click OK, and the Choose SQL Table dialog box appears. 
Choose a SQL Server database table from the SQL Tables list 
and click OK to add the table to your report.

4 Type your MS

SQL Server login

ID and password.

5 Then, click the Options button.

6 Verify the settings

for your SQL Server.
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How to log off an ODBC data source

1 Choose the LOG OFF SERVER command from the Database 
menu. The Log Off Server dialog box appears.

4 The ODBC data source is removed from the Logged On Servers 
list.

5 Click Done when finished.

How to change the ODBC data source accessed by a report

1 Choose the SET LOCATION command from the Database menu. 
The Set Location dialog box appears with a list of table aliases 
for the tables in the report displayed. Table location and log 
on information for the table you highlight will also be 
displayed below the list of tables. Select the first table in the 
list and click the Set Location button.

2 Highlight the ODBC data source

you want to log off from this list.

3 Then click the

Log Off button.
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4 Log on to the original ODBC data source if you are not logged 
on already. You must first log on to the old data source before 
you can change a report to use a new data source. Since you 
must be logged on to the old data source, the old data source 
must be available on the local machine.

●   If the machine is no longer connected to the old server, you 
can install an ODBC data source with the name of the old 
data source and have it point to the new database server. 
Log on to this data source as the “old” data source.

●   If you are using the same data source name to connect to a 
new server, you must configure that data source under 
ODBC Admin or the ODBC Control Panel, and make it 
point to the new server.

After logging on to the old data source, you will see the Choose 
SQL Table dialog box with a list of tables in the SQL Tables list 
box and the old data source in the SQL Databases list box.

3 Click the Set

Location button.

2 Highlight the first

table in this list.
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   You should now be logged on to both the old and the 
new data sources.

   The new data source should now appear in the SQL 
Databases list box of the Choose SQL Table dialog box. 

6 Click the new data source to display its tables, then select the 
appropriate table from this list. The table you choose should 
correspond to the first table you selected in the Set Location 
dialog box.

7 Click OK and you are prompted to change the location of all 
tables in the report to the location you specified for the first 
table.

9 Close the Set Location dialog box, and choose the VERIFY 
DATABASE command from the Database menu to refresh the 
table definitions in the report.

10 Log off the old data source.

11 Save the report.

5 Click the Log On Server button

to log on to the new data source.

8 Click Yes to set the location of all tables

in the report to the same database.
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How to select a stored procedure from an SQL database and

change stored procedure parameters

1 Choose the OPTIONS command from the File menu. The File 
Options dialog box appears. Click the SQL Tab to activate it.

●   The Stored Procedures option automatically displays any 
available stored procedures when you log on to an SQL 
database.

●   The Prompt on every table option displays the Allow 
Reporting On dialog box every time you log on to an ODBC 
data source. This dialog box provides the same options as 
the Allow Reporting On section of the File Options dialog 
box, but provides those options for every ODBC data source 
you log on to.

3 In addition, you can specify Table name LIKE and Owner LIKE 
options if you wish.

2 Make sure either the Stored Procedures or the

Prompt on every table check box is toggled on.
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●   Table name LIKE is based on the SQL LIKE clause. This 
option allows you to specify the kinds of table names you 
want to appear in the Choose SQL Table dialog box. Use the 
underscore character (_) or the percent sign character (%) as 
wildcards with this function. The underscore character 
specifies any single character, while the percent sign 
signifies any character string. For example, DAV_ matches 
DAVE only, while DAV% matches DAVE and DAVID. 
Table name LIKE C% would display only those tables that 
have a table name beginning with the letter C.

●   Owner LIKE is also based on the SQL LIKE clause. The 
Owner LIKE option allows you to select the Owner (or 
Creator or Alias) of the table, not the table name itself. For 
example Owner LIKE C% would display only those tables 
that had an owner beginning with the letter C.

NOTE: For more information on the SQL LIKE clause, refer to

your SQL documentation.

4 Click OK to exit the File Options dialog box.

5 Create a new report based on the SQL database that contains 
the stored procedure you want to use. When you choose SQL/
ODBC as the source of your data, the Log On Server dialog 
box appears.

The SQL Server Login dialog box appears.

6 Highlight the ODBC

data source for your SQL

Server from this list, then

click OK.
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The Options section of the SQL Server Login dialog box 
appears.

10 Click OK. If you toggled the Prompt on every table check box on 
using the File Options dialog box, the Allow Reporting On 
dialog box now appears. Otherwise, skip to Step 12.

The Choose SQL Table dialog box appears.

7 Enter required

information then

click OK when

finished to log in.

8 Click the Options button.

9 Verify the

settings for your

SQL Server.

11 Make sure the

Stored Procedures

check box is selected,

then click OK.
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13 The stored procedure is added to your report, and the Stored 
Procedure Input Parameters dialog box appears.

16 The value displayed in the Name list box will be updated.

17 Repeat Steps 14 and 15 for each parameter that appears in the 
Name/Value list box.

18 Click OK when finished. You can change parameter values at 
any time by choosing the STORED PROCEDURE PARAMETERS 
command on the Database menu.

12 Highlight an SQL stored procedure

from this list, then click OK.

14 Highlight a parameter from this list box.

15 Assign a value

by typing into the

Parameter Value

text box and click

the Update button.
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How to set up an A to B, A to C link

NOTE: This tutorial demonstrates how to set up an A to B, A to C

report using the Cust, Credit, and Orders tables in the

ORDRCR.MDB sample database. The ORDRCR.MDB database is

located in the \CRW directory, or directory in which the program

resides. Use the instructions here as a guideline for creating A to

B, A to C reports with your own database files.

1 Click the NEW button on the standard toolbar. The Report 
Gallery appears.

2 Click Custom, and the dialog box is expanded.

3 Select the type of custom report you wish to create, and click 
Data File. The Choose Database File dialog box appears. 

4 Locate and highlight the ORDRCR.MDB database file and 
click OK.

The Select Tables dialog box appears.

5 Click Select All to include all tables and click OK.

6 The Visual Linking Expert appears.

7 Link the {credits.CUST} field to the {orders.CUSTOMER} field 
and the {cust.NUMBER} field.

NOTE: Linking will not occur if you click the Smart Linking

button. For more information on linking, search for Visual Linking 
Topics Index in Seagate Crystal Reports online Help.

8 Select one of the link lines in the Visual Linking Expert, and 
click Options. The Link Options dialog box appears.

9 Click the Look up all of one, then all of others option button in the 
When linking to two files from this file section of the Link 
Options dialog box. This option establishes an A to B, A to C 
link.

10 Click OK to return to the Visual Linking Expert. The option 
you selected affected all links. To make sure, click the link line 
that you did not select in the last step.
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11 Click Options, and verify the Look up all of one, then all of others 
setting in the Link Options dialog box.

12 Click OK in the Link Options dialog box, then click OK again 
back in the Visual Linking Expert. See LOOK UP ALL OF 
ONE, THEN ALL OF OTHERS (A TO B, A TO C), Page 534.

You have now established an A to B, A to C relationship among 
the three tables.

How to edit an SQL query

NOTE: This section is only valid for reports using ODBC data

sources. An SQL query is automatically generated by Seagate

Crystal Reports when you design a report based on one or more

ODBC data sources. This query is sent to ODBC as an instruction

to gather data needed by the report.

1 Choose the SHOW SQL QUERY command from the Database 
menu. The Show SQL Query dialog box appears.

2 Click anywhere inside the SQL Query edit box to begin 
making changes.

3 Use the ANSI SQL language to fine tune the SQL query.
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NOTE: You can not change the SELECT clause of the SQL

statement.

4 Cut, copy, or paste any part of the query to or from the 
Clipboard if needed. See The SQL language, Page 551.

How to use an ACT! database

ACT! is a powerful Contact Management application that stores 
all of your contact information in a database format similar to 
xBASE databases (dBASE, Clipper, and FoxPro). See ACT!, Page 
601.

1 Click the NEW button on the standard toolbar. The Report 
Gallery appears.

The Report Gallery expands.

The Choose Database File dialog box appears.

5 Use the controls in the Choose Database File dialog box to 
locate and highlight the file CRW.ACT. This file is located in 
the \CRW directory or the directory in which the program 

2 Click the Custom button.

3 Click the Custom

Report button.
4 Click the Data

File button.
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resides. Click OK when finished. The Choose File for ACT! 
dialog box appears.

6 Use the controls in this dialog box to locate and highlight your 
ACT! database.

7 Click OK when finished, and a new Design Tab appears in the 
application window. Create your report using fields from 
your ACT! database.

How to open the NT Event Log

If you are using a Windows NT system, the 32-bit version of 
Seagate Crystal Reports gives you the ability to generate reports 
based on the NT Event Log. For your convenience, the program 
comes with a pre-designed report that you can run using your 
own Event Log as a data source. The report, EVENTDTL.RPT, is 
located in the \REPORTS\101\NTEVENT\ directory.

NOTE: This report is only available with the Professional version

of the program and is not available on floppy disks.

1 Open the EVENTDTL.RPT report file in Seagate Crystal 
Reports.

2 Click the REFRESH button on the standard toolbar. A dialog 
box will appear asking if you want to refresh data. 

●   If you click No, the original report will appear. 

●   If you click Yes, the Select Current Event Log dialog box 
appears:
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3 The computer referenced in the Computer(s) box is the 
computer the sample report is based on. To change the 
computer, click on the plus (+) sign to the left of Microsoft 
Windows Network. The directory structure will expand to 
display the network group that your computer is connected 
to. The Select Current Event Log dialog box will now look 
similar to the following:

4 You can now click on the plus (+) sign to the left of the 
network group to display individual machines connected to 
the group. The Select Current Event Log dialog box will now 
look similar to the following:
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5 From this point, you simply need to select the NT machine for 
which you would like an NT Event Log Report. When you 
select a machine by clicking on it, that name will appear in the 
Computer(s) text box. 

NOTE: If you select a non-NT machine, the following error

message appears: The RPC server is unavailable. You can run this

report only from NT machines.

6 Click OK. A new NT Event Log Report will appear. This 
report will contain information for the machine that you 
selected via the Select Current Event Log dialog box.

7 You can now print the report if you wish or review it in the 
Preview Tab. When you are ready to save the report, save the 
report to a new file name. When you want to update the 
report, simply refresh the report data. When you want to run 
a report on a different NT event log, open the original report 
(EVENTDTL.RPT) and repeat Steps 2-7.
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24 Data Sources

What you will find in this chapter...

Introduction, Page 584

Four types of data, Page 585

Direct access database files, Page 585

ODBC data sources, Page 606

Crystal Query Designer files, Page 623

Crystal Dictionary files, Page 624
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Introduction

Seagate Crystal Reports can access data stored in almost any 
common database format, as well as many uncommon formats. In 
addition, Seagate Crystal Reports leverages the full benefits of 
query (.QRY) files and dictionaries (.DC5). See Queries, Page 467, 
and Dictionaries, Page 491.

This section discusses the many different types of data that 
Seagate Crystal Reports can access and explains the data access 
layers involved in connecting to the data. If you are not sure what 
Database Management System (DBMS) your company uses, 
contact your IS manager or network administrator.

Why you
should read this
chapter

The principal purpose of Seagate Crystal Reports is simply to 
access data stored in databases and produce reports on that data. 
This goal is one of the oldest uses of computers and remains one 
of the most common and necessary. Seagate Crystal Reports is 
designed to make that task easier, less time consuming, and more 
powerful.

This idea of accessing data remains at the root of every report 
produced. By understanding how Seagate Crystal Reports 
accesses data, you will gain a better knowledge of the reporting 
process as well as a better knowledge of the type of data that the 
program can work with.

In addition, understanding the data access process will help you 
troubleshoot problems you may encounter while trying to open a 
particular database file. This is especially useful for IS managers 
and anyone providing data access support for a group of users.

Most of the information in this section is designed for experienced 
Seagate Crystal Reports users and IS managers and covers 
technical aspects of Database Management Systems (DBMS) and 
data storage techniques. A familiarity with computers, the 
Windows, Windows 95, or Windows NT operating system, and at 
least one DBMS application is assumed.

A note to
developers

This section concentrates on the principles of data access. 
However, most of the same concepts can be applied to any 
application accessing data through the Crystal Report Engine, or 
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any of the Crystal Report Engine development tools described in 
the Technical Reference. For that reason, Seagate Crystal Reports, 
as used in this section, refers both to the application and the 
Report Engine unless otherwise specified.

NOTE: Most of the file names mentioned in this chapter are for

the 16-bit version of the program unless otherwise specified. File

names for 32-bit version are similar, but will have some aspect

indicating 32-bit. For example, PDSODBC.DLL is the 16-bit

ODBC translation file, while P2SODBC.DLL is the 32-bit ODBC

translation file.

Four types of data

The type of data that Seagate Crystal Reports can access falls into 
four general categories:

1. Direct access database files, Page 585

2. ODBC data sources, Page 606

3. Crystal Query Designer files, Page 623

4. Crystal Dictionary files, Page 624

Each type of data must be accessed using a specific set of DLLs 
and other data access related files. Once you understand the 
process the program uses to access each type of data, you will 
have a better understanding of the report creation process and the 
elements used to turn your data into powerful reports. See 
Queries, Page 467, and Dictionaries, Page 491.

NOTE: When accessing any type of data, Seagate Crystal Reports

relies on the database drivers to provide field names, field types,

and field lengths. This information is provided by either the

database engine or the ODBC database driver.

Direct access database files

Seagate Crystal Reports can access many of the most common PC 
database formats directly. In other words, the program has built-
in capabilities to directly open database files and tables designed 
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in dBASE, FoxPro, Clipper, Btrieve, Paradox, and Microsoft 
Access, among others. This functionality exists as soon as you 
install Seagate Crystal Reports. Once it is installed on your 
system, you can immediately begin creating reports based on 
these databases simply by selecting the appropriate file.

Advantages Accessing the database directly is the fastest route to reading the 
data. Seagate Crystal Reports only needs to talk to a single data 
access layer that provides contact with the data. Report results can 
be obtained quickly in almost any system environment.

In addition, data access is simple. Direct access database files are 
point-and-click data sources. You need only select the required 
database files and Seagate Crystal Reports reads all of the stored 
data. 

Disadvantages When you access a database directly from Seagate Crystal 
Reports, only that database type can be used by the report. You 
can not switch to a different type of database or table without 
creating a new report.

For example, if you design a report based on Btrieve data, you can 
not change the tables accessed by the report to Paradox data. 
Seagate Crystal Reports communicates with Btrieve data using a 
Btrieve specific syntax, a syntax that is not compatible with 
Paradox data.

If you access data through ODBC, on the other hand, the syntax 
used is always the SQL language regardless of the actual database 
type. See ODBC data sources, Page 606.

Three layers Direct access of database files from Seagate Crystal Reports 
requires three layers: 

1. Seagate Crystal Reports, Page 587,

2. Data Translation, Page 587, and 

3. Database, Page 588.
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Seagate Crystal Reports uses the data translation layer to talk to 
the database and access its data.

Seagate Crystal Reports

Seagate Crystal Reports operates as an interface through which 
you format, arrange, select, and sort the data stored in database 
files. It obtains data by communicating with one or more files in 
the data translation layer that can actually read the database. Since 
Seagate Crystal Reports can work with many forms of data, it 
must rely on other files to work directly with the data. Seagate 
Crystal Reports can then use a native method of communication 
to talk to the translation files.

Data Translation

Data is translated through a set of DLLs specific to Seagate Crystal 
Reports. The program uses the DLLs specific to a certain data type 
to understand how data is organized for that type and to present 
it correctly when your report is printed, previewed, or exported.

NOTE: Seagate Crystal Reports comes with all data translation

files for each of the direct access database types that it supports.

Crystal Reports Layer

Data Translation Layer

Database Layer
Data Sources 587



For complete information on all required files, refer to the

Runtime File Requirements online Help (RUNTIME.HLP).

Database

The database file consists of one or more tables. Different DBMS 
applications store database information differently. For example, 
dBASE stores each database table as a separate file. Access, on the 
other hand, can store several tables, along with queries, macros, 
and other database elements, all in a single file.

When Seagate Crystal Reports accesses a database file directly, it 
automatically retrieves information about all of the tables and 
fields in that file. You may not use all of the tables or fields, but the 
program will make them available to you. In other words, when a 
dBASE file is opened, only one table in the dBASE file is available. 
However, when an Access file is opened, every table in that file is 
available, even if you never use them all.

NOTE: Seagate Crystal Reports will also open queries in an Access

database through the DAO engine or ODBC and will allow you to

report on query fields, just like table fields. See DAO, Page 594,
and Access, Page 612.

Common
database
formats

Although Seagate Crystal Reports uses the same three-tiered 
system for obtaining data from all direct access database file 
formats, each format requires a different set of Dynamic Link 
Libraries (DLL). However, some formats expand the basic three-
tiered structure. The following sections cover the system used by 
Seagate Crystal Reports to access data from some of the most 
popular database formats.

dBASE, FoxPro, Clipper

The dBASE database format remains one of the most popular 
database management systems (DBMS) used in business. For that 
reason, Seagate Crystal Reports has been designed to open dBASE 
data simply and directly through the xBase engine (inside 
PDBXBSE.DLL). FoxPro and Clipper are dBASE compatible 
database formats, and Seagate Crystal Reports uses the same DLL 
to access files created by any of these three DBMS applications.
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NOTE: The PDBXBSE.DLL translation layer supports FoxPro files

up through version 2.5. See Visual FoxPro, Page 621.

The file PDBXBSE.DLL handles all translation between the 
Seagate Crystal Reports and the dBASE, FoxPro, or Clipper files. 
Each database file contains only a single database table, but there 
is no limit on the number of files that can be accessed by a report.

NOTE: dBASE data can also be accessed through the Borland

Database Engine (BDE) using the translation file PDBBDE.DLL. To

see how the BDE communicates with database data, see Paradox, 
Page 589. The BDE, however, does not support FoxPro or Clipper

data.

Paradox

Files created with Paradox (.DB) are made available to other 
applications through the Borland Database Engine (BDE). The 
BDE is made up of several files installed by Seagate Crystal 
Reports in the \IDAPI directory by default.

●   ILD01.DLL

●   IDDBAS01.DLL

Crystal Reports

PDBXBSE.DLL

dBASE
file

FoxPro
file

Clipper
file

Crystal Reports layer

Translation layer

Database layer
Data Sources 589



●   IDR10009.DLL

●   IDODBC01.DLL

●   IDASCI01.DLL

●   IDAPI01.DLL

●   IDBAT01.DLL

●   IDQRY01.DLL

The BDE does the actual work with the Paradox data, retrieving 
the requested tables and fields. Since the BDE works so closely 
with the actual data, it combines with the Paradox database file to 
create the database layer in the three layer data access model. 
Seagate Crystal Reports accesses the BDE through the 
PDBBDE.DLL translation file.

The 32-bit version of the BDE uses different files. Otherwise, 
Seagate Crystal Reports uses 32-bit Paradox files in the same way, 
accessing them through the P2BBDE.DLL 32-bit translation file.

Crystal Reports

Crystal Reports layer

Translation layer

Database layer

PDBBDE.DLL

Borland Database Engine
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The files that make up the 32-bit version of the BDE are:

●   BLW32.DLL

●   IDDR32.DLL

●   CEEUROPE.BLL

●   IDODBC32.DLL

●   CHARSET.BLL

●   IDPDX32.DLL

●   EUROPE.BLL

●   IDQBE32.DLL

●   IDAPI32.DLL

●   IDR20009.DLL

●   IDAPIINST.DLL

●   IDSQL32.DLL

●   IDASCI32.DLL

●   OTHER.BLL

●   IDBAT32.DLL

●   USA.BLL

●   IDDBAS32.DLL

●   CW3215.DLL

Microsoft Access

Microsoft Access provides several means for opening its database 
files. Each method has its advantages and disadvantages, and the 
technique that you should use can depend on how your data is set 
up. Below are descriptions of two techniques for opening Access 
data from Seagate Crystal Reports, through the Jet engine and 
through the DAO engine. The third technique uses Microsoft’s 
Open Database Connectivity (ODBC) standard, and is described 
in Access, Page 612.
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NOTE: You can maintain Access security when opening database

files using Seagate Crystal Reports by running SYSDB32.EXE and

select the Access SYSTM.MDW file. In this way, the program will

look to SYSTM.MDW when opening an Access database and the

user will be prompted for the Access password (as required) in

Seagate Crystal Reports

NOTE: When you open an Access database using the Jet or DAO

engine, opens the entire database and loads information about all

tables and queries from the database. To do this, Seagate Crystal

Reports must reserve a large section of your computer�s memory,

called a buffer, in advance. Computer memory restrictions limit

this buffer to 65,536 bytes (64K). On average, this restricts the

size of your Access database to about 80 tables (depending on the

number of fields in your tables).

JET

The Microsoft Jet Database Engine is the part of the Microsoft 
Access Database Management System that actually handles your 
database data. As a user, you usually do not work directly with 
the Jet engine. It acts as a gateway through which Access data is 
made available to applications. For this reason, the Jet engine 
must be used regardless of the overall method used to access your 
Access data. You will see the Jet engine in other sections that 
discuss Access data.

Since the Jet engine is so closely tied to Access data, Seagate 
Crystal Reports considers it a part of the actual database. In the 
following diagram, the files for the Jet engine appear in the 
database layer. Seagate Crystal Reports uses three files to translate 
information to and from the Jet engine:

1. PDBJET.DLL

2. PDIRJET.DLL

3. PDCTJET.DLL
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Reading Access data through the Jet engine is the most direct 
route, and, therefore, the fastest method, for reading the data. 
However, Jet does not allow you to read Access queries. If you 
need to open Access queries from Seagate Crystal Reports, you 
should use the DAO engine (DAO, Page 594) or ODBC (Access, 
Page 612).

NOTE: If you toggle the Use Indexes check box on using the

Database Tab of the File Options dialog box, Seagate Crystal

Reports can pass much of the data retrieval process, including

simple selection formulas, down to the Jet engine, improving

performance and speed. Search for File Options dialog box in
Seagate Crystal Reports online Help.

NOTE: Seagate Crystal Reports provides all necessary files for

reading Access tables through the Jet engine. For complete

information on necessary files, refer to the Runtime File

Requirements online Help (RUNTIME.HLP).

Access MDB

Crystal Reports layer

Data Translation Layer

Database layer

PDBJET.DLL PDIRJET.DLL PDCTJET.DLL

Crystal Reports

THE MICROSOFT JET ENGINE

MSAJT200.DLL MSABC110.DLL MSAJT112.DLL
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DAO

Microsoft’s new Data Access Object (DAO) Engine provides all of 
the functionality of the Jet engine but also adds many new data 
access features. DAO uses Microsoft’s Object Linking and 
Embedding (OLE) technology (installed with Windows 95 and 
Windows NT) to provide access to Access data through an object-
oriented approach.

In addition to Access database tables, Seagate Crystal Reports can 
open and use Access queries through DAO. If you are not familiar 
with Access queries, refer to your Access documentation. See How 
to open Access queries through DAO, Page 554.

NOTE: Access Parameter queries and cross-tab queries can only

be opened through an ODBC connection. See How to open Access 
parameter queries, Page 558. Access Action queries are not

supported by Seagate Crystal Reports.

NOTE: When opening Access queries in a report, make sure the

Views and Stored Procedures options are toggled on using the

SQL Tab of the File Options dialog box in Seagate Crystal Reports.

This ensures that the queries will be visible when you open the

Access database.

The DAO engine greatly broadens the possibilities available to 
Access database users. Because DAO expands and builds on the 
basic functionality of the Jet engine, primarily working with the 
actual Access database data, DAO is also considered part of the 
database layer. To translate information and data to and from 
DAO, Seagate Crystal Reports uses the DAO translation files 
P2BDAO.DLL, P2CTDAO.DLL, and P2IRDAO.DLL. Compare 
these files to the translation layer for accessing MS Access data 
directly through the Jet engine. See JET, Page 592.

NOTE: The Jet engine is incorporated into the DAO engine and

does not appear as a separate engine in the diagram below.
594 Seagate Crystal Reports User�s Guide



NOTE: Seagate Crystal Reports provides all necessary files for

reading Access data through the DAO engine. Because the

program supports the most recent version of DAO, there is also

native support for VSFoxPro (see Visual FoxPro, Page 621). For
complete information on necessary files, refer to the Runtime File

Requirements online Help (RUNTIME.HLP).

Secured Microsoft Access Databases

If you will be using secured Access databases, the SystemDB 
parameter in the Windows Registry database (32-bit systems) or 
CRW.INI (16-bit systems) must be set to point at the path where 
the SYSTEM.MDA or SYSTEM.MDW (Access 95) file is located. 
On Windows 95 and Windows NT systems, the SystemDB 
parameter is located in the following Registry key:

\\HKEY_LOCAL_MACHINE\Software\Crystal 
Software\Jet\3.0\Engines\Jet

Seagate Crystal Reports includes two utilities to take care of 
setting this parameter for you: 

1. SYSDB16.EXE (16-bit systems changes CRW.INI)

Crystal Reports

P2IRDAO.DLL P2CTDAO.DLL P2BDAO.DLL

OLE

DAO2532.TLB
DAO3032.DLL

VBAJET32.DLL
VEN2232.OLB

MSJINT32.DLL
MSJTER32.DLL
MJT3032.DLL
VBA232.DLL

MSRD2X32.DLL

DAO Engine

ACCESS DATA

Crystal Reports layer

Translation Layer

Database layer
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2. SYSDB32.EXE (32-bit systems changes Registry key)

These utilities are installed in the \CRW directory (or directory in 
which the program resides). Simply run the appropriate utility 
and point it at the location of the SYSTEM.MDA or 
SYSTEM.MDW file.

Btrieve

The 16-bit version of Seagate Crystal Reports uses two translation 
files to communicate with the 16-bit Btrieve engine:

1. PDBBTRV.DLL

2. PDCTBTRV.DLL

These files work with the Btrieve files WBTRVDEF.DLL, 
WBTRCALL.DLL, SBTRVDEF.DLL, and SEDTCONV.DLL for 
most data access operations.

The rest of the Btrieve engine is a complex collection of DLLs and 
EXEs that are specific to the version of Btrieve you are using. For 
complete information on different 16-bit Btrieve engine files, 

Crystal Reports

Database Layer

PDBBTRV.DLL PDCTBTRV.DLL

Btrieve Data

Crystal Reports layer

Translation layer

Database layer

WBTRCALL.DLL
WBTRVDEF.DLL
SEDTCONV.DLL
SBTRVDEF.DLL

Btrieve Engine
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search for Btrieve in Seagate Crystal Reports online Help, and refer 
to your Btrieve documentation.

NOTE: Btrieve must be configured correctly for Seagate Crystal

Reports to read Btrieve databases. If Btrieve is already configured

correctly on your system, Seagate Crystal Reports can use your

Btrieve data upon installation. Seagate Crystal Reports installs the

Btrieve files that it requires to read Btrieve data, but you should

refer to your Btrieve documentation to make sure the Btrieve

engine is configured correctly.

The 32-bit version of Seagate Crystal Reports connects to the 32-
bit Btrieve engine through a similar set of Btrieve translation files:

The primary difference between 32-bit Btrieve and 16-bit Btrieve 
is the Btrieve engine itself. For complete information on the 
Btrieve engine, refer to your Btrieve documentation.

NOTE: When you open a Btrieve database, Seagate Crystal

Reports opens the entire database and loads information about all

Crystal Reports

P2BBTRV.DLL      P2CTBTRV.DLL

Btrieve Engine

Btrieve Data

WBTRCALL.DLL
WBTRVD32.DLL
S2DTCONV.DLL
SBTRVD32.DLL
W32MKRC.DLL
WBTRV32.DLL
W32MKDE.DLL

Crystal Reports layer

Translation layer

Database layer
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tables from the database. To do this, Seagate Crystal Reports must

reserve a large section of your computer�s memory, called a

buffer, in advance. Computer memory restrictions limit this buffer

to 65,536 bytes (64K). On average, this restricts the size of your

Btrieve database to about 80 tables, depending on the number of

fields in each table.

Btrieve DDF files

Seagate Crystal Reports does not determine the definitions of 
Btrieve data files directly from the data files themselves. It needs 
a set of Btrieve Data Dictionary Files (.DDF) that contain file, field, 
and index information. Seagate Crystal Reports uses 
WBTRVDEF.DLL and SBTRVDEF.DLL to parse these DDF files. 
The following are the required DDFs which must all reside in the 
same directory:

●   FILE.DDF

●   FIELD.DDF

●   INDEX.DDF

A set of DDFs normally contain definitions for multiple Btrieve 
data files. Once any of the DDFs is selected when creating a new 
report, Seagate Crystal Reports immediately adds all the data files 
defined in the DDFs into the report. Seagate Crystal Reports also 
takes the path defined in the DDFs as the default path of the data 
files. The DDFs and data files can reside in different locations.

NOTE: Be sure to study your Btrieve documentation for more

information on Btrieve DDFs and configuring the Btrieve engine.

Exchange

Exchange is Microsoft’s successor to MS Mail. Exchange, 
however, includes not only e-mail, but also management of group 
scheduling, electronic forms, groupware, and Internet 
connectivity. An Exchange folder can contain standard notes 
(mail), files, and instances of Exchange forms. All of this data is 
stored in the Exchange Information Store.

Seagate Crystal Reports can report on data contained in the 
Exchange Information Store. Exchange data sources available for 
reporting include:
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●   Message Tracking Logs (32-bit only)

●   Address Lists

   Personal Address Books

   Global Address Lists

   Distribution Lists

●   Exchange Folder Contents

   mail messages

   Exchange Form applications

   properties of OLE documents

●   Exchange Administrator (32-bit only)

   properties of Exchange mailboxes on the Exchange 
Server

   properties of public folders on the Exchange Server

   replica list of public folders

   ACL (Access Control List) of public folders

Each Exchange data source can be used like a database table and 
can be linked to other data sources. For example, the Message 
Tracking Log may be joined to an Address List by using an e-mail 
address as the link field.
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The data translation file used to access the Exchange data source 
depends on what data source is being accessed. The following 
table lists each of the Exchange data translation files and describes 
their purpose:

NOTE: PDSMAPI.DLL works with 16-bit Seagate Crystal Reports

while P2SMAPI.DLL works with 32-bit Seagate Crystal Reports.

Also, PDSMAPI.DLL is the only Exchange driver available for 16-

bit Seagate Crystal Reports.

File name Data source

P2STRACK.DLL Message Tracking Logs (32-bit only)

P2SMAPI.DLL / 
PDSMAPI.DLL

Exchange Folder Contents and 
Address Lists

P2SEXR.DLL Properties of Exchange Mailboxes and
Public Folders (32-bit only)

P2SREPL.DLL Replica Lists of Public Folders 
(32-bit only)

P2SACL.DLL Access Control Lists (ACL) of Public 
Folders (32-bit only)

Crystal Reports

Exchange Data Source

Crystal Reports layer

Translation layer

Database layer

MAPI

P2STRACK.DLL
P2SREPL.DLL

Exchange Data Translation

P2MAPI.DLL
P2SEXR.DLL

P2MACL.DLL
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Exchange translation files work directly with the Microsoft 
Messaging API (MAPI). MAPI acts as a database engine for 
Exchange data.

ACT!

Symantec’s ACT! contact management software stores 
information in a relational database format similar to the xBase 
format. See dBASE, FoxPro, Clipper, Page 588. Seagate Crystal 
Reports can read this data and let you produce reports based on 
your contact information.

You open ACT! data by selecting the CRW.ACT file from Seagate 
Crystal Reports when you create a new report. CRW.ACT must be 
installed in the same directory as the program. This file forces 
Seagate Crystal Reports to load the PDBACT.DLL and 
PDCTACT.DLL translation files. This step is important, because 
ACT! data looks like xBase data to Seagate Crystal Reports, so it 
will use the PDBXBSE.DLL translation file unless instructed 
otherwise. If this happens, the data will be translated as xBase 
data rather than ACT! data, and may not appear correctly in your 
report. See How to use an ACT! database, Page 579.

Crystal Reports

CRW.ACT

Database Layer

PDBACT.DLL PDIRACT.DLL

ACT! Database

Crystal Reports layer

Translation layer

Database layer
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Oracle 7

This version of Seagate Crystal Reports supports direct access of 
Oracle 7 SQL databases. This accessibility is provided by the 
PDSORA7.DLL translation file (installed with the program). This 
file can communicate directly with the Oracle 7 database driver 
ORA72WIN.DLL, which works directly with Oracle databases 
and clients, retrieving the data you need for your report.

NOTE: The Oracle client software must be installed on your

system, and the location of the ORA72WIN.DLL file must be in

the PATH statement of your AUTOEXEC.BAT file.

Microsoft SQL Server 6.x

Databases created by Microsoft’s SQL Server, versions 6.0 and 6.5, 
can be read directly from Seagate Crystal Reports. The 
PDSSQL.DLL file installed with the program translates requests 
to the SQL server and returns data from the SQL server. It 
communicates directly with the Microsoft SQL Server driver 
MSDBLIB.DLL.

Crystal Reports

Oracle Data

Crystal Reports layer

Translation layer

Database layer

PDSORA7.DLL

ORA72WIN.DLL
and Oracle client
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NOTE: Network administrators and IS managers who run

Microsoft�s Systems Management Server for BackOffice can run

reports off of Systems Management Server data. Systems

Management Server uses SQL Server to store system data, so the

files used to access that data are the same files shown here for

SQL Server.

Sybase System 10/11

Seagate Crystal Reports opens SQL data created by Sybase System 
10 or System 11 directly through the PDSSYB10.DLL, installed 
with Seagate Crystal Reports. This translation file works with the 
Sybase database drivers WCTLIB.DLL and WCSLIB.DLL to read 
Sybase System 10/11 data. If your Sybase server is correctly 
configured, you will be able to read Sybase data as soon as Seagate 
Crystal Reports is installed.

NOTE: The 32-bit Sybase drivers are LIBCT.DLL and LIBCS.DLL.

Crystal Reports

SQL Database

Crystal Reports layer

Translation layer

Database layer

PDSSQL.DLL

MSDBLIB.DLL
(SQL Server driver)
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Arbor Essbase

Essbase is a highly powerful database format designed on the 
OLAP (On-Line Analytical Processing) model. OLAP presents 
data in dimensions, rather than tables. Users can look at 
relationships between data on an as-needed basis, drilling-down 
on dimensions to find exactly the data they need in a matter of 
seconds.

Seagate Crystal Reports opens Essbase data directly through the 
P2OESBSE.DLL translation file. This file works with the complex 
engine that drives Essbase. The power of OLAP is combined with 
the power of Seagate Crystal Reports to produce the most 
informative and comprehensive reports.

Sybase Database

Crystal Reports layer

Data Translation Layer

Database layer

PDSSYB10.DLL

Crystal Reports

WCTLIB.DLL
WCSUB.DLL
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NOTE: Essbase data can only be accessed from the 32-bit version

of Seagate Crystal Reports.

NT Event Log

If using Windows NT version 3.51 or later, you can use Seagate 
Crystal Reports to report on the NT Event Log. The Event Log is a 
database used by network administrators to record and keep track 
of different types of events that can occur on a Windows NT 
Workstation or a Windows NT server.

Seagate Crystal Reports provides the translation file P2SEVT.DLL 
for working with NT Event Log data. This file communicates with 
the Event Logging API in ADVAPI32.DLL, a part of the Windows 
NT operating system.

Crystal Reports

ESSAPIN.DLL
ESSBASE.MDB
ESSNET.DLL

Essbase Data

Crystal Reports layer

Translation layer

Database layer

Essbase drivers
ESSOTLN.DLL
ESSOTLS.MDB
ESSSHR.DLL

SH22W32.DLL

P20ESBSE.DLL
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NOTE: The NT Event Log can only be reported on with the 32-bit

version of Seagate Crystal Reports.

ODBC data sources

Open Database Connectivity (ODBC) is a standard developed by 
the Microsoft Corporation through which many different types of 
data can be accessed by a single application. An application need 
only communicate with one set of files, ODBC, to instantly be able 
to work with any source of data that can be accessed by ODBC.

There are hundreds of Database Management Systems (DBMS) 
available for personal computers, and thousands of applications 
that access DBMS data. Normally, a company that designs an 
application that accesses data, such as Seagate Crystal Reports, 
must develop a means for the application to communicate with 
each type of data that a customer might want to use. Seagate 
Crystal Reports does this with the databases that it can access 
directly.

Crystal Reports

NT Event Log

Crystal Reports layer

Translation layer

Database layer

P2SEVT.DLL

ADVAPI32.DLL
NT Event Logging API
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On the other hand, if a DBMS simply provides a means by which 
ODBC can access its data, the DBMS data becomes an ODBC data 
source. Any application, such as Seagate Crystal Reports, can 
communicate with ODBC, and instantly have access to any ODBC 
data source. With ODBC drivers available for most common 
DBMS products, the possible types of data that Seagate Crystal 
Reports can use is almost unlimited.

Advantages Perhaps the biggest advantage to accessing data through ODBC is 
the ability to access a wide range of data with just one interface. 
Since most popular Database Management Systems now offer 
ODBC drivers, with more appearing every day, Seagate Crystal 
Reports can use any type of data you have.

Because of the extreme flexibility built into ODBC as well, you can 
use the same report file with different ODBC data sources. For 
example, you might design a report using an Oracle data source, 
then, later, if your company switches to Microsoft SQL Server, you 
can simply change the ODBC data source used by your report. 
The only requirement is that the new data source must have the 
same structure (tables and fields) that the original data source had 
(although table names can be different). See How to change the 
ODBC data source accessed by a report, Page 570.

Experienced SQL (Structured Query Language) programmers 
also benefit from the ODBC standard. Since Seagate Crystal 
Reports uses SQL to communicate with ODBC, SQL programmers 
and Database Administrators can view and edit the SQL 
statement that is sent to ODBC, controlling exactly how data is 
retrieved from the data source.

Finally, by using SQL pass-through technology to send an SQL 
statement to ODBC and retrieve an initial set of data, Seagate 
Crystal Reports off-loads much of the data retrieval and sorting 
work onto the server system, freeing up local memory and 
resources for your more important tasks. In addition, only the 
data specified by the SQL statement is returned to Seagate Crystal 
Reports, reducing network traffic and the use of network 
resources. By working more efficiently with the original data, 
Seagate Crystal Reports saves you time and effort and lets you 
concentrate on the design process and your more important work.
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Disadvantages Because of the many layers involved in passing data through 
ODBC from a database to an application, ODBC data sources can 
often take more time to return data. First, Seagate Crystal Reports 
must request some data. The request must be translated by the 
ODBC translation layer to a format that ODBC understands (an 
SQL statement). ODBC must determine where the requested data 
exists, and pass the request on to the ODBC data source; see 
DBMS Translation (ODBC data source) Layer, Page 611. The data 
source must analyze the request and translate it again into a 
format that can be understood by the DBMS. This complex 
process not only takes time, it can fail at any of several possible 
levels.

In addition, ODBC data sources must be configured and correctly 
set up in the ODBC.INI and ODBCINST.INI files before they can 
be used. If you create a report on one system and try to open it on 
another system that does not have the same ODBC data source set 
up, Seagate Crystal Reports will not be able to connect to the data.

When working with ODBC, you should also be aware that the 
SQL language used by ODBC is based on the standards set for the 
SQL language by the American National Standards Institute 
(ANSI). Some SQL-based DBMS applications, however, provide 
additional features to the SQL language that are specific to that 
DBMS. If your data uses features unique to your DBMS, ODBC 
will not be able to translate those features (though in many cases 
it will still retrieve most of the data). See The SQL language, Page 
551.

Five layers The process by which Seagate Crystal Reports accesses data from 
an ODBC data source consists of five layers:

1. Seagate Crystal Reports Layer, Page 609

2. ODBC Translation Layer, Page 610

3. ODBC Layer, Page 610

4. DBMS Translation (ODBC data source) Layer, Page 611

5. The Database Layer, Page 612
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By using the Structured Query Language (SQL) to communicate, 
all five layers can conveniently pass data from the database to 
your report.

Seagate Crystal Reports Layer

When working with ODBC data, Seagate Crystal Reports 
generates an SQL statement that requests the appropriate data 
from ODBC. The powerful SQL generator built into Seagate 
Crystal Reports is designed to create an SQL statement that will let 
the ODBC data source or ODBC itself do as much of the report 
generation as possible, returning only the data needed to produce 
the report. This SQL statement can be viewed and fine-tuned by 
anyone familiar with the SQL language. See How to edit an SQL 
query, Page 578.

Database layer

DBMS Translation layer

ODBC

ODBC Translation layer

Crystal Reports layer
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ODBC Translation Layer

Seagate Crystal Reports uses the Dynamic Link Library 
PDSODBC.DLL to communicate with ODBC. This file is unique to 
the Seagate Crystal Reports environment and provides your 
report with access to any ODBC data source. This is the driver that 
actually passes data to and from ODBC.

ODBC Layer

ODBC is a set of several DLLs and INI files built into the Windows 
environment that act as a gateway through which database 
requests and data can pass. Any database file or format that is to 
be used via ODBC must be set up as an ODBC data source.

In 16-bit Windows (Windows 3.x), the primary Dynamic Link 
Libraries that make up ODBC are:

●   ODBC.DLL, and

●   ODBCINST.DLL.

Information about an ODBC data source is stored in:

●   ODBC.INI, and

●   ODBCINST.INI.

ODBC uses these files to get and use information about the data 
source.

In 32-bit Windows (Windows 95 and Windows NT), the ODBC 
DLLs are:

●   ODBC32.DLL (32-bit version of ODBC.DLL),

●   ODBCCP32.DLL (32-bit version of ODBCINST.DLL), and

●   ODBCINT.DLL (ODBC 2.5 and later).

Although information regarding data sources is still recorded in 
ODBC.INI and ODBCINST.INI, 32-bit ODBC uses the Windows 
Registry database to retrieve information about individual data 
sources.

NOTE: For complete information on ODBC and the ODBC files,

see the Microsoft ODBC documentation.
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ODBC uses the SQL language for all transactions between Seagate 
Crystal Reports and ODBC. Even if the database does not 
normally use SQL to create and work with tables, the ODBC 
driver provided by the database (the DBMS translation layer) 
must communicate with ODBC using SQL. For most users, this 
feature of ODBC is transparent, but some more advanced users 
often take advantage of the features of the SQL language used by 
ODBC.

DBMS Translation (ODBC data source) Layer

This layer consists of one or more drivers provided by a DBMS 
that allow ODBC to communicate with the database. Seagate 
Crystal Reports ships with several ODBC drivers for many of the 
most common database formats. If you are unsure whether or not 
you can use an ODBC driver to access the data in your database, 
refer to the documentation for your DBMS application. Most 
DBMS applications that run on a Windows-based platform offer 
an ODBC driver.

When a DBMS provides an ODBC driver, it must register the 
driver with ODBC on the machine it has been installed on. It does 
this by assigning a name to the driver and recording the filename 
in the ODBCINST.INI file. Usually, this step is handled 
automatically when the DBMS application is installed on the 
system. However, your network system or DBMS application 
may require that you register the ODBC driver manually using 
the ODBC Setup application. For complete information on 
registering an ODBC driver with ODBC, refer to the 
documentation for your DBMS.

Once an ODBC driver is registered, you need to establish an 
ODBC data source using that driver. The ODBC data source is the 
object that you connect to when accessing data from Seagate 
Crystal Reports through ODBC. Data sources are recorded in the 
ODBC.INI file. The data source keeps track of the DBMS 
translation files (ODBC drivers) and, sometimes, the database 
itself. An ODBC data source can specify just a database format, 
such as Oracle, Gupta, Sybase SQL, or MS SQL Server. Some 
users, however, prefer to actually specify a certain database. In 
this case, the ODBC data source extends across both the DBMS 
translation layer, and the database layer.
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If you are using a client/server database, such as an SQL server, 
the ODBC drivers communicate with the database server through 
the Database Communication Layer, the same layer that your 
database client uses to communicate with the database server.

NOTE: ODBC drivers find their specific DBMS client files on the

local machine mainly through key directories that the DBMS

client has installed in the search path (specified in

AUTOEXEC.BAT). The important thing is that a workstation client

on a local PC must be able to connect to its server successfully. If

you are not sure how to verify this, contact your IS manager.

For Seagate Crystal Reports and the ODBC drivers, it does not 
matter what kind of a platform your database server exists on. It 
is the DBMS client that connects and communicates with the 
server; Seagate Crystal Reports and the drivers need only 
communicate with the DBMS client. See Using SQL and SQL 
databases, Page 545.

The Database Layer

The database file referred to by the ODBC data source can be 
located anywhere on a system. Once the ODBC data source is set 
up, Seagate Crystal Reports does not need to know the actual 
location and format of the data. Thus, the database can have any 
format and be located anywhere on a network, as long as ODBC 
can communicate with it through the ODBC data source.

Common
ODBC

database

formats

Access

Although Microsoft Access files can be opened directly by Seagate 
Crystal Reports (see Microsoft Access, Page 591), you may wish to 
use ODBC for these files instead. When communicating with 
Access databases, ODBC uses a translation file that communicates 
with the Microsoft Jet Database Engine. The Jet Database Engine 
is an example of a DBMS specific ODBC driver.

The Jet engine is a part of the Access DBMS that does all of the 
actual work with an Access database. Jet is a required component 
for working with Access data. Since the Jet engine is an integral 
part of all Access databases, it is shown here as a part of the 
database layer.
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NOTE: The diagram shown here illustrates the files required by

Seagate Crystal Reports to work with databases designed using the

16-bit version of Microsoft Access 2.0. If you are using a different

version of Access, refer to the Runtime File Requirements online

Help (RUNTIME.HLP) for information on specific files required to

open your Access data.

Excel

Microsoft Excel spreadsheets can be converted into databases that 
can be read by Seagate Crystal Reports through ODBC. In Excel 
4.0 and earlier, use the Set Database command on the Data menu. 
In Excel 5.0 and later, use the Define command on the Insert 
menu|Name. Once converted, spreadsheet rows become records, 
and spreadsheet columns become fields. (For more information 
on converting your spreadsheets to database format, refer to your 
Excel documentation.) Once the spreadsheet is converted, you can 
set up an ODBC data source for the file, then select it from Seagate 
Crystal Reports.

Access 2.0
Database

Crystal Reports layer

ODBC
Translation

Layer

Crystal Reports

ODBC

DBMS
Translation

Layer

Database
Layer

ODBC.DLL
ODBCINST.DLL

ODBC

PSDODBC.DLL

ODBCJT16.DLL

MSAJT200.DLL
MSABC200.DLL

Jet Engine
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NOTE: If you are using Excel 7.0 or later, you can export your

spreadsheets as Access database tables, and read them from

Seagate Crystal Reports as you would read other Access tables.

Refer to your Excel documentation for more information.

Excel databases for 16-bit Windows environments are read 
through the CRXLS07.DLL translation file, for version 4.0 and 
earlier of Excel, or through the CRXLS507.DLL for version 5 of 
Excel. 

These drivers are installed by Seagate Crystal Reports. ODBC can 
communicate with this driver to read the converted Excel 
spreadsheet.

If you are using a 32-bit Windows system, you can set up an 
ODBC data source for 32-bit Excel spreadsheets using the 32-bit 
DAO engine. The DAO engine is installed on your system when 
you install the 32-bit version of Seagate Crystal Reports. You 
must, however, set up an ODBC data source manually for your 
Excel spreadsheet. See How to set up an ODBC data source, Page 562.

Crystal Reports

ODBC

Excel
Spreadsheet

CRXLS07.DLL or
CRXLS507.DLL

Crystal Reports layer

ODBC
Translation

layer

ODBCODBC.DLL
ODBCINST.DLL

PDSODBC.DLL

DBMS
Translation

layer

Database
layer
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INFORMIX

Seagate Crystal Reports accesses INFORMIX databases through 
ODBC. The INFORMIX client, called INFORMIX-NET, must be 
installed on your machine. Seagate Crystal Reports provides the 
necessary driver that ODBC uses to communicate with the 
INFORMIX database engine.

Crystal Reports

Excel
Spreadsheet

Crystal Reports layer

ODBC
Translation

layer

ODBC

ODEXL32.DLL

ODBC32.DLL
ODBCINT.DLL

ODBCCP32.DLL

DBMS
Translation

layer

Database
layer32-bit DAO Engine

ODBC

P29ODBC.DLL
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NOTE: The 32-bit version of Seagate Crystal Reports provides the

32-bit ODBC driver CRINF509.DLL for reading 32-bit INFORMIX

data.

SQL Databases through INTERSOLV DataDirect

There are many different SQL Database Management Systems 
available on the market, and most of them can be accessed 
through ODBC. Seagate Crystal Reports automatically installs 
and sets up several ODBC data sources allowing you to access 
many of the most popular SQL databases, including:

●   Oracle

●   Sybase SQL Server

●   MS SQL Server

●   Gupta SQLBase

●   Scalable SQL

●   DB2/2

●   ASCII Text

Crystal Reports

INFORMIX Database

Crystal Reports layer

Translation layer

Database layer

INFORMIX-NET

CRINF507.DLL

ODBC
ODBC,DLL

ODBCINST.DLL

PDSODBC.DLL

ODBC

DBMS Translation layer
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NOTE: ASCII Text is not really an SQL database format, but text

files can be read by Seagate Crystal Reports program using ODBC

in the same way that many SQL databases are.

Seagate Crystal Reports provides the INTERSOLV DataDirect 
ODBC drivers for these SQL database formats. Not all SQL 
databases are accessed through these drivers, but, as a 
convenience, the program automatically sets up these drivers for 
you it is when installed. Seagate Crystal Reports still 
communicates with ODBC using the PDSODBC.DLL translation 
file, but the DataDirect drivers provide ODBC with easy access to 
the actual databases.

NOTE: If you are using an SQL database not accessed by the

INTERSOLV drivers, refer to your DBMS documentation for

complete information on the ODBC drivers required.

Do not confuse SQL databases with the SQL language. Structured 
Query Language (SQL) is a specialized computer language used 
to design, build, and read database files. See Using SQL and SQL 
databases, Page 545.

SQL databases are any collection of computer applications that 
depend on the SQL language for database creation and 
manipulation. SQL DBMS applications are usually designed to 
run as large client/server applications spread across a network.

To open an SQL database, ODBC uses a set of four DataDirect 
ODBC support drivers (these are the same for every SQL database 
format), a DataDirect ODBC driver specific to the database 
format, and the Database Communication Layer that actually 
communicates directly to the database file. The files provided for 
this DBMS translation layer are all INTERSOLV DataDirect 
drivers.

NOTE: ODBC does not have to use the INTERSOLV DataDirect

drivers to access the SQL databases shown here. Most SQL DBMS

applications provide their own ODBC drivers. However, Seagate

Crystal Reports sets up the INTERSOLV drivers for you

automatically.
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NOTE: The 32-bit version of Seagate Crystal Reports provides 32-

bit INTERSOLV drivers for accessing SQL databases. These 32-bit

drivers are named CR*09.DLL instead of CR*07.DLL.

As mentioned previously, Seagate Crystal Reports automatically 
creates several ODBC data sources for the SQL database formats 
supported by INTERSOLV DataDirect. 

These data sources appear in the Log On Server dialog box:

●   ODBC-CRDBM supports DB2/2

●   ODBC-CRGUP supports Gupta

●   ODBC-CROR7 supports Oracle 7

●   ODBC-CRORA supports Oracle 6

Database Communication layer

MS SQL
Server

Sybase Gupta DB2/2 Oracle Other databases
that use an ODBC
back-end driver.

INTERSOLV DataDirect Supporting ODBC Drivers
(DataDirect requires you to use all 4 of these)

CRBA507.DLL   CRFLT07.DLL
CRUTL07.DLL   CRMDS07.DLL

CRGUP07.DLL
CRORA07.DLL
CROR707.DLL
CRTXT07.DLL
CRSS07.DLL
CRXQL07.DLL
CRDB207.DLL
CRSYB07.DLL

INTERSOLV DataDirect ODBC Drivers

(For Gupta)
(Oracle 6)
(Oracle 7)
(Text/ASCII Files)
(SQL Server/Sybase SQL)
(Scalable SQL)
(DB2/2)
(Sybase System 10)

Back-End
Drivers.
Choose one of
these drivers as
per your database.
This layer can
be replaced by
other back-end
ODBC Drivers
if desired.

ODBC.DLL   ODBCINST.DLL

Microsoft ODBC API

Crystal Reports

PDSODBC.DLL Front-End Driver
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●   ODBC-CRSS supports MS SQL Server and Sybase SQL 
Server

●   ODBC-CRXQL supports Scalable SQL

●   ODBC-CRSYB supports Sybase System 10

INTERSOLV DataDirect Library

Instead of communicating directly with ODBC through the 
PDSODBC.DLL file, Seagate Crystal Reports can use the 
INTERSOLV DataDirect Library that ships with Seagate Crystal 
Reports. These front-end drivers use the ODBC standard as an 
underlying layer. However, instead of using PDSODBC.DLL to 
communicate with ODBC, Seagate Crystal Reports uses a specific 
PDS*.DLL file appropriate to the SQL database being accessed.

DataDirect Library vs. ODBC

The strength of the DataDirect Library over ODBC direct is 
mainly in its ability to pass proprietary SQL syntax to specific 
servers. For example, because Oracle has its own PDS driver, an 
SQL developer working with Oracle data is able to pass, at times, 
more precise SQL statements to the server. This way, SQL 
language features unique to a particular DBMS can be passed 
from Seagate Crystal Reports. When using ODBC direct, the 
PDSODBC.DLL is a common DLL that is used for all DBMS types, 
and proprietary SQL syntax based on specific servers may not be 
entirely possible.

DataDirect Library structure

With the INTERSOLV DataDirect Library, Seagate Crystal 
Reports uses an ODBC translator specific to the SQL database 
format being accessed. This file, in turn, communicates with the 
DataDirect Library. The DataDirect Library makes the final 
translation of the SQL statement to ODBC.
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NOTE: The 32-bit version of Seagate Crystal Reports provides 32-

bit INTERSOLV drivers for accessing SQL databases. These 32-bit

drivers are named CR*09.DLL instead of CR*07.DLL.

Database Communication layer

MS SQL
Server

Sybase Gupta DB2/2 Oracle Other databases
that use an ODBC
back-end driver.

INTERSOLV DataDirect Supporting ODBC Drivers

CRBA507.DLL   CRFLT07.DLL
CRUTL07.DLL   CRMDS07.DLL

CRGUP07.DLL
CRORA07.DLL
CROR707.DLL
CRTXT07.DLL
CRSS07.DLL
CRXQL07.DLL
CRDB207.DLL
CRSYB07.DLL

INTERSOLV DataDirect ODBC Drivers

(For Gupta)
(Oracle 6)
(Oracle 7)
(Text/ASCII Files)
(SQL Server/Sybase SQL)
(Scalable SQL)
(DB2/2)
(Sybase System 10)

Back-End
Drivers.
Choose one of
these drivers as
per your database.
This layer can
be replaced by
other back-end
ODBC Drivers
if desired.

ODBC.DLL   ODBCINST.DLL

Microsoft ODBC API

Front-End Driver

Crystal Reports

PDSORACL.DLL PDSGUPTA.SDLL PDSNETW.DLL PDSDB22.DLL PDSSYBAS.DLL

INTERSOLV Datadirect Library

CRLIB.DLL
CRGUI07.DLL  CRUTL07.DLL  CRFLT07.DLL  CRSQL07.DLL  CRMDS07.DLL  CRBAS07.DLL
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INTERSOLV DataDirect Library databases

●   Oracle

●   Sybase SQL Server

●   MS SQL Server

●   Gupta SQLBase

●   Scalable SQL

●   DB2/2

NOTE: The ODBC data sources that Seagate Crystal Reports

installs for the INTERSOLV DataDirect Library appear in the Log

On Server dialog box without the �ODBC-� prefix used by the

data sources that go through ODBC direct.

Visual FoxPro

Microsoft Visual FoxPro data is accessed through ODBC, whereas 
FoxPro data from version 2.5 and earlier is accessed directly 
through the xBase engine. If you are using FoxPro version 2.5 or 
earlier, see dBASE, FoxPro, Clipper, Page 588.

Seagate Crystal Reports provides the ODBC driver 
VFPODBC.DLL to allow ODBC to work with Visual FoxPro data.

Visual FoxPro
Database

Crystal Reports layer

Database layer

Crystal Reports

ODBC.DLL
OBDCINST.DLL

VFPODBC.DLL

ODBC

PDSODBC.DLL ODBC
Translation layer

ODBC

DBMS
Translation

layer
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NOTE: Because the program supports the latest version of DAO,

there is native support for VSFoxPro 5.0 (see DAO, Page 594).

Lotus Notes

A Lotus Notes database can be read by Seagate Crystal Reports 
through ODBC. The Lotus Notes DBMS translation layer consists 
of three files:

1. NOTESSQL.DLL

2. NSQLODBC.DLL

3. NSQLCFG.DLL

These files use the drivers installed by the Lotus Notes 
Workstation to work with the Lotus Notes database. The 
Workstation component of Lotus Notes must be installed on the 
local machine.

Lotus Notes Database

Crystal Reports

NOTESSQL.DLL
NSQLODBC.DLL
NSQLCFG.DLL

Crystal Reports layer

Translation layer

Database layer

Lotus Notes Workstation

ODBC
ODBC.DLL

ODBCINST.DLL

PDSODBC.DLL

ODBC

DBMS Translation layer
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Crystal Query Designer files

A query is simply a request for a specific set of data from a 
database. Once the data is gathered, it can be stored as a Crystal 
Query Designer file (.QRY). The Crystal Query Designer file can 
then be used much like a database table. The data it gathers from 
your SQL databases becomes a new data set that can be added to 
reports.

A Crystal Query Designer file gathers data from ODBC data 
sources, such as SQL servers, by means of SQL (Structured Query 
Language). An SQL statement with instructions to gather and 
return a specific set of data is sent directly to the SQL DBMS. The 
DBMS handles all of the actual data gathering, sorting, and 
grouping according to the instructions in the SQL statement. Only 
the final set of data is returned to the Query Designer and stored 
as a query file.

NOTE: If you are not familiar with SQL, see SQL join types (ODBC 
data sources), Page 537.

First, you refine an SQL statement and create a query file that 
contains only the data you need. Then, you design your reports 
based on the query file instead of the original databases. Most of 
the data gathering process is done on the SQL server when you 
design the query. When you design your report, Seagate Crystal 
Reports needs only work with a small set of data, saving you time 
and trouble. See How to create a new query, Page 472.

Crystal Reports
Query file
collects data
and stores as
new data set.

ODBC
Data Source
(SQL Server)

Crystal Reports
uses data stored
in query file.Crystal

query
file

Query
data
set
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Advantages While there are many reasons for using queries, the primary 
reason is the ability to off-load most of the data retrieval process 
to a server and store the resulting data as a separate data set. 
Using this SQL pass-through technique, where data retrieval tasks 
are passed through to the server, you retrieve your data faster and 
more efficiently. Anytime you are working with SQL data, you 
should consider building a query file before designing your 
report.

In addition, the Query Expert provides for more control over your 
data with the SQL language. Seagate Crystal Reports provides 
some SQL language features when accessing SQL or ODBC data, 
but the Query Expert is a powerful query tool that provides more 
powerful SQL data access features. The Query Expert allows 
aggregate functions in an SQL statement and supports all data 
query elements of the SQL language. If you know the SQL 
language, you can perform complex SQL tasks using UNION 
operations and sub-queries. See The SQL language, Page 551.

Disadvantages Since a query represents a complete data set, any records, fields, 
or tables that were not included when the query was created are 
not available when using the query to build a report. A report can 
not be any more complex than the data it accesses, so by using a 
query, you limit your reporting options to the data in the query.

In addition, a query can not be used with any other source of data. 
If you decide to use a query in your report, you can not select an 
additional source of data, such as a database table or another 
query file, to use in the report.

Crystal Dictionary files

A dictionary (.DC5) file is a structured and simplified view of 
organizational data that you can create for some or all of the 
individuals in your organization that are using Seagate Crystal 
Reports. With a dictionary, end users only see the subset of tables 
and fields they need.

NOTE: The application for creating dictionaries is only available

with the Professional edition of Seagate Crystal Reports. This

application is designed for IS and DatabaseManagers who need to
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provide alternatives to accessing data for users. Both the Standard

and Professional editions of Seagate Crystal Reports can open and

use dictionary files.

A dictionary is an optional source of data for Seagate Crystal 
Reports. It provides a convenient filter, clarifying and simplifying 
complex data access techniques for end users, but data can still be 
accessed directly from the database by the user. Dictionaries 
simply provide all the convenience without enforcing restrictions.

If you choose to use a dictionary to design a report, however, you 
can only use that dictionary as a source of data for that report. In 
other words, you can not open both a dictionary and an ODBC 
data source, a direct access database, or any other source of data 
from within the same report. This includes other dictionaries. The 
purpose of a dictionary is to provide fast, easy to understand 
access to a particular set of data. Connecting to other sources of 
data within the same report would defeat this purpose. See How 
to create a new dictionary, Page 493.

Dictionaries let you:

●   design a single, dynamic view of all the data that is 
necessary to create organizational reports and queries,

●   create a dictionary that contains multiple data sources, 
tables, and links,

●   organize the data and rename tables and fields to make it 
easier for users to understand the content and purpose of 
the data, and

●   create complex data-manipulation formulas that users can 
access without the need to understand formula concepts.

Dictionaries reduce support cost and time, increase user 
productivity, and reduce data misuse, loss, and damage.

Once created, the dictionary acts as a filter, providing a view of 
complex data that is clear and easy for any user to understand. 
Complicated data will not stop end users from creating powerful 
reports.
Data Sources 625



Seagate Crystal Reports reads the dictionary file using the 
PDIXBSE.DLL file (P2IXBSE.DLL for 32-bit). This translation file 
is based on the xBase engine used to access dBASE, FoxPro, Clipper, 
Page 588, databases, but provides all the flexibility needed to read 
dictionaries.

NOTE: If you upgraded from an earlier version of Seagate Crystal

Reports that allowed dictionary files, the older dictionary files

(.DCT) were based on the Btrieve engine. If you convert those

older files to new dictionary files, the new files will use the xBase

translation layer instead of Btrieve. However, the Btrieve engine

installed by the earlier version of Seagate Crystal Reports must

remain on your system for the new dictionary application to read

the older dictionary files.

The Database Access Layer is the layer through which the 
dictionary file actually reads the original database data. 
Dictionaries must read database data through the same routes 
that Seagate Crystal Reports reads the data. The section on direct 
access database layers and ODBC data sources that are described 
throughout this chapter illustrate the files needed for dictionaries 
to open data.

The benefit of dictionaries is that this Database Access Layer is 
completely transparent to the user. The dictionary displays a view 
of data in Seagate Crystal Reports that may or may not match the 

PDIXBSE.DLL (16 bit) or
P2IXBSE (32 bit)

Crystal Reports

Dictionary

Database Access Layer
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actual data, but displays a view that is easily accessible and usable 
by users.

Finally, dictionaries provide an easy means of changing the 
original data accessed without changing the view of data seen by 
users. For example, your original database may contain Price, 
Quantity, and Cost fields, but you decide that Cost can be 
calculated from Price and Quantity, so you eliminate the Cost 
field. By simply updating the dictionary to calculate Cost instead 
of getting it directly from the database, your users never know the 
difference. This also helps when the entire underlying database 
format is changed. Once again, just update the dictionary.

Dictionary files are often created by an IS manager who controls a 
company database. The IS manager can work with data that is 
organized and classified to create simple, easy dictionaries for 
company employees. The employees will find only the data they 
need in each dictionary file, because the original data has been 
manipulated or customized by the IS manager for varying usage.
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A Report Processing Model

What you will find in this appendix...

Multi-pass reporting, Page 630

What is a “pass”?, Page 630

Pre-pass #1, Page 630

Pass #1, Page 630

Top/bottom N and group sorting, Page 631

Pass #2, Page 631
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Multi-pass reporting

What is a

�pass�?

A pass is a process that Seagate Crystal Reports uses each time the 
data is “read” and manipulated. Therefore, if a report reads and 
manipulates the data twice, it is considered to be a two-pass 
report. This feature is one that is very powerful in the data access 
and reporting industry because it allows for complex reporting 
and formula manipulation. Therefore, percent of subtotal 
calculations are possible due to the two-pass reporting 
capabilities of Seagate Crystal Reports. Some reports can be one-
pass, yet in most cases two-passes will be issued. The following 
section offers a brief overview of the two-pass reporting concept. 
Following the written description is a visual representation of this 
process.

Pre-pass #1 When previewing a report, the first elements to be evaluated are 
“flat” formulas. Flat formulas are those that do not contain 
database fields. For example, 100* 30 would be a flat formula. Flat 
formulas are evaluated at the beginning of the print preview 
process and are never evaluated again. This process is known as 
“BeforeReadingRecords”. If you were to place a flat formula field 
(i.e., 100*30) in the Details section, the result would be 3000 for 
each record displayed.

Pass #1 Once the “BeforeReadingRecords” process has taken place, 
Seagate Crystal Reports will begin reading the database records. 
During the record reading process the following will occur:

1. Record Retrieval.

2. Evaluate “recurring” formulas. These formulas are those that 
contain database fields but do not contain references to 
subtotals or summary information that would require data 
manipulation in the second pass. This evaluation time is 
known as “WhileReadingRecords”.

3. Apply the record selection criteria. If the selection criteria is 
based on a database field that is indexed (i.e., 
{company.LASTNAME} = “SMITH”), then Seagate Crystal 
Reports rejects records not equal to SMITH immediately after 
evaluating the recurring formulas. The reason for this is that 
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the selection criteria may include recurring formulas. 
(i.e., {table.FIELD} = {@Formula}).

4. Totalling. A typical report usually contains groups, sorts, and 
subtotals and Seagate Crystal Reports tries to process as many 
of these in the first pass as possible. As the records are 
processed they are divided into groups based on the group 
field specified in the report. Each of these groups is sent to an 
internal “totaler”. This counting mechanism stores a subtotal 
of each group, in memory, which is then used later in the 
report process.

5. Store the saved records. After the totalling process is 
complete, all of the records and totals are stored into a “saved 
records” object. This object stores data in memory and on disk 
in the form of temporary files. Saved records are used during 
the report's second pass for two-pass calculations, group 
sorting, etc. Therefore, the second pass of the report does not 
actually read the database again, instead it uses the saved 
records object.

Steps 1 to 5 are an iterative process that will repeat for each record 
being read.

Top/bottom N

and group

sorting

Top/Bottom N is a process that allows a user to select either the 
Top or Bottom N groups. N is the number you specify. Before you 
can use the Top N feature, your data must be subtotaled or 
summarized. The group sorting allows you to specify the order in 
which your “groups” are printed. This sort order is based on the 
subtotaled or summarized field, not the grouping field.

This process, an intermediate step between passes, actually occurs 
in between the first and second pass of the report process and does 
not actually require the records to be read. Instead it only looks at 
the grouping information stored in the saved records object and 
orders the groups as specified.

Pass #2 After completing the TopN/Group sort process, Seagate Crystal 
Reports enters into a second pass of the data. This means that the 
program will look at the saved records object for the current 
information and continue with the following elements of Pass #2.
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1. Read records that are contained in the saved records object. 
These records are read one at a time along with their 
respective subtotals.

2. Once the subtotal or summary information is available, the 
group selection formula can be applied. The group selection 
formula allows the user to select groups based on the 
subtotaled or summary field, not the grouping field. For 
example, you may only want the groups that have a subtotal 
greater than X.

HINT: The Group Selection Formula Editor can be used for record
selection formulas, however it is not recommended. If, for
example, you chose to use a typical selection such as:

{company.LASTNAME} = “SMITH”

in the Group Selection Formula Editor, the records that are
displayed on your report may be correct, however, the subtotals,
summaries and grand totals will most likely be incorrect. All of the
subtotal/grand total information is calculated in Pass #1 and
therefore, if you decide to filter out records in Pass #2 the
subtotals will not be modified accordingly.

3. Evaluation of print time formulas. This process is known as 
“WhilePrintingRecords”. This would include formulas that 
have been explicitly defined as “WhilePrintingRecords” in the 
formula itself as well as formulas that refer to subtotals or 
summary fields. Examples of print-time formulas are:

●   % of subtotals

●   running totals or running averages

●   formulas explicitly marked “WhilePrintingRecords”

4. MetaPage Generation. These pages are generated to display 
your report to screen. MetaPages are similar to a standard 
Windows Meta File. Essentially each page is a “recording” of 
the individual report pages. Therefore, all of the lines, boxes, 
fields, etc., are stored in the MetaPages. This method of 
storing report pages is much more efficient than storing the 
pages as bitmaps. For example, the following diagram is a 
flow-chart of the multi-pass report process:
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B Product Support

What you will find in this chapter...

Product support, Page 636

Web support, Page 636

E-mail support, Page 636

Fax support, Page 637

Telephone support, Page 638

Extended technical support policy, Page 639

Product registration, Page 639

Product return policy, Page 641

Product replacement policy, Page 641
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Product support

Seagate Crystal Reports is a powerful report writer for the 
Windows environment. Seagate Software IMG, Inc. is proud of 
the quality of the product and has spent a great deal of time trying 
to make it intuitive to use. If, however, there is something you can 
not figure out how to do, you should consult the extensive online 
help system. The help system can be accessed by clicking on any 
Help button, by pressing the F1 key, or by choosing the CONTENTS 
command from the main Help menu. The help system contains all 
of the information from the User’s Guide, as well as in-depth 
explanations and numerous examples. 

NOTE: Product support plans vary from region to region. Contact

your local distributor for a list of product support plans available

in your region. See README.HLP for a list of International

distributors.

Web support

WEB SITE

http://www.img.seagatesoftware.com/

E-mail support

INTERNET

●   Report Creation and Design
tsrcad@img.seagatesoftware.com 

●   Delphi/VCL
tsvcl@img.seagatesoftware.com

●   dBase and Paradox
tsxbse@img.seagatesoftware.com

●   Report Engine API
tscrpe@img.seagatesoftware.com 
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●   Crystal Info Product Support
tscinfo@img.seagatesoftware.com

●   Report Engine NewEra Class Library Issues
tsnewera@img.seagatesoftware.com

●   Report Engine C++ Class Library Issues
tsmfc@img.seagatesoftware.com

●   Miscellaneous Issues
tsmisc@img.seagatesoftware.com

●   Operating System Specific Issues
tsosplat@img.seagatesoftware.com

●   Visual Basic, VBX, OCX Support
tsvbocx@img.seagatesoftware.com

●   PC database connectivity Support
tspcdata@img.seagatesoftware.com

●   SQL/ODBC connectivity Support
tssql@img.seagatesoftware.com 

●   OLE Automation Tools
tsole@img.seagatesoftware.com

●   Web Developer Tools
Web Viewers
ActiveX Viewers
tsweb@img.seagatesoftware.com

●   Holos, Essbase, and other OLAP Products
tsolap@img.seagatesoftware.com

Fax support

Another efficient way to receive support on Seagate Crystal 
Reports is to fax in your technical support request. To do this, first 
fill in the bottom part of the Technical Support Request form in the 
product. This form appears when you choose the TECHNICAL 
SUPPORT REQUEST command from the Seagate Crystal Reports 
Help menu. When you have completed the form, click the Print 
button to print it.
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Fax the completed form to Seagate Software 24 hours a day, 
Monday through Friday. After a technical support representative 
has had a chance to review your fax, one of the support 
representatives will respond to you by return fax the next 
business day.

NOTE: Product support plans vary from region to region. Contact

your local distributor for a list of product support plans available

in your region. See README.HLP for a list of International

distributors.

Seagate Fax Support (604) 681-7163

Telephone support

Registered users of Seagate Crystal Reports are entitled to free 
telephone support (subject to availability) for 60 days from the 
time of purchase. Telephone support is available from 8 a.m. to 5 
p.m., P.S.T. Monday through Thursday and 8 a.m. to 4 p.m. P.S.T. 
on Friday. If you are calling from outside the Vancouver, B.C. 
area, long distance charges apply.

Before you call technical support, make sure you do the following:

●   check the manual,

●   check the online help system, and

●   check the Internet (www.img.seagatesoftware.com).

Please have the
following
information
available:

1. Serial number.

●   If you are registered, you can find the serial number by 
choosing the ABOUT SEAGATE CRYSTAL REPORTS command 
on the Help menu.

●   If you are not registered, you will need to register first to 
obtain your serial number.

2. Product name and version number.

3. Operating system you are using (i.e., Windows 95, Windows 
NT, or Windows 3.1) and whether you are using a 16-bit or 
32-bit version of Seagate Crystal Reports.
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4. Version of database and other software you are using with 
Seagate Crystal Reports (if required) - Btrieve, Sybase, 
Paradox, etc.

5. Technical Support Request form from the product.

6. Network information if you are on a network.

7. Contents of AUTOEXEC.BAT and CONFIG.SYS files.

8. A list of steps necessary to recreate the problem.

9. The database type you are using.

10. The programming environment (if applicable).

NOTE: Product support plans vary from region to region. Contact

your local distributor for a list of product support plans available

in your region. See README.HLP for a list of International

distributors.

Telephone Number (604) 669-8379

Extended technical support policy

Registered user may purchase an extended support policy which 
entitles the user to unlimited technical support via a toll-free 
number for a one year period. suport plan members will receive a 
special toll-free phone number which they can use to get directly 
through to the Technical Support team, and will receive priority 
handling in the support queue. Call (604) 681-3435 for (800) 877-
2340 for detailed information about this plan.

NOTE: The extended technical support policy is available in the

United States and Canada only.

Product registration

When using Seagate Crystal Reports for the first time, a dialog box 
will appear that asks for your name, address, and related 
information. Then the program will suggest that you register the 
program to receive your product Serial Number. The program 
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will ask for the Serial Number the next time you run Seagate 
Crystal Reports. When you enter the Serial Number, you have 
completed the registration process. You can register the program 
using four different methods:

1. If you have access to the Internet, fill out the Product 
Registration form on the Seagate web site at:

www.seagatesoftware.com/crystalreports/
register/

You can also go directly to the Registration form by choosing 
the PRODUCT REGISTRATION command on the Help|Seagate 
Software on the Web menu. The procedure will immediately 
transmit a registrtion number back to you so you can enter it 
into the product.

2. Fill out the Registration form that is built into the program 
and then register by modem using the Seagate Crystal 
Reports communications program. The procedure will 
register your copy of the program, assign a registration 
number, and enter that number automatically into your 
system.

3. Print the Registration Form and then fax it to Seagate 
Software at (604) 681-5147.  Seagate will then fax back to you a 
registration number that can be entered into the product the 
next time it asks for it.

4. Fill out the enclosed Registration Form and mail it to Seagate 
Software. Seagate will mail a registration number back to you 
so you can enter it into the product.

Registering the program will ensure that you are kept up to date 
with all product advancements, and it will allow Seagate to 
provide quality technical support to people that are properly 
registered with Seagate Software.

Registration FAX (604) 681-5147
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Product return policy

If you are not satisfied with Seagate Crystal Reports for any 
reason, you can return it to the original place of purchase for a 
refund within 30 days of the purchase date.

Product replacement policy

If the Seagate Crystal Reports diskettes or documentation are 
defective, then please contact Seagate Software Information 
Management Group, Inc., within 30 days of the purchase date. Fax 
the description of the problem and Seagate will solve it as quickly 
as possible. Please fax the description of the defect to (604) 681-
2934.

NOTE: Replacement policies vary from region to region. Contact

your local distributor for a list of replacement policies available in

your region. See README.HLP for a list of International

distributors.
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Glossary

Absolute

formatting

Formatting that is always applied to an object. See also Conditional 
Formatting.

Access To access data means to retrieve data.

Acrobat Reader Application used to review and print online manuals.

Active database An active database is a database that has been selected for use in 
a report. You activate databases via the NEW command on the File 
menu and the ADD DATABASE TO REPORT command on the 
Database menu.

Active Server

Page

Active Server Pages are web pages that run under Microsoft’s 
Internet Information Server (IIS) version 3.0 and later. Active 
Server Pages combine HTML, VBScript or JScript, and ActiveX 
controls to create dynamic web pages that can be viewed from any 
of the most popular web browsers. The Crystal Report Engine 
Automation Server, the Crystal Design-Time ActiveX Control, 
and the Crystal Active Data Driver can be combined to create 
active web sites in Microsoft Visual InterDev that display reports 
from an Internet or intranet site.

ActiveX

Control

Custom Control for Visual Basic 4.0 that incorporates the Object 
Linking and Embedding (OLE) technology. Formerly known as 
an OLE Control (OCX).

Aggregate

functions

An operation that summarizes data (sums, calculates an average, 
identifies a maximum value, etc.). The term “Aggregate 
functions” is often associated with SQL data sources.
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Alias An alias is an alternative name assigned to a database. If a 
database is called CUSTOMER.DB, for example, you can assign 
the alias customer, cust, company, DB1, or any other name that 
suits your needs. Aliases make it easier for you to use a report 
created with a database whose name and/or location has changed 
since the report was created.

Area An area is a group of like sections (i.e., Details A and Details B) 
that all share the same characteristics but can be formatted 
differently.

Argument An argument is an item, or one of a group of items, that receives 
the action of a function. It provides information that the function 
needs in order to operate. The Truncate function, for example, can 
not operate by itself. It needs an argument that identifies the item 
to be truncated. Thus, in the formula:

Truncate ({orders.ORDER AMOUNT})

«Where Truncate is the function and {orders.ORDER 
AMOUNT} is the argument, it is the value of the 
{orders.ORDER AMOUNT} field that is the item to be 
truncated.»

Array An array is a group of values, separated by commas. Arrays are 
used with a variety of Seagate Crystal Reports functions: Average 
([array]), Maximum ([array]), etc. In these functions, the array is 
the argument for the function. The function works on the items in 
the array. Items in an array can be constants, data fields, or 
formula results. 

Arrowhead A symbol to show that a field is indexed.

Attribute An attribute is a quality applied to an object (i.e., font size, color, etc.).

Auto arrange When you place a field on your report, the program allocates a 
space equal to the field width as specified in your database. Often 
that field width is far larger than the values that actually appear in 
each of the fields. For neat looking reports, it is often necessary to 
resize the fields so the space allotted more closely matches the size 
of the field values. Once you have resized the fields you often 
need to reposition them for proper balance. 
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Auto Arrange will do this for you. Simply choose the AUTO 
ARRANGE REPORT command from the Format menu.

Bitmap A graphic file that can be added to a report.

BLOB field A BLOB field is a field containing BLOB data. A BLOB (Binary 
Large Object) is simply a bitmapped graphic that has been entered 
into a database. Placing a BLOB field on your report allows you to 
access these graphics as you would other data types.

Boolean

expression

A Boolean expression is an expression that defines a logical 
relationship between two or more items. A Boolean expression is 
either TRUE or FALSE. A>5 And B<10 is a Boolean expression 
that uses the Boolean operator And. For the expression to be 
TRUE, both conditions (joined with the And operator) must be 
true. The value of A must be greater than 5 and the value of B must 
be less than 10. If the values do not fall into those ranges, then the 
expression is FALSE. Boolean expressions are useful in If-Then-
Else formulas. For example:

If A>5 And B<10 Then 
“In Range” 

Else 
“” 

This formula says, if the Boolean expression A>5 and B<10 is 
TRUE, print “In Range” otherwise (if the Boolean expression is 
FALSE), print nothing (as designated by the empty string “”). 

Boolean

formulas

Boolean formulas are formulas that return a Yes/No (TRUE/
FALSE) value. For example, the Boolean formula {orders 
detail.QUANTITY} > 6 compares the value in the {orders 
detail.QUANTITY} field to 6. If the value is greater than 6 it 
returns a Yes; if it is 6 or less, it returns a No. Contrast this with a 
non-Boolean formula like {orders detail.QUANTITY} * 6. In this 
case the program returns a number, the value of {orders 
detail.QUANTITY} multiplied by 6. All record and group 
selection formulas must be Boolean.

Browser A browser is an application that enables viewing of documents in 
HTML format.
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Calculated

data field

A calculated data field is a field that holds a value that comes from 
a calculation instead of coming directly from a database. For 
example, if the database you are using includes a {file.SALES} 
field and a {file.COST} field but no Gross Profit field, you can still 
show gross profit on your report, if you wish, using a calculated 
data field. To create a calculated data field, you simply create a 
formula that subtracts {file.COST} from {file.SALES}. The formula 
calculates a Gross Profit value for each row and prints it wherever 
you place the formula.

Case sensitive Case sensitive means that a program differentiates between 
uppercase and lowercase letters when evaluating a text string. A 
case sensitive search for the word “house” will return only the 
value “house,” but a non-case sensitive search will return 
“house,” “House,” “HOUSE,” “HoUsE,” and similar mixed-case 
responses. Seagate Crystal Reports operators (Equal, In string, 
etc.) are case sensitive.

Column A column is the display of data from a single field or formula. 
Columns run up and down the page. The words column and field 
are sometimes used interchangeably in the documentation. 
Contrast with Row definition.

Comments Comments are blocks of text that accompany formulas to describe 
their functionality. Seagate Crystal Reports ignores comments 
when it runs the formula.

Concatenate Concatenate means to join two or more text strings together to 
form a single contiguous string.

Condition In an If-Then-Else formula, the condition is the If part of the 
formula, the set of circumstances that must take place (be true) to 
trigger the Then (or consequence) part of the formula. In the 
formula If x<5 Then x Else 5, the expression x<5 is the condition.

Conditional

formatting

The ability to apply formatting to objects and sections only in 
certain situations. For example, you can conditionally format 
numeric database fields to display in red when negative.
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Conditional

formatting

formulas

Conditional formatting formulas are expressions that apply 
specific attributes to objects or sections only if certain criteria is 
met.

Conditional

properties

Performed on an object only if a comparison statement returns 
True.

Consequence In an If-Then-Else formula, the consequence is the Then part of the 
formula, the action that takes place if the If condition is met. In the 
formula If x<5 Then x Else 5, the expression Then x is the 
consequence.

Constant A constant is a value that is fixed and unchanging as opposed to a 
variable value which can take on different values depending on 
the circumstances. 

The value 5 is a constant; the value of the Quantity field (which 
sometimes may be 5, sometimes may be a different number) is a 
variable value. In the formula for converting pounds to ounces 
(Ounces = Pounds * 16) for example, 16 is a constant while Ounces 
and Pounds are variables. In the formula Today - January 1, 1900, 
January 1, 1900, is a constant, while Today is a variable that 
changes whenever the current date changes. In Seagate Crystal 
Reports, constants can be numbers, text strings, dates, dollar 
amounts, time, date/time, or the result of a formula that itself 
contains no variables (i.e., 14-9).

Container

document

A file that contains an embedded or linked OLE object.

Cross-tab A cross-tab is a report that summarizes data and then presents the 
summaries in a compact row and column format that makes it 
easy to make comparisons and identify trends. 

Database A database is a bank of related data. Each unit (record) of the 
database is typically organized in a fixed format to make it easier 
to retrieve selected portions of the data on demand. Each record is 
made up of one or more data fields, and each data field can hold 
one piece of data (known as a value).
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Data field A data field (or field) is the basic building block of a record. Each 
record is made up of one or more data fields, and each data field 
can hold one piece of data (known as a value). A customer record 
in a typical customer mailing list database might contain data 
fields similar to these: Name, Address, City, State, Zip, Phone, 
Fax. A data field can be empty or contain a value. Data field data 
is generally displayed or printed in columns in the Details section 
of a report.

Data source A data source is a database, table, query, dictionary, or stored 
procedure result set that provides the data for a report.

Data types A data type is a classification of the data that appears in a field or 
formula. Each piece of data used in a report or formula has one of 
the following data types: string, currency, number, date, date/
time, time, or Boolean (TRUE/FALSE). It is important to 
understand data types because each function and operator works 
with only a limited number of data types (often as few as one). For 
some operators (+ and - for example), the program uses a different 
set of calculation rules for one type of data than it uses for another.

Debug Eliminating errors that occur when you run a formula.

Default A default is a pre-loaded response to a software request for data. 
It is the response the computer accepts automatically if you do not 
enter different data. 

Details area A collection of one or more Details sections (i.e., Details A, Details 
B, etc.).

Details section The Details section of a report is the core section of the report. You 
structure the report in this section by inserting data fields, 
formulas, and other report elements.

Dictionary A one-stop, ready-to-use source of data that is usually created for 
end users by computer professionals within the organization. The 
dictionary takes away the need for the end user to search multiple 
databases, struggle with links, build formulas, and decode cryptic 
field names. The user just selects the data he or she needs from the 
dictionary and builds the report.
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Divide by zero

protection

PCs will not allow you to divide a number by zero. If you attempt 
such a division, you will get a system error message. To protect 
you from a system error, the program refuses to print a report 
which contains a formula that divides a value by zero.

Drag Drag means different things, depending on the context in which 
the word is used:

●   When referring to moving a field, drag means to click on the 
field box and, while keeping the button pressed, to move it 
to a new position using the mouse. You release the mouse 
button when the field is in the position you want it.

●   When referring to resizing a field, drag means to click on 
one of the field box handles and, while keeping the button 
pressed, to make the field bigger or smaller using the 
mouse. You release the button when the field is the size you 
want it.

●   When referring to formatting text, drag means to highlight 
the text of interest by moving the I-beam cursor across it 
while the button is pressed. You release the button when 
you have finished highlighting.

Dynamic Link

Library (DLL)

A Dynamic Link Library (DLL) is a special kind of file that contains 
Windows functions. DLLs are used by developers to extend the 
capabilities of Windows applications. The library is activated 
whenever a program or another DLL calls a function in the library. 
DLLs link on the fly, at runtime, whenever an included function is 
called. DLL functions are available on an as-needed basis to any 
program that can call DLLs; they do not need to be linked to the 
program via the compiler. The Crystal Report Engine can be called as 
a DLL by developers for use with applications they are developing.

Element The word element is used at times to describe individual report 
components such as database fields, formulas, and group fields. 
The Design Tab uses rectangular boxes to represent fields.

Embed,

Embedded

object

An embedded object contains a presentation of the object, all of 
the data that pertains to the object, and information about the 
application used to create it. When you modify the original object 
in the server document, nothing happens to the embedded object 
unless you specifically update that object.
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Empty date An empty date [designated as Date (0, 0, 0)] is a date that contains 
no month, day, or year, and thus does not print. Use an empty 
date in If-Then-Else formulas that either return a date or not. For 
example, the formula:

If PageNumber = 1 Then
PrintDate 

Else 
Date(0,0,0)

«Prints the print date on the first page and prints nothing on 
every other page.»

Since the Then part of the formula is a date (PrintDate), the Else 
part of the formula must be a date as well, but a non-printing date. 
To create such a non-printing (empty) date use the Date function 
and the arguments (0, 0, 0).

Empty number An empty number [designated as zero (0)] is a field value that is 
printed typically when a value does not meet a specific condition 
in a numeric If-Then-Else formula. Use an empty number to 
specify that 0 be printed. For example, in the formula:

If {file.FIELD} = 3.5 Then
{file.FIELD}

Else 
0

you are specifying that the numeric Gradepoint be printed (Then) 
if the grade point is 3.5 or higher. You are using the empty number 
0 to indicate that 0 is to be printed (Else) if the grade point is below 
3.5. Often a user will format the field that contains this formula to 
be suppressed if 0. In other words, nothing gets printed in the case 
of a zero value.

Empty string An empty string (designated as ““) is a string that contains no 
characters. Use an empty string to specify that nothing be printed. 
For example, in the formula:

If {file.FIELD} = 3.5, Then
“Cum Laude”

Else 
““
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you are specifying that the words Cum Laude be printed (Then) if 
the grade point is 3.5 or higher. You are using the empty string ““ 
to indicate that nothing is to be printed (Else) if the grade point is 
below 3.5.

Evaluation time Evaluation time refers to the time in the reporting process that a 
formula gets evaluated. Three evaluation times functions are:

1. BeforeReadingRecords

2. WhileReadingRecords

3. WhilePrintingRecords

For a complete discussion of the Evaluation Times, see Advanced 
Formulas, Page 345.

Expert Seagate Crystal Reports offers you several Experts. Experts are 
tools that take you step-by-step through various aspects of report 
creation. In most cases Experts have a series of numbered tabs. 
Simply begin at step one and proceed to the last step. When you 
have completed the last step, the Expert will do the rest of the 
work. Its that easy!

NOTE: The term �expert� in Seagate Crystal Reports is equivalent

to the term �wizard� in Microsoft Access.

Export Export means to distribute your report to a disk file or through e-
mail. Seagate Crystal Reports enables you to export your reports 
in many popular spreadsheet, database, word processor, HTML, 
and data interchange formats.

Field A field is the basic building block of a record. Each record is made 
up of one or more fields, and each field can hold one piece of data 
(known as a value). A customer record in a typical customer 
mailing list database might contain fields similar to these: Name, 
Address, City, State, Zip, Phone, Fax. A field can be empty or 
contain a value. Field data is generally displayed or printed in 
columns in the Details section of a report.

Field value See Value definition.
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Field width Field width is the size of the field in the originating database. A 
field width is generally fixed, and values in the field may take up 
all or only a part of the allotted width. The program includes Trim 
functions for removing excess white space from field values that 
do not fill their respected fields.

File A file is a collection of related data stored together under a single 
name. In Seagate Crystal Reports, each report is stored as a single 
file.

Fixed

properties

Properties that will always be performed on the object.

Flag A flag is a character or group of characters used to highlight or 
identify items of interest to call them to the reader's attention. For 
example, in an accounts receivable report, the words “past due” 
might be printed as a flag beside every past due account. 

Flat formula A formula that does not reference any database field. For example: 
1+1.

Footer A footer is text that appears at the bottom of a report page. Footer 
text often includes page numbers and sometimes other 
information that describes or identifies the report. Seagate Crystal 
Reports gives you the option of printing the footer on all pages or 
only on selected pages of your report.

Format bar The bar that displays buttons you can click to perform many 
common formatting tasks.

Form letter In Seagate Crystal Reports, a form letter is a letter that can be 
reproduced, personalized, and customized using the program’s 
powerful text object capabilities. Form letters generally include both 
text and field values. You create the letter, and the program runs it 
each time inserting values from a different record in the database.

Formula A formula is a symbolic statement of the manipulations you want 
performed on certain data before it is printed on your report. 

If your report is to contain a {file.SALES} field and a {file.COST} 
field, for example, you may want to create a GrossProfit field and 
designate its value as {file.SALES} - {file.COST}. This is a simple 
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formula that tells the program to subtract the value of the 
{file.COST} field from the value of the {file.SALES} field and then 
to print the result. 

You can use formulas to calculate numeric values, compare one 
value to another and select alternative actions based on the 
comparison, join multiple text strings into a single string, and for 
a multitude of other purposes. Creating a formula in Seagate 
Crystal Reports is much like creating one in your favorite 
spreadsheet.

NOTE: The term �formula� in Seagate Crystal Reports is

equivalent to the term �expression� in Microsoft Access.

Formula Editor The Formula Editor is used to create and edit formulas. It contains 
tools for inserting fields, functions and operators into the formula, 
for checking formula syntax and for typing in formula 
components and arguments. Modified versions of the Formula 
Editor are used for creating Record and Group Selection formulas.

Formula

language

The formula language is a powerful, easy to use, programming 
language designed for creating formulas.

Formula syntax Formula syntax is the set of grammar rules you are required to 
follow when creating formulas using the formula language.

Free form Free form implies that placement of objects is not limited to grids 
(vertical or horizontal).

Function A function is a built-in procedure or subroutine used to evaluate, 
make calculations on, or transform data. When you specify a 
function, Seagate Crystal Reports performs the set of operations 
built into the function without you having to specify each 
operation separately. In this way, a function is a kind of shorthand 
that makes it easier and less time consuming for you to create 
reports. 

Seagate Crystal Reports comes with a wide range of functions, 
and it also includes tools that allow you to build and save 
additional functions for yourself.

Grand total A grand total is the summary of all values in a column for the 
entire report.
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Grid In Seagate Crystal Reports, the grid is an underlying network of 
“lines” that are similar to the lines on graph paper. You can use 
these lines to help align fields and graphics. If you have the Snap 
to Grid option toggled on in the File Options dialog box, Seagate 
Crystal Reports will automatically align any fields you insert or 
resize to the nearest grid coordinate.

Group A group is a set of records that are related to each other in some 
way. In a customer list, for example, a group could consist of all 
those customers living in the same Zip Code, or in the same 
Region. In a sales report, a group could consist of all the orders 
placed by the same customer, or all of the orders generated by a 
specific sales representative. Seagate Crystal Reports offers you a 
great deal of flexibility in the way you group the data on your 
report.

Group Footer A Group Footer is a section created by the program whenever you 
insert a group, a summary, or a subtotal. The Group Footer section 
is typically used to display the summary or subtotal. 

Group Header A Group Header is a section created by the program whenever 
you insert a group, a summary, or a subtotal. The Group Header 
section is typically used to display the name of the group or some 
other identifying information.

Guidelines Guidelines are lines that are non-printing lines that you can use 
for aligning, moving, and resizing objects with precision. 
Guidelines enable you to work in a free form environment 
(without a grid), yet still have absolute control over the placing of 
objects in your report.

Header A header is text that appears at the top of a report page, above the 
body of the report. While a header can contain virtually any 
information, it often contains such things as the report title, 
company name, date, range of dates covered by the report, etc. 
Seagate Crystal Reports gives you the option of printing the 
header on all pages or only on selected pages of your report.

HTML The language used by the World Wide Web to publish web pages 
on the Internet that contain links to other pages.
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Index An index is a small file that identifies the location of each record 
in a database. Since a tiny index file can be searched or sorted 
much quicker than a large database, Seagate Crystal Reports uses 
index files to speed up the report generation process. In a search, 
for example, Seagate Crystal Reports searches the index for the 
correct field location. Once found, the program goes directly to 
the database field. Such a search does away with the need for 
searching every field of every record in a database. A database 
may have several indexes, each based on a specific field (or fields).

Indexed fields Fields in the database that are in a specific order to speed up the 
retrieval of particular records. Instead of searching through all the 
data in all the records, the program goes first to the index, and 
finds a pointer that direct it to the specific record it is looking for. 
Indexed fields are tagged with arrowheads in the Select Expert 
and Visual Linking Expert.

In-place editing The ability to change an OLE object’s properties while in Seagate 
Crystal Reports. The menu items change to provide the editing 
tools from the server application so that you can make the changes 
easily.

In-place ruler The ruler that appears when you are editing a text object. This 
ruler enables you to set tabs, and position objects with precision.

Insertion point The insertion point is a vertical line that indicates the point at 
which Seagate Crystal Reports will insert any text that you type in. 
You set the insertion point by moving the I-beam cursor to the 
position you want to insert text and click. When typing text for the 
first time in a Design Tab section, the program sets the insertion 
point flush left in the section, regardless of where you click the I-
beam cursor. 

Integer An integer is a positive or negative whole number or zero. 
Integers have no decimal places.

Link A link is a field that is common to two or more databases and that 
serves as a connecting point between those databases. Seagate 
Crystal Reports uses the link to match up records from one 
database with those from the other(s). For example, if the 
databases each contain a customer number field (even though the 
fields might have different names), Seagate Crystal Reports can 
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use those fields to electronically connect all records in one 
database with corresponding records in the other(s). When you 
create a single report based on multiple databases, the link assures 
that all the data in each row on that report refers to the same 
customer (transaction, invoice, etc.).

NOTE: The term �link� in Seagate Crystal Reports is equivalent to

the term �relationship� in Microsoft Access.

Linked object A linked object contains a presentation of the object, and a pointer 
to a defined part of the server document. When you modify the 
original object in the server document, the links assure that the 
object in your report is modified automatically as well. 
Conversely, if you modify the object in the container document, 
the original object file is modified as well.

Live header A live header is a header that changes dynamically with the 
content of a field. If you group your data by region, for example, 
a typical live group header would print the name of the region at 
the beginning of each group. 

Microsoft

Foundation

Class (MFC)

An object-oriented programming interface that encapsulates 
many related function calls into one object.

Nesting In Seagate Crystal Reports, nesting means to use one If-Then-Else 
expression inside another. For example, If employee’s degree is 
not Ph.D. Then (if employee's sex is male, use the salutation Dear 
Mr. Else use the salutation Dear Ms.) Else use the salutation Dear 
Dr. In this example, the nested If-Then-Else statement is 
surrounded by parentheses. The example says, check the degree 
field on the employee record to verify that the employee is not a 
Ph.D. If that condition is true (the employee is not a Ph.D.), then 
use a letter salutation based on the sex indicated on the employee 
record. (If the sex is male, Then use a male salutation. Else [if the 
sex is female] use a female salutation.) Else (that is, if the employee 
is a Ph.D.), use a Dr. salutation. By using this type of formula 
construction, you can create a wider set of conditions and a wider 
set of consequences easier than you could without nesting.
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Null Null means there is no value within a database field for a given 
record. It does not mean zero because zero is a value.

Null string A null string is an empty string. It contains no characters. If you 
were to use the Count function to count the string, it would return 
a length of zero. “” is used to designate a null string.

Numeric Numeric data is data on which you can perform arithmetic. The 
designation numeric refers to the way the data is treated by 
Seagate Crystal Reports and database programs, not to the way 
the data looks to you. 

For example, a serial number 12345 looks numeric, that is, every 
character is a number. But a serial number is not the kind of data 
on which you would want to perform arithmetic, so you would 
probably store a serial number as text instead of as numeric data. 

Numeric is one of several data types. Database programs require 
you to designate a data type when you create a field for use in a 
database. The data type you select determines the rules the 
program follows when dealing with the values stored in that field.

Object An object is one of several kinds of report elements that generally 
contain data and have specific properties that define their 
behavior or appearance. Seagate Crystal Reports uses the 
following kinds of objects:

●   field objects

●   text objects

●   cross-tab objects

●   graph objects

●   subreport objects

●   picture objects

●   OLE objects

Each of these objects can be formatted individually, moved, 
resized, duplicated, and so forth.

Object frame An object frame is a rectangular cursor that appears as an aid to 
placing database fields and formulas on your report. Once you 
have selected a field or created a formula, the object frame 
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appears. When you move the frame to the place in the report you 
want the field or formula to appear and click the button, the 
program inserts the item at the point specified.

ODBC ODBC stands for Open Database Connectivity. It is an interface 
that gives applications the ability to retrieve data in data 
management systems using SQL for accessing the data. Such an 
interface allows a developer to develop, compile, and ship 
applications without targeting specific database management 
systems. Also called interoperability.

OLE OLE is an acronym for Object Linking and Embedding. It refers to 
the ability to create compound reports, that is, reports that contain 
elements from other applications and that can be edited using the 
original application.

OLE container

application

An OLE container application is an application that can contain 
and process OLE objects created elsewhere (like Paint or 
Paintbrush, etc.). Seagate Crystal Reports is a container 
application.

OLE server

application

An OLE server application is an application that can create OLE 
objects that can then be placed in documents created by container 
applications. Seagate Crystal Reports is a container application, 
whereas Microsoft Word and Excel are examples of server 
applications.

One-to-many One-to-many refers to a situation occurring in linked databases in 
which one record in one database can be matched with many 
records in another database. An example of a one-to-many link 
would occur when linking a customer table to an orders table. In 
such a case, for every one customer in the primary database, there 
would typically be many orders in the second (lookup) database.

Operators Operators are special symbols that describe an operation or an 
action to take place between two or more values. 

The symbol / for example, is an operator that means divide. A/B 
means Divide A by B. Seagate Crystal Reports reads the operators 
in a formula and performs the actions specified. Seagate Crystal 
Reports contains arithmetic, string, comparison, Boolean, 
conversion, date, and range operators, among others.
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Order of

precedence

The order of precedence is a set of rules that determines the order 
in which arithmetic operations take place in a formula that 
involves multiple arithmetic operations. Multiplication (*) and 
division (/) are performed first (first tier operations), followed by 
addition (+) and subtraction (-) (second tier operations). When 
there are multiple operations involving the same tier, the order of 
precedence dictates that the operations are performed from left to 
right. You can use parentheses, if you wish, to alter the normal 
order.

Page Footer A section that prints at the bottom of each page. Page footers are 
typically used for page numbers, chapter names, and other 
identifying information.

Page Header A section that prints at the top of each page. Page headers are 
typically used for titles and other identifying information.

Parameter field A special kind of field that prompts the user for a value. You can 
use parameter fields for report titles, record selection, sorting, and 
a variety of other uses. Using parameter fields enables you to create 
a single report that you can modify quickly to fit a variety of needs.

NOTE: The term �parameter field� in Seagate Crystal Reports is

equivalent to the term �parameter queries� in Microsoft Access.

Paste Paste means to retrieve and place data from the Clipboard into a 
report or formula. The data may have been cut from the same 
report or formula or from a different one.

Perspective

Editor

The third party tool to change graphs that are plotted off the 
summaries in a report. (Also called PG Editor.)

Population A population is the entire set of values that might be tested 
statistically, as opposed to a sample which is a subset of the 
population. A population does not necessarily refer to a group of 
people; it can refer to the number of automobiles produced on an 
assembly line or the number of construction companies bidding 
on a project.

For example, a real estate agent might sell 20 houses in one year. 
The population of houses sold by that agent in that year is 20.
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Population

standard

deviation

Population standard deviation is a statistical test of how the 
values in an entire population (all values) deviate from the mean 
or average value for that population. Population standard 
deviation is most often used when all values are being evaluated 
as opposed to just a sample of those values (StdDev).

NOTE: This comparison simply suggests typical usage. In practice,

some users prefer a calculation based on N values

(PopulationStdDev) while others prefer a calculation based on N-

1 values (StdDev). Both forms of standard deviation are provided

by the program.

Population

variance

Population variance is the square of the population standard 
deviation. It is a measure of the amount by which the values in an 
entire population vary from the mean (average) value for that 
population. 

Population variance is typically used when all values are being 
evaluated as opposed to just a sample of those values (Variance).

NOTE: This comparison simply suggests typical usage. In practice,

some users prefer a calculation based on N values (Population-

Variance) while others prefer a calculation based on N-1 values

(Variance). Both forms of variance are provided by the program.

Properties Properties are qualities that define the appearance or action of an 
object or a section. There are two kinds of properties in Seagate 
Crystal Reports:

1. On/Off
A property that can only be toggled on or off.

2. Attribute
A property for which you have to supply a value.

Range A range is a set of values that fall between and include a defined 
upper and lower limit. For example, the range 10 to 20 includes 10, 
20, and all the numbers that fall between. Also, the range January 
1, 1991 to January 30, 1991, includes January 1, January 30, and all 
the dates that fall between. In Seagate Crystal Reports, a range can 
consist of numbers, dollar amounts, or dates. 
660 Seagate Crystal Reports User�s Guide



Record In a database, a record is a complete unit of related information, 
an electronic file folder that holds all of the data on a given entity. 
Each record contains one or more fields that contain the specific 
pieces of data of interest. In a customer database, for example, a 
record would store all of the data on a single customer. In an 
inventory database, a record would store all of the data on a single 
inventory item. Data from an individual record is displayed or 
printed as a row of data on a columnar report. 

Report A report is simply an organized presentation of data. As a 
management tool, a report is used to provide management with 
the insight it needs to run an organization effectively. Seagate 
Crystal Reports allows you to create comprehensive, customized, 
attractive management reports quickly and easily. But report in 
Seagate Crystal Reports also refers to invoices, form letters, 
mailing labels, and other related items that require the 
organization and output of data.

Report Footer The Report Footer section is the last section of your report in the 
Design Tab. You can place a summary in this section that you 
want to appear only on the last page of your report.

Report Gallery The Report Gallery is a special dialog box that appears when you 
click the NEW button on the standard toolbar or choose the NEW 
command from the File menu. The Report Gallery serves as a 
gateway to all the report creation experts and to the graphical 
interface for selecting the report and data type for creating custom 
reports.

Report Header The Report Header section is the first section of your report in the 
Design Tab. You can place a title in this section, or any data you 
want to appear only on the first page of your report.

Request A request is a set of criteria that specifies the subset of data that 
you want to use for your report. For example, if you want your 
report to contain only California data, you can create a record 
selection request that retrieves only California records for your 
report. You create record and group selection requests using the 
Select Expert.
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Returns The word “returns” refers to the result of a function, an operation, 
or a formula. For example:

●   When using a function, it performs a calculation or 
manipulation that results in a data change of some kind. 
The data that results is what the function returns. For 
example, Average(1, 2, 3, 4, 5) returns the average of the 
array 1, 2, 3, 4, 5. Truncate(1.2345) returns the integer (whole 
number) portion of the number 1.2345.

●   When using an operator, the result of the operation using 
that operator is what the operation returns. For example, 
5*6 equals 30. You can say that the operation 5*6 returns 30. 
Also, the operation 100<200 compares the two values and 
returns True; 200<100 compares the two values and returns 
False.

●   When using a formula that contains functions or operators, 
each function or operation within the formula returns a 
result, but the formula taken as a whole returns a result too. 
When talking about a formula, it is the result of the formula 
that is of interest, not the result of individual functions or 
operations. For example, in the following formula: 

If {file.QTY} < {file.REORDERAMOUNT} Then
“Reorder “

Else 
““

an internal operation compares the value of the {file.QTY} 
field with the value of the {file.REORDERAMOUNT} field. 
If {file.QTY} is less than {file.REORDERAMOUNT}, that 
individual operation returns the value True, but that is not 
what the formula taken as a whole returns. The formula, 
taken as a whole, returns the flag “Reorder” when the 
operation internally returns the value True.

Row A row is the display of data from a single record. Rows run 
horizontally across the page. The words row and record are 
sometimes used interchangeably in this manual. Contrast with 
column.
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Ruler The ruler provides a visual reference for positioning and resizing 
fields, graphs, lines, boxes, and bitmaps. The increments on the 
ruler are based on your measurement settings in the International 
section of the Windows control panel. The ruler also enables you 
to change page margins while immediately seeing the results of 
your changes on the report itself.

The Ruler is visible in both the Design Tab and Preview Tab when 
their respective check boxes are toggled on in the File Options 
dialog box.

Running totals Running totals are totals that are displayed generally on a record 
by record basis. They total all records (in the report, in the group, 
and so forth) up to and including the current record. For example, 
if your first three records have values of 2, 4, and 6, the running 
total for each of the three records would be 2, 6, and 12, 
respectively.

Sample A sample, as used in statistics, is a subset of a population used to 
represent the entire population. Researchers frequently do not 
have the option of testing an entire population before forming 
conclusions based on their tests. In such cases, they use a sample 
to represent the whole.

For example, political polling before elections is often based on 
questioning only four or five hundred people. From the answers 
given by this sample, predictions can be made on how an entire 
nation will vote.

Scroll bars,

scrolling

Sometimes a window can display only a portion of a document. In 
such a case, the window includes scroll bars that you can use to 
move other parts of the document into the window for your 
review. 

Scroll bars also appear with lists that are longer than the available 
window. The scroll bars allow you to move back and forth 
through the list. The process of moving through a list or document 
using scroll bars is called scrolling. In Seagate Crystal Reports, the 
screen automatically scrolls whenever you move the cursor 
outside the window and press and hold down the button.
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Section A section is a part of the report design environment. The program 
divides the design environment into several sections, each of 
which has different printing characteristics. You place objects in 
the various sections to build your report.    

Select ●   With regard to a report element (data field, formula, etc.), 
select means to point to the element and then click to choose 
the element as the object of the next menu selection.

●   With regard to text, select means to highlight the text by 
dragging the I-beam cursor over it.

●   With regard to records, select means to identify and choose 
those records of interest while disregarding all others.

●   With regard to groups, select means to identify and choose 
those groups of interest while disregarding all others.

Selection

formula

A selection formula is a formula that specifies the records, or 
groups of records, you want included in your report.

Server

document

A file that stores the original OLE object.

Shortcut menu A dynamic menu available in the Design and Preview Tabs. 
Access the shortcut menu by highlighting an object and right-
clicking.

Smart

Processing

Cache

The Crystal Web Report Server stores requested reports in the 
Smart Processing Cache directory. When a user requests a report 
through a web browser, the report is generated and stored in the 
cache. If another user requests the same report, the Crystal Web 
Report Server retrieves the report from the cache rather than 
generating it all over again.

Cached reports that remain unused for a long period of time are 
invalidated by the Crystal Web Report Server. Periodic clean up 
processes delete invalid reports from the cache to make room for 
more recent or more popular reports. This process of caching 
frequently used reports and deleting unused reports provides an 
efficient use of web server and network resources, reducing 
repetitive report generation and network traffic.
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Snap property Snap is a “magnetic” property that attracts nearby objects. Seagate 
Crystal Reports uses two facilities that have the snap property: 
Guidelines and the Grid. Whenever an object is moved close to a 
guideline or a grid coordinate, the program snaps it into position 
for accurate placement and alignment.

Sort and group

by field

A sort and group by field is a field that triggers the printing of a 
subtotal (or a group field value) whenever its own value changes. 

For example, you may have a customer report that contains the 
{customer.CUSTOMER ID} and {orders.ORDER AMOUNT} fields. 
If you want to subtotal by customer (total the orders for each 
customer), click the {orders.ORDER AMOUNT} field as the field to 
subtotal and the {customer.CUSTOMER ID} field as the sort and 
group by field. Seagate Crystal Reports sorts the data by customer, 
so that all orders from the same customer are grouped together. 
Then, whenever the value in the {customer.CUSTOMER ID} field 
changes (when it changes from one customer to a different 
customer), Seagate Crystal Reports prints a subtotal of the values 
in the {orders.ORDER AMOUNT} field (a total of orders for the 
individual customer). You can also use sort and group by fields to 
trigger summaries. See Sorting, Grouping, and Totalling, Page 271.

Sort direction Sort direction describes the way records or groups are printed in 
your report. They are printed either in ascending (A to Z, 0 to 9), 
or descending (Z to A, 9 to 0) order.

Sort field A sort field is a data field on which the sort procedure is based. A 
mailing list, for example, could be sorted, in ascending order, on 
the {customer.POSTAL CODE} field; that is, the customers would 
be sorted so that those with the lowest postal codes would appear 
first and those with the highest postal codes would appear last. 
The report could also be sorted in ascending alphabetic order, on 
the {customer.CONTACT LAST NAME} field; that is, customers 
with last names beginning with A would appear first and those 
with last names beginning with Z would appear last.

Sort order Sort order is an indicator of the direction in which you want your 
data to be presented once it is sorted. Data is typically printed in 
one of two sort orders: ascending (lowest to highest, earliest to 
latest, first to last, A to Z, etc.) or descending (highest to lowest, 
latest to earliest, last to first, Z to A, etc.).
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Sorting Sorting is a method of organizing the order in which data appears 
on your report. Seagate Crystal Reports provides you with 
powerful tools for sorting your report data.

SQL SQL stands for Structured Query Language; a system for 
managing, organizing, and retrieving data stored on a computer 
database. Structured Query Language is a computer language 
that enables you to interact with a specific type of database called 
a relational database.

SQL

pass-through

The ability to get the SQL Server to process the data retrieval 
criteria in order to pass the smallest possible result set back to 
Seagate Crystal Reports for final processing. When processing can 
be passed-through to the server, it makes the reporting process 
more efficient and it minimizes network traffic.

Standard

deviation

Standard deviation is the square root of the variance. It is a 
statistical test of how various values in a set of values deviate from 
the mean or average value for that set. You can use standard 
deviation, for example, for assessing the relative difficulty of tests 
given to students, for evaluating and projecting customer 
purchase patterns, or for comparing the results delivered by two 
or more products under evaluation (laboratory blood tests, smoke 
detectors, radar detectors, etc.). The uses are endless.

Standard deviation (as opposed to population standard 
deviation) is typically used to project the standard deviation for 
an entire population (all values) based on testing only a small 
sample of that population. For example, a company producing 
batteries with a new manufacturing process might want to test the 
batteries to determine how long they will last before they go dead. 
If the company tested all of its batteries, it would have no product 
left to sell. As an alternative, the company might test thirty 
batteries selected at random and project the mean burn out time 
and standard deviation for all batteries based on the results from 
that thirty battery sample. 

NOTE: This comparison simply suggests typical usage. In practice,

some users prefer a calculation based on N values

(PopulationStdDev) while others prefer a calculation based on N-

1 values (StdDev). Both forms of standard deviation are provided

by the program.
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Static OLE

object

A static OLE object is a picture of an object that is stored in a 
document when it is saved. The picture can be displayed or 
printed by a user who does not have the application in which the 
original object was created. The object can not be edited in place, 
however, without first converting it to an editable type of object. 
Static OLE objects offer better online and print performance than 
do standard bitmaps.

String A string is a series of connected characters (letters, numbers, 
symbols, spaces) stored and used as text. The word “hello” is a 
text string as is the phrase “Order # 2453“ and the customer 
number “B30-124-777.” Strings are sometimes referred to as text 
strings or character strings.

Subreports A subreport is a report within a report. It has all of the 
characteristics of a report with one exception: it can not itself 
include a subreport. Subreports can be free-standing or they can 
be linked to the data in the primary report. Seagate Crystal 
Reports enables you to insert as many subreports as you wish.

Substring A substring is simply a part of a larger string. “Columbia” is a 
substring of the string “British Columbia,” “1040” is a substring of 
the customer number “B-1040-0032456,” and “B” is a substring of 
the string “President Bill Clinton.” 

Subtotal A subtotal is a partial total, a total of a specific, limited group of 
data in a field. For example, given the following data: 

1, 2, 3, 4, 5, 6, 7

a subtotal after the 3 produces the value 6 (1 + 2 + 3). A second 
subtotal after the 6 produces the value 15 (4 + 5 + 6).

Summary A summary is the value generated as the result of an evaluation, 
a tally, or a calculation performed on data from a single group. 

A subtotal is the sum of all values from a single field, from all the 
records in a group. In a sales report, for example, if you subtotal the 
amount ordered by sales representative, Seagate Crystal Reports 
gathers all the records that belong to the sales representative and 
totals the amounts ordered from all the records. 
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In a group average, Seagate Crystal Reports averages the values in 
a group of records; in a group count, it counts the values in a 
group of records, and so forth. Summary values are important 
tools for creating powerful reports.

Summary field A summary field is a field that determines the sum of the values, 
the average value, the maximum value, the minimum value, or 
count of values in a group of values in a given field. Much like a 
subtotal, a summary field groups data to your specifications and 
then performs the requested calculation/determination. 

Syntax Syntax, in Seagate Crystal Reports, is a set of rules that specifies 
the proper way to use functions and operators in formulas. 

Tabs Tabs are used in many dialog boxes and Experts in Seagate 
Crystal Reports. Tabs resemble the tabs on common file folders. 
Tabs always have text on them to indicate what you will find on 
the Tab.

Template A template is a copy of a report used as the starting point for 
creating a new report. When a template is used, your original 
report remains unchanged.

Text object A text object is a specialized object that can contain text, database 
fields, and formula fields. It contains its own mini word processor 
that can be used for anything from adding a label to creating an 
entire document.

Text string A text string is text that is entered directly onto the report itself 
instead of being entered via a data field or formula.

Toolbar A bar at the top of Seagate Crystal Reports application window 
which contains a number of buttons that you can click to activate 
the most frequently used commands.

Total A total is a sum of values. Subtotals and grand totals are different 
varieties of totals.

Truncate Truncate means to cut off or eliminate all data that comes after the 
decimal point. Thus, if you truncate 1.2345, you get the value 1. If 
you truncate the value 1.9999 you also get the value 1. Truncate 
does not round data, it simply cuts off unwanted data.
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Two pass

formula/

function

A two pass formula is a formula that requires two passes through 
the data for completion. The first pass performs some calculation 
or selection and the second pass performs a calculation or 
selection that uses the result generated by the first pass. 

An example of a two pass formula is one that calculates the sales for 
each sales representative as a percent of total company sales. The 
first pass sums the sales for each representative to arrive at total 
company sales. The second pass divides the sales per representative 
by total company sales to calculate the percent of total sales.

Underlay The ability of an object (a bitmap, a graph, etc.) to print beneath 
multiple sections which follow the section in which it was placed. For 
example, you can place a bitmap in one section, format the section to 
underlay the following sections and then expand the bitmap so it 
appears as a background for the entire page of your report.

Value A value is the data found in a field. In a field called 
{customer.CONTACT FIRST NAME}, for example, John or Mary 
might be the value. In a field called {orders.ORDER AMOUNT}, 
1234.55 or $200 might be the value.

Variance Variance is the square of the standard deviation. It is a measure of 
the amount by which all values in a group vary from the mean 
(average) value in the group. It is a statistical test that can be used 
to evaluate the variability in a group of values (for example, the 
amount bid by each of the bidders on a construction project). 

Variance (as opposed to PopulationVariance) is most often used 
to project the variance for an entire population (all values) based 
on testing only a small sample of that population. For example, 
with a limited number of bids in on a construction project, you 
might want to project the variance for all bids based on the sample 
already in. Or, based on sales figures for the first three months of 
the year, you might want to project the variance for orders for the 
entire year (including the nine months yet to come). 

NOTE: These comparisons simply suggest typical usage. In

practice, some users prefer a calculation based on N values

(PopulationVariance) while others prefer a calculation based on

N-1 values (Variance). Both forms of variance are provided by the

program. For a more thorough discussion on the use of variance,

consult any reliable statistics text.
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Verify In Seagate Crystal Reports terms, verify does not mean to repair 
and compact the database (MDB file) in Access. It means to let the 
report understand the changes made to the database structure 
(fields and tables, NOT records).

Wildcard A wildcard is a character that represents any character (?) or any 
group of characters (*) in a search string. For example, if you are 
searching for Dan*, the search string will return strings like Danny 
and Daniel.

Word wrap Word wrap is a word processor-type property of a text object that 
automatically moves a word to the following line when the word 
is too long to fit the remaining space on the current line.
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